## Contents

### Chapter 1. About Financial Management

- Financial Management Features ........................................... 15
- Architecture ........................................................................... 16
- Performance Management Architect ....................................... 16
- Workspace ............................................................................... 16
- Financial Management Dimensions ........................................ 16
  - Scenario Dimension ............................................................. 17
  - Year Dimension .................................................................. 17
  - Period Dimension ............................................................... 17
  - Entity Dimension .................................................................. 17
  - Value Dimension .................................................................. 18
  - Account Dimension ............................................................. 18
  - Intercompany Dimension ...................................................... 18
  - View Dimension ................................................................... 18
  - Custom Dimensions ............................................................ 18
- User-Defined Elements ............................................................ 19

### Chapter 2. Basic Financial Management Procedures

- Starting Financial Management ............................................... 23
  - Starting Financial Management from the Windows Desktop ....... 23
  - Starting Financial Management on the Web ............................. 24
  - Starting Financial Management with SiteMinder ..................... 24
- Opening Applications ............................................................... 24
- Setting User Preferences .......................................................... 25
  - Specifying Number Formatting ............................................. 26
  - Specifying File Extract Options .......................................... 26
  - Specifying Language Support ............................................. 26
  - Specifying Startup Options ................................................. 26
  - Setting User Preferences on the Desktop ................................. 27
  - Setting User Preferences on the Web ..................................... 27
- Using Financial Management Help ........................................... 28
- Exiting Financial Management .................................................. 28
Using Financial Management on the Desktop ............................................. 29
  Showing and Hiding Desktop Components ........................................... 29
  Setting the Point of View on the Desktop .......................................... 29
  Selecting Point of View Members on the Desktop .................................. 30
  Using Point of View Check Boxes in Explore Data .................................. 30
  Selecting Member Lists on the Desktop .............................................. 31
  Viewing Active Entities on the Desktop .............................................. 32
  Searching for Dimension Members on the Desktop .................................. 32
Using Financial Management on the Web .............................................. 33
  Setting the Point of View on the Web .............................................. 33
  Selecting Multiple Members ............................................................ 35
  Viewing Active Entities ................................................................. 36
  Searching for Dimension Members on the Web ...................................... 36
Managing Documents ............................................................................... 37
Managing Task Lists ............................................................................... 42
Managing Favorites .............................................................................. 45
Working with System Messages ............................................................ 46

Chapter 3. Managing Data .......................................................................... 49
  Working with Data Files .......................................................................... 49
    Data File Sections .............................................................................. 49
    Dimension Groupings ......................................................................... 51
    Data File Example ............................................................................. 51
  Load Methods ....................................................................................... 52
    Merge .................................................................................................. 52
    Replace ............................................................................................... 52
    Replace by Security ........................................................................... 53
    Accumulate .......................................................................................... 53
  Load Example ......................................................................................... 53
  Loading Data ......................................................................................... 54
    Viewing Data Load Progress ............................................................. 57
    Canceling Data Load Tasks ............................................................... 58
  Loading Submission Groups ................................................................. 58
  Extracting Data ..................................................................................... 59
  Copying Data ......................................................................................... 61
    Copying Line Item Detail ................................................................... 64
    Copying Intercompany Transactions .................................................. 65
  Clearing Data ......................................................................................... 65
### Chapter 4. Using Explore Data on the Desktop

- Starting Explore Data ............................................... 67
- Working with Data Grids ........................................... 67
- Selecting Explore Data Settings .................................... 68
  - Setting Grid Column Widths ........................................ 68
  - Saving Data Grid Settings ......................................... 69
- Opening Data Grids .................................................. 69
- Entering or Editing Data ............................................. 70
  - Entering Data into Summary-Level Time Periods ............... 70
  - Adjusting Data Using Operator Keys .............................. 71
  - Using Cell Colors in Data Grids to Determine Status .......... 71
  - Refreshing Data .................................................. 72
- Viewing Data in Data Grids ......................................... 73
  - Viewing Calculation Status ....................................... 73
  - Viewing Cell Information ......................................... 74
  - Viewing Cell Adjustments ....................................... 74
  - Adding Cell Text ................................................ 75
  - Viewing Cell Text ................................................ 75
  - Adding Line Item Detail .......................................... 76
  - Viewing Line Item Detail ......................................... 76
- Running Allocations .................................................. 77
- Locking and Unlocking Data ......................................... 77
- Running Data Explorer Reports ..................................... 78

### Chapter 5. Using Data Grids on the Web

- Creating Data Grids ................................................. 79
- Opening Data Grids .................................................. 80
- Data Grid Tasks .................................................... 80
  - Data Grid Options ................................................ 80
  - Process Management Options .................................... 81
- Working with Data Grids ............................................ 81
  - Setting Grid Rows and Columns .................................. 82
  - Setting Display Options ........................................ 82
  - Saving Data Grid Settings ....................................... 83
- Creating Data Grid Folders .......................................... 84
- Loading Data Grids .................................................. 85
- Extracting Data Grids ............................................... 85
- Deleting Data Grids .................................................. 85
- Entering or Editing Data ............................................. 86
Entering Data into Summary-Level Time Periods ........................................ 87
Filling Data Blocks ............................................................................. 87
Clearing Data ..................................................................................... 88
Using Data Cell Colors to Determine Status ........................................... 88
Refreshing Data .................................................................................... 89
Viewing Data in Data Grids .................................................................. 89
Viewing Calculation Status ..................................................................... 89
Viewing Process Level ........................................................................ 90
Viewing Cell Information ...................................................................... 91
Viewing Cell Adjustments ..................................................................... 91
Adding Cell Text .................................................................................. 92
Viewing Cell Text ................................................................................ 92
Attaching Documents to Data Grids ...................................................... 92
Line Item Detail Options ....................................................................... 93
Adding Line Item Detail ....................................................................... 94
Viewing Line Item Detail ..................................................................... 95
Viewing Cell History ........................................................................... 95
Running Allocations ............................................................................ 95
Locking Data ....................................................................................... 96
Unlocking Data .................................................................................... 96
Viewing Destination and Source Transactions ....................................... 97
Running Entity Transaction Detail Reports ......................................... 97
  Starting the Entity Transaction Detail Report .................................... 98
  Report Point of View ......................................................................... 98
  Selecting Rows and Columns for the Report ..................................... 99
  Displaying Line Item Detail ............................................................. 100
  Displaying Base Details ................................................................... 100
  Displaying Source and Destination Transactions ............................. 100
  Linking to Journal Detail .................................................................. 101
  Printing Entity Transaction Detail Reports ...................................... 101
Drilling Through to Intercompany Transactions .................................... 101
Drilling Through to FDM ..................................................................... 102

Chapter 6. Consolidating Data ................................................................. 103
Consolidation Process .......................................................................... 103
Translation Process ............................................................................... 105
Calculation Process ............................................................................ 106
Entering Currency Rates ....................................................................... 107
Entering Percent Consolidations ............................................................ 108
Chapter 7. Using Data Forms ...................................................... 115
  Viewing Lists of Data Forms ........................................... 115
  Opening Data Forms ................................................... 116
  Using the Data Form Toolbar ........................................ 116
  Viewing Data Form Instructions ...................................... 117
  Entering Data in Data Forms ........................................... 117
  Working with Cell Text ................................................ 118
    Entering Cell Text in Data Forms ................................... 118
    Viewing Cell Text in Data Forms .................................... 119
    Editing Cell Text in Data Forms ................................... 119
  Attaching Documents to Data Forms ................................. 120
  Entering Line Item Detail in Data Forms ............................ 120
  Viewing Line Item Detail in Data Forms ............................ 121
  Deleting Line Item Detail in Data Forms ........................... 121
  Using Linked Forms .................................................. 122
  Changing the Point of View in Data Forms ........................ 123
  Calculating Data in Data Forms ..................................... 123
    Suppressing Data in Data Forms ................................... 123
    Adding Members to Data Forms .................................... 124
  Exporting or Importing Data Forms to Excel ....................... 125
  Drilling Through to Intercompany Transactions .................... 126
  Drilling Through to FDM ............................................. 126

Chapter 8. Managing Ownership .............................................. 127
  Managing Ownership .................................................. 127
  Changing the Point of View .......................................... 128
  Setting Display Options ............................................. 128
  Filling Multiple Entities with Values ............................... 129
  Entering Ownership Information .................................... 129
Chapter 9. Reporting on Financial Management Data ........................................ 135
  Opening Reports ................................................................. 135
  Viewing Reports ................................................................. 137
  Working with Style Sheets ...................................................... 137
    Applying Report Style Sheets ............................................... 137
    Retrieving Style Sheets .................................................... 138
  Setting Report Descriptions .................................................. 139
  Saving Reports ........................................................................ 139
  Drilling Through to Intercompany Transactions .................................... 140
  Printing Reports ...................................................................... 141
  Deleting Reports ...................................................................... 142

Chapter 10. Processing Intercompany Transactions ............................................. 143
  Intercompany Transaction Module Features ......................................... 143
  Intercompany Transaction Security Roles ........................................... 144
  Sample Intercompany Transactions Task Flow ....................................... 145
  Intercompany Transaction Load Files ................................................ 147
    Section Headers in the Load File .............................................. 147
    Special Keywords in the Load File ............................................ 147
    Intercompany Transaction File Example ..................................... 148
  Load Methods ......................................................................... 148
  Loading Intercompany Transactions .................................................. 149
  Extracting Intercompany Transaction Files ......................................... 150
  About the Process Transactions Window .......................................... 151
  Creating Intercompany Transactions ............................................... 151
  Viewing Intercompany Transactions ................................................ 154
    Selecting an Entity and Partner ............................................... 155
    Displaying Transaction Columns .............................................. 156
    Displaying Transaction Rows .................................................. 157
    Viewing Partner Entity Transactions ......................................... 158
  Editing Intercompany Transactions ............................................... 159
  Assigning Reason Codes to Intercompany Transactions ......................... 159
Matching Intercompany Transactions ........................................ 160
  Auto-Match Process .......................................................... 160
  Auto-Matching Intercompany Transactions ............................ 164
  Creating Auto-Match Templates ......................................... 164
  Manually Matching Transactions with Tolerance Amount .......... 165
  Manually Matching Transactions without Tolerance Amount .... 167
  Generating Adjustments for Transaction Differences ............... 167
  Matching Status .................................................................. 168
  Match Code .......................................................................... 169
Unmatching Intercompany Transactions .................................... 169
Posting Intercompany Transactions ....................................... 170
  Posting Process ................................................................. 171
  Posting to Flow Accounts .................................................. 171
  Viewing Posted Status ....................................................... 172
Unposting Intercompany Transactions ..................................... 172
Viewing Intercompany Transaction Progress ............................ 173
Deleting Intercompany Transactions ...................................... 173
Reporting on Intercompany Transactions ................................. 174
Running Transaction Detail Reports ....................................... 174
  Displaying Transaction Report Columns ............................... 175
  Displaying Transaction Report Rows .................................... 177
Running Matching Reports .................................................... 178
  Selecting Matching Report Options ..................................... 178
  General Options .............................................................. 178
  Account Options .............................................................. 179
  Display Options .................................................................. 179
  Running a Matching Report by Account ................................. 179
  Running a Matching Report by Transaction ID ....................... 180
Exporting Transaction Reports to Excel ................................ 182
Drilling Through to Transaction Details ................................. 182
E-mail Alerts for Intercompany Transactions ............................ 182

Chapter 11. Using Journals ................................................... 183
About Journals ....................................................................... 183
Journal Security Roles .......................................................... 184
Setting Up Journals ............................................................... 184
  Starting Set Up Journals on the Desktop .............................. 185
  Using the Templates Process Pad on the Desktop ................. 185
Using Journal Templates ....................................................... 185
Contents

Creating Standard Journal Templates ........................................ 186
Creating Recurring Templates .................................................. 188
Viewing Template Lists .......................................................... 190
Displaying Journal Template Columns on the Desktop ..................... 190
Selecting Column Sort Order on the Desktop ................................ 191
Displaying Journal Template Columns on the Web .......................... 191
Filtering Journal Template Lists on the Web ................................ 192
Editing Journal Templates .......................................................... 192
Printing Journal Templates on the Web ......................................... 193
Deleting Journal Templates .......................................................... 193
Managing Journal Periods ......................................................... 194
Viewing Periods ...................................................................... 194
Opening and Closing Periods ..................................................... 195
Processing Journals .................................................................. 196
Starting Process Journals ............................................................. 197
Using the Journals Process Pad on the Desktop .............................. 197
Creating Journals ..................................................................... 198
Creating Auto-reversing Journals ............................................... 201
Creating Journals Using Recurring Templates ............................... 203
Scanning Journals ..................................................................... 204
Journal Status .......................................................................... 204
Managing Journal Groups ......................................................... 205
Creating Journal Groups .............................................................. 205
Removing Journal Groups ............................................................ 206
Viewing Journal Lists ................................................................. 206
Displaying Journal Columns on the Desktop ................................... 207
Selecting Column Sort Order on the Desktop ................................ 207
Filtering Journal Lists on the Desktop ........................................... 208
Displaying Journal Columns on the Web ........................................ 208
Filtering Journal Lists on the Web ............................................... 209
Editing Journals ...................................................................... 209
Selecting Dimension Members for Journal Detail ........................... 211
Collapsing the Grid Columns on the Desktop ................................ 212
Expanding the Grid Columns on the Desktop ................................ 212
Copying and Pasting Cells .......................................................... 213
Submitting Journals .................................................................. 214
Unsubmitting Journals ............................................................... 215
Approving Journals .................................................................. 216
Rejecting Journals .................................................................... 217
Chapter 13. Using E-mail Alerts .......................................................... 257
   About E-mail Alerts ........................................................................ 257
   Generating E-mail Alerts for Intercompany Transactions ............... 257
      Sending E-mail Alerts from the Intercompany Transactions Process Window .... 258
      Sending E-mail Alerts from the Intercompany Transactions Monitor Window ............. 259
      Sending E-mail Alerts from Intercompany Transactions Reports ................. 260
      Sending E-mail Alerts from Intercompany Partner Matching Reports .................. 260
      Intercompany Transactions E-mail Content ...................................... 261
      Receiving Intercompany Transaction E-mail Alerts ............................ 262
   Generating Alerts for Process Control ........................................... 262
      Process Control E-mail Content ...................................................... 263
      Receiving Process Control E-mail Alerts ....................................... 264

Chapter 14. Using Task Automation .................................................... 265
   Overview ......................................................................................... 265
   Available Financial Management Tasks ......................................... 266
   Prerequisites for Task Automation ............................................... 266
   Managing Taskflows ..................................................................... 266
   Creating Taskflows ..................................................................... 267
About Financial Management

In This Chapter

- Financial Management Features ................................................................. 15
- Architecture .................................................................................................. 16
- Performance Management Architect ........................................................... 16
- Workspace ..................................................................................................... 16
- Financial Management Dimensions ............................................................ 16
- User-Defined Elements ................................................................................ 19

Financial Management Features

Oracle’s Hyperion® Financial Management – System 9 is a comprehensive, Web-based application that delivers global collection, financial consolidation, reporting, and analysis in one highly scalable solution.

Financial Management supports these features:

- One unified view of enterprise financial information consolidates key performance and operating metrics from global sources in a scalable, Web-based application.
- “Virtual close” features trim days and weeks off your close cycle using Web-based intercompany reconciliations and a consistent set of data and business measures.
- Powerful multidimensional analysis identifies and reports new sources of profitability and cash flow at corporate, cost center, product, brand, customer, and channel levels.
- Flexible “what if” scenario management feature dynamically consolidates and reports all financial budgets, forecasts and plans, producing new statements as assumptions and facts change.
- High-volume, preformatted reports deliver timely, accurate financial information for internal management and external regulatory and government bodies from the same application.
- Prepackaged features are deployed out-of-the-box, quickly and cost-effectively, including features such as world-class allocations, multicurrency translations, and robust data integration with legacy applications, ERP, and CRM systems.
- Customizable and extensible application solves your issues quickly and cost-effectively, using industry standard tools.
Architected for the Web so users can easily and securely access global financial information from any location, using a standard Web browser. Relational data storage ensures mission critical data is available to users 24x7x365.

Architecture

Financial Management is designed to operate as a multitier system.
- The client tier contains the user interface and the ability to communicate with the application tier. You can display data and metadata, and enter data in this tier.
- On the Web server tier, you access the Web-enabled portions of Financial Management.
- The middle tier contains the domain intelligence and connections to the relational database.
- The data tier contains the relational database and all Financial Management data and metadata.

Performance Management Architect

Oracle's Enterprise Performance Management Architect is a component of Financial Management installation and configuration. You use it to create and work with applications and dimensions, and synchronize data.

For help on tasks performed in Performance Management Architect, see the Hyperion Enterprise Performance Management Architect Administrator’s Guide.

Workspace

Financial Management is available within Oracle’s Hyperion® Workspace. For information on tasks performed in Workspace, such as preferences or features in the Navigate, Favorites, Manage, or Tools menu, see the Hyperion Workspace User’s Guide, Administrator’s Guide and Web help.

Financial Management Dimensions

Dimensions describe an organization’s data and usually contain groups of related members. Examples of dimensions are Account, Entity, and Period. Financial Management supplies eight system-defined dimensions and enables you to populate up to four custom dimensions that you can apply to accounts.

Dimension members are arranged in hierarchies. Upper-level members are called parent members, and a member immediately below a parent member is referred to as the child of a parent member. All members below a parent are referred to as descendants. The bottom-level hierarchy members are called base-level members.
The following sections describe the system-defined dimensions. For information on setting dimension attributes, see the *Hyperion Enterprise Performance Management Architect Administrator’s Guide* if you are using Oracle’s Enterprise Performance Management Architect, or the *Hyperion Financial Management — System 9 Administrator’s Guide* if you are using Classic Application Administration.

**Scenario Dimension**

The Scenario dimension represents a set of data, such as Budget, Actual, or Forecast. For example, the Actual scenario can contain data from a general ledger, reflecting past and current business operations. The Budget scenario can contain data that reflects the targeted business operations. The Forecast scenario typically contains data that corresponds to predictions for upcoming periods. A Legal scenario can contain data calculated according to legal GAAP format and rules.

You can define any number of scenarios for an application and define attributes for Scenario dimension members, such as the default frequency, the default view, and zero data settings.

**Year Dimension**

The Year dimension represents the fiscal or calendar year for data. An application can contain data for more than one year. You specify a year range when you create the application and select a year from the Year dimension to process data.

**Period Dimension**

The Period dimension represents time periods, such as quarters and months. It contains time periods and frequencies by displaying the time periods in a hierarchy. For example, if the Actual scenario maintains data on a monthly basis, generally 12 periods of data are available for this scenario in a year. Financial Management supports years, months, and weeks for the period dimension. It does not support days for the dimension.

**Entity Dimension**

The Entity dimension represents the organizational structure of the company, such as the management and legal reporting structures. Entities can represent divisions, subsidiaries, plants, regions, countries, legal entities, business units, departments, or any organizational unit. You can define any number of entities.

The Entity dimension is the consolidation dimension of the system. Hierarchies in the Entity dimension reflect various consolidated views of the data. Various hierarchies can correspond to geographic consolidation, legal consolidation, or consolidation by activity. All relationships among individual member components that exist in an organization are stored and maintained in this dimension. Entities in an organization are dependent, base, or parent entities. Dependent entities are owned by other entities in the organization. Base entities are at the bottom of the organization structure and do not own other entities. Parent entities contain one or more dependents that report directly to them.
You define attributes for Entity dimension members, such as the default currency and security class, and to specify whether the entity allows adjustments and stores intercompany detail.

**Value Dimension**

The Value dimension represents the different types of values stored in your application, and can include the input currency, parent currency, adjustments, and consolidation detail such as proportion, elimination, and contribution detail. For example, the Entity Currency member stores the value for an entity in its local currency. The Parent Currency member stores the value for an entity translated to the currency of its parent entity.

**Account Dimension**

The Account dimension represents a hierarchy of natural accounts. Accounts store financial data for entities and scenarios in an application. Each account has a type, such as Revenue or Expense, that defines its accounting behavior.

You define attributes for Account dimension members, such as the account type, the number of decimal places to display, and whether the account is a calculated, consolidated, or intercompany partner account.

**Intercompany Dimension**

The Intercompany dimension represents all intercompany balances that exist for an account. This is a reserved dimension that is used in combination with the Account dimension and any custom dimension. Financial Management can track and eliminate intercompany transaction details across accounts and entities. You can also run intercompany matching reports to view intercompany transactions.

**View Dimension**

The View dimension represents various modes of calendar intelligence; for example, Periodic, Year-to-Date, and Quarter-to-Date frequencies. If you set the view to Periodic, the values for each month are displayed. If you set the view to Year-to-Date or Quarter-to-Date, the cumulative values for the year or quarter are displayed.

**Custom Dimensions**

Four custom dimensions are available for analysis of detailed data. You can use custom dimensions to store additional details associated with accounts, such as products, markets, channels, balance sheet movement, or types of elimination. For example, custom dimensions could include Product Line, Region, Channel, or Customers.
Many elements in Financial Management are user-defined. For example, when you set up applications, you give the application a label and a description.

This information is important for setting up and maintaining applications. For example, if you are creating an application and you name it My New App, an error occurs because spaces are invalid for application labels. Instead, you can name your application MyNewApp.

The following table lists user-defined elements, the minimum and maximum length for each element, and any additional restrictions. The table groups the elements by the modules in which they are found.

### Table 1  Requirements for User-Defined Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Min. length</th>
<th>Max. length</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Profile</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>1</td>
<td>20</td>
<td>None</td>
</tr>
<tr>
<td>Period label</td>
<td>1</td>
<td>20</td>
<td>● Must contain only alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot start with a number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot contain spaces, symbols, or diacritical marks such as umlauts.</td>
</tr>
<tr>
<td>View label</td>
<td>1</td>
<td>10</td>
<td>● Must contain only alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot start with a number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot contain spaces, symbols, or diacritical marks such as umlauts.</td>
</tr>
<tr>
<td>View description</td>
<td>0</td>
<td>40</td>
<td>Cannot contain an ampersand ( &amp; ).</td>
</tr>
<tr>
<td>Period description</td>
<td>0</td>
<td>40</td>
<td>Cannot contain an ampersand ( &amp; ).</td>
</tr>
<tr>
<td><strong>Create Application</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application label</td>
<td>1</td>
<td>10</td>
<td>● Must contain only alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot start with a number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Cannot contain spaces, symbols, or diacritical marks such as umlauts.</td>
</tr>
<tr>
<td><strong>Note:</strong> Application labels are not case-sensitive. For example, App1 and APP1 are considered the same application label.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application description</td>
<td>1</td>
<td>40</td>
<td>Cannot contain an ampersand ( &amp; ).</td>
</tr>
<tr>
<td><strong>Metadata Manager</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User-Defined Elements 19
<table>
<thead>
<tr>
<th>Element</th>
<th>Min. length</th>
<th>Max. length</th>
<th>Restrictions</th>
</tr>
</thead>
</table>
| Member label    | 1           | 20          | Must be unique. The label can contain up to 20 characters including spaces, but cannot start with a space.  
Note: If you are using an Oracle database, member labels cannot contain spaces.  
You cannot use the following characters in the member name:  
- period ( . )  
- plus sign ( + )  
- minus sign ( - )  
- asterisk ( * )  
- forward slash ( / )  
- number sign ( # )  
- comma ( , )  
- semicolon ( ; )  
- at symbol ( @ )  
- double quotation mark ( " )  
- curly brackets ( { } )  
- ampersand ( & )  
Note: You cannot use ALL as the name of an entity. |
| Member description | 0           | 40          | Cannot contain an ampersand ( & ). |
| Alias label     | 0           | 20          | Cannot contain an ampersand ( & ). |
| Security        |             |             | None                                                                         |
| Security class  | 1           | 80          | None                                                                         |
| Journals        |             |             |                                                                              |
| Journal label   | 1           | 20          | Cannot include the following characters:  
- period ( . )  
- plus sign ( + )  
- minus sign ( - )  
- asterisk ( * )  
- forward slash ( / )  
- number sign ( # )  
- comma ( , )  
- semicolon ( ; )  
- at symbol ( @ )  
- double quotation mark ( " )  
- curly brackets ( { } ) |
<table>
<thead>
<tr>
<th>Element</th>
<th>Min. length</th>
<th>Max. length</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: If you are using an Oracle database, journal labels cannot contain spaces.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journal description</td>
<td>0</td>
<td>255</td>
<td>None</td>
</tr>
<tr>
<td>Journal group</td>
<td>0</td>
<td>30</td>
<td>None</td>
</tr>
<tr>
<td>Journal line item description</td>
<td>0</td>
<td>50</td>
<td>None</td>
</tr>
</tbody>
</table>

**Load/Extract**

<table>
<thead>
<tr>
<th>Delimiter character</th>
<th>1</th>
<th>1</th>
<th>Must be one of the following characters and cannot be used in the file or in the file name:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>● comma (, )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● tilde (~)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● at sign (@)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● number sign (#)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● dollar sign ($)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● percent sign (%)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● ampersand (&amp;)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● carat (^)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● line (</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● colon (:)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● semicolon (;)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● question mark (?)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● back slash ()</td>
</tr>
</tbody>
</table>

**Note:** The ampersand (&) is not a valid delimiter for metadata .app files. You must use the same delimiter character throughout the file. Using different delimiter characters within the same file causes an error when you load the file.

**Data Explorer**

<table>
<thead>
<tr>
<th>Element</th>
<th>Min. length</th>
<th>Max. length</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell description</td>
<td>1</td>
<td>1900</td>
<td>None</td>
</tr>
<tr>
<td>Line item detail</td>
<td>1</td>
<td>80</td>
<td>None</td>
</tr>
<tr>
<td>Annotation</td>
<td>0</td>
<td>255</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** The following characters are invalid decimal characters for Data Explorer:

- back slash (\)
- forward slash (/)
- plus sign (+)
- minus sign (-)

**Documents**
<table>
<thead>
<tr>
<th>Element</th>
<th>Min. length</th>
<th>Max. length</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document names</td>
<td>1</td>
<td>16</td>
<td>The following characters are invalid characters for document names:</td>
</tr>
<tr>
<td>(including folder and report names)</td>
<td></td>
<td></td>
<td>• plus sign ( + )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• question mark ( ? )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• asterisk ( * )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• back slash ( \ )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• forward slash ( / )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• number sign ( # )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• comma ( , )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• semicolon ( ; )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• colon ( : )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• at sign ( @ )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• double quotation mark ( &quot; )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• curly brackets ( { } )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• line (</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• less than sign ( &lt; )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• greater than sign ( &gt; )</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• period ( . ) at the end of a document name</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
<td></td>
<td>Document names also cannot contain trailing or leading white space.</td>
</tr>
</tbody>
</table>
Starting Financial Management

You can start Financial Management from the Windows desktop or from a Web browser. You can also start Financial Management using Netegrity SiteMinder as a Web security agent.

Starting Financial Management from the Windows Desktop

When you start Financial Management, the Logon dialog box is displayed. Financial Management uses Windows usernames and passwords for authentication. You enter your Windows logon ID and password and the name of the domain server used by your organization. When you log on, the system stores the logon information in memory on your workstation. When you attempt to open an application, Financial Management determines whether you are a valid user, based on the user ID and password that you entered.

To start Financial Management from the Windows desktop:

1. From the Windows desktop, take one of these actions:
   - Double-click the Financial Management icon.
   - Select Start > Programs > Hyperion > Financial Management > Financial Management.

2. For Domain, enter the name of the domain to which to log on.

3. For User, enter your username.

4. For Password text box, enter the password that corresponds with your username.

5. Optional: Select Remember Password so that the system stores your password and you do not need to enter it each time that you log on.
Starting Financial Management on the Web

On the Web, you work with Financial Management in the Workspace environment.

For information on installing and configuring Workspace, see the Hyperion Reporting and Analysis — System 9 Installation Guide and Hyperion Workspace Administrator’s Guide.

To start Financial Management on the Web:

1. Ensure that the Web server is started and the Web application server is running in the Services panel.
2. In your browser, enter the URL for the Workspace Log On page.
   - Note: The default Workspace URL is http://localhost:port/workspace, where localhost is the name of the BI+ server and port is the TCP port on which the application server is listening. For Apache Tomcat, the default port for Workspace is 19000.
3. Enter your system user name.
4. Enter your system password.
5. Click Log On.
6. In Workspace, select Navigate > Applications > Consolidation and select an application.

Starting Financial Management with SiteMinder

When you set up Financial Management security, you can use Netegrity SiteMinder as a Web security agent. When you use SiteMinder, the user’s credentials are sent from SiteMinder. The system verifies the credentials sent by SiteMinder against the external authentication provider and uses the credentials to log you on to Financial Management.

To log on to the Workspace and access Financial Management using SiteMinder, see the Hyperion Reporting and Analysis — System 9 Installation Guide.

Opening Applications

An application is a set of dimensions and dimension members that meet a set of analytical or reporting requirements. For example, you can have an application to report on tax data and a separate application for sales analysis.

You can open one application for each Financial Management session that you are running. However, you can have several Financial Management sessions open, with different applications open on each session.
Note:
To access an application, you must be assigned as a user of the application.

Windows Procedure

➤ To open applications:
1 From the desktop navigation frame, select Open Application.
2 From Cluster, select the application server or cluster on which the application to open is running.
   If the server cluster is not listed, you may need to register it.
   a. Click .
   b. Select Use Automatic Load Balancing to automatically balance the load among servers or Use One Server Only.
   c. For Server, enter the name of one of the servers in the cluster that you want to register.
   d. Click Register, and click Close.
3 Click Connect.
   When you connect to an application server or cluster, the system authenticates your username and password. If you enter an invalid username-password combination, you cannot access or create applications.
4 Highlight the application to open, and click Open Application.

Web Procedure

➤ To open applications:
1 Select File > Open > Applications > Consolidation.
2 From the list of applications, select the application to open.

Setting User Preferences

You can specify user preferences for applications.

When you make any change in a user preference, you must log off and log back in for the change to take effect.

See these procedures:

● “Specifying Number Formatting” on page 26
● “Specifying Language Support” on page 26
● “Specifying File Extract Options” on page 26
● “Specifying Startup Options” on page 26
**Specifying Number Formatting**

You can specify number formatting for the decimal and thousands separator characters. The system uses this number format for the data in data grids, and in data load and extract. During data load, the system uses the user-defined decimal point and thousands separator. For data extract, the system uses only the user-defined decimal point. You can use any characters for delimiters except Arabic numerals (for example, 0 through 9), an ampersand (&), or a back slash (\).

**Specifying File Extract Options**

When you use Financial Management on the Web, you can specify whether to save all extracted files in Unicode format. The Unicode format for encoding text provides the ability to view multilingual characters. If you select this option, all extracted files including documents, reports, data files, metadata files, member list files, journals, rules, and security files are saved in Unicode format, using the UTF-16 character set.

Select the Unicode file option if the extract files might contain multibyte (Japanese or other) characters and your code page on the Web server does not support them. For example, if your default code page on the Web server is English, and you extract a file that contains Japanese characters, those characters are displayed correctly only if you select this option.

If you do not select to save all files as Unicode, only metadata files are saved as Unicode. All other extract files are saved as ASCII files.

**Specifying Language Support**

You can specify the language in which to display descriptions for metadata. The languages that you can select are based on the languages that you defined when you set up the application.

**Specifying Startup Options**

When you use Financial Management on the Web, you can specify an Financial Management application as your startup application. From the General Preferences in Workspace, you can select an Application, and when you log off and log back into Workspace, the Financial Management application that you selected opens automatically.

On the Web, the Preferences Current Startup Option displays your current settings. The system populates a list of applications, and the Current Web Server and Current Cluster boxes based on the Web Server and cluster that was used at logon.

You can select different startup options. This is useful in scenarios where you have multiple Financial Management Web Servers configured and would like to manually direct user access through specific Web Servers.
Setting User Preferences on the Desktop

➤ To set user preferences on the Desktop:

1 From an open application, select User Preferences.
2 For Decimal Character, enter the character to use for a decimal.
   This can be only one character. The default setting is a period (.)
3 For Thousands Separator Character, enter the character to use to separate thousands.
   This can be only one character. The default setting is a comma (,).
4 From Default Language for Descriptions, select the language to use for descriptions.
5 To save your preferences, click Save.
   The preferences are saved to the database for the current application.
6 Log off, and log back on for the changes to take effect.

Tip:
To restore the values to what they were before you changed them, click Restore.

Setting User Preferences on the Web

When you use Financial Management on the Web, you set user preferences through the Workspace.

➤ To set user preferences:

1 From the Workspace, select File > Preferences > Consolidation.
2 From the List of Applications, select an application.

Note:
The Current Startup Option boxes display your current settings. The system populates the list of applications, and Current WebServer and Current Cluster boxes, based on the Web Server and cluster that you used at logon.

3 Optional: To change the Consolidation Application Startup option:
   a. For Alternate WebServer, enter the Web Application name for the Web server to which you want to connect. If you do not specify a name, the application startup uses the default Web Server (hfm).

Note:
The new or alternate Web application must be configured with the Oracle's Hyperion® Workspace Web Server. For details on configuration, see the Hyperion Reporting and Analysis — System 9 Installation Guide.
b. From the List of Clusters, select a new application server cluster.

4 For Decimal Character, enter the character to use for a decimal.

5 For Thousands Separator Character, enter the character to use to separate thousands.

6 From Default Language for Descriptions, select the language to use for descriptions.

Note:
The languages are listed in alphabetical order.

7 Optional: For Extract Options, select Save all files in Unicode format.

8 To save your preferences, click Save.
The preferences are saved to the database for the current application.

9 Log off, and log on again for the changes to take effect.

Tip:
To restore the values to what they were before you changed them, click Restore.

Using Financial Management Help
Help on using Financial Management is available in the Financial Management Desktop and in the Web user interface.

➢ To access online help, take one of these actions:
  ▪ Select Help > Contents from the desktop, or click the Financial Management Help icon to show the Help contents.
  ▪ Click Help, or select Help on This Topic to access information about a dialog box.
  ▪ To access help in the Web, click Help at the top of any Financial Management Web page.

Exiting Financial Management
You can exit Financial Management from any module.

Windows Procedure
➢ To exit Financial Management, from the Financial Management Desktop, select File > Exit.

Web Procedure
  ▪ To log off from a Financial Management Web page, select File > Logoff, or click from the top menu and click Yes to confirm that you want to log off. The system returns you to the Logon dialog box, so that you can log on again if necessary.
Using Financial Management on the Desktop

When you log on to Financial Management in Windows, the Financial Management Desktop is displayed. The Desktop is the starting point for all Financial Management operations. The left side of the Desktop contains the navigation frame, from which you access application tasks. If you do not have the appropriate security rights for a certain task, you receive a warning message when you select that task.

The right side of the Desktop displays the form related to the task selected in the navigation frame. For example, if you select the Process Journals task, the Journals form is displayed on the right.

Showing and Hiding Desktop Components

You can show or hide various components on the Financial Management Desktop, such as the navigation frame, the toolbar, and the status bar. Hiding these components provides you with a larger workspace. Showing these components provides you with access to Financial Management modules and features. You must show the navigation frame to access any of the Financial Management modules.

➤ To show or hide components, from the Desktop menu bar:

- Select View > Navigation Frame, or click Navigation Frame to show the navigation frame, or deselect to hide it.
- Select View > Toolbar to show the toolbar, or deselect to hide it.
- Select View > Status Bar to show the status bar, or deselect to hide it.

Setting the Point of View on the Desktop

You use the Point of View bar to select a set of dimensions that determines the data accessed for an application. The system dimensions include Scenario, Year, Period, View, Entity, Value, Account, and Intercompany Partner, and custom dimensions such as Product, Region, and Customer. For the point of view, you can select eight system dimensions and up to four custom dimensions. See “Financial Management Dimensions” on page 16.

You specify the point of view when you create an application and can use it for various tasks and documents, or you can choose to override the point of view settings as required.

The entire Point of View bar is not always visible in modules on the Desktop. You can use the arrow keys at either end of the Point of View bar to scroll through all the current settings for each dimension.
Selecting Point of View Members on the Desktop

You set the point of view by clicking dimension members from the Point of View dialog box. When you click a dimension member to select it from the list, it is highlighted and displayed on the top line of the member list box.

Using Point of View Check Boxes in Explore Data

From the Explore Data module on the Financial Management Desktop, you can select dimension members to display on rows and columns of the Explore Data grid. To select a dimension member, you select the check box next to it. In the Explore Data grid, you select whether to display members based on the selected Point of View (POV) items.

For example, you can select items for the Entity dimension, and in the Explore Data grid, you can select whether to display Entity members based on the selected point of view items. See “Selecting Explore Data Settings” on page 68.

The following figure shows the check box for the Actual member selected to display the Actual member in the data grid:

![Figure 2 Selecting Point of View Items for Explore Data Grids](image)

To set the point of view from the Financial Management Desktop:

1. Open an application for which to set the point of view.
2. Click the Point of View bar to display the Point of View.
3. Take one or more of these actions:
● Select Scenario and highlight a member from the list of scenarios.
● Select Year and highlight a member from the list of years.
● Select Period and highlight a member from the list of periods.
● Select View and highlight a member from the list of views.
● Select Entity and highlight a member from the list of entities.
● Select Value and highlight a member from the list of values.
● Select Account and highlight a member from the list of accounts.
● Select ICP and highlight a member from the list of intercompany partners.
● Select a custom dimension tab, and highlight a member from the list of custom members.

Note:
Click to select a member list for each dimension in the point of view and select individual members from the member list.

4 Optional: To select dimension members to display on the data grid rows and columns, select the check boxes next to the dimension members.

Tip:
Click Select All to check all dimension members, or Deselect All to clear all dimension members for the grid.

5 Optional: To display dimension descriptions in addition to labels, select Show Descriptions.

6 Click OK.

Selecting Member Lists on the Desktop

You can set your point of view with member lists for each dimension. Member lists display a subset of related members that belong to one dimension. Using member lists can reduce the time that you spend browsing the hierarchy of members. For example, if Italy, France, and UK are used frequently in the point of view for the Entity dimension, you can create a member list named European Region. You can select from this list instead of browsing through the entire Entity dimension hierarchy.

Financial Management provides a number of system-defined member lists, such as [Descendants], [Children], and [Base]. System-defined member lists are enclosed in brackets ([ ]). You can also create additional member lists and load them into the application.

➤ To select a member list from the Financial Management Desktop:
1 Open an application for which to select a member list.
2 Click the Point of View bar and click .
3 From Select Member List, select a member list.
4 Optional: For Parent Member, enter a parent member to further filter the list. This can be used as a starting point for the list.

5 Optional: To view only active entities, select Active Entities Only.

Note:
This option is available only if the application is set up for Organization by Period.

6 Select the scenario, year, and period.

7 Click OK.

Viewing Active Entities on the Desktop

You can view the list of active children under a given parent if your application is set up to support the Organization by Period setting. Organization by Period enables you to preserve historical organizational structures and have them coexist in an application with the current organization. These organizational changes may be due to acquisitions, disposals, mergers, or reorganizations.

Organization by Period is determined through the use of the Organization by Period setting and the Active system account. The Active account value controls whether the entity should be included in the consolidation. See the Hyperion Financial Management — System 9 Administrator’s Guide.

You can view or change the value for Active accounts through data grids. In the point of view, you must select Active as the account, and <System> as the Intercompany Partner dimension list.

➤ To view active entities:

1 Click the Point of View bar.

2 From Select Member List, select a member list.

3 Optional: For Parent Member, enter a parent member to further filter the list. This can be used as a starting point for the list.

4 Select Active Entities Only.

5 Select the scenario, year, and period.

6 Click OK.

Searching for Dimension Members on the Desktop

You can use the Point of View dialog box to search for dimension members so you can quickly find a member within a large dimension. In addition to providing search capabilities, the Point of View dialog box displays your location in the dimension hierarchy. A period (.) separates each level of the hierarchy.
To search for dimension members on the Financial Management Desktop:

1. Click the Point of View bar.
2. Select a dimension tab.
3. Enter full or partial search criteria in the text box next to Next and Previous.

Tip:
You can use a partial name or description. For example, you can enter “Qu” to find Quarter1. You cannot use wildcard characters in the search.

4. Click Next, ➤, to display the next dimension member that contains the search criteria that you entered.
5. Continue until you find the appropriate dimension member, or click Previous, ◀, to view a previous member.
6. Click OK.

Using Financial Management on the Web

When you use Financial Management on the Web, you can navigate to tasks and documents in a browser view and set up custom task lists for frequently used tasks and documents.

Hyperion recommends that you add Financial Management to the exceptions for your Web pop-up blocker. When you perform some Financial Management tasks on the Web such as loading data, a status window pops up showing the task status. If you have a pop-up blocker enabled on your computer, the status window is not displayed.

Setting the Point of View on the Web

The point of view is a set of dimensions you define that determines the data accessed for an application and displayed in the data grid. The point of view can contain folders, which indicate that there are additional members for the dimension. You can expand the folders to show additional members in the hierarchy.

Financial Management provides initial point of view settings. When you change the settings, the point of view is updated with your changes. This User Point of View is available throughout the application session. When you exit the application, the information is saved and can be used the next time that you open the application.

The list of dimensions in the point of view indicates the dimension that you are selecting in these ways:

- The current dimension is represented by text, while the other dimensions are represented by links.
- The current dimension is enclosed by small, triangular characters.
- If you have set an alias for a custom dimension, the alias is displayed under the dimension name.
To set the point of view:

1. **From the Point of View bar, click a dimension.**

2. **To select a dimension member, highlight the member, or type the member label in Selected Dimension Value, where Dimension is the name of the dimension being selected and click OK.**

   ![Image of the Point of View bar]

   **Tip:**
   
   If you click a folder symbol, the folder name is displayed in the text box next to the member list, so that you do not need to type the name. If additional members are available for the dimension, you can expand them by clicking the plus (+) sign.

3. **Optional: To validate the member or member list syntax, click Validate.**

4. **To select a member from a member list other than the default of [Hierarchy], select the member list from Selector.**

   **Tip:**
   
   [Hierarchy] contains all members of a dimension.

5. **Optional: To filter the list using a top member, type a member for Selector, and click Enter.**

   The updated list displays the top member and its descendants.

6. **Optional: To display dimension descriptions in addition to labels, select Description.**

7. **Optional: To view only active entities, select Filter Active Entities only.**

   **Note:**
   
   This option is available only if the application is set up for Organization by Period.
8 To select a member for another dimension, click the link for the dimension at the top of the page and repeat these steps.

**Tip:**
To clear a dimension member, click Clear.

9 Click OK to apply your changes.

## Selecting Multiple Members

In several modules such as Extended Analytics, Database Management, and Data Extract, you can select multiple dimension members or use a member list to define the selection.

Member lists display a subset of related members that belong to one dimension. Using member lists can reduce the time that you spend browsing the hierarchy of members. System-defined member lists, such as [Descendants] and [Children] are enclosed in brackets ([ ]).

To select multiple members:

1 From the Point of View bar, click a dimension.

2 Expand the dimension members by clicking the plus (+) sign, or select a member list and click Expand selected list into members to display all the members in a list.

**Tip:**
If you click a folder symbol, the folder name is displayed in the text box next to the member list, so that you do not need to type the name.

3 Highlight the members to move them to Selected Values, or click Check All to select all members.

4 Optional: To move a selected member up or down in the list, highlight the member and click the up or down arrow.

5 Optional: To validate the members or member list syntax, click Validate.

6 To select a member from a member list other than the default of [Hierarchy], select the member list from Selector.

**Tip:**
[Hierarchy] contains all members of a dimension.

7 Optional: To filter the list using a top member, type a member name for Selector and click Enter. The updated list displays the top member and its descendants.

8 Optional: To display dimension descriptions in addition to labels, select Description.

9 Optional: To view only active entities, select Filter Active Entities only.
Note:
This option is available only if the application is set up for Organization by Period.

Tip:
To clear a dimension member, click Clear.

10 Click OK to apply your changes.

Viewing Active Entities

You can view the list of active children under a parent if your application is set up to support the Organization by Period setting. Organization by Period enables you to preserve historical organizational structures and have them co-exist in an application with the current organization. These organizational changes may be due to acquisitions, disposals, mergers, or reorganizations.

Organization by Period is determined through the use of the Organization by Period setting and the Active system account. The Active account value controls whether the entity should be included in the consolidation.

The option to filter active entities is enabled only after you select a scenario, year, and period in the point of view.

You can view or change the value for Active accounts through data grids. In the point of view, you must select Active as the account, and <System> as the Intercompany Partner dimension list.

To view active entities:

1 Click the Point of View bar.
2 Select a member list.
3 Optional: For Selector, enter a top member to further filter the list.
4 Select Filter Active Entities only.

Note:
This option is available only if the application is set up for Organization by Period.

5 Click OK.

Searching for Dimension Members on the Web

You can use the Point of View dialog box to search for dimension members so that you can quickly find a member within a large dimension. In addition to providing search capabilities, the Point of View dialog box displays your location in the dimension hierarchy.

You can search using wildcards before, after, or within the member name; for example, *con, con*, or *con*. To find the entity named Massachusetts, for example, type ma*. The search
defaults to the first member with a name that starts with “ma.” When you click Enter, the cursor moves to the next member that fits the criteria.

➤ To search for dimension members:

1. Click the Point of View bar to display the Point of View dialog box.
2. Select a dimension.
3. Enter full or partial search criteria for Selected Dimension Value.
4. Click Find Next Value to display the next dimension member that contains the search criteria you entered.
5. Continue until you find the appropriate dimension member, or click Find Previous Value to view a previous member.
6. When you find and select the dimension member, click OK.

Managing Documents

From the Manage Documents dialog box, you can work with task lists, data grids, data forms, reports, links, related content or custom documents. From the tabs in the Manage Documents dialog box, you can create, edit, load, extract, and delete documents, add them to your Favorites, or create document folders. You can create public documents that can be shared with other users. You can also create private documents, which are displayed in the Documents list of the user who created them.

You can select the All tab to work with different types of documents. When you use the All tab, you can delete or extract documents, create folders for them, or add them to Favorites all at once instead of selecting each individual document tab.

Figure 3  Manage Documents Dialog Box

When you load or create files of varying case sensitivity, the system sorts the file names alphabetically in the Documents list. File names that start with uppercase letters are displayed
alphabetically first in the list before those that start with lowercase letters. See “User-Defined Elements” on page 19.

➤ To access Manage Documents, select Administration > Manage Documents, or click Manage Documents.

Creating Document Folders

You can create a folder hierarchy to organize documents. The Root folder is available by default and cannot be deleted. Any folders that you create are created under the Root folder.

For information on restrictions for folder names, see “User-Defined Elements” on page 19.

➤ To create document folders:

1. Select Administration > Manage Documents, or click Manage Documents and select the tab for which to create folders.
2. Select New Folder.
3. Enter a folder name
   The name can contain a maximum of 20 characters, including spaces.
4. Optional: Enter a folder description.
   The description can contain a maximum of 80 characters, including spaces.
5. For Content Type, select the type of documents for the folder.

   Tip:
   If the folder will be used for all documents, select All.

6. Optional: Select Private if you want the folder to be private.

   Note:
   Private folders cannot be shared or viewed by other users. This option is only available if you have ALL access to at least one security class.

7. From Security Class, select the security class to assign to the folder.

   Note:
   Users of this folder must have access rights to the specified security class. This option is only available if you have ALL access to at least one security class.

8. Click OK.
Showing or Hiding Private Documents

When you create documents, you can save them as public documents that can be shared with other users. If you save documents as public documents, you must apply a security class to them. You can also save documents as private documents that are not displayed to other users. To view private documents of other users, you must be the application administrator.

➤ To show or hide private documents:

1. Select Administration > Manage Documents, or click Manage Documents and select the document tab for which to show or hide documents.
2. Take one of these actions:
   - To show private documents, click Show Private Docs. The documents are indicated by an icon next to the name (ظ).  
   - To hide private documents, click Hide Private Docs.

Setting Up Links to Documents or Web Pages

You can create a link in the Documents frame to link to a file or a Web page, and incorporate the link in a task list or define it as a favorite.

If you have a link to a Web page that could be time-consuming to open, you can select the option to have the system prompt you before opening it.

➤ To link to a document or Web page:

1. Select Administration > Manage Documents, or click Manage Documents and select Links.
2. Click New.
3. Enter the name of a document or the URL.
   
   Note:
   For a URL, you must enter a Web address and include http:// before the address.
4. Click View.
   The page opens in a new browser window to test connectivity.
5. To display the document or page within the current page, select Task List opens link within same page.
   
   Note:
   If you do not select this option, the document or page opens in a separate browser window.
6. Optional: Select Prompt user before rendering link so that the system prompts you with a confirmation dialog box before opening the document.
7. Optional: Select Include Single Sign On information in page request so that the single sign-on information is appended to the URL to enable you to sign on when you open the link.
8 To save the document in the task list, click Save.
9 To close the Links window, click Cancel.

When you return to the Documents frame, the link is added.

**Copying Document Links**

You can copy a Financial Management document link to the system clipboard and paste it into another product that supports single sign-on so the document can be viewed from that product. For example, you can open a Financial Management data form, copy the document link, and paste the link into a Oracle’s Hyperion® Planning – System 9 application so that the form can be displayed in a Planning Tasklist. In addition, from Planning you can copy a Planning document link and paste the link into a Financial Management application.

To copy a document link from Financial Management to Planning:
1 From Financial Management, open the document to copy from the list of documents in the view pane or from the Documents frame.
2 Select Administration > Copy Document Link.
3 Open a Planning application and paste the document link as a URL task in a Tasklist.

**Note:**
When you paste the link, make sure that you select Single Sign On so that the single sign-on information is appended to the URL to enable you to sign on when you open the link.

To copy a document link from Planning to Financial Management:
1 From Oracle’s Hyperion® Planning – System 9, open the document to copy.
2 Select Administration > Copy Document Link.
3 From a Financial Management application, select Links, click New, and paste the document link.

**Note:**
When you paste the link, make sure that you select Include Single Sign On information in page request so that the single sign-on information is appended to the URL to enable you to sign on when you open the link.

**Working with Custom Documents**

You can attach one or more documents to cells in data grids, data forms, and process management cells. You can attach any type of public document that you have stored in your task list. For example, you can attach a Microsoft Word document, Microsoft Excel spreadsheet, or XML file. You can load, extract, organize, view, and delete custom documents from the Custom Documents tab in the same way that you work with Financial Management documents.
To attach or extract any custom documents to or from the server, you must be assigned the Manage Custom Documents security role.

You can set a size limit for document attachments and a maximum number of document attachments by user when you create an application. You set the limits in the AppSettings attribute for the application metadata.

**Accessing Related Content**

You can include content that is contained in the Workspace directly within a Financial Management task list. When you create a related content document in Financial Management, it serves as a link to a resource in the other product. For example, you can view a report from Oracle's Hyperion® Financial Reporting – System 9 in HTML or as a PDF file. You can add the item to a task list or launch it separately from the Related Content menu in the view pane. You must be assigned the appropriate security rights to view the content.

Before you can use related content, you must perform these tasks:

- Set up a link to the related content resource server. You use the Financial Management configuration utility to set up the link.
- Configure external authentication. If you are not using external authentication, the Related Content tab is not displayed in Manage Documents.

See the *Hyperion Financial Management — System 9 Installation Guide*.

To access related content:

1. Make sure that your administrator has enabled external authentication and that a link is established to the related content resource server.

   **Note:**

   The Workspace URL is `http://<workspace_server>:19000/workspace/browse/listXML`.

2. Select Administration > Manage Documents, or click Manage Documents ![and select Related Content.](image)

   **Note:**

   If external authentication is not enabled, the Related Content tab is not displayed.

3. Click New.

4. For Resource Server, select the resource document to access.

   **Tip:**

   You can drill down to different directories by double-clicking folders.

5. Optional: To open the selected document, select When in a task list, open the selected document in the client area.
Note:

If you do not select this check box, the document that you select opens in a separate pop-up window.

You can select Close to close Related Content, or you can save the document.

6 To save the document:

a. From the list next to the document name, select the type of document to save the document as, and click Save.

b. For Name, enter a document name, or use the default name. The name can have a maximum of 20 characters.

c. Optional: For Description, enter a document description. You can enter up to 255 characters for the description.

d. Optional: From Security Class, select a security class.

Note:

This option is only available if you have ALL access to at least one security class.

e. Optional: Select Private if you do not want to display this task list to other users.

Note:

By default, if no security classes are available, the Private check box is grayed out and the document is automatically saved as a private document.

f. To overwrite a task list format, select Overwrite existing file.

g. Click OK.

Managing Task Lists

You can create, edit, and organize custom task lists on the Web for quick access to frequently used tasks and documents. After you create them, you can view and manage them from the Project or Browser view.

In the Browser view, task lists are listed in the top pane in a folder and the items contained in the task list are listed in the bottom pane. In the Project View, the entire list of task lists is displayed in the view pane in a tree hierarchy format. For Basic users, task lists are listed in the drop-down list and only the selected task list is displayed in the view pane in tree hierarchy format.

See these procedures:

● “Creating Task Lists” on page 43

● “Editing Task Lists” on page 44

● “Deleting Task Lists” on page 45
Creating Task Lists

You can create task lists on the Web that contain tasks that you perform frequently, data forms, data grids, reports, links, and related content. For example, suppose you need to enter intercompany balances in data forms, review intercompany balances in reports, and translate parent entities in a data grid. Creating a task list enables you to complete your workflow without navigating among forms, grids, and report modules.

You can create a public task list that can be shared with other users, or a private task list that is not displayed to other users. Private task lists can be accessed only by the users who create them. You can assign security classes to limit access.

You can attach a task or document in multiple places to the same task list. For example, a task list may contain these items for a workflow: Input Grid, Load Data, Input Grid, Process Control.

You can also attach a task list to another task list. For example, you can create a task list for journal actions and add it to a task list for closing tasks. When you create a task list, you define whether it can be added to other task lists. A task list that is attached to a major list cannot contain another task list.

In addition, you can attach document folders to task lists. For example, you can add a folder of data forms. You can attach a folder with subfolders, and you can modify a folder that is attached to a task list to add a subfolder to it. You can attach as many folders as you like to a task list. When a folder is attached, all documents and subfolders that exist in that folder are displayed in the task list, with any changes to the folder.

After you create and save a task list, it is available in the Project and Browser views.

➤ To create a task list:

1 **Take one of these actions:**
   - Select File > New > Tasklist.
   - Select Administration > Manage Documents, select Tasklists, and click New Tasklist.
   - Click Manage Documents, select Tasklists, and click New Tasklist.
2 **Click Add and select an item:**
   - Folder
   - Tasklist
   - Custom Documents
   - Data Forms
   - Data Grids
   - Links
   - Related Content
   - Reporting
   - Tasks
3 **Select the items to add, and click Add to Tasklist.**
4 Optional: To reorder items in a task list, highlight the item to move, and click the Up or Down arrow to change the sequence.

Tip:
To remove items from a task list, select the item and click Remove.

5 Click Save.

Note:
If you do not want to save your changes, click Close.

6 For Name, enter a task list name.
7 Optional: For Description, enter a description.
8 From Security Class, select a security class, or use the [Default] security class.
9 Optional: Select Private if you do not want to display this task list to other users.
10 To overwrite a task list format, select Overwrite existing file.
11 Click OK.
12 Click Save.

Editing Task Lists
You can edit task lists by adding or removing items.

Note:
Removing items from a task list only removes them from the task list that you selected. It does not delete items from the system.

➢ To edit a task list:

1 Select Administration > Manage Documents, or click Manage Documents and select Tasklists.
2 Select the task list to edit.
3 Add or remove items:
   a. To add items, click Add, select an item, then click Add to Tasklist.
   b. To remove items, highlight the item and click Remove.
4 To reorder items, click the item to move, and click the Up or Down arrow to change the sequence.
5 Optional: To make the task list your default, select This is my default tasklist.
6 When you finish editing items, click Save.
7 Click OK.
Deleting Task Lists

You can delete a task list that you no longer need.

➤ To delete a task list:

1. Select Administration > Manage Documents, or click Manage Documents \hspace{1em} and select Tasklists.
2. Select the task list to delete.
3. Click Delete.
4. Click OK.

Managing Favorites

You can add documents or task lists that you use frequently to your list of Favorites. You can view the list of documents marked as favorites, quickly access them from the Favorites section, or remove items as favorites.

Any changes that you make to the Favorites list are saved when you log out of the application.

See these procedures:

● “Adding Documents to Favorites” on page 45
● “Removing Favorites” on page 45

Adding Documents to Favorites

You can add documents that you use frequently, such as data forms, data grids, or reports, to the Favorites section. In addition, you can add task lists that contain documents or tasks that you frequently perform.

After you add favorites, you can view and access them from the Favorites section.

➤ To add favorites:

1. Select Administration > Manage Documents, or click Manage Documents \hspace{1em} and select the documents tab from which to add favorites.
2. Select the item to add.
3. Click Add to Favorites.

Removing Favorites

You can remove items from your list of Favorites.

➤ To remove items from your Favorites list:

1. Select Administration > Manage Favorites, or click Manage Favorites \hspace{1em}.
2 Select the item to remove.
3 Click Remove.
4 Optional: To delete all links that refer to moved or deleted documents, click Clean.

Working with System Messages

When you use Financial Management in a Web browser, you can retrieve, view, print, and delete Financial Management system messages. You can retrieve system messages by date, server name, and application name. Any user can access and clear the system messages log. System messages remain in the log until you delete them.

Caution!

You should review the error log frequently to ensure that the log table’s growth is limited. Hyperion recommends that you perform regular log maintenance, and that the log not exceed 500,000 messages.

See these procedures:

- “Retrieving System Messages” on page 46
- “Viewing and Printing System Messages” on page 47
- “Deleting System Messages” on page 47

Retrieving System Messages

You can retrieve system messages that the system has logged for an application.

To retrieve system messages:

1 Select Administration > System Messages.
2 Take one or more actions to specify the system messages to view:
   - Enter a start date.
   - Enter an end date.
   - Enter the server name.
   - Enter the application name.

Note:

You can leave the server name and application name blank to view system messages for all servers and applications.

3 Click View.
**Viewing and Printing System Messages**

You can view system message detail for more information, and print the messages. If you need further information, see your administrator.

➤ To view system message detail:

1. In the System Messages log, select the check box next to each message to view.
2. Click Details.
3. Click Print to print the displayed messages.
4. Click Close when you finish reviewing and printing message details.

**Deleting System Messages**

You can delete system messages that you no longer need in your message log.

➤ To delete system messages, take one of these actions:

- To delete individual messages, select the check box next to each message to delete, and click Delete.
- To delete all system messages, click Delete All.
Working with Data Files

There are two ways to add data to a Financial Management application:

- Create a data file and load it into an application.
- Enter data in a data grid.

Sample data files are installed with Financial Management and are located in the Financial Management Sample Apps directory.

Creating and loading a data file is an alternative to manually entering data in a data grid. You create data files in an ASCII format supporting multibyte character sets (MBCS) or a file encoded with the Unicode format. By default, data files use the .dat file extension. A data file can contain these sections:

- Column Order
- View
- Data
- Line Item Detail
- Description

Data File Sections

Data file sections include column order, data, view, line item detail, and descriptions.
<table>
<thead>
<tr>
<th>File Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Column Order | Specifies the order in which dimension members are displayed. The following syntax specifies the default column order:  
\[Column\_Order =\text{Scenario, Year, Period, View, Entity, Value, Account, ICP, Custom1, Custom2, Custom3, Custom4}\]  
You can change the column order to meet your needs. You can specify multiple Column Order sections in the data file. Each subsequent Column Order section overrides the previously defined section and the data within each section must use the defined column order.  
If you do not specify the scenario, year, or period dimensions in the column order sequence, it is assumed that they are specified in a separate section of the data file. If you do not include the ICP or custom dimensions in the sequence, they are assumed to be [ICP None], and [None] respectively. |
| View | Specifies the default view for all data following it. You can specify multiple View sections in the data file; each section must start with a valid View dimension. Each subsequent View section overrides the previously defined section. If you do not specify a View section, the view must be specified in the point of view. |
| Data | Specifies numeric amounts for valid input cells. If accounts do not accept line item detail, you must load data into them.  
The syntax for this section is as follows:  
\[<\text{Scenario}>; <\text{Year}>; <\text{Period}>; <\text{View}>; <\text{Entity}>; <\text{Value}>; <\text{Account}>; <\text{ICP}>; <\text{Custom1}>; <\text{Custom2}>; <\text{Custom3}>; <\text{Custom4}>; <\text{Data}>\]  
**Note:** Zeros are stored as data. Loading zeros into an application is not recommended because zeros can increase the size of the database and impact performance.  
You can specify several Data sections throughout the data file. If you place the Data section before the first Column Order section, the default column order is used.  
Ownership data is used to calculate the ultimate ownership and consolidation percentages for the dependents of the selected parent.  
Ownership information is managed within the ICP dimension by way of a member list called [System] that is automatically generated by the system.  
For percent consolidation data, you must know an entity member’s parent in the hierarchy. The parent is required for percent consolidation data but is ignored in all other circumstances.  
See “Entering Ownership Information” on page 129. |
| Line Item Detail | You load line item detail to accounts that support line item detail and are valid dimension combinations. A line item is represented by a delimited pair that consists of a description and a value. You can specify several Line Item Detail sections throughout the data file. The following syntax specifies a sample point of view, line item detail, and line item value:  
\[!\text{Line\_Item\_Detail}\]  
\[Actual; 2007; July; Periodic; Connecticut; USD; Salaries; [ICP None]; Golfballs; Customer2; [None]; Increases; "John Doe"; 5000\]  
You must load line item detail to one period. You cannot load it to a range of periods. The scenario’s default view (YTD or Periodic) determines how the line item detail is loaded.  
The line item detail description cannot be blank, but you can leave the line item detail value blank. Descriptions do not need to be unique. If you do not enter a description and value pair after the point of view settings, an error occurs and you are prompted to enter a description for the line item detail. |
<table>
<thead>
<tr>
<th>File Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Use only double quotation marks (&quot; ) in line item detail. Single quotation marks (’ ) are not supported.</td>
</tr>
</tbody>
</table>

**Dimension Groupings**

You can group sets of data by fixing one or more dimensions. One dimension must always remain unfixed. For every dimension except Period, you must specify one member. For the Period dimension, you can specify one or a range of periods.

You can specify groupings for dimensions as many times as necessary throughout the data file. However, they must agree with the respective column order sequence. Each subsequent occurrence of a grouping overrides the previous grouping.

**Data File Example**

Following is an example of a data file. Each exclamation mark (!) indicates the beginning of a section. The exclamation mark must be followed by a valid section name. Each apostrophe (’) starts a comment line. Use one of these file delimiter characters to separate information in a data file:

```
, ~ @ # $ % & ^ | : ; ? \n```

**Note:**

You can use any of the valid characters as long as the character is not used in the file name or in any other way in the file. For example, if you are using the ampersand ( & ) in an entity member name, you cannot use the ampersand as the delimiter character. You must use the same delimiter character throughout the file. Using different delimiter characters within the same file causes an error when you load the file.

```
!column_order = scenario, year, period, view, entity, value, account, ICP, custom1, custom2, custom3, custom4
!DATA
'Budget data for six months.
Budget; 2007; July; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1200000
Budget; 2007; August; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1100000
Budget; 2007; September; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1150000
Budget; 2007; October; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1000000
Budget; 2007; November; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1250000
Budget; 2007; December; Periodic; Connecticut; USD; Sales; [ICP None]; GolfBalls; Customer2; [None]; Increases; 1200000
```
Load Methods

Several options are available for loading data into an application. You can merge, replace, or accumulate the data into the application. You select one of these options for each load process.

**Note:**
You cannot load calculated data into an application.

**Merge**
Select this option to overwrite the data in the application with the data from the file.
For each unique point of view that exists in the data file and in the application, the value in the data file overwrites the data in the application.

**Note:**
If you have multiple values in the file for the same point of view, the system loads only the value for the last entry.

If you select the Accumulate Within File option in conjunction with the Merge option, the system adds all values for the same point of view in the data file, and overwrites the data in the application with the total.
For each unique point of view that is in the data file but does not have a value in the application, the value from the data file is loaded into the application.

**Replace**
For each unique combination of scenario, year, period, entity, and value in the data file, the system first clears all corresponding values from the application, then loads the value from the data file.

**Note:**
If you have multiple values in the file for the same unique combination of dimensions, the system loads only the value for the last entry.

If you select the Accumulate Within File option in conjunction with the Replace option, the system clears the value from the application, adds all values for the same point of view in the data file, and loads the total.
You can achieve the same result as using the Replace option with the Accumulate Within File option by using the Database Management module. You can organize the data in the file into groups based on Scenario, Year, Entity, Value, and Period.
Use the Clear Data tab in the Database Management module to clear each unique combination of these dimensions, selecting all accounts including system accounts. Enter the data manually in a data grid, or load or copy the data into the application using the Merge or Accumulate load options. When you perform the Clear operation for a period in a subcube, data, cell text, and line item detail are cleared, but cell attachments are not cleared.

**Note:**

You may need to create several small files to load a data file using the Replace mode, especially if the data is very large or if the file contains ownership data. An error message is displayed if the file is too large when you try to load it.

**Replace by Security**

This option enables you to perform a data load in Replace mode even if you do not have access to all accounts. When you perform the Clear operation for a period in a subcube, only the cells to which you have access are cleared. Data, cell text, and line item detail are cleared, but cell attachments are not cleared.

**Accumulate**

For each unique point of view that exists in the data file and in the application, the value from the load file is added to the value in the application.

**Note:**

Data for system accounts is not accumulated.

**Accumulate Within File**

You can use the Accumulate Within File option in conjunction with the Merge and Replace options. This option accumulates the data in the file first and loads the totals into the application based on the load option selected.

**File Contains Ownership Data**

If the file contains ownership data, you must indicate this by selecting **File Contains Ownership Data**. If you do not select this option and the data file contains ownership or shares information, an error occurs when you load the file.

**Load Example**

The following example shows how the load options work. The following data exists in the application for the Sales and Purchases accounts:

```
...Sales;... 15
...Purchases;... 10
```
This data is loaded into the application:

...Sales;... 50

...Sales;... 25
...Sales;... NODATA

The following table displays the effect that load mode selections have on data loaded into an application:

### Table 3  Load Options Result in Application

<table>
<thead>
<tr>
<th>Load Mode</th>
<th>Sales</th>
<th>Purchases</th>
<th>Sales</th>
<th>Purchases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge</td>
<td>NODATA</td>
<td>10</td>
<td>75</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Because it is the last entry in the file, NODATA overwrites the Sales value.</td>
<td>This account does not exist in the file.</td>
<td>The values in the file are added up to equal 75. This value (75), overwrites the value of 10 in the application.</td>
<td>This account does not exist in the file.</td>
</tr>
<tr>
<td>Replace or Replace by Security</td>
<td>NODATA</td>
<td>NODATA</td>
<td>75</td>
<td>NODATA</td>
</tr>
<tr>
<td></td>
<td>In the application, the value for this account is cleared. Because it is the last entry in the file, NODATA is entered as the value.</td>
<td>In the application, the value for this account is cleared. Because there is no data for this account in the file, NODATA is entered as the value.</td>
<td>In the application, the value for this account is cleared. The values in the file are added up to equal 75. 75 is entered as the value.</td>
<td>In the application, the value for this account is cleared. There are no values in the file for this account, so NODATA is entered as the value.</td>
</tr>
<tr>
<td>Accumulate</td>
<td>90</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The system adds the values for the same POVs in the data file and adds the total to the value in the application. Therefore, 75 is added to 15.</td>
<td>There are no values in the file to add to the value.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Loading Data

Hyperion recommends that you not run reports, books, or batches while data is being loaded.

In the Web, specify the name of the data file to load, and make sure that you set up a directory for the Web log file.

Hyperion recommends that you add Financial Management to the exceptions for your Web pop-up blocker. When you perform some Financial Management tasks on the Web, such as
loading data, a status window pops up showing the task status. If you have a pop-up blocker enabled on your computer, the status window is not displayed.

In Windows, specify the name of the data file to load and a log file name.

**Note:**
The log file stores information about the load process; for example, syntax errors and invalid records.

**Windows Procedure**

To load data:

1. Open the application to which to load data.
2. From the navigation frame, select **Load Data**.
3. For **Data Filename**, enter the file name, or click to find the file.
   
   **Note:**
   By default, data files use the `.dat` file extension. You can click View to display the contents of the data file that you specified.
4. For **Log Filename**, enter a file name, or click to find the file.
5. Select an option:
   - **Merge** to overwrite data in the application
   - **Replace** to replace data in the application
   - **Replace by Security** to replace data to which you have access, depending on your security rights
   - **Accumulate** to add data to data in the application
     
     See “Load Methods” on page 52.
6. **Optional:** Select **Accumulate Within File** to add up multiple values for the same cells in the load file before loading them into the application.
7. **Optional:** Select **File Contains Ownership Data** if the load file contains ownership data, such as shares owned.

**Caution!**
If ownership data is included in the file, you must select this check box, or an error occurs when you load the file.

8. For **Delimiter Character**, enter the character used to separate data in the file. Valid characters are as follows:

   ``, ~ @ # $ % & ^ | ; ; ? \`
Note:

You can use any of the characters above as long as the character is not used in the file name or in any other way in the file. For example, if you are using the ampersand ( & ) in an entity member name, you cannot use the ampersand as the delimiter character.

9 Optional: Click Scan to verify that the file format is correct.

Note:

After you scan the file, click View next to the Log Filename text box to see if there were any errors.

10 Click Load.

Web Procedure

➤ To load data:

1 Open the application into which to load data.

2 Select Browser View.

3 In the view pane, expand Tasks and select Load Tasks.

4 Select Load Data.

5 From Delimiter Character, select the default character used to separate the data in the file. Valid characters are as follows: , ~ @ # $ % & ^ | : ; ? \ 

Note:

You can use any of the characters above as long as the character is not used in the file name or in any other way in the file. For example, if you are using the ampersand ( & ) in an entity member name, you cannot use the ampersand as the delimiter character.

6 From Load Mode, select a default load mode:

● Merge to overwrite data in the application

● Replace to replace data in the application

● Replace by Security to replace data to which you have access, depending on your security rights

● Accumulate to add data to data in the application

See “Load Methods” on page 52.

7 Optional: Select Accumulate Within File to add multiple values for the same cells in the load file before loading them into the application.

8 Select File Contains Ownership Data if the load file contains ownership data, such as shares owned.
Caution!
If ownership data is included in the file, you must select this check box, or an error occurs when you load the file.

9 Select File Contains Process Management Data if the load file contains process management submission phases.

10 For File, enter a file name, or click Browse to locate the file.

Note:
By default, data files use the .dat file extension.

11 Optional: To override the default load options for a particular file, select Override, and select a different delimiter, load mode, accumulate, or ownership setting for the file.

12 Optional: Click Scan to verify that the file format is correct.

13 Click Load.
The system displays the load task progress, and a log file for each load file when the process is finished. Any data load information, including errors and invalid records, is located in the log file.

14 To return to the Load Data task, click Back to Load Data.

Viewing Data Load Progress
When you load data on the Web, you can monitor the data load progress. During the load process, a progress bar page is displayed in a separate browser window. This page displays the current progress percentage, status, and last update time.

In addition, you can view the data load status from the Running Tasks module. In the Running Tasks module, you can view all tasks that are running, but you can cancel only tasks that you started.

➤ To view data load progress:

1 In the Browser View, expand Tasks and select Load Tasks.

2 Select Load Data.

3 Take one of these actions:
   ● From the Progress page, view the data load progress.
   ● From the Running Tasks page, select Data Load from Task Filter, and click View to view the progress.
Canceling Data Load Tasks

When you load data on the Web, you can cancel a data load. If you are viewing the data load progress from the Running Tasks module, you can cancel only data loads that you started. Administrators can cancel running tasks by any users to free resources.

To cancel a data load, take one of these actions

- From the Progress page, click Stop Task for the data load.
- From the Running Tasks page, select the Data Load task from Task Filter and click Stop Task.

Loading Submission Groups

In the Load Data task, you can load and extract Process Management Phased Submission groups. The load file cannot contain both submission phase records and data records. The submission phase number must be between 1 and 9 (inclusive) and the group number must be between 0 and 99 (inclusive).

No period can have a duplicate submission group assigned for phases 1–9. If duplicates are assigned, the entire load for that period is ignored and returned to the status before the load.

In Replace mode, all data for the period is cleared before new group/phase assignments are processed for that period, and new data replaces old data.

Example: Scenario=Actual; Period=January has the following assignments: Phase=1, Groups=1,3,5, and Phase=2, Groups=2, 4, 6.

If you load the following data:

```
!SUBMISSION PHASE
Actual;January;1;“7,8,9”
```

All data for January (including Phase 2 assignments) is cleared, and the final result is as follows:

```
Scenario=Actual;Period=January
Actual;January;1;“7,8,9”
```

In Merge mode, the new group/phase assignments for the period override the assignments for the same groups, but keep the assignments for other groups. If an error is detected for a period, all new assignments for that period are ignored.

The load format is as follows:

```
!SUBMISSION PHASE
<scenario>;<period>;<phase#>;<“group assignment”>
```

LOAD FILE EXAMPLE

```
!SUBMISSION PHASE
Actual;January;1;“*”
Actual;February;1;“1,3,5”
Actual;February;2;“2,4,6–15”
```
Extracting Data

You can extract base-level input data and some calculated data from an application. When you extract data, it is saved to an ASCII file that supports multibyte character sets (MBCS). By default, data files use the `.dat` file extension. After you extract data to a data file, you can view and modify it in a text editor.

When you extract data, you must specify a member for the Scenario and Year dimensions. You can specify one or more members for the Period, Entity, and Account dimensions.

You can also extract these types of calculated data:

- Consolidated data for parent entities
- Base accounts and custom dimension members that are calculated by rules
- Parent accounts intersecting with their respective CustomTop member and `[ICPTop]` member. If the CustomTop metadata attribute is blank or ALL, then the `[None]` member is used.

In the Web, specify the name of the file to extract and make sure that you set up a directory for log files and extracted Web files.

In Windows, specify the name of the file to extract and a log file name.

**Note:**

The log file stores information about the process, such as the start and end time of the extract and the number of extracted records.

**Windows Procedure**

1. To extract data:
   1. Open the application from which to extract data.
   2. From the navigation frame, select **Extract Data**.
   3. For **Data Filename**, enter a file name, or click ![file_icon] to find the file.

**Note:**

By default, data files use the `.dat` file extension. You can click View to display the contents of the data file that you specified.

4. For **Log Filename**, enter a file name, or click ![file_icon] to find the file.
5. Select a data view to extract:
Year to Date
Periodic
Scenario Default

6 For Delimiter Character, enter the character used to separate the data in the file. Valid characters are as follows:

, ~ @ # $ % & ^ | , . ? \n
Note:
You can use any of the valid characters as long as the character is not used in the file name or in any other way in the file. For example, if you are using the ampersand ( & ) in an entity member name, you cannot use the ampersand as the delimiter character.

7 From Data Subset, specify the subset of dimension members or member lists as follows:

- For Year and Scenario, highlight one year and one scenario member.
- For Period, Entity, and Account, select the check boxes next to the dimension members to specify.

Note:
You can click \_ to select a member list for each dimension and select individual members from the member list.

Tip:
Click Select All or De-Select All to select or clear all check boxes.

8 Optional: Select Calculated to extract calculated data.

9 Click Extract.

Note:
After you click Extract, you can click View next to the Log Filename text box to display any errors encountered during the extract.

Web Procedure

➤ To extract data:

1 Open the application from which to extract data.
2 Select the Browser View tab.
3 In the view pane, expand Tasks and select Extract Tasks.
4 Select Extract Data.
5 Select a data view to extract:
Optional: Select Extract Calculated Data to extract calculated data.

Select a member for the Scenario dimension and a member for the Year dimension.

Select one or more members for the Period, Entity, and Account dimensions.

Click Extract.

Take one of these actions:

- In Internet Explorer, click the Click Here to Download link and select Save.
- In Netscape, click the link and click OK.

Enter a name for the extracted file and make sure that the location for the file is in the Web directory that you set up.

Note:

By default, data files use the .dat file extension.

Click Save.

Copying Data

You can copy input and derived entity and account data from a scenario, year, and period, or group of periods to a destination (provided that the destination is not locked). The frequency of the source and destination periods must be the same. If you copy a list of periods, the number of source and destination periods must be the same. To update values, you must reconsolidate after you copy the data.

Note:

If you select multiple periods from which to copy the data, the number of destination periods must be the same. Regardless of whether you copy data from one period or multiple periods, the frequency of the source and destination periods must also be the same.

You can also define a factor by which to multiply the data that you are copying. The source amounts are multiplied by the factor before the data is copied to the destination. For example, you can increase data values in one scenario before you copy them to another scenario. The multiplication factor that you define is not applied to system accounts.

You must also consider any business rules you created and loaded that may affect the account data; for example, a rule that can be used to calculate an account in one period but not in another period.
The copy option that you select determines how data is copied into an application. You can select an option to merge, replace, or accumulate the data. The copy options are the same as the data load options. See “Load Methods” on page 52.

You also specify a log file, which stores information about the copy process; for example, the start and end times for the copy process and access violations.

**Windows Procedure**

➤ To copy data:

1. Open the application from which to copy data.
2. From the navigation frame, click Database Management.
3. Select Copy Data.
4. From Source, select a scenario and year, and a period or a range of periods from which to copy data.

   **Note:**

   To select multiple periods, press and hold Ctrl, and select the periods. If you select multiple periods from which to copy data, the number of destination periods must be the same. Also, whether you copy data from one or multiple periods, the frequency of the source and destination periods must be the same.

   ![Copy Data Table](image)

5. From Destination, select a scenario, year, and the same number of periods to which to copy data.

   **Tip:**

   To select multiple periods, press and hold Ctrl, and select the periods.

6. From Copy Members, select the entity and account data to copy.
Note:

You must check the box next to the dimension members to copy. You can click to select a member list for each dimension and select individual members from the member list. Use Select All or De-select All to select and clear Entity and Account dimensions.

7 From Options, select a copy mode:
- Merge to overwrite data in the application
- Replace to replace data in the application
- Accumulate to add data to data in the application

8 From View, select YTD or Periodic view.

9 From Value Dimension, select one or both options:
- Rates and System to copy data from system accounts
- Entity Currency to copy the data in the <EntityCurrency> member of the Value dimension

10 For Factor, enter a factor by which to multiply the data that you are copying.

Note:
The factor that you specify is not applied to system accounts.

11 Optional: Select one or both options:
- Copy Cell Text to copy cell text
- Copy Derived Data to copy derived data

12 For Log File, enter a log file name, or click to find the file.

13 Click Copy Data.

Note:
After you copy the data, you can click View next to the Log File text box to see if any errors were encountered during the copy process.

Web Procedure

➤ To copy data:

1 Open the application from which to copy data.

2 Select Browser View.

3 In the view pane, expand Tasks and select Data Tasks.

4 Select Database Management and select Copy Data.

5 For Source, select a scenario and year, and a period or a range of periods from which to copy data.

6 For Destination, select a scenario, year, and the same number of periods to which to copy data.

7 For Copy Members, select the entity and account members from which to copy data.
8 In Options, from Mode, select an option:
   - Merge to overwrite data in the destination scenario
   - Replace to replace data in the destination scenario
   - Accumulate to add data to data in the destination scenario

9 From View, select YTD or Periodic view.

10 For Value Dimension, select one or both options:
   - Entity Currency to copy the data in the <EntityCurrency> member of the Value dimension
   - Rates and System to copy data from system accounts

11 For Factor, enter a factor by which to multiply the data that you are copying.

   Note:
   The factor that you specify is not applied to system accounts.

12 Optional: Select one or both options:
   - Copy Cell Text to copy cell text
   - Copy Derived Data to copy derived data

13 Optional: To store the copy information in a log file, select Enable Detailed Logging.

14 Click Copy Data.

**Copying Line Item Detail**

When you copy data, line item detail is copied based on the source and destination scenario views and the ability of the source and destination scenarios to accept line item detail.

**Note:**
You set up scenarios to use line item details by specifying this attribute in the Scenario metadata.

These behaviors result when line item detail is copied to a scenario:

- If the source scenario has line item detail and the destination scenario can accept line item detail, all details and the corresponding total are copied to the destination scenario.
- If the source scenario has line item detail and the destination scenario cannot accept line item detail, only the total is copied from the source scenario to the destination scenario. No line item detail is copied to the destination scenario.
- If the source scenario does not have line item detail and the destination scenario cannot accept line item detail, no detail is copied.
- If the source scenario does not have line item detail and the destination scenario accepts line item detail, the total amount is copied from the source to the first line item detail data in the destination scenario with the description equal to the label of the scenario.
If the source and destination scenario views are the same, Periodic to Periodic or YTD to YTD, all details and the corresponding total are copied to the destination scenario. The amount reflects the default view defined for the scenario.

If the source and destination scenario views are not the same, Periodic to YTD or YTD to Periodic, the line item detail in the destination scenario may not match the total after the copy operation. Line item detail in the destination scenario only matches the total when you view the data in the nondefault view of the scenario.

**Copying Intercompany Transactions**

When you copy data, intercompany transactions are copied based on the source and destination scenario views and the ability of the source and destination scenarios to accept transactions. These rules apply to copying intercompany transactions:

- If both the source and destination support intercompany transactions, the system copies the source amount to the destination. It also copies the corresponding intercompany transaction details to the destination cell.
- If the source supports intercompany transactions but the destination does not, the system does not copy the transaction.
- If the source does not support intercompany transactions but the destination does, the system does not copy the transaction.
- If the destination contains intercompany details, the system does not copy the transaction.

**Clearing Data**

You can clear data for selected entities and accounts for a scenario, year, and period or list of periods. When you clear data, base and parent entities are cleared, however, only base-level accounts are cleared. You also cannot clear any cells that contain posted intercompany transactions.

*Note:*

Select only unlocked cells when you clear data. Otherwise, the data clear fails.

**Windows Procedure**

To clear data:

1. Open the application from which to clear data.
2. Select **Database Management** on the navigation frame.
3. Select **Clear Data**.
4. From **Clear Members**, select a dimension tab and specify a subset of dimension members as follows:
   a. Highlight a scenario and year member.
b. Select the check box next to the Period, Entity, and Account dimension members to clear.

**Tip:**
Click ![image] to select a member list for each dimension and select individual members from the member list. Use Select All toolbar or De-select All to select and clear dimension members.

5 *From Value Dimension*, select an option:
  - Entity Currency to clear the data in the <Entity Currency> member of the Value dimension
  - Rates and Systems to clear data from system accounts

6 For Log File, enter a file name, or click ![image] to find the file.

7 Click Clear Data.

**Note:**
After you clear data, you can click View next to the Log File text box to display any errors encountered during the clear process.

**Web Procedure**

➤ To clear data:

1 Open the application from which to clear data.

2 Select **Browser View**.

3 In the view pane, expand **Tasks** and select **Data Tasks**.

4 Select **Database Management** and select **Clear Data**.

5 From the Point of View bar, select a scenario and year, and select the period, entity, and account dimension members to clear.

6 From **Value Dimension**, select an option:
  - Entity Currency to clear the data in the <Entity Currency> member of the Value dimension
  - Rates and Systems to clear data from system accounts

7 Optional: To store the clear information in a log file, select **Enable Detailed Logging**.

8 Click Clear Data.
Starting Explore Data

You use Explore Data to enter or edit data, calculate the data, translate data to other currencies, consolidate data, view calculation status, line item detail, adjustments, or run reports on data.

To start Explore Data:

1. From the Financial Management Desktop, click Explore Data.
2. If you do not have an application open, at the system prompt, select an application to open.

Working with Data Grids

You can display data or calculation status in data grids. If journals are posted to the selected intersection in the grid, you can display all journal transactions against the cell. You can store text and line item detail for cells in the grid.

Dimensions are displayed in rows and columns on a data grid. You can save the grid settings and reopen the grid later instead of resetting the rows and columns.

When you right-click from a data cell, you can select menu commands to calculate, translate, and consolidate the data. If a task is not applicable for a cell, the menu command is not selectable.

You can specify number formatting preferences for cells in the data grid. See “Setting User Preferences” on page 25.
Selecting Explore Data Settings

Before you enter data into an application, you must select the dimensions and dimension member lists to display on the rows and columns of the data grid. Any dimensions that you did not include in the grid rows and columns are called slicer dimensions. You should select a member for each slicer dimension.

You can select whether to display the data or the calculation status of the data. The calculation status indicates, for example, whether data needs to be calculated, translated, or consolidated.

You can also display metadata labels, descriptions, or both. When descriptions are enabled, they display in the language that you specified in the User Preferences dialog box. If you select to display both labels and descriptions, the dimension member is displayed as “Label - Description.” For entities, the member is displayed as “Parent.Entity - Description”, where the description is the entity description.

To save your settings, see “Saving Data Grid Settings” on page 69.

➤ To select Explore Data settings:

1. From the Financial Management Desktop, click Explore Data.
2. Click Grid,  
3. From Page Dimensions, select one or more dimensions to display on the grid rows by dragging them to Row Dimensions.
4. From Page Dimensions, select a dimension to display on the grid columns by dragging it to Column Dimensions.
5. From Properties, select whether to display the row or column items based on Member List Selection or POV Checked Items.

Note:

The Selected Dimension Properties title changes to a dimension name when you select a dimension. For example, if you select the Entity dimension, the Properties title changes to Entity Properties. The POV Checked Items are based on the check boxes that you select from the Point of View dialog box. See “Setting the Point of View on the Desktop” on page 29.

6. Select a display option: Data or Calculation Status.
7. From Metadata Display, select an option: Label, Description, or Both.
8. Click OK.
9. Select the slicer dimensions on the Point of View bar.

Setting Grid Column Widths

In a data grid, you can set the default width for columns in the grid. When you click in a column, the default setting is the current width. The available range is 25-10,000, and the default setting
is 90. After you change a column width, you must change the point of view or change the grid layout to see the new column width applied.

➤ To set the default column width:
1 From the Financial Management Desktop, click Explore Data.
2 Select Data > Set Default Column Width.
3 For Grid Settings, enter a value for the default column width.
4 Click OK.
5 From the confirmation message, click OK.
6 Change the POV or the grid layout to see the effect of the changes.

Saving Data Grid Settings
You can save frequently used data grid settings. By saving your grid settings, you can reduce the time that you spend selecting the dimension for the rows and columns. For example, you can save the point of view selection, member list selection, and POV checked items for a selected dimension. You can also save the grid dimension positions such as row and column dimensions, the display mode such as Data, Calculation Status, or the expanded rows and columns displayed on the grid.

The file is saved with the .hde file extension. The default storage location for data grid files is in the DataExplorer folder, which is located in the folder that you specified as the working folder for the current application when you created the application.

➤ To save data grid settings:
1 From the Financial Management Desktop, click Explore Data.
2 Select the data grid settings. See “Selecting Explore Data Settings” on page 68.
3 Click Save.
4 Specify a file name and storage location for the grid settings file.
5 Click OK.

Opening Data Grids
After you save the data grid settings to a file, you can open the file to display the saved settings. Data grid files are saved with the .hde file extension.

➤ To open data grids:
1 From the Financial Management Desktop, click Explore Data.
2 Click Open.
3 Select the data grid to open.
4 Click Open.

**Entering or Editing Data**

You use data grids to enter data manually into input accounts for base entities. Values for parent-level members are aggregated from the children of the parent-level members. In some cases, data for base-level members is calculated. For example, the Salaries member might be a base-level member calculated based on headcount and salary rate.

Calculated and consolidated accounts do not accept data entry, because the values they contain come from other sources. For example, if a company called USA East has three dependents, you enter values into the dependent entities. After you consolidate, the value in USA East is the total of the values in its three dependents.

After you enter or edit data, you can submit the changes to the database, and refresh the grid with the most recent data from the database.

➤ To enter or edit data:

1 From the Financial Management Desktop, click Explore Data.

2 Select the cell in which to enter or edit data.

<table>
<thead>
<tr>
<th></th>
<th>July</th>
<th>August</th>
<th>September</th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>500</td>
<td>680</td>
<td>728</td>
<td>769</td>
</tr>
<tr>
<td>Discount</td>
<td>53</td>
<td>56</td>
<td>57</td>
<td>59</td>
</tr>
<tr>
<td>Net Sales</td>
<td>547</td>
<td>685</td>
<td>665</td>
<td>739</td>
</tr>
<tr>
<td>COGS</td>
<td>13</td>
<td>13</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>Gross Margin</td>
<td>534</td>
<td>692</td>
<td>656</td>
<td>728</td>
</tr>
</tbody>
</table>

3 Enter a value in the cell and press Enter.

4 Repeat steps 2 and 3 until you finish entering or editing data.

**Note:**

You can clear a value by entering NODATA in a cell.

5 To save the data, click Submit Data, ![Submit Data](image).

**Entering Data into Summary-Level Time Periods**

You can enter an amount directly in a summary-level time period and have it distributed evenly among lower-level periods for Revenue, Expense, and Flow type accounts. For example, you could enter the amount 300 in the Quarter time period that contains the months of June, July, and August. The amount 100 could be distributed evenly among those three months. Asset, Liability, and Balance type accounts distribute the entire amount to the last base period of the summary time period.
If the base periods are blank when you input data at the summary level, the data is distributed evenly across the periods. If the base periods contain data and you enter data in the summary level, the system distributes the data based on the percentage in the base periods. For example, if the months of January, February, and March list 3, 3, and 4 as the data, and you enter the amount 100 in the summary level for quarter Q1, the system distributes the 100 amount as 30, 30, and 40 to January, February, and March, respectively.

➤ **To enter data into summary-level time periods:**
1. From the Financial Management Desktop, click **Explore Data**.
2. Select the cell in which to enter or edit data.
3. Enter a value in the cell and press **Enter**.
4. Repeat steps 2 and 3 until you have entered or edited all the necessary data.
5. To save the data, click **Submit Data**.

### Adjusting Data Using Operator Keys

You can quickly adjust data in data grids by using the Add, Subtract, Multiply, and Divide (“+,” “-,” “*,” “/”) operator keys. For example, you can type “10+” in a cell to add 10 to the value or you can type “10-” to subtract 10 from the value. You can type “10*” in a cell to multiply the current cell by 10, and “10/” to divide by 10.

➤ **To adjust data using operator keys:**
1. From the Financial Management Desktop, click **Explore Data**.
2. Select the cell for which to adjust data.
3. Do one of these tasks:
   - To add a number to the value of a cell, type “number+.”
   - To subtract a number from the value of a cell, type “number-.”
   - To multiply the current cell value by a number, type “number*.”
   - To divide the current cell value by a number, type “number/.”
4. To save the data, click **Submit Data**.

### Using Cell Colors in Data Grids to Determine Status

Cell colors in data grids indicate additional information about the data. The following table shows the default cell colors in data grids:
### Table 4 Default Data Cell Colors

<table>
<thead>
<tr>
<th>Cell Color</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off-white</td>
<td>This is an input cell. You can enter or edit data manually.</td>
</tr>
<tr>
<td>Light green</td>
<td>Allows allocations/derived data.</td>
</tr>
<tr>
<td>Medium green</td>
<td>This cell is read-only.</td>
</tr>
<tr>
<td>Dark green</td>
<td>This cell has no write or read access/derived data.</td>
</tr>
<tr>
<td>Red</td>
<td>Invalid intersection of dimension members. You cannot enter data in invalid cells.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow indicates one of these conditions:</td>
</tr>
<tr>
<td></td>
<td>● Data in the cells has been modified but has not yet been saved.</td>
</tr>
<tr>
<td></td>
<td>● The input status is OK, but the status of the adjustment is not OK (CH, CN or TRN). If the status is CN for node level adjustments, you must run Force Calculate Contribution to clear up the adjustment member status.</td>
</tr>
<tr>
<td>Gray</td>
<td>This cell contains locked/derived data.</td>
</tr>
<tr>
<td>Blue</td>
<td>This is a header cell.</td>
</tr>
<tr>
<td>Black</td>
<td>This is the active cell.</td>
</tr>
</tbody>
</table>

You cannot perform any actions on cells in invalid dimension intersections. Invalid dimension intersections do not accept data entry because the top parent's detail members are not used, or restrictions have been set for those dimensions. You set restrictions for dimensions when you set up members in the metadata file. For example, if you set up the Sales account in the metadata file to accept data entry by customer, the intersection of Sales and None for the Custom dimension is an invalid intersection for data entry.

### Refreshing Data

You can refresh the data that is displayed in data grids and display the data that is saved in the database. This enables you to make changes to the data and restore the original data. When you refresh data, you are prompted to save any changes that you made to the data. You can select whether to save the changes to the database or restore the data that is saved in the database.

**Note:**

When multiple users are updating data values in the same cells in data grids, there is no indication to users that cell data has been overwritten. If multiple users enter data in the same cell simultaneously, the database stores the data from the last user who saved data.
To refresh the grid with data stored in the database, click **Refresh Grid**.

**Viewing Data in Data Grids**

In addition to working with data, you can use data grids to view the calculation status of the data. You can also view cell information, such as the point of view information, cell adjustments, cell text, and line item detail.

**Viewing Calculation Status**

Financial Management maintains calculation statuses for each scenario, year, period, entity, parent, and value combination. The calculation statuses indicate, for example, whether data needs to be calculated, translated, or consolidated. You can view the calculation status in a data grid.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>None of the data for the specified Scenario, Year, Period, Entity, and Value dimensions has changed.</td>
</tr>
<tr>
<td>OK ND</td>
<td>OK — No data. The calculation has been effectively run, but no calculations were run for NODATA.</td>
</tr>
<tr>
<td>OK SC</td>
<td>OK — System changed. Some of the data for the specified Scenario, Year, Period, Entity, and Value dimensions has changed. For example, a new rules file or metadata file has been loaded.</td>
</tr>
<tr>
<td>CH</td>
<td>Needs Calculation. At least one data cell for the specified Scenario, Year, Period, Entity, and Value dimensions has been changed, or metadata parameters or rules have changed. As a result, other data cells in this Scenario, Year, Period, Entity, or Value dimension may not be up to date because calculation logic has not been run. For base-level entities, the data cell may have been entered by manual data entry or by a bulk data file load. For any entity, the data cell may have been entered by a journal posting.</td>
</tr>
<tr>
<td>CH ND</td>
<td>Needs Calculation — No Data. This indicates the first time that calculation will be performed on the cell.</td>
</tr>
<tr>
<td>TR</td>
<td>Needs Translation. The selected Value dimension member is not the entity’s default currency, and its translated values may not be up to date.</td>
</tr>
<tr>
<td>TR ND</td>
<td>Needs Translation — No Data. This indicates the first time that translation will be performed on the cell.</td>
</tr>
<tr>
<td>CN</td>
<td>Needs Consolidation. The data for the specified Scenario, Year, Period, Entity, and Value dimensions may not be up to date because data for a child entity has changed, data for the same entity’s default currency has changed, or metadata parameters or rules have changed.</td>
</tr>
<tr>
<td>CN ND</td>
<td>Needs Consolidation. The parent has no data, but data for a child entity has changed. This indicates the first time that consolidation will be performed on the cell.</td>
</tr>
<tr>
<td>Locked</td>
<td>The data for the specified Scenario, Year, Period, Entity, and Value dimensions has been locked by an administrator and can no longer be modified by manual data entry or calculations.</td>
</tr>
<tr>
<td>NODATA</td>
<td>No data exists for the specified Scenario, Year, Period, Entity, and Value dimensions.</td>
</tr>
<tr>
<td>NoAccess</td>
<td>The user does not have rights for the specified dimension member.</td>
</tr>
</tbody>
</table>
To view calculation status:

1. From the Financial Management Desktop, click Explore Data.
2. Click Grid.
3. Change the dimension settings as necessary. See “Selecting Explore Data Settings” on page 68.
4. Select Calculation Status.
5. Click OK.

Viewing Cell Information

You can view information for any cell in Explore Data grids. Cell information includes information about the point of view such as the point of view detail, and View. It also includes status information, such as calculation status and security access.

The cell information displays the base input currency value. The stored data is the amount stored in the database, which is always in units. The full resolution data is the amount entered, with the decimal and thousand separator defined in user preferences.

The displayed data is the amount displayed for the cell using the decimal places for the account. The displayed data might appear different than the data stored due to rounding, based on the number of decimal places that you select to display. For example, suppose you have an account that specifies 0 for the decimal place, the currency of the entity has a scale of 3, and your user preferences specifies the comma (,) as the thousands separator, and the period (.) as the decimal separator. If you enter the amount “12345.6789”, the cell information is displayed as follows:

Displayed data = 12,346 (rounding to display 0 decimal places) Full resolution data = 12,345.6789 Stored data=12345678.9 (stored in units)

To view cell information:

1. From the Financial Management Desktop, click Explore Data.
2. Select the cell for which to view information.
3. Right-click and select Cell Information.
4. View the cell information, and click Close.

Viewing Cell Adjustments

Using a data grid, you can view the adjustments made to accounts. An adjustment is a set of debit/credit changes posted through a journal entry to natural account balances for one scenario and period.

To view adjustments:

1. From the Financial Management Desktop, click Explore Data.
2. Select the cell for which to view the adjustment history.
3 Right-click and select **Cell Adjustments**.
4 View the cell's adjustment detail information and click **Close**.

### Adding Cell Text

You can add a text description for any valid cell in a data grid. For example, you might want to add a description for a cell’s currency information, such as Entity Currency or Parent Currency. After you add cell text, you can make changes to the text.

You can set a size limit for cell text in an application. The default cell text setting is a maximum of 8,000 bytes. You set the maximum size in the AppSettings attribute for the application metadata.

When you finish adding cell text, you can save the data to the database. After you save the data, a plus sign (+) is displayed in the right corner of the cell to indicate that there is text associated with the cell.

➤ **To add cell text:**
1 From the Financial Management Desktop, click **Explore Data**.
2 Select the input cell for which to add cell text.
3 Right-click and select **Cell Text**.
4 Enter the cell text.
5 Click **OK**.
6 Repeat steps 2 through 5 to add cell text for additional cells.

7 To save the data, click **Submit Data**.

### Viewing Cell Text

You can view cell text from data grids. Cell text is indicated by a plus sign (+) in the upper right corner of the cell.

➤ **To view cell text:**
1 From the Financial Management Desktop, click **Explore Data**.
2 Select the input cell for which to view cell text.
3 Right-click and select **Cell Text**.
4 View the cell text.
5 Repeat steps 2 through 4 to view additional cell text.
6 Click **OK**.
Adding Line Item Detail

You can enter line item detail for accounts that are set up to accept it through the Use Line Items metadata attribute and for a scenario that supports line item detail. Line item is used as the lowest level of detail for you to enter information for that account. For example, you might have a travel expense account and want to detail the amount by expense type, such as gas, tolls, or parking. To enter the travel expense information, you must first enter the amount for each line item detail. After you save the detail, the system calculates the total amount for the travel expense account.

You can enter line item detail only in the base frequency defined for the scenario. For example, if the scenario is Monthly, you cannot enter line item detail in “Quarter1.”

Line item detail applies only to the <Entity Currency> Value member, or to the default currency. The system does not consolidate, translate, or calculate contribution for line item detail.

You can enter as many line item details as you need. You can add line item detail in the blank rows that the system automatically creates in the line item detail grid. If there are no blank rows, you can manually create a line item.

Line item detail cannot contain single quotation marks (‘), and the maximum length for the description is 80 characters.

In Explore Data grids, after you enter cell line item detail, the system displays a small plus (+) sign in the lower right corner of the cell to indicate that there is line item detail associated with the cell.

To add cell line item detail:

1. From the Financial Management Desktop, click Explore Data.
2. Select the cell for which to add line item detail.
3. Right-click and select Cell Line Item Detail.
4. Take one of these actions:
   a. If the cell has a blank row to enter line item detail, go to step 5.
   b. To insert a line at the end of the rows, highlight a row in the line item detail grid, right-click and select New Line Item.
   c. To insert a row between line item rows, place the cursor where you want to insert the line item, right-click, and select Insert Line Item.
5. Enter a description and value for the line item detail.
6. Click OK to save your changes, or click Cancel.

Viewing Line Item Detail

After you add line item detail for cells in data grids, you can view it at any time. You can view line item detail in both YTD and Periodic views, but only in the base frequency defined for the scenario. For example, if the scenario is Monthly and you are in the Quarterly view, you can see the description of the line item detail but not the amounts. You can only verify that the Total...
amount matches the sum of the line item data when you view line item detail in the default view of the scenario. If you view data in another view, the Total amount and the line item detail will not match for any subsequent periods other than the first period.

➤ To view cell line item detail:

1. From the Financial Management Desktop, click Explore Data.
2. Select the cell for which to view line item detail.
3. Right-click and select Cell Line Item Detail.
4. View the cell’s line item detail.
5. Click Cancel.

### Running Allocations

You can run allocations from a data grid if you are assigned the Run Allocation security role. You can allocate data from a source account in an entity to a destination account in a list of entities. The entity for which you run allocations can be a base or parent entity. Before you can run allocations, you must first create rules for them. See the Hyperion Financial Management — System 9 Administrator’s Guide.

➤ To run allocations:

1. From the Financial Management Desktop, click Explore Data.
2. Select a cell for which to run allocations.
3. Right-click and select Allocate.

Note:
The Allocation menu option is available only if the entity status is OK.

### Locking and Unlocking Data

You can lock an entity for a period or periods if you do not want users to be able to modify that data, and if you are in the Lock Data security role. When data is locked, you cannot change the data for that scenario, year, entity, parent, value, and period.

When you lock data, the system locks recursively across the Entity and Value dimensions, so it is only necessary to select the top parent. When you lock a parent entity, the system locks recursively upward starting at all of the base entities. For each entity, Value members are locked in this order: <Entity Currency>, [None], <Parent Currency>, [Contribution Total]. When you unlock data, the system unlocks recursively across the Entity and Value dimensions, so you only need to select the top parent.

You can lock data for a period only if these conditions are met:
The entity’s calculation status must be OK. See “Viewing Calculation Status” on page 73.

All prior periods must be locked for the current year.

If the entity is a parent, all of its children must also be locked. If you select the top parent, the system locks all of its children.

The Validation account for the entity currency and entity currency adjustments must be zero.

When you unlock data, you must be in the Unlock Data security role. You must also unlock a parent entity before you unlock its children.

To lock data:
1. From a data grid, select a cell for which to lock data.
2. Right-click and select Lock.

To unlock data:
1. From a data grid, select the cell for which to unlock data.
2. Right-click and select Unlock.

Running Data Explorer Reports

You can run reports on the information that is displayed in the Data Explorer module. The reports are based on the settings that you selected for the Data Explorer grid. A default style sheet is provided for the Data Explorer report; however, you can apply and customize other style sheets.

When you create a report in the Explore Data module, the report definition is created automatically and opened in the Financial Management System Reports module. You can use the Design view to modify the script before you generate the report. You can set a report description and save the report locally or remotely.

To run Data Explorer reports:
1. From the Financial Management Desktop, click Explore Data.
2. Select the grid for which to run a report.
3. Click Reports.

Using Explore Data on the Desktop
Creating Data Grids

You can use data grids to manually enter or edit data in Financial Management applications. After you enter or edit the data, you can calculate the data, translate the data to other currencies, or consolidate the data. You can view data status, calculation status, process levels, line item detail, and destination and source transactions. In addition, you can lock and unlock data, run allocations, and run entity transaction detail reports.

You can display data, calculation status, or process level in data grids. If journals are posted to the selected intersection in the grid, you can display all journal transactions against the cell. You can store text and line item detail for cells in the grid.

Dimensions are displayed in rows and columns on a data grid. You can save the grid settings and reopen the grid later instead of resetting the rows and columns.

From a data grid, you can select menu commands to calculate, translate, and consolidate the data. If a task is not applicable for a cell, the menu command is not selectable.

You can specify number formatting preferences for cells in data grids. See “Setting User Preferences” on page 25.
To create data grids:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Grid.
2. Click New Data Grid.
3. Set the grid rows and columns. See “Setting Grid Rows and Columns” on page 82.
4. Set the grid display options. See “Setting Display Options” on page 82.

Opening Data Grids

You use data grids to view, enter, and edit data.

To open data grids, take one of these actions:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Grid.
2. Click a grid name to open it.

Data Grid Tasks

You can perform these tasks from data grids on the Web:

- Setting Grid Rows and Columns
- Entering or Editing Data
- Setting the Point of View on the Web

Data Grid Options

These options are available for data grid cells:

- Viewing Cell Information
- Adding Cell Text
- Viewing Cell Adjustments
- Adding Line Item Detail
- Calculation Process
- Translating Data
- Consolidating Data
- Locking Data
- Viewing Cell History
- Viewing Destination and Source Transactions
- Running Entity Transaction Detail Reports
- Running Allocations
You can select a cell and right-click to display a menu of these options. If an option does not apply to a particular cell, it is not selectable.

**Process Management Options**

These Process Management options are available from data grids.

- Information
- Start
- Promote
- Reject
- Sign Off
- Submit
- Approve
- Publish

These options are also available from the Process Control module. See Chapter 12, “Using Process Management”.

To access Process Management options, take one of these actions:

- Highlight a cell in a data grid that is set up for Process Management, right-click and select Manage Process.
- To use the Process Control module, in the File Browser, expand Tasks and Data Tasks, and select Process Control.

**Working with Data Grids**

You can select the grid rows and columns, change them at any time, and save your grid settings for later use. You can load, extract, and delete grids, and you can organize them in folders.

These topics describe the tasks that you can perform for data grids on the Web:

- “Setting Grid Rows and Columns” on page 82
- “Setting Display Options” on page 82
- “Saving Data Grid Settings” on page 83
- “Creating Data Grid Folders” on page 84
- “Loading Data Grids” on page 85
- “Extracting Data Grids” on page 85
- “Deleting Data Grids” on page 85
Setting Grid Rows and Columns

Before you enter data into a Financial Management application, you must select the dimensions and dimension member lists to display on the rows and columns of the data grid. Any dimensions that you did not include in the grid rows and columns are called slicer dimensions. You should select a member for each slicer dimension.

You can select whether to display data, calculation status, process level, and metadata labels or descriptions in grids. See “Setting Display Options” on page 82.

When you exit a grid, the user point of view is updated for all dimensions except the values in the dimensions defined in the rows and columns. Although the values for rows and columns are stored in the grid settings, these values are not used to update the User Point of View when you exit the grid.

➤ To set grid rows and columns:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Grid.

2. Click New Data Grid and click Grid Settings.

3. From Layout, select row and column dimensions from Page Dimensions, and use the arrows to move them to Row and Column:
   - To move a dimension to Column Dimensions, click .
   - To move a dimension to Row Dimensions, click .
   - To return a dimension to Page Dimensions, click .
   - To move dimensions between Row and Column, use the arrow keys.

4. Click OK.

Setting Display Options

You can select whether to display the data, the calculation status, or the process review level of the data in data grids. The calculation status indicates, for example, whether data needs to be calculated, translated, or consolidated. The review levels indicate the process management level for combinations of data called process units. You can easily toggle between the data and the calculation status and review level. The data grid automatically refreshes to reflect any changes.

See “Viewing Calculation Status” on page 89 and “Viewing Process Level” on page 90.

You can also select whether to display metadata labels, descriptions, or both. When descriptions are enabled, they display in the language that you specified in the User Preferences dialog box. If you select to display both labels and descriptions, the dimension member is displayed as “Label - Description”. For entities, the member is displayed as “Parent.Entity - Description”, where the description is the entity description.
In addition, you can select a scale value to determine how data is displayed in a data grid. For example, if the currency U.S. dollars (USD) is defined with a scale of 3, an amount of 300,000 USD loaded into the system is displayed as 300.

➤ To set display options:

1 Open a data grid.

2 Click Grid Settings and select Display Options.

3 For Cell, select an option:
   - To show calculation status, select Calculation Status.
   - To show data, select Data.
   - To show process review level, select Process Level.

4 For Metadata, select an option:
   - To display metadata labels, select Label.
   - To display metadata descriptions, select Description.
   - To display both metadata labels and descriptions, select Both.

5 For Row Suppression, select one or both options:
   - To suppress cells that do not contain data, select Suppress No Data.
   - To suppress cells that contain zero values, select Suppress Zero.

6 For Page Size, set these options:
   - Enter a Columns Per Page value, or use the default value of 128.
   - Enter a Rows Per Page value, or use the default value of 1024.

7 From Scale, select a scale value, or use the default scale defined for the currency assigned to the entity.

8 When you finish selecting display options, click OK.

**Saving Data Grid Settings**

You can save frequently used data grid settings. By saving your grid settings, you can reduce the time that you spend selecting dimensions for the rows and columns. After you save a grid, the grid name is displayed in the Documents list on the Data Grids tab.

➤ To save grid settings:

1 From a data grid, click Save Settings.

2 Enter a name for the grid settings.
   The name can have a maximum of 20 characters, including spaces.

3 Optional: Enter a grid description.
   The description can be a maximum of 255 characters, including spaces.

4 Optional: Select a security class for the grid.
Optional: Select Private if you want the grid to be private.

To overwrite a file, select Overwrite an existing file.

Click OK.

Creating Data Grid Folders

You can create a folder hierarchy for data grids. Organizing grids into folders might help if you save many grids. A Root folder is available by default and cannot be deleted. Any folders that you create are created under the Root folder.

To create data grid folders:

1. Open the application in which to create folders.

2. Select Administration > Manage Documents, or click Manage Documents and select Data Grid.

3. Click New Folder.

4. Enter a folder name.

Note:
The folder name can contain a maximum of 20 characters, including spaces.

5. Optional: Enter a folder description.

Note:
The folder description can contain a maximum of 255 characters, including spaces.

6. From Content Type, select Data Grids.

Tip:
If the folder will be used for all documents, select All.

7. Optional: Select Private if you want the folder to be private.

Note:
Private folders cannot be shared or viewed by other users.

8. From Security Class, select the security class for the folder.

Note:
Users of this folder must have access rights to the specified security class.

9. Click OK.
Loading Data Grids

After you create data grids, you can load them into an application.

➢ To load data grids:
1 Open the application into which to load a data grid.
2 Select Administration > Manage Documents, or click Manage Documents and select Data Grid.
3 Click Load.
4 Enter the grid name or click Browse and locate the data grid to load.
5 Optional: To override the security class or Private type for this grid during load, select Override, and select Security Class or Private.

Note:
If you do not select Override, the system uses the settings in the grid XML file.
6 To update a data grid or reload a previously extracted grid, select Overwrite Existing Documents.
7 Click OK.
8 To add more grids, click Load more files, and repeat steps 1 through 7 until all grids are added.
9 When you finish loading grids, click Finished.

Extracting Data Grids

You can extract data grids from an application. Extracting the grid does not delete the grid from the folder or from the application. It only extracts the contents of the grid to a location you select.

After you extract a data grid, you can modify it and reload it into the application. Make sure to overwrite the old file when you reload the grid. You can also use the extracted grid as a model for a new grid.

➢ To extract data grids:
1 Open the application from which to extract a grid.
2 Select Administration > Manage Documents, or click Manage Documents and select Data Grid.
3 Select the document to extract, and click Extract.
4 Click the document to download and enter a file name to save it.
5 Click OK.

Deleting Data Grids

You can delete data grids that you no longer need.
To delete data grids:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Grid.

2. Optional: Click the link for the folder from which to delete a grid.

   Note:
   To delete a grid from the Root folder, skip this step.

3. Select the check box next to the grid to delete and click Delete.

   Note:
   You can also delete a folder, but you must first delete any Web grids that it contains.

4. At the system prompt, click OK.

## Entering or Editing Data

You use data grids to enter data manually into input accounts for base entities in Financial Management applications. Values for parent-level members are aggregated from the children of the parent-level members. In some cases, data for base-level members is calculated. For example, the Salaries member might be a base-level member calculated based on headcount and salary rate.

Calculated and consolidated accounts do not accept data entry, because the values they contain come from other sources. For example, if a company called USA East has three dependents, you enter values into the dependent entities. After you consolidate, the value in USA East is the total of the values in its three dependents.

To view more of a page when entering or editing data, you can use the Page Up, Page Down, Page Left, and Page Right arrows in the toolbar at the top of the data grid.

After you enter or edit data, you can submit the changes to the database, and refresh the grid with the most recent data from the database.

To enter or edit data:

1. Open a data grid.

   The following figure shows a sample data grid on the Web.

   ![](image.png)

<table>
<thead>
<tr>
<th>Account</th>
<th>Period</th>
<th>January</th>
<th>February</th>
<th>March</th>
<th>April</th>
<th>May</th>
</tr>
</thead>
<tbody>
<tr>
<td>GrossMargin</td>
<td></td>
<td>32,133</td>
<td>57,940</td>
<td>96,400</td>
<td>96,400</td>
<td></td>
</tr>
<tr>
<td>TotalRevenues</td>
<td></td>
<td>32,133</td>
<td>57,940</td>
<td>96,400</td>
<td>96,400</td>
<td></td>
</tr>
<tr>
<td>Sales</td>
<td></td>
<td>32,133</td>
<td>57,940</td>
<td>96,400</td>
<td>96,400</td>
<td></td>
</tr>
<tr>
<td>SalesInterco</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Select the cell in which to enter or edit data.
To select multiple cells, you can press the Shift key and left-click a cell or row to add to the current selection. For example, to select all 12 periods in a grid, you can click period 1, scroll to the right using the scroll bar, and shift-click period 12.

3 Enter a value in the cell and click Enter.
4 Repeat steps 1 through 3 until you have entered or edited all the necessary data.

Note:
You can clear a value by entering NODATA in a cell.

5 Click Submit Data to save the data, or click Reset Data to refresh the database.

Entering Data into Summary-Level Time Periods

You can enter an amount directly in a summary-level time period and have it distributed evenly among lower-level periods for Revenue, Expense, and Flow type accounts. For example, you could enter the amount 300 in the Quarter time period that contains the months of June, July, and August. The amount 100 could be distributed evenly among those three months. Asset, Liability, and Balance type accounts distribute the entire amount to the last base period of the summary time period.

If the base periods are blank when you input data at the summary level, the data is distributed evenly across the periods. If the base periods contain data and you enter data in the summary level, the system distributes the data based on the percentage in the base periods. For example, if the months of January, February, and March list 3, 3, and 4 as the data, and you enter the amount 100 in the summary level for quarter Q1, the system distributes the 100 amount as 30, 30, and 40 to January, February, and March, respectively.

To enter data into summary-level time periods:

1 Open a data grid.
2 Click the cell in which to enter or edit data.
3 Enter a value in the cell and press Tab.
4 Repeat steps 1 through 3 until you have entered or edited all the data.
5 Click Submit Data to save the data, or click Reset Data to refresh the database.

Filling Data Blocks

You can highlight blocks of accounts and periods in a data grid, and modify or enter data in all the highlighted cells simultaneously. The fill value is taken from the upper left corner of the selected area. If the upper left corner is not an input cell, the Fill function has no effect.
To fill data blocks:

1. **From a data grid, highlight a cell or block of cells that contains the data to use for other cells:**
   - To highlight a row, select the dimension heading to the left of the row.
   - To highlight a column, select the dimension heading at the top of the column.
   - To highlight a block of cells, select a cell, and drag the cursor until all desired cells are highlighted.

2. **Select the cell or block of cells into which to paste the data.**

3. **Right-click and select Fill.**

   The system fills the highlighted input cells only. If a highlighted cell is read-only, it is skipped.

### Clearing Data

You can clear the values from one cell or from a block of cells. The system clears the highlighted input cells only. Cells that are read-only are not cleared.

To clear data, from a data grid, select the cell or block of cells to clear, right-click and select Clear.

### Using Data Cell Colors to Determine Status

Cell colors in data grids indicate additional information about the data. The following table shows the default cell colors in data grids:

<table>
<thead>
<tr>
<th>Cell Color</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off-white</td>
<td>This is an input cell. You can enter or edit data manually.</td>
</tr>
<tr>
<td>Light green</td>
<td>This cell allows allocations/derived data.</td>
</tr>
<tr>
<td>Pink</td>
<td>Invalid intersection of dimension members. You cannot enter data in invalid cells.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow indicates one of these conditions:</td>
</tr>
<tr>
<td></td>
<td>- Data in the cells has been modified but has not yet been saved.</td>
</tr>
<tr>
<td></td>
<td>- The input status is OK, but the status of the adjustment is not OK (CH, CN or TRN). If the status is CN for node level adjustments, you must run Force Calculate Contribution to clear up the adjustment member status.</td>
</tr>
<tr>
<td>Beige</td>
<td>This cell contains locked/derived data.</td>
</tr>
<tr>
<td>Blue</td>
<td>This is a header cell.</td>
</tr>
<tr>
<td>Light gray</td>
<td>This cell has no write or read access/derived data.</td>
</tr>
<tr>
<td>Dark gray</td>
<td>This cell is read-only.</td>
</tr>
</tbody>
</table>
You cannot perform any actions on cells in invalid dimension intersections. Invalid dimension intersections do not accept data entry because the top parent’s detail members are not used, or restrictions are set for those dimensions. You can set up restrictions for dimensions when you set up members in the metadata file. For example, if you set up the Sales account in the metadata file to accept data entry by customer, the intersection of Sales and None for the Custom dimension is an invalid intersection for data entry.

To determine the data status, you must check both the calculation status and the process level of the data. See “Viewing Calculation Status” on page 89 and “Viewing Process Level” on page 90.

**Refreshing Data**

You can refresh the data that is displayed in data grids and display the data that is saved in the database. This enables you to make changes to the data and restore the original data. When you refresh data, you are prompted to save any changes that you made to the data. You can select whether to save the changes to the database or restore the data that is saved in the database.

**Note:**

When multiple users are updating data values in the same cells, there is no indication to users that cell data has been overwritten. If multiple users enter data in the same cell simultaneously, the database stores the data from the last user who saved data.

➤ To refresh the data in a data grid, click Reset Data.

**Viewing Data in Data Grids**

In addition to working with data, you can use data grids to view the calculation status and process level of the data. You can also view cell information, such as the point of view information, cell adjustments, cell text, and line item detail.

**Viewing Calculation Status**

Financial Management maintains the calculation status for each scenario, year, period, entity, parent, and value combination. The calculation status indicates whether data needs to be calculated, translated, or consolidate. You can view the calculation status in a data grid.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>None of the data for the specified Scenario, Year, Period, Entity, and Value dimensions has changed.</td>
</tr>
<tr>
<td>OK ND</td>
<td>OK — No data. The calculation has been effectively run, but no calculations were run for NODATA.</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>OK SC</td>
<td>OK — System changed. Some of the data for the specified Scenario, Year, Period, Entity, and Value dimensions has changed. For example, a new rules file or metadata file has been loaded.</td>
</tr>
<tr>
<td>CH</td>
<td>Needs Calculation. At least one data cell for the specified Scenario, Year, Period, Entity, and Value dimensions has been changed, or metadata parameters or rules have changed. As a result, other data cells in this Scenario, Year, Period, Entity, or Value dimension may not be up to date because calculation logic has not been run. For base-level entities, the data cell may have been entered by manual data entry or by a bulk data file load. For any entity, the data cell may have been entered by a journal posting.</td>
</tr>
<tr>
<td>CH ND</td>
<td>Needs Calculation — No Data. This indicates the first time that calculation will be performed on the cell.</td>
</tr>
<tr>
<td>TR</td>
<td>Needs Translation. The selected Value dimension member is not the entity’s default currency, and its translated values may not be up to date.</td>
</tr>
<tr>
<td>TR ND</td>
<td>Needs Translation — No Data. This indicates the first time that translation will be performed on the cell.</td>
</tr>
<tr>
<td>CN</td>
<td>Needs Consolidation. The data for the specified Scenario, Year, Period, Entity, and Value dimensions may not be up to date because data for a child entity has changed, data for the same entity's default currency has changed, or metadata parameters or rules have changed.</td>
</tr>
<tr>
<td>CN ND</td>
<td>Needs Consolidation. The parent has no data, but data for a child entity has changed. This indicates the first time that consolidation will be performed on the cell.</td>
</tr>
<tr>
<td>Locked</td>
<td>The data for the specified Scenario, Year, Period, Entity, and Value dimensions has been locked by an administrator and can no longer be modified by manual data entry or calculations.</td>
</tr>
<tr>
<td>NODATA</td>
<td>No data exists for the specified Scenario, Year, Period, Entity, and Value dimensions.</td>
</tr>
<tr>
<td>NoAccess</td>
<td>The user does not have rights for the specified dimension member.</td>
</tr>
</tbody>
</table>

➤ To view calculation status:
1. Open a data grid.
2. Click Grid Settings and select Display Options.
3. Select Calculation Status.
4. Click OK.

### Viewing Process Level

If Process Control is enabled, Financial Management maintains process level information for each scenario, year, period, and entity combination. The process review level indicates, for example, whether data needs to be promoted to the next review level, submitted, or approved. See “Process Levels” on page 231.

➤ To view process review level:
1. Open a data grid.
2. Click Grid Settings and select Display Options.
4 Click OK.

**Viewing Cell Information**

You can view information for any cell in data grids. Cell information includes information about the point of view such as the process unit, point of view detail, and View. It also includes status information, such as calculation status, process level, and security access. If the application uses process management submission phases, cell information includes the submission phase to which the cell is assigned for the scenario and period.

The cell information displays the base input currency value. The stored data is the amount stored in the database, which is always in units. The full resolution data is the amount entered, with the decimal and thousand separator defined in user preferences.

The displayed data is the amount displayed for the cell using the decimal places for the account. The displayed data might appear different than the data stored because of rounding, based on the number of decimal places that you select to display.

For example, suppose you have an account that specifies 0 for the decimal place, the currency of the entity has a scale of 3, and your user preferences specifies the comma (,) as the thousands separator and the period (.) as the decimal separator. If you enter the amount 12345.6789, the cell information is displayed as follows:

Displayed data = 12,346 (rounding to display 0 decimal places) Full resolution data = 12,345.6789 Stored data=12345678.9 (stored in units)

➤ To view cell information:

1 Open a data grid.
2 Select the cell for which to view information.
3 Right-click and select Cell Information.
4 View the cell information, and click OK.

**Viewing Cell Adjustments**

Using a data grid, you can view the adjustments made to accounts. An adjustment is a set of debit/credit changes posted through a journal entry to natural account balances for one scenario and period.

The system displays the journal entry label and the amount. If the cell contains multiple adjustment entries, the system lists all of the entries and corresponding amounts.

➤ To view adjustments:

1 Open a data grid.
2 Select the cell for the adjustment member for which to view the history.
3 Right-click and select Cell Adjustments.
4 View the cell’s adjustment detail information, and click Close.

Adding Cell Text

You can add a text description for any valid cell in a data grid. For example, you might want to add a description for a cell’s currency information, such as Entity Currency or Parent Currency. After you add cell text, you can make changes to the text.

You can set a size limit for cell text in an application. The default cell text setting is a maximum of 8,000 bytes. You set the maximum size in the AppSettings attribute for the application metadata.

After you add cell text, a blue border is displayed to indicate that there is text associated with the cell.

➤ To add cell text:
1 Open a data grid.
2 Select the cell for which to add text.
3 Right-click and select Cell Text.
4 Enter the cell text.
5 Click OK.
6 Repeat steps 2 through 5 to add cell text for more cells.
7 Click Submit Data to save the data, or click Reset Data to refresh the database.

Viewing Cell Text

You can view cell text from data grids. Cells that contain cell text are indicated by a blue border.

➤ To view cell text:
1 Select the input cell for which to view cell text.
2 Right-click and select Cell Text.
3 View the cell text.
4 Click OK.
5 Repeat steps 1 through 4 to view additional cell text.

Attaching Documents to Data Grids

In addition to or instead of entering cell text, you can attach one or more documents to cells for additional detail. For example, you can attach a Microsoft Word document, Microsoft Excel spreadsheet, XSL, or RPT file. To attach or extract any custom documents to or from the server, you must be assigned the Manage Custom Documents security role.
You can set a size limit for document attachments and a maximum number of document attachments by user when you create an application. You set the limits in the AppSettings attribute for the application metadata.

You can attach multiple documents, but Hyperion recommends that you attach no more than two or three documents to a cell. Each document should be smaller than 100K to limit the performance effect on the database.

Note:
Cell attachments are accessible only from the Web.

➤ To attach a document to a cell:
1. Select the input cell to which to attach a document.
2. Right-click and select Cell Text.
3. Click Attach.
4. From your list of custom documents, select one or more documents to associate with the cell, and click Attach.

Note:
You cannot attach private documents.

5. Click Submit Data.
The attachment is displayed in the Attachments section of the Cell Text dialog box.

Tip:
To detach a document from a cell, select the document to detach, and click Detach.

**Line Item Detail Options**
The options for line item detail differ depending on whether you are using a data grid on the Desktop or on the Web, or Data Forms.

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows Data Grid</th>
<th>Web Data Grid</th>
<th>Data Forms</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Multiple Periods</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>View Single Period</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Insert Line Item Detail</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clear Line Item Detail from a Single Period</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clear Line Item Detail from Multiple Periods</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Adding Line Item Detail

You can enter line item detail for accounts that are set up to accept it through the Use Line Items metadata attribute, and for a scenario that supports line item detail. Line item detail is used as the lowest level of detail for you to enter information for that account. For example, you might have an account for travel expenses and want to detail the amount by type of expense, such as gas, tolls, or parking. To enter the information for the travel expense, you must first enter the amount for each line item detail. After you save the detail, the system calculates the total amount for the travel expense account.

You can enter line item detail only in the base frequency defined for the scenario. For example, if the scenario is Monthly, you cannot enter line item detail in “Quarter1.”

**Note:**

Line item detail cannot contain single quotation marks (‘ ’), and the maximum length for the description is 80 characters.

Line item detail applies only to the <Entity Currency> Value member, or to the default currency. The system does not consolidate, translate, or calculate contribution for line item detail.

In a data grid, after you enter the line item detail for the cell, a blue border is displayed to indicate that there is line item detail associated with the cell.

To add line item detail:

1. Open a data grid.
2. Select the cell for which to add line item detail.
3. Right-click and select Cell Line Item Detail.
4. Click New Entry.
5. Enter a Description and Value for the line item detail.
6. Enter line items, and click Enter or select a different cell to see the change.

   **Tip:**
   To clear line item detail, enter zero as the value to clear the amount.

7. Click Save to save the line items.
8. Click Close.
Viewing Line Item Detail

After you add line item detail for cells, you can view it at any time. You can view line item detail in both YTD and Periodic views, but only in the base frequency defined for the scenario. For example, if the scenario is Monthly and you are in the Quarterly view, you can see the description of the line item detail but not the amounts. You can only verify that the Total amount matches the sum of the line item data when you view line item detail in the default view of the scenario. If you view data in another view, the Total amount and the line item detail will not match for any subsequent periods other than the first period.

➤ To view line item detail:
1 Open a data grid.
2 Select the cell for which to view line item detail.
3 Right-click and select Cell Line Item Detail.
4 View the cell’s line item detail.
5 Click Close.

Viewing Cell History

Financial Management provides a data audit feature so that you can view data changes performed by users. You can view the username and server, activity performed, time modified, point of view, and new value for the point of view. This option is available in data grids only if the administrator has enabled the Data Audit feature for the scenario and account during application setup.

➤ To view cell history:
1 Open a data grid.
2 Select the cell for which to view history.
3 Right-click and select Cell History.
4 View the cell information, and click Close.

Running Allocations

You can run allocations from a data grid if you are assigned the Run Allocation security role. You can allocate data from a source account in an entity to a destination account in a list of entities. The entity for which you run allocations can be a base or parent entity. Before you can run allocations, you must first create rules for them. See the Hyperion Financial Management — System 9 Administrator’s Guide.

➤ To run allocations:
1 Open a data grid.
2 Select a cell for which to run allocations.
3 Right-click and select Allocate.

**Locking Data**

You can lock an entity for a period or periods if you do not want users to be able to modify that data, and if you are in the Lock Data security role. When data is locked, you cannot change the data for that scenario, year, entity, parent, value, and period.

When you lock data, the system locks recursively across the Entity and Value dimensions, so it is only necessary to select the top parent. When you lock a parent entity, the system locks recursively upward starting at all of the base entities. For each entity, Value members are locked in this order: <Entity Currency>, [None], <Parent Currency>, [Contribution Total].

You can lock data for a period only if these conditions are met:

- The entity’s calculation status must be OK. See “Viewing Calculation Status” on page 89.
- If process management is enabled for the scenario, the entity must have a process level of Published. If Process Management is enabled and the cell status is NODATA, you must promote the process unit before it can be locked. See “Process Levels” on page 231.
- All prior periods must be locked for the current year.
- If the entity is a parent, all of its children must also be locked. If you select the top parent, the system locks all of its children.
- The Validation account for the entity currency and entity currency adjustments must be zero.

➤ To lock data:

1 From a data grid, select a cell for which to lock data.
2 Right-click and select Lock.

**Unlocking Data**

To unlock data, you must be in the Unlock Data security role. You must also unlock a parent entity before you unlock its children.

When you unlock data, the system unlocks recursively across the Entity and Value dimensions, so you only need to select the top parent. If you need to unlock specific children under a parent entity instead of unlocking all the children, an administrator can disable recursive unlocking using the UseRecursiveUnlock registry setting.

➤ To unlock data:

1 From a data grid, select the cell for which to unlock data.
2 Right-click and select Unlock.
To disable recursive unlocking:

1. From the Start menu, select Run.
2. In the Open text box, type regedit, and click OK.
3. Expand HKEY_LOCAL_MACHINE\SOFTWARE\Hyperion Solutions\Hyperion Financial Management\Server.
4. Right-click and select New > DWORD Value.
5. For Name, enter UseRecursiveUnlock.
6. The default value is 1. To disable recursive unlocking, change the value to 0.

Viewing Destination and Source Transactions

After you run a consolidation, you can view the source and destination transactions generated by the consolidation process to provide an audit trail. You can view consolidation transactions only if you have set up your consolidation rules file to store these transactions. The Nature parameter of the HS.Con function determines whether consolidation transactions are stored. See the Hyperion Financial Management — System 9 Administrator’s Guide.

In addition, you must have View or All security access to the destination point of view. The destination point of view corresponds to the destination cell impacted by the transaction. The source destination point of view corresponds to the cell from which the consolidation was run. When you select to view transactions, they open in a new Web browser window. You can print the transactions.

When you view consolidation transactions, if you select a parent member of the Custom dimension or ICP dimension, the system generates all of the corresponding audit transaction details for all base members of the selected parent. This applies to the Custom 1, 2, 3, and 4 and the ICP dimension.

To view consolidation transactions:

1. From a data grid, select a cell for which to view consolidation transactions.
2. Right-click and select an option:
   - To view the destination data impacted by the consolidation, select Destination Transactions. The system displays all of the destination transactions generated from or affected by the selected cell.
   - To view the source data from which the consolidation was run, select Source Transactions. The system displays all the source transactions that have affected the selected cell.

Running Entity Transaction Detail Reports

The Entity Transaction Detail Report provides a full audit detail of the entire consolidation path for a specific data cell of a given entity. The report starts with the source amount entered in the
Value dimension and shows all of its related details in each Value dimension, including the journal entries generated in the journal posting process and the audit transaction details generated as part of the consolidation process. If the account contains line item detail, the report also shows the related line item details entered for the account.

This report provides the capability of viewing transactions, showing the detail of the amounts generated from each step of the consolidation process, including currency translations and intercompany eliminations. It also displays the transaction records for derived data from prior periods.

See these procedures:
- “Starting the Entity Transaction Detail Report” on page 98
- “Selecting Rows and Columns for the Report” on page 99
- “Displaying Line Item Detail” on page 100
- “Displaying Base Details” on page 100
- “Displaying Source and Destination Transactions” on page 100
- “Linking to Journal Detail” on page 101
- “Printing Entity Transaction Detail Reports” on page 101

**Starting the Entity Transaction Detail Report**

You access the Entity Transaction Detail Report from a data grid on the Web.

To start the Entity Transaction Detail Report:

1. From a data grid, select the cell for which to view entity transaction detail.
2. Right-click and select Entity Details.

The report is displayed in a separate browser window.

**Report Point of View**

The Entity Transaction Detail report uses the point of view from the data grid that you are using. The POV information used for the report includes the Scenario, Year, Period, Entity, View, Account, ICP, Custom 1, 2, 3 and 4 dimensions. The Value dimension information is ignored, and all Value members are displayed on the report.

You can only select one account when you run the report. If the account selected is a parent account, the system does not display line item details, journal details, or audit transaction details for the account. The system does not enumerate the details for the base members of the parent account. The support of base members applies only to the custom dimensions. For example, if the Intercompany Partner, Custom 1, 2, 3, or 4 is a Parent member, all entries that are posted to all base members of the Parent member are displayed.
Selecting Rows and Columns for the Report

You can select the rows and columns to display on the report. You can change these selections at any time.


The columns display the amount, Custom 1-4 accounts, ICP, debits, credits, ID, or remarks.

<table>
<thead>
<tr>
<th>Table 9 Possible Values for the Remark Column</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value Dimension</strong></td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Entity Currency</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Adjustments</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Proportion/Elimination</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

You can suppress the display of some transaction details or dimensions by deselecting the applicable options. For example, if you want the report to show only the journal details, you can deselect all other row display options, leaving only the journals option selected. If you want to also suppress the Custom 1, 2, 3 and 4 columns because they are not used for the account, you can also deselect these options from the column display.

The system always displays the Value and Amount columns. The Value column contains all of the Value members. If the currency of the parent member is the same as the currency of the entity, the system skips the display of the <Parent Currency> related Value members because it is duplicate information. The Amount column contains the amount from the data subcube. The amounts for each transaction detail are stored in the Debit or Credit column, depending on the sign of the data cell.

To select report rows and columns:

1 Start an Entity Transaction Detail Report.
2 Select one or more Row Display Options:
   ● Base Details
   ● Line Items
   ● Journals
3 Select one or more Column Display Options:
- Entity
- Account
- Custom 1, 2, 3 or 4
- ICP
- Debit
- Credit
- ID
- Remarks

4 Click Refresh to view the report selections.

### Displaying Line Item Detail

The option to display line item detail is only applicable for the scenario and account defined to use line item detail. Line item detail information is available only for the `<Entity Currency>` Value dimension.

### Displaying Base Details

The option to display base details applies only to a data cell that is a parent member cell. If the option to display base details is not selected, the aggregated amount for the parent cell is displayed as one entry in the report. If you select to display base details, all the information from the base records of the parent cell is displayed.

For example, suppose AllCustom1 is a parent member of the Custom 1 dimension. The base members include Opening, Appropriation, Variances, Increases, Decreases, and Closing. When you select to display base details in the report, the system generates the report with all applicable base records for AllCustom1. If you do not select to display base details, the only the amount for the selected parent cell is displayed; for example, the parent cell AllCustom1 is displayed without any base details.

### Displaying Source and Destination Transactions

From the Entity Transaction Detail report, you can view the audit transaction detail information generated from the consolidation process. To view the transaction detail, you can display Destination Transactions. If you also want to view the Source transactions that generated the amount, you can also display Source Transactions.

You can view these transactions only if you have set up your consolidation rules file to store these transactions. You must use the HS.CON function with the Nature parameter in the rules...
file. If the HS.CON function is not used or if the Nature parameter is not specified in the function, the system will not generate any audit transaction detail during the consolidation process. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.

**Linking to Journal Detail**

When the Entity Transaction Detail Report contains the journal detail for any of the adjustment Value members, the debit or credit amount is displayed with the journal ID. You can click the journal ID link in the ID column to display the Journals Detail window containing all of the information for that journal entry.

➤ To link to journal detail:
1. Start an Entity Transaction Detail report.
2. Select a cell that contains a journal adjustment.
3. From Row Display, select Journals, and from Column Display, select ID.
4. From ID, double-click the journal ID.
5. Click Refresh to view the report selections.

**Printing Entity Transaction Detail Reports**

You can print an Entity Transaction Detail Report. The system processes the report for all entities at once and prints one report containing all pages for all entities.

➤ To print reports:
1. From a report, right-click and select Print.
2. From the Print dialog box, click Print.

**Drilling Through to Intercompany Transactions**

After transactions are posted to an account, you can view the account balance reflecting the posted amounts in the data grid. Account cells in the grid that contain posted transactions are indicated with a red border around the cells. The corresponding transaction details for the account cell are displayed in a separate window.

To drill through to intercompany transactions, you must be assigned the Intercompany Transaction User security role. You can only view intercompany transactions from the data grid; you cannot make changes to the transactions using this view.

➤ To view Intercompany transactions from a data grid:
1. From a data grid, select a cell that contains intercompany transactions, as indicated by a red border.
2. Right-click and select Intercompany Transactions to view the transaction detail.
Drilling Through to FDM

If you use Oracle’s Hyperion® Financial Data Quality Management to load data, you can drill down from Web data grids to FDM to view the source used to load data. You can view additional information about the data load, including POV information, load date and time, and the user who performed the load. For information on using FDM, see the Hyperion Financial Data Quality Management Administrator’s Guide.

To configure your Financial Management application to support FDM, you must provide an FDM application name in the metadata file. You must also configure the FDM URL in the Financial Management configuration utility on the Web tab. See the Hyperion Financial Management — System 9 Installation Guide.

➢ To drill through to FDM from a data grid:

1. From a data grid, select an input cell that has been configured for FDM.
2. Right-click and select Audit Intersection to launch FDM with the POV for the selected cell.
Consolidation Process

Consolidation is the process of gathering data from dependent entities and aggregating the data to parent entities. After you enter or load data into base entities, you perform a consolidation to aggregate the data through the organization. As data consolidates, the system performs the necessary currency translation and intercompany eliminations, and equity adjustments or minority ownership calculations if needed on the data.

Financial Management provides a default consolidation method. To enable statutory consolidations, you can customize the consolidation process. When you create an application, you can set the Consolidation Rules attribute. By default, when this setting is OFF, the system performs the default consolidation and eliminations. When this setting is ON, the system performs consolidation according to the rules written in the Sub Consolidate() routine, as defined by the user. See the Hyperion Financial Management — System 9 Administrator’s Guide.

You launch the consolidation process from data grids on the Desktop or on the Web. Launching consolidation runs the consolidation rules for the specified scenario, year, period, entity, and value. As part of that process, consolidation is run for all descendent entities and all prior time periods within the same year. The consolidation process runs all Calculate functions for each affected entity and value. Translation is run as required to convert from child entity currency to parent entity currency. If the child and parent entity are using the same currency, translation is not run.

After you select the parent into which the dependent entities consolidate, this process takes place:

- The system executes chart rules, and aggregates input and adjustment data in the local currency.
● The system performs translation, if it has not been previously executed. The system also aggregates input and adjustment data by currency for a given entity.

● You can enter adjustments to data through journals.

● The consolidation process begins. The system generates proportion and elimination detail, and creates contribution data. You can make further adjustments to contribution data through journals.

At the entity level of the consolidation process, you enter data in input accounts and enter adjustments through journals in the entity currency. The system executes chart rules at the entity level, resulting in adjusted data for the entity.

The following figure shows an example of the consolidation process:
Translation Process

Translation converts values from one currency to another. The data in the local currency of the dependent entity is translated to the currency of the parent using the local currency exchange rate.

You can enter currency rates by entity for base entities. If you enter currency rates by entity, during translation, the system uses the current entity for the direct translation rate. For example,
if the entity currency rate is Euro, and the parent currency rate is USD, the system uses Rate.Euro.USD in the entity that is being translated. If you do not enter currency rates by entity, the system derives the direct rate from the indirect rate in the current entity. For example, it reverses the amount stored in Rate.USD.Euro to obtain Euro/USD.

If the currency rate is not found in the current entity, the system uses the direct rate in the [None] entity. If the rate is not found, the system derives the direct rate from the indirect rate in the [None] entity. For example, the system reverses the amount stored in Rate.USD.Euro to obtain Euro/USD. See the Hyperion Financial Management — System 9 Administrator’s Guide.

After the translation rule is run, the translated currency dimension is stored. You can make adjustments to the translated amounts in each currency through journals.

The total of these two levels (Translated and Adjusted data) represents the starting point of the consolidation process. The translation process does not take place if the entity and the parent have the same default currency. In this case, the system moves directly to the consolidation process.

As a dependent entity’s values roll up into its parent during consolidation, the system can store consolidation detail, such as Proportion and Elimination detail. Proportion detail contains the balances resulting from the execution of consolidation rules. It also reflects the results of the percent consolidation on the base values. Elimination detail contains any eliminating balances that result during consolidation based on elimination rules.

The system derives as aggregation the contribution (before adjustment) values. It is still possible to adjust this data through journals. The system executes chart rules for adjustments to contribution after you post the journals.

The total of the contribution data (before adjustments) plus the adjustments represents the contribution of the base entity to its parent. The system adds the contribution to the contributions of the other immediate dependents of the parent to obtain the parent consolidated data. The intermediate contribution level aggregations are not stored during calculation. However, the parent consolidated data is stored by the system.

**Calculation Process**

When you calculate data, the system runs calculation rules for the scenario, year, period, entity, and value that you specify. For example, you can calculate the current month’s opening balances by using the prior month’s closing balances.

Calculation rules for all prior time periods within the same year are also run if they have not been run previously. Because calculation rules do not consolidate source entities or execute translation, the status (for example, needs translation or consolidation) is not removed from the cell. Even if the input accounts are not current, calculation uses that data to derive calculated accounts.
Entering Currency Rates

Currency rates are used during translation and consolidation. You can maintain currency rates for each application by loading the rates from an ASCII file or by entering the rates manually in the data grid. See “Loading Data” on page 54.

There are system-defined currency members in the Custom1 and Custom2 dimension for each currency in the application. You must input currency rates to accounts that have the Currencyrate account type.

You can enter currency rates in data grids using these grid settings:

- **Row Dimension = Custom 1**
- **Column Dimension = Custom 2**
- **Row List and Column List =** The member lists you created that contain the application currencies, or the System List [Currencies]

You enter currency rates in a data grid using this point of view:

<table>
<thead>
<tr>
<th>Table 10</th>
<th>Point of View for Currency Rates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimension</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Scenario</td>
<td>Scenario for which the currency rate applies</td>
</tr>
<tr>
<td>Year</td>
<td>Year for which the currency rate applies</td>
</tr>
<tr>
<td>Period</td>
<td>Period for which the currency rate applies</td>
</tr>
<tr>
<td>View</td>
<td>YTD</td>
</tr>
<tr>
<td>Entity</td>
<td>Entity for which the currency rate applies, or None</td>
</tr>
<tr>
<td></td>
<td>If None, the system uses the default currency rate.</td>
</tr>
<tr>
<td>Value</td>
<td><code>&lt;Entity Currency&gt;</code></td>
</tr>
<tr>
<td>Account</td>
<td>Account to contain currency rates</td>
</tr>
<tr>
<td></td>
<td>Account type must be &quot;currencyrate,&quot; which you specify in the metadata load file.</td>
</tr>
<tr>
<td>Intercompany Partner</td>
<td>ICP None</td>
</tr>
<tr>
<td>Custom Dimension 1</td>
<td>Source currency</td>
</tr>
<tr>
<td></td>
<td>Select the [Currencies] system member list.</td>
</tr>
<tr>
<td>Custom Dimension 2</td>
<td>Destination currency</td>
</tr>
<tr>
<td></td>
<td>Select the [Currencies] system member list.</td>
</tr>
<tr>
<td>Custom Dimension 3</td>
<td>None</td>
</tr>
<tr>
<td>Custom Dimension 4</td>
<td>None</td>
</tr>
</tbody>
</table>
Entering Percent Consolidations

The consolidation percentage determines what percent of an entity is consolidated to the parent entity. You can enter the percentage manually in a data grid or load the information through the data load process. The default consolidation percentage for each entity is 100. See “Loading Data” on page 54.

You can enter consolidation percentages using these grid settings:

- Row Dimension = Entity
- Column Dimension = Period

You enter consolidation percentages using this point of view and entering data at the parent entity cell. The child entity cell is red.

Table 11  Point of View for Consolidation Percentages

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>Scenario for which the consolidation percent applies</td>
</tr>
<tr>
<td>Year</td>
<td>Year for which the consolidation percent applies</td>
</tr>
<tr>
<td>Period</td>
<td>Period for which the consolidation percent applies (This does not need to be set if the grid is set as described above.)</td>
</tr>
<tr>
<td>View</td>
<td>YTD</td>
</tr>
<tr>
<td>Entity</td>
<td>&lt;Parent Entity&gt;</td>
</tr>
<tr>
<td>Value</td>
<td>[None]</td>
</tr>
<tr>
<td>Account</td>
<td>&lt;PCON&gt;</td>
</tr>
<tr>
<td>ICP</td>
<td>&lt;Child Entity&gt;</td>
</tr>
<tr>
<td>Custom Dimension 1</td>
<td>None</td>
</tr>
<tr>
<td>Custom Dimension 2</td>
<td>None</td>
</tr>
<tr>
<td>Custom Dimension 3</td>
<td>None</td>
</tr>
<tr>
<td>Custom Dimension 4</td>
<td>None</td>
</tr>
</tbody>
</table>

Calculating Data

You calculate data from data grids on the Desktop or on the Web. In addition to data grids, you can also calculate data from the Process Control module on the Web.

When you calculate data, calculation rules run for the selected scenario, year, period, entity, and value. In addition, all prior time periods within the same year that were not previously calculated are calculated. For example, if you calculate data for June, data that was not previously calculated for January through May is calculated.
You can calculate contribution values rather than parent values. Contribution values are values added to a parent by a dependent entity. When you select contribution values, this populates the Value dimension members of the current entity without rolling the contribution total up to the parent entity. You can also force calculation to generate contribution values.

After you calculate data, the Calculate Data menu option is disabled. If you load or enter new data or metadata, the Calculate Data menu item is reenabled. If the Calculate Data option is not enabled, you can use the Force Calculate option to calculate data.

➤ To calculate data:

1 From the data grid, select the point of view.
2 Select the cell for which to calculate data.
3 Right-click and take one of these actions:
   ● To calculate the selected cells, select Calculate.
   ● To force calculation to run for all selected cells, select Force Calculate.
   ● To calculate contribution values, select Calculate Contribution.
   ● To force calculation to run for all selected contribution values, select Force Calculate Contribution.

Translating Data

Translation converts values from one currency to another. You can translate data from the entity's input currency to any other currency that has been defined in the application. Currencies are not associated with a parent-child entity pair, so you can translate data on demand, separately from the consolidation process.

Launching translation runs the default translation rules for the specified scenario, year, period, entity, and value. As a part of the process, translation rules for all prior time periods within the same year are also run, if translation for those periods is required (TR status). Because translation rules do not cause dependent entities to be consolidated, they do not remove the status that indicates that a cell needs consolidation (CN status). Even if the data for the entity’s default currency is not current, translation uses that data to derive the input accounts for the specified currency (Value dimension). Subsequently, the translation rules automatically invoke calculation so that the calculated accounts are populated for the specified currency.

You translate data from data grids on the Desktop or on the Web. In addition to data grids, you can also translate data from the Process Control panel on the Web.

After you translate data, the Translate Data menu command is disabled. If you load new data, the Translate Data menu option is reenabled. If the Translate Data menu option is not enabled, you can use the Force Translate menu command.

➤ To translate data:

1 Select the point of view.
2 Select a cell for which to run translation rules.

3 Right-click and take one of these actions:
   ● To translate the selected cells, select **Translate**.
   
   **Note:**
   Translation is run for all cells in the current scenario, year, period, entity, and value.
   ● To force translation to run for all selected cells, select **Force Translate**.

### Consolidation Options

Consolidation is the process of gathering data from dependent entities and aggregating the data to parent entities. Invoking consolidation runs the consolidation algorithms for the specified scenario, year, period, entity, and value. As a part of that process, consolidation for all descendant entities and all prior time periods within the same year is run, if it has not been run previously. The consolidation process runs all calculation rules functions for each affected entity and value, and translation runs as necessary to convert from child entities to parent entities. The consolidation process does not run translation rules for currencies that are not used in the process of deriving parent entity data from its children.

These options are available for consolidating data: Consolidate (Impacted), Consolidate All with Data, and Consolidate All.

#### Consolidate (Impacted Consolidation)

The Consolidate (Impacted Consolidation) option is available for any parent entity with a status of CN or CN ND. When you select this option for a parent entity, the system performs calculations (Calculate, Translate, Consolidate) for any dependent entity within the consolidation path of the selected parent that has a calculation status of Impacted, such as CN, CN ND, CH, TR, or TR ND, on the current period or on any prior period in the current year. Consolidate is the most efficient option because only entities that require consolidation are updated by the system.

Process units with a status of NODATA on the current period and all prior periods are skipped.

Process units with a status of OK or OK SC on the current period are not recalculated, retranslated, or reconsolidated.

If the selected parent has a status of CN or CN ND in the prior period, consolidation runs for all periods from the first period in the current year where the parent is impacted until the current period.

#### Consolidate All with Data

The Consolidate All with Data option is available for any parent entity regardless of its status. When you select this option for a parent entity, the system consolidates every dependent entity
within the consolidation path of the selected parent that contains data, regardless of its status, in the current period or in any of the prior periods. This option is useful for updating system status from OK SC to OK after metadata changes.

Process units with a status of NODATA on the current period and all prior periods are skipped.

Process units with a status of OK or OK SC on the current period are recalculated, retranslated, and reconsolidated.

If the selected parent has a status of CN or CN ND in the prior period, consolidation runs for all periods from the first period in the current year where the parent is impacted until the current period.

**Consolidate All**

The Consolidate All option is available for any parent entity regardless of its status. When you select this option for a parent entity, the system performs calculations for every process unit within the consolidation path of the selected parent, regardless of its status.

Process units with a status of NODATA on the current period are calculated, translated, and consolidated.

Process units with a status of OK or OK SC on the current period are recalculated, translated, and reconsolidated.

If the selected parent has a status of CN or CN ND in the prior period, consolidation runs for all periods from the first period in the current year where the parent is impacted until the current period.

The Consolidate All option is useful when an update from prior periods is required, or when an entity with no data needs to be populated using allocations. This option should be used sparingly because the system does not skip entities with NODATA, which can have a significant impact on consolidation performance.

**Consolidating Data**

You can consolidate data by selecting cells in data grids on which to run consolidation. To use Consolidate, you must be assigned the Consolidate security role. To use Consolidate All, you must be assigned the Consolidate All security role. To use Consolidate All with Data, you must be assigned the Consolidate All with Data security role.

You consolidate data from data grids on the Desktop or on the Web. In addition to data grids, you can also consolidate data from the Process Control panel on the Web.

When the consolidation process is complete, the status of each successfully consolidated entity changes to OK.

**Note:**

If the consolidation process is running for the selected entity, the system displays a warning message when an overlapping consolidation is launched.
To consolidate data:

1. Select the point of view.
2. Select a cell for which to run consolidation.
3. Right-click and take one of these actions:
   - To consolidate the selected entity, select **Consolidate**.
   - To consolidate all selected entities, regardless of whether they contain data, select **Consolidate All**.

   **Note:**
   Consolidation is run for all cells in the current scenario, year, period, entity, and value.

   - To consolidate all selected entities that contain data, select **Consolidate All with Data**.

**Viewing Consolidation Progress**

When you consolidate data on the Web, you can monitor the progress of one or more consolidations that you started in a particular session.

When you select Consolidate, Consolidate All, or Consolidate All with Data, a progress bar page is displayed in a separate browser window. This page displays the current progress percentage, the point of view, status, and last update time. If you start a series of tasks, you can see the progress of the task that is running.

When the progress bar is displayed, you cannot perform any other tasks Financial Management using the same Web page. You can start another session by starting another user interface instance. If you close the instance from which you started the task, the task continues to run in the server on its own.

In addition, you can view the status of the task from the Running Tasks module. In the Running Tasks module, you can view all of the tasks that are running, but you can cancel only tasks that you started.

To view consolidation progress:

1. From a data grid, select a cell for which to run consolidation.
2. Right-click and select **Consolidate**, **Consolidate All**, or **Consolidate All with Data**.
3. Take one of these actions:
   - From the **Consolidation Progress** page, view the progress for the task that is running.
   - From the **Running Tasks** page, select the **Consolidation** task from **Task Filter** and click **View** to view the progress.
Canceling Consolidation Tasks

When you consolidate data on the Web, you can cancel a consolidation task or series of consolidations. If you are viewing consolidation progress from the Running Tasks module, you can only cancel any tasks that you started. Administrators can cancel running tasks by any user to free resources. See the Hyperion Financial Management — System 9 Administrator’s Guide.

➢ To cancel a consolidation task, take one of these actions:
  ● From the Consolidation Progress page, click Cancel for the consolidation to cancel.
  ● From the Running Tasks page, select the Consolidation task from Task Filter and click Stop Task.

Consolidation Status

The consolidation status of a base level or parent entity can change as a result of several actions:
  ● Changing the organization structure
  ● Adding or deleting accounts
  ● Modifying entity attributes
  ● Entering data in data grids, or loading data from external sources
  ● Posting or unposting journals
  ● Posting or unposting intercompany transactions
  ● Reloading rules
  ● Changing percent consolidation
  ● Changing currency rates

You can view the consolidation status from the Explore Data module on the Desktop or on the Web.
Using Data Forms

In This Chapter

Viewing Lists of Data Forms .................................................................................................... 115
Opening Data Forms ............................................................................................................. 116
Using the Data Form Toolbar ............................................................................................... 116
Viewing Data Form Instructions ........................................................................................ 117
Entering Data in Data Forms ............................................................................................... 117
Working with Cell Text ...................................................................................................... 118
Attaching Documents to Data Forms ................................................................................. 120
Entering Line Item Detail in Data Forms ............................................................................ 120
Viewing Line Item Detail in Data Forms ............................................................................ 121
Deleting Line Item Detail in Data Forms ............................................................................ 121
Using Linked Forms ........................................................................................................ 122
Changing the Point of View in Data Forms ....................................................................... 123
Calculating Data in Data Forms ....................................................................................... 123
Exporting or Importing Data Forms to Excel ................................................................. 125
Drilling Through to Intercompany Transactions ............................................................ 126
Drilling Through to FDM ................................................................................................. 126

Viewing Lists of Data Forms

You can enter data in an application on the Web using forms that your administrator created. Data Forms enable you to enter data for pre-defined views, such as specific periods and accounts. The forms support nested columns and rows for multidimensional analysis, and additional functionality enables you to drill into further detail.

Sample Data Form scripts are included when you select the Sample Applications during installation, and are located in the Hyperion Financial Management\Sample Apps directory.

Only an administrator with Manage Data Forms security rights can create, load, and delete forms. See the Hyperion Financial Management — System 9 Administrator’s Guide.

You can also work with Data Forms directly in Oracle’s Hyperion® Smart View for Office™. If you want to use Data Forms in Microsoft Excel, we recommend that you access them through Oracle’s Hyperion® Smart View for Office. See the Hyperion Smart View for Office User’s Guide.
You can view a list of available Data Forms. The list displays the name, description, and last-modified date. If you have the Manage Data Forms security role, you can also view the security class for each form.

Forms may also be included in folders. The Data Forms administrator can create folders to organize the forms in an application. You can view the forms in a folder, but only the administrator can create or delete folders.

You can only enter data on forms for which you have security rights. You can open, view, enter or edit data, and save data in Data Forms. Only an administrator with Manage Data Forms security rights can create, load, and delete forms.

To view a list of Data Forms:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Forms.
2. Review the list of available forms and folders.

Opening Data Forms

You can open a Data Form to view, enter, or edit data. To open a form, you must have access to its security class.

To open Data Forms:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Forms.
2. Click the link to the form to open, or select a form from a folder.

Using the Data Form Toolbar

You can select Data Form options from the toolbar at the top of the form.

The following table shows the toolbar buttons available when a form is opened:

<table>
<thead>
<tr>
<th>Function</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit</td>
<td>![Submit Icon]</td>
</tr>
<tr>
<td>Refresh</td>
<td>![Refresh Icon]</td>
</tr>
<tr>
<td>Calculate</td>
<td>![Calculate Icon]</td>
</tr>
<tr>
<td>Force Calculate</td>
<td>![Force Calculate Icon]</td>
</tr>
<tr>
<td>Cell Text</td>
<td>![Cell Text Icon]</td>
</tr>
</tbody>
</table>
**Function** | **Toolbar Button**
---|---
Instructions | ![Instructions](image)
Print | ![Print](image)
Export to Excel | ![Export to Excel](image)
Import to Excel | ![Import to Excel](image)
Suppress Rows | ![Suppress Rows](image)
Suppress Columns | ![Suppress Columns](image)
Suppress Lines | ![Suppress Lines](image)

**Viewing Data Form Instructions**

Before you begin entering data in a Data Form, you can view instructions that the administrator has created about using the form. If the administrator has not created any instructions, when you click Instructions, a message is displayed that no instructions have been defined.

➤ **To view Data Form instructions:**

1. **Open a Data Form.** See “Opening Data Forms” on page 116.
2. **On the form toolbar, click Instructions.**
3. **When you finish viewing instructions, click Close.**

**Entering Data in Data Forms**

You can enter or edit data in predefined Data Forms that your administrator has created. You can enter data in input (off-white) cells, or enter an amount directly in a summary-level time period and have it distributed across base-level periods. You cannot enter data into calculated or cells at invalid intersections, which are indicated in red. See “Entering or Editing Data” on page 86.

To enter data in a Data Form, you must have access to the security class for the form and security rights for the data in the cells on the form.

You can use the scroll bars for rows and columns to view various parts of the form.

➤ **To enter data in Data Forms:**

1. **Open a Data Form.**
   
   See “Opening Data Forms” on page 116.
2 Enter data into input (off-white) cells.

Note:
To clear a cell, you can delete its contents or enter NODATA.

3 When you finish entering data, click Submit.

4 To refresh the data, click Refresh.

Working with Cell Text

You can enter, view, and edit cell text in Data Forms. A cell that contains text is indicated by a blue triangular mark in the top left of the cell.

Entering Cell Text in Data Forms

You can enter a text description for cells in a Data Form. For example, you might add a description for a cell’s currency information, such as Entity Currency. After you add cell text, you can change it.

You can set size limits for cell text in an application. The default cell text setting is a maximum of 8,000 bytes. You set the maximum size in the AppSettings attribute for the application metadata.

Note:
You cannot enter text for a cell that is calculated by the form.

To add cell text in Data Forms:

1 Open a Data Form.

2 Select the cell for which to add text.

3 Take one of these actions:
   ● Highlight a cell, right-click, and select Cell Text.
   ● Select a cell, and in the form toolbar, click Cell Text.
   ● If the administrator has set up the form with a cell text column, enter the cell text in the column.

   Note:
The cell point of view is displayed for informational purposes only.

4 In the text box below the cell point of view information, enter the text for that cell, and click OK.
Note:
After you enter cell text, the cell has a blue triangular mark in the top left corner to indicate that it contains cell text. Cells that contain both cell text and line item detail are indicated by a blue and red triangular mark.

**Viewing Cell Text in Data Forms**
You can view text descriptions for cells in a Data Form.

➤ To view cell text in Data Forms:

1. Open a Data Form.
2. Select the cell for which to view text.

Note:
Cells with text are indicated by a blue triangular mark in the top left.

3. Do one of these tasks:
   - Highlight a cell, right-click, and select **Cell Text**.
   - Highlight a cell, and in the form toolbar, click **Cell Text**.
   - If the administrator has set up the form with a cell text column, view the cell text in the column.

Note:
The cell point of view is displayed for informational purposes only.

4. Click **OK** to close the Cell Text dialog box.

**Editing Cell Text in Data Forms**
When a cell contains cell text, you can edit the cell text title from the column next to the cell instead of the Cell Text dialog box. The cell text title is one line of 69 characters maximum. Additional text that you enter for the cell is considered body text.

Cells that have only cell text titles display the cell text title in the column, and are not indicated by a blue triangular mark in the top left corner of the cell. Cell text that is more than 69 characters is indicated by a blue triangular mark in the cell, and can be edited only in the Cell Text dialog box.

➤ To edit cell text:

1. Open a Data Form.
2. Select the cell for which to edit text.
3. Take one of these actions:
• Highlight a cell, right-click, and select Cell Text.
• Highlight a cell, and in the form toolbar, click Cell Text.
• If the administrator has set up the form with a cell text column, edit the cell text in the column, or click Cell Text to add more text.

Attaching Documents to Data Forms

In addition to or instead of entering cell text, you can attach one or more documents to cells for additional detail. For example, you can attach a Microsoft Word document, Microsoft Excel spreadsheet, XSL, or RPT file. To attach or extract any custom documents to or from the server, you must be assigned the Manage Custom Documents security role.

You can set a size limit for document attachments and a maximum number of document attachments by user in an application. You set the limits in the AppSettings attribute for the application metadata.

You can attach multiple documents; however, Hyperion recommends that you attach no more than two or three documents to a cell. Each document should be smaller than 100K to limit the performance effect on the database.

➤ To attach a document to a cell:

1 Select the input cell for which to attach a document.
2 Right-click and select Cell Text.
3 Click Attach.
4 From your list of custom documents, select one or more documents to associate with the cell, and click Attach.

Note:
You cannot attach private documents.

The attachment is displayed in the Attachments section of the Cell Text dialog box.

Tip:
To detach a document from a cell, select the document to detach, and click Detach.

Entering Line Item Detail in Data Forms

You can enter line item detail for cells in a Data Form. If a cell does not support line item detail, this menu option is not displayed.

The maximum description length is 80 characters. You cannot change detail descriptions.
To add line item detail in Data Forms:

1. Open a Data Form.
2. Select the cell for which to add detail.
3. Right-click and select Cell Line Item Detail.

**Note:**
The cell point of view is displayed for informational purposes only.

4. Enter the cell line item detail, and click Save.
5. To add a row, click New Entry.

**Note:**
If the form was set up for multiple period line item detail, you can click Delete Row to delete a row of line item detail. You can also click Clear Row to clear the line item detail from a row.

6. To refresh the data, click Refresh.
7. When you finish entering line item detail, click Close.

**Note:**
After you save your entries, cells that contain line item detail are indicated by a red triangular mark in the top left corner. A cell that contains both cell text and line item detail is indicated by a blue and red triangular mark.

**Viewing Line Item Detail in Data Forms**

You can view line item detail for cells in a Data Form. You can view line item detail by one period or by all periods. The system administrator specifies how line item detail is viewed when creating the Data Form.

To view line item detail in Data Forms:

1. Open a Data Form.
2. Select the cell for which to view line item detail.

**Note:**
A cell that contains line item detail is indicated by a red triangular mark in the top left corner.

3. Right-click and select Cell Line Item Detail.

**Deleting Line Item Detail in Data Forms**

You can delete line item detail from cells in a Data Form.
To delete line item detail:

1. Open a Data Form and make sure the administrator has set it to display line item detail for all input periods.
2. Select the cell for which to delete line item detail.

**Note:**

A cell that contains line item detail is indicated by a red triangular mark in the top left corner.

3. Right-click and select **Cell Line Item Detail**.
4. Select the row to delete and select **Delete Row**.
5. Click **Save**, close the line item detail window, and click **Refresh** to refresh the data.

---

**Using Linked Forms**

When administrators create Data Forms, they can define links from one form to another to enable drill-through to a more specific data entry view of the data. For example, a form that contains summary account balances can link to a corresponding detail form to provide the necessary details for the summary account. The links to other forms apply to an entire row. A Data Form can contain up to 64 linked forms.

If an administrator defines a Data Form to link to a more specific data entry view of the data, the cell contains a link that indicates additional information is available. For rows that contain linked forms, the row headers display in yellow.

To use linked forms:

1. In a Data Form, select a row that contains linked forms.

**Tip:**

Rows that contain linked forms have yellow row headers.

2. Right-click and select **Linked Form**.

A new form is displayed in a separate browser window.

3. When you finish using the linked form, click **Close**.

The system returns you to the list of available forms.

**Note:**

If you do not have security rights to a form, or the form is deleted, an error message is displayed. Click **Return**.
Changing the Point of View in Data Forms

An administrator creates a Data Form by defining the rows and columns for the form and the point of view. However, the administrator can also allow users to change some elements in the point of view on the form by selecting members from a specified list. This enables you to use the same form for different dimension members.

The point of view is displayed on the top of the form. Elements that can be changed are displayed as links in the point of view. For example, if the Entity dimension is displayed as a link, you can change the entity but not the other dimensions in the point of view.

To change a point of view element on Data Forms:

1. Open a Data Form. See “Opening Data Forms” on page 116.
2. In the Point of View, click the element to change.
3. From the Point of View box, select the dimension member to change and click OK.

The system returns you to the Data Form.

Calculating Data in Data Forms

After you enter data in Data Forms, you can calculate the data to see the results. When you select to calculate data, the system calculates data for the scenario, year, period, value, parent, and entities defined in the grid.

To calculate data in Data Forms:

1. Open a Data Form.
2. Select the cell for which to calculate data and save the data.
3. Take one of these actions:
   - Click Calculate if you want the system to calculate the cells that have changed.
   - Click Force Calculate to force calculation to run for each scenario, year, period, value, parent, entity defined in the grid, regardless of status.

Note:

You must submit the data before you calculate.

Suppressing Data in Data Forms

You can set row and column suppression options individually, under Suppress Rows and Suppress Columns, or together, under Suppress Lines. For example, setting Suppress Lines to NoData has the same effect as setting both Suppress Rows and Suppress Columns to NoData. When the current row and column suppression options differ, the option selected is displayed with a check mark that indicates the current setting. For example, if NoData is suppressed on
rows and Zero is suppressed on columns, Suppress Lines places the check mark on NoData & Zero. Clicking NoData & Zero sets both row and column suppression to NoData & Zero.

**Note:**

Only users with the security rights to manage forms see the invalid cells suppression option. Suppression of invalid cells is automatically enabled for all other users.

➤ To suppress data:

1. Open a Data Form.

2. Take one or more of these actions:
   - To suppress rows, on the toolbar, click Suppress Rows, and select None, or one or more of these options: NoData, Zero, or Invalid.
   - To suppress columns, on the toolbar, click Suppress Columns and select None, or one or more of these options: NoData, Zero, or Invalid.
   - To suppress rows and columns, on the toolbar, click Suppress Lines and select None, or one or more of these options: NoData, Zero, or Invalid.

**Tip:**

Another method of selecting suppression options is to place your cursor over a row or column header, and right-click to change the row or column. To change both row and column options, place your cursor in the space at the top left of the form where the rows and columns intersect, right-click and select an option.

---

**Adding Members to Data Forms**

When administrators define Data Forms, they can choose to allow form users to insert additional lines of data. If an administrator has enabled the form to be modified and updated, an Add Member button ( ) is displayed in the left header cell of the form. You can select additional members, and enter and save data for those members. The new entries are inserted into the form and the totals are updated.

For example, a form may have been defined for an account with intercompany transactions for IC1, IC2, and IC4. You can select members IC3 and IC5, and enter and save data for those members. The form is refreshed with the newly saved data and the new lines are displayed in the appropriate hierarchical order.

➤ To add members to Data Forms:

1. Select Administration > Manage Documents, or click Manage Documents and select Data Forms.

2. Click the form into which to enter data.

3. To add dimension members to the form, in the leftmost header cell of the form, click Add Member.

4. Select the members for which to enter data and click Add.
Tip:
To select multiple members, hold Ctrl and select members. Use Add All and Remove All to add or remove all members.

5 Click OK.

6 Enter data for the additional members.

7 Optional: Enter cell text by taking one of these actions:
   ● Highlight a cell, right-click, and select Cell Text.
   ● Select a cell and click Cell Text.
   ● If the administrator has set up the form with a cell text column, enter the cell text in the column.

8 Optional: To calculate or force calculate the selected cells, click Calculate and Force Calculate, respectively.

Note:
You must submit the data before you calculate.

9 To save your changes, click Save.
The form is automatically refreshed and updated with the newly added entries.

Exporting or Importing Data Forms to Excel

You can export Data Forms to Microsoft Excel and import forms from Excel to an application. For example, you can export a form to Excel, use Excel to enter or edit data, and reload the form into the application.

To export Data Forms:
1 Open the Data Form to export.
2 Click Export to Excel.
3 From File Download, click Save, enter a file name, and click Save.
4 From Download Complete, click Close.
5 Navigate to the saved file and open it.
6 In Excel, enter or edit data in the input cells.
7 Select File > Save or File > Save As and save the file.

Note:
When you save the file, the system displays the file name in quotation marks and the file type as a Web page (*.htm, *.html). If you change the file type, you cannot reload the file into the application.
To import a form from Microsoft Excel:

1. Open the Data Form into which to import data.
2. Click Import from Excel.
3. Click Browse to locate the file to import, and click Open.
4. Click OK.

After the file is loaded, the Data Form is refreshed to the default point of view. You can change the point of view to view the data.

**Drilling Through to Intercompany Transactions**

After transactions are posted to an account, you can view the account balance reflecting the posted amounts in the Data Form. Account cells in the form that contain posted transactions are indicated with a red symbol in the cell. The corresponding transaction details for the account cell are displayed in a separate window.

To drill through to intercompany transactions, you must be assigned the Intercompany Transaction User security role. You can view intercompany transactions from the data form, but you cannot make changes to the transactions using this view.

**To view Intercompany transactions from Data Forms:**

1. From a Data Form, select a cell that contains intercompany transactions, as indicated by a red mark in the top left of the cell.
2. Right-click and select Intercompany Transactions to view the transaction details.

**Drilling Through to FDM**

If you use FDM to load data, you can drill down from Web data forms to FDM to view the source used to load data. You can view additional information about the data load, including POV information, load date and time, and the user who performed the load. For information on using FDM, see the *Hyperion Financial Data Quality Management Administrator’s Guide*.

To configure your Financial Management application to support FDM, you must provide an FDM application name in the metadata file. You must also configure the FDM URL in the Financial Management configuration utility on the Web tab. See the *Hyperion Financial Management — System 9 Installation Guide*.

**To drill through to FDM from a data form:**

1. From a data form, select an input cell that has been configured for FDM.
2. Right-click and select Audit Intersection to launch Oracle’s Hyperion® Financial Data Quality Management with the POV for the selected cell.
Managing Ownership

You can set up the ownership and control of an organization by recording the shares of stock that the entities in the organization own in one another. You can record two types of shares for an organization: regular shares and voting shares. The system uses regular shares to calculate ownership and voting shares to calculate control.

You can enter the number of shares that entities own. If you assign a holding company to a parent entity, the system can calculate the ultimate ownership and control percentages based on the share values. It can then use the ultimate percentages to propose the consolidation percentage and method for the entities below that parent.

If you are using Financial Management on the Web, you can manage ownership information such as percent consolidation, percent ownership, percent control, and consolidation method. You can enter information for selected entities and these system accounts: Active, Method, PCON, POWN, PCTRL, DOWN, Consol1, 2, and 3. The grid also displays a column called PMIN, which is a calculated column using this calculation: PCON - POWN = PMIN. To enter ownership information, you must be assigned the Manage Ownership security role. See “Entering Ownership Information” on page 129.

In addition, you can calculate values for ownership percentages based on the ownership of shares of entities. See “Calculating Ownership” on page 132.

The following figure shows a sample ownership grid. The rows display the list of child entities based on the entity you are using as the parent entity in the point of view. The columns display system accounts for which you can enter values.
Changing the Point of View

The default point of view when you start Ownership Management for the first time contains the top members for the Scenario, Year, and Period dimensions. For the Entity dimension, the default member is [None]. You can change the scenario, year, period, and the entity to use as the parent entity.

➤ To change the point of view:

1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Ownership Management.
3. On the Point of View bar, click the dimension to change.
4. Select a dimension member and click OK.

Setting Display Options

You can specify display options for the Ownership Management grid. You can show active entities only, entity descriptions in rows, or period descriptions in columns. You can select to display the Entity Currency, or the Active, Method, PCON, POWN, PMIN, PCTRL, DOWN, and Consol 1, 2, or 3 columns.

Note:

The Entity Currency column is for display only. You cannot change the currency from the Ownership Management grid.

➤ To set display options:

1. Create or open an Ownership form.
2. Optional: To show only active entities, select Show Active Only.

Note:

If you do not select this check box, all entities are displayed.
3 Optional: To display the entity description, select Show Entity Description.
4 Optional: To display the period description, select Show Period Description.
5 Optional: To select the columns to display, click Display Options.
6 Select the columns to display.
7 Click OK.

Filling Multiple Entities with Values

You can select multiple entities and update the entities with the same value for a particular account. When you use the Fill option, the changes that you make to values apply to all selected entities for the period selected in the point of view.

You use the check boxes next to the rows to select multiple rows and apply the value in one row to multiple rows. You can also select all entities in the list at a time.

For example, you can select the entities California, Connecticut, and Florida and enter a value of 90 for California. When you select Fill, the system applies a value of 90 to California, Connecticut, and Florida. You can also apply a value that you previously entered by highlighting that value, and selecting entities to which to apply the value.

➤ To fill multiple entities with values:
1 From the Ownership Management grid, select entities using one of these methods:
   ● Select the check box next to the row or rows to fill.
   ● To select all, select the box at the top of the list next to Entities.
2 Highlight the account from which to fill values, and click Fill.
   The system applies the current value to all the selected entities.
3 Take one of these actions:
   ● To save the current values to the database and refresh the data, click Save.
   ● To reset the data to the values that were last saved in the database, click Reset.

Entering Ownership Information

You use the Ownership Management feature to enter ownership information for entities such as Percent Ownership, Percent Consolidation, and Percent Control. You can also select the consolidation method for the entity and select whether the consolidation status of a child into its parent is active or inactive.

To enter ownership information, you must be assigned the security role of Manage Ownership.

The rows display the list of child entities based on the entity you selected to use as the parent entity in the point of view. You can select multiple rows and apply a value in one row to multiple rows.
You can save changes to the data, or you can reset the data to the values in the database without saving any changes. When you select to save data, all values in the grid are saved in the database.

**Note:**

For the PCON, POWN, PCTRL, and DOWN system accounts, no data is displayed as a value of 100. For Consol 1, 2, 3, no data is displayed as 0.

**Table 13** shows the system accounts that appear in the columns and the possible values that you can enter for each. These columns are preset and cannot be changed. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.

<table>
<thead>
<tr>
<th>Account</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active - Consolidation status of a child into its parent</td>
<td>Yes for active, No for inactive</td>
</tr>
<tr>
<td>Method - Consolidation method assigned to the entity</td>
<td>&lt;None&gt;, or a method selected from the list of available methods</td>
</tr>
<tr>
<td>[PCON] - Percent consolidation. The percentage of an entity’s value that consolidate to its parent.</td>
<td>Positive or negative number between -100 and 100, including 0. Default value is 100.</td>
</tr>
<tr>
<td>[POWN] - Percent ownership based on the entity’s shares that other entities own.</td>
<td>Positive number between 0 and 100. Default value is 100.</td>
</tr>
<tr>
<td>[PMIN] - Percent minority</td>
<td>A value calculated from the formula PMIN = PCON - POWN.</td>
</tr>
<tr>
<td>[PCTRL] - Percent control based on the entity’s voting shares that other entities own</td>
<td>Positive number between 0 and 100. Default value is 100.</td>
</tr>
<tr>
<td>[DOWN] - Percent of direct ownership</td>
<td>Positive number between 0 and 100. Default value is 100.</td>
</tr>
<tr>
<td>Consol 1, 2, 3 - Consolidation methods</td>
<td>A number between 0 and 255</td>
</tr>
<tr>
<td>Active - Consolidation status of a child into its parent</td>
<td>Yes for active, No for inactive</td>
</tr>
</tbody>
</table>

➢ To enter ownership information:

1. In the **Browser View**, expand **Tasks** and select **Data Tasks**.
2. Select **Ownership Management**.
3. Select the point of view to display the entities for which to enter ownership information.
4. Optional: To display the entity currency, click **Display Options** and select **Entity Currency**.
5. For selected entities, take one or more of these actions:
   - For **Active**, select **Yes** or **No** to specify whether the consolidation status of the child into its parent is active.
   - For **Method**, select a consolidation method for the entity.
● For PCON, enter a value for percent consolidation.
● For POWN, enter a value for percent ownership.
● For PCTRL, enter a value for enter a value for percent control.
● For DOWN, enter a value for direct ownership.
● For Consol1, Consol2, and Consol3, enter a consolidation method.

6 Take one of these actions:
● To view additional entities, select the range to display, and select a value from Per Page.
● To save the changes to the database and refresh the grid, click Save.
● To reset the data to the values in the database without saving changes, click Reset.

Calculate Ownership Process

You can calculate values for ownership percentages based on the ownership of shares of particular entities. The Calculate Ownership process uses the direct share percentages that entities own to calculate the ultimate ownership and control percentages for the dependents of the selected parent in these system accounts: POWN, PCON, PCTRL, DOWN, and METHOD. The calculation procedures use the shares stored in the system accounts [voting%owned] and [shares%owned].

Percent Control

Percent control represents the percentage of an entity based on voting shares that other entities own, directly or indirectly. When you select Percent Control, the system calculates the percentage that the selected parent’s holding company controls of each dependent based on the shares information stored in the Voting%Owned account, and the To%Ctrl field in the Consolidation Method metadata table. The calculation result is stored in the system account [PCTRL] using the ICP dimension. For example, if the calculation returns 80% for Entity A, the system stores 80 in the parent entity’s account [PCTRL], ICP=A.

Consolidation Method

Consolidation method is the set of rules that determine how to consolidate data from an entity to its parent. The system proposes this method based on the percent control and the consolidation methods in the Consolidation Method metadata table that have the “UsedbyCalcRoutine” attribute enabled. For each entity for which percent control is calculated, the system assigns the consolidation method corresponding to the percent control range for the consolidation method specified in the table. For example, if the percent control calculated for Entity A is 75%, and the consolidation method assigns the GLOBAL method when percent control is from 50% to 100%, the system stores 1 in the parent entity’s account [Method], Custom1=GLOBAL, ICP=A.
The exception to this rule is the holding company for the parent. For the holding company only, the system does not use percent control to determine the consolidation method, but assigns the consolidation method that has the IsHoldingMethod attribute enabled.

**Percent Ownership**

Percent ownership represents the percentage of an entity’s nonvoting shares that other entities own, directly or indirectly. When you select Percent Ownership, the system calculates the ultimate percent owned based on the share values stored in the Shares%Owned account. The calculation result is stored in the parent in the system account [POWN] using the ICP dimension. For example, if the calculation returns 90% for Entity A, the system stores 90 in the parent entity’s account [POWN], ICP=A.

**Percent Consolidation**

Percent consolidation is the percentage of an entity’s values that consolidate to its parent. The system uses the methods defined in the Consolidation Method metadata table to determine the percent consolidation to apply for each entity. If there is no consolidation method assigned to the entity, or the method assigned to the entity does not match a method marked UsedByCalcRoutine, then the system uses the percent consolidation corresponding to the percent control range.

For example, if the account [Method], Custom1=Global, ICP=001 has a value of 1, and in the consolidation method table, the percent consolidation corresponding to method Global is 100%, the system stores 100 in the account [PCON], ICP=001.

**Direct Percent Ownership**

Direct percent ownership is the percentage of regular nonvoting shares of stock owned by each entity. When you select Direct Percent Ownership, the system calculates this based on information in the Shares%Owned account.

For example, if Entity 002 has a value of 80 in the Shares%Owned account, ICP=holding (the holding company owns 80% of Entity 002), the system fills 80 in the account [DOWN], ICP=A for Entity=Group1.

**Calculating Ownership**

You use the Calculate Ownership option to calculate values for ownership percentages based on the ownership of shares of particular entities. You can run the calculation procedures together or separately. You can calculate ownership for multiple parent entities and for multiple periods for a specific scenario and year.

You must assign a holding company to the parent for the Calculate Ownership option to be available. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.
To calculate ownership:

1. From the Ownership Management grid, select the parent entity as the POV entity for which to calculate ownership.

   **Note:**
   The parent entity that the calculation uses is the Entity on the point of view. For example, if the POV entity is Region.Europe, the calculation takes place for Europe, not Region.

2. Click Calculate Ownership.

3. Highlight one or more periods for which to calculate ownership.

4. Select one or more calculation options:
   - To calculate ultimate percent control, select **Percent Control**.
   - To select a consolidation method for percent control, select **Consolidation Method**.
   - To calculate ultimate percent ownership, select **Percent Ownership**.
   - To calculate ultimate percent consolidation, select **Percent Consolidation**.
   - To calculate direct percent ownership, select **Direct Percent Ownership**.

5. Select an entity option:
   - To calculate ownership for the current entity only, select **Current Entity**.
   - To calculate ownership for the current entity and all parent entities below it, select **Descendants**.
   - To calculate ownership for all entities, select **All Entities**.

6. Click Calculate.
Opening Reports

You can generate these types of reports:

- Data Explorer reports, which display information from data grids
- Journal reports, which display information for a journal or list of journals based on criteria that you select in the Journals module
- Intercompany Partner (ICP) Matching reports, which display the intercompany transactions that are to be eliminated during consolidation
- Intercompany Transaction reports, which display a list of intercompany transactions
- IC Matching by Account reports, which display intercompany transactions based on selected accounts
- IC Matching by Transaction ID reports, which display intercompany transactions by transaction ID
- IC Matching templates, which contain settings that you frequently use for auto-matching intercompany transactions

You can apply report style sheets, and you can save, print, and delete reports. You can also drill down from an Intercompany Matching Report to view intercompany transactions.

See “Running Data Explorer Reports” on page 78 and “Running Journal Reports on the Desktop” on page 223.

To create reports, see the Hyperion Financial Management — System 9 Administrator’s Guide.
You can open a report that is stored on a local computer or one that is stored remotely on a server. When you open reports that are stored on the server, you can select to show reports created by other users. You can only open reports on the server to which you have Read or All security access.

You can view the list of available reports by these types: Data Explorer, Journal, or Intercompany Matching. You can display reports by file type, such as Report Definition, XML, or HTML. You can also sort the list by report name or the date and time last modified.

Windows Procedures

➤ To open reports stored locally:
1. From the System Reports module, select File > Open Local.
2. Enter a file name or browse to locate the file, and click Open.

➤ To open reports stored remotely:
1. From the System Reports module, select File > Open Remote.
2. Optional: To view reports by all users, select Show Reports for all users.
3. From Reports of type, select a report type.
4. From Files of type, select a file type.

Tip:
To refresh the report list, click Refresh List.

5. Optional: To sort the list, select an option:
   - To sort by report name, click Report Name
   - To sort by descriptions, click Report Description.
   - To sort by date and time last modified, click Last Modified.
6. Select a report and click Open.

Web Procedure

➤ To open reports:
1. Select Administration > Manage Documents, or click Manage Documents and select Reporting.
2. From Report Type, select the report type to open.
3. From File Type, use the default option: Report Definition.
4. Click the name of the report to open.
Viewing Reports

You can view reports that you create in the Journals and Data Explorer modules, and reports that you create from System Reports on the Desktop. You can only view the reports on the server to which you have Read or All security access.

The date, time, and user are automatically displayed as header information on all reports.

Windows Procedure

➤ To view reports:
1 From the Financial Management Desktop, click System Reports.
2 Open a report.
3 Select View.
4 When you finish viewing the report, select File > Close.

Web Procedure

➤ To view reports:
1 Select Administration > Manage Documents, or click Manage Documents and select Reporting
2 From Report Type, select the report type to view.
3 From File Type, use the default option: Report Definition.
4 Click the name of the report to open.

Note:

If you view a report on the Web using Netscape and the report contains Japanese characters in the label, you must modify the character coding setting in Netscape to view the report. From the Netscape menu bar, select View > Character Coding > Auto-Detect, and select All.

Working with Style Sheets

You can apply a style sheet to view a report on the Web. Financial Management provides several default report style sheets. On the Desktop, you can also retrieve report style sheets (XSL and CSS files) from the server and store them on your local computer to use with other XML viewing tools.

Applying Report Style Sheets

After you define a report, you can apply an XSL style sheet to transform the XML data into HTML format for easier viewing on the Web.
Financial Management provides several default report XSL style sheets for Journals, Data Explorer, and Intercompany Matching Partner reports. For example, if you want the report to display journals in tables with borders, you can use the HFM_JournalTableWithBorders.xsl style sheet.

The style sheets are installed in the Server Working Folder during the installation process. The default location for the style sheets is C:\Hyperion\FinancialManagement\ServerWorkingFolder\Report Style Sheets.

If you want to create your own style sheets instead of using the ones provided, contact your IT administrator for support with XSL.

Windows Procedure

➤ To apply report style sheets:

1. From the Financial Management Desktop, click System Reports.
2. Open a report.
4. From HFM System Reports, select a style sheet and click OK.
5. Select View to view the report with the style sheet applied.

Web Procedure

➤ To apply report style sheets:

1. From the reports list, open a report.
2. From Style Sheet, select a report style sheet.

Retrieving Style Sheets

You can retrieve report style sheets (XSL and CSS files) from the server and store them on your local computer to use with other XML viewing tools. The HFM System Reports dialog box lists the style sheets that are available. This option is available only from the Desktop.

➤ To retrieve a report style sheet:

1. From the Financial Management Desktop, click System Reports.
2. Select File > Retrieve Style Sheets.
3. From HFM System Reports, select one or more style sheets and click OK.
4. Select the Reports folder in which to store the style sheet and click OK.
Setting Report Descriptions

You can modify the report description that appears at the top of a report. You can also add a description to a report that you created in the Journals or Data Explorer modules. This option is available only from the Desktop.

➤ To set report descriptions:
1. From the Financial Management Desktop, click System Reports.
2. Open the report for which to set a description.
3. Select Options > Set Report Description.
4. Enter a report description.
5. Click OK.

Saving Reports

You can save a report locally or on the server. When you save a report on the server, you can assign a security class to the report. To save a report on the server, you must be assigned the Save System Report on Server security role.

The report name can contain a maximum of 20 characters. Do not use double quotation marks (““) or an equal sign (=) in the report name.

Windows Procedures

➤ To save reports locally:
1. From the Financial Management Desktop, click System Reports.
2. Define a new report or open a report.
3. Select File > Save Locally.
4. Enter a report name.
5. Specify a storage location for the report, and click Save.

➤ To save reports on the server:
1. From the Financial Management Desktop, click System Reports.
2. Define a new report or open a report.
4. Enter a report name.
5. From Save As, specify the report format.
6. From Security Class, select a security class for the report.
7. To overwrite a file, select Overwrite existing file if it exists.
8 Click OK.

Web Procedures

➤ To save reports locally:
1 From the Reports page, open the report to save.
2 Click Save Local.
   a. Right-click the link.
   b. Select Save Target As, and select the All Files type.
   c. Specify the report name and location, and click OK.
   d. Click Close.

➤ To save reports on the server:
1 From the Reports page, open the report to save.
2 Click Save Remote.
3 To save the report on a server, click Save Remote.
   a. Enter a report name.
   b. Save as a Report Definition, XML, or HTML file.
   c. From Security Class, select a security class for the report.
   d. Click OK, and click Close.

Drilling Through to Intercompany Transactions

Intercompany Matching Reports help you track intercompany transactions for analysis and auditing purposes. After you consolidate data, you can run intercompany matching reports to provide detail on intercompany account balances that were eliminated.

When you run an Intercompany Matching Report at the account balance level, a link is displayed on the report if the administrator has set up the report to display intercompany transactions detail for the matching group. When you click the link, you can view the matching report at the transaction detail level.

To drill down to intercompany transactions, you must be assigned the Intercompany Transaction User security role. You can only view intercompany transactions from the report; you cannot make changes to the transactions using this view.

➤ To view intercompany transactions from an intercompany system report:
1 From the list of System Reports, open an Intercompany Matching Report.
2 From the report, double-click the link to the transactions detail.
Printing Reports

You can print reports that you created and saved on the local client computer or the server. When you select Print, the report is created based on the report selections.

When you print an Intercompany Partner Matching report on the Web, you can choose to override the default report settings. For example, you could select a different partner entity for the report. You can also print the report using the default settings.

Windows Procedure

➤ To print reports:
1 Open a report and select View.
2 Right-click and select Print.

Web Procedure

➤ To print reports:
1 From the list of reports, select the check box next to the report to print.
2 Click Print.
3 If you print an Intercompany Partner Matching Report, take one of these actions:
   ● Select the value to override, specify a new value, and click OK.
   ● If you do not want to override any values, click OK.

Figure 6 Override Options for Printing Intercompany Reports
Deleting Reports

You can delete reports that you no longer need. To delete a report from the server, you must have All access to the report’s security class.

Windows Procedure

➤ To delete reports on the server:
1 From the Financial Management Desktop, click System Reports.
2 Select File > Open Remote.
3 Select the report to delete.
4 Select Delete and click Yes.

Web Procedure

➤ To delete reports on the server:
1 Select Administration > Manage Documents, or click Manage Documents and select Reporting.
2 Optional: Click the link for the folder from which to delete reports.

   Note:
   To delete a report from the root directory, skip this step.
3 Select the report to delete and click Delete.
4 At the system prompt, click OK.

   Note:
   You can also delete folders, but you must first delete any reports that they contain.
Intercompany Transaction Module Features

An intercompany transaction is a transaction between two entities in an organization. Financial Management enables you to track and reconcile intercompany transaction details across accounts and custom dimensions. Common intercompany transaction types include these types:

- Intercompany Sales/Purchases
- Intercompany Receivables/Payables
- Sales/Transfer of Fixed Assets to related parties
The Intercompany Transactions module provides an efficient way to identify, report, and reconcile intercompany account differences. With the ability to view detail transaction at any time, you can reconcile intercompany account differences frequently and thus minimize their impact on the closing cycle.

The Intercompany Transaction module provides these capabilities:

- Capture intercompany transaction details at the invoice level.
- Match transactions at the invoice level.
- Match transactions in the transaction currency and the reporting or parent currency.
- Drill down from an Intercompany Matching Report to the transaction details.
- Drill down from an account balance to transactional details through a data grid or data form on the Web.
- View an entity partner’s intercompany transaction details with the entity at any time.
- Enter text comments to help resolve mismatched entries.
- Analyze differences due to real errors in transaction currency or differences due to exchange rates.
- Lock data to prevent unauthorized input.

For intercompany administrative tasks, see the Hyperion Financial Management — System 9 Administrator’s Guide.

### Intercompany Transaction Security Roles

An administrator with intercompany security rights can create a custom workspace for handling intercompany matching tasks and perform all intercompany tasks. Users who have been assigned the Intercompany Transaction User role can perform Process Transaction functions and Intercompany Reporting functions.

If you are assigned the Intercompany Transaction User role, you can perform these tasks:

- Create transactions.
- Edit transactions.
- View list of transactions.
- Delete transactions.
- Load and extract transactions.
- Run transaction reports and matching reports.
- Drill through to transaction detail from other modules.

To perform matching tasks for transactions, you must be assigned one or more of these security roles for that task:

- Intercompany Transaction Match Template
Intercompany Transaction Auto Match by Account
- Intercompany Transaction Auto Match by ID
- Intercompany Transaction Manual Match with Tolerance
- Intercompany Transaction Manual Match

To unmatch transactions, you must be assigned the Intercompany Transaction Unmatch security role.

To post and unpost transactions, you must be assigned the Intercompany Transaction Post/Unpost security role.

**Sample Intercompany Transactions Task Flow**

This section describes a typical task flow for Intercompany Transaction module users. Before you can work with transactions, the administrator must open the periods for the transactions. Administrators can also set matching requirements, specify intercompany matching tolerance values, and define reason codes to indicate the reason for mismatched transactions. See the *Hyperion Financial Management — System 9 Administrator’s Guide.*

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage reason codes</td>
<td>The administrator defines reason codes in the application to be used for the intercompany matching process. Users can select from this list when processing intercompany transactions.</td>
</tr>
<tr>
<td>Open period</td>
<td>Before you can perform any action on intercompany transactions, the administrator must open the transaction periods. During this process, the administrator also defines the Match/Validate Before Posting requirement and the matching tolerance to be used for the matching process.</td>
</tr>
<tr>
<td>Load transactions</td>
<td>You can load transactions into the system using external ASCII files. You can also enter transactions manually.</td>
</tr>
<tr>
<td>Process transactions</td>
<td>You can view the list of transactions in the Process Transactions window, change the entity and partner selections, and select other filtering criteria to view transactions.</td>
</tr>
<tr>
<td>Edit transaction</td>
<td>You can make changes to a transaction, such as adding comments to the transaction.</td>
</tr>
<tr>
<td>Run transaction report</td>
<td>You can run a transaction report to view a list of transactions based on the filter criteria.</td>
</tr>
<tr>
<td>Run matching report by transaction ID</td>
<td>Before performing the matching process, you can run the matching report to see which transactions are to be matched.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto-match by transaction ID</td>
<td>You can match transactions using the transaction ID or the reference ID. The system updates the transactions with a matched status and matched code. You can also save the matching settings to a matching template to be used later.</td>
</tr>
<tr>
<td>Run matching report by account</td>
<td>This is another option to view the matching transactions report where the transactions are matched based on the accounts instead of a transaction or invoice.</td>
</tr>
<tr>
<td>Auto-match by account</td>
<td>This option is useful to match transactions when the application does not have an exact match of transaction ID and detail. To avoid a possible mismatch, you can perform auto-matching by ID first, then auto-matching by account.</td>
</tr>
<tr>
<td>Perform manual match of transactions</td>
<td>After you perform the auto-match process, you might find some transactions that should be matched even though they do not fit the matching criteria for the process. You can select certain transactions and manually match the transactions. The matching process updates the matched status and assigns a matched code.</td>
</tr>
<tr>
<td>Perform unmatch of transactions</td>
<td>During the matching process, you might need to unmatch certain groups of transactions manually. When you select a transaction, the system displays the group of transactions that have the same matched code. You can then unmatch all transactions within the same matched group.</td>
</tr>
<tr>
<td>Post transactions</td>
<td>After all transactions have been matched and you are ready to post the transactions to the system, you can select the transactions to post.</td>
</tr>
<tr>
<td>Run transaction report</td>
<td>After you post transactions, you can create a transaction report to view the status of each transaction. This report contains information on the posting status, and posting user, date and time. This can be used as a summary report so that you can quickly view the posting information.</td>
</tr>
<tr>
<td>Lock entities</td>
<td>The administrator can lock entities to prevent users from adding new transactions or making changes to specific entities. When the entity is locked, no more matching can be done for that entity, and no additional transactions can be posted for the entity.</td>
</tr>
<tr>
<td>Drill down to transaction details from the Intercompany Matching System Report</td>
<td>After you post transactions and the intercompany accounts reflect the account balance of these transactions, you can run the Intercompany Matching System Report to view the matching at the account level for individual transactions.</td>
</tr>
<tr>
<td>Drill through to transaction details from data grids or data forms on the Web</td>
<td>When you are in a data grid or data form on the Web, you can view the corresponding intercompany transactions. You cannot modify transactions from data grids or forms.</td>
</tr>
</tbody>
</table>
Intercompany Transaction Load Files

In addition to manual input of intercompany transaction details, you can load transaction details from an external ASCII file. You can select multiple external files in one load process and select whether to merge or replace the transactions.

Section Headers in the Load File

The intercompany transaction load file can contain two sections:

- Reason Code table: This section is loaded only if you have Intercompany Transaction Administrator security role access; otherwise, this section is ignored during the load.
- IC Transaction section: This section is used most frequently and is loaded if you have Intercompany Transaction User security role access.

During the load process, the system also does not load the posting or matching status from the load file.

Special Keywords in the Load File

A special keyword is indicated by an exclamation mark (!) in front of the keyword.

Table 15  Keywords for IC Transaction Load Files

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercompany Detail</td>
<td>Indicates that the data represents intercompany detail.</td>
</tr>
<tr>
<td>Column_Order</td>
<td>Indicates the order of the items in the file.</td>
</tr>
<tr>
<td>Thousand_Separator</td>
<td>(Optional). Indicates the delimiter used in the amount to separate the thousands. If this is not specified, the system uses the regional settings for the numeric value defined in the application server.</td>
</tr>
<tr>
<td>Decimal</td>
<td>(Optional). Indicates the character to be used for the decimal amount. If this is not specified, the system uses the regional settings for the numeric value defined in the application server.</td>
</tr>
</tbody>
</table>
Intercompany Transaction File Example

Following is an example of an intercompany transaction load file. Use an exclamation mark (!) followed by a valid section name to indicate the beginning of a new section. Use an apostrophe (' ) to start a comment line. Use one of these file delimiter characters to separate information in the file:

, ~ @ # $ % & ^ | : ; ? \

You can use any of the valid characters as long as that character is not used in the file name or in any other way in the file. For example, if you use the ampersand ( & ) in an entity member name, you cannot use the ampersand as the delimiter character. You must use the same delimiter character throughout the file. Using different delimiter characters within the same file causes an error when you load the file.

Note:

If you are using an Oracle database, the system converts the transaction ID, sub ID, reference ID, and reason code to upper case during the load process. For example, the system converts the “t123” Transaction ID to “T123” during the file load.

Example

!SCENARIO=Actual
!YEAR=2007
!PERIOD=January
!DECIMAL=.
!THOUSAND_SEPARATOR=,
INTERCOMPANY DETAIL

COLUMN_ORDER=ENTITY;PARTNER;ACCOUNT;C1;C2;C3;C4;TRANSID;SUBID;DATE;TRANSCUR
TR;TRANSAMT;ENTCURRAMT;RATE;REFID;COMMENT1;COMMENT2
China;France;ICPay;[None];[None];[None];[None];DE124;08/10/06;EUR;2000;8000;Ref123;Text1234;Text9995
China;France;ICPurch;[None];[None];[None];[None];BX3212;08/12/06;EUR;2500;10000;Text2345;Text8984
China;Germany;ICRef;[None];[None];[None];[None];AC4345;08/15/06;EUR;1700;6970;ABC12;Text2323;Text9232
...

Load Methods

When you load intercompany transactions, you can select to merge or replace the transactions.

Merge

Select this option to update the records with the new changes and create any new records. The system does not update any information in records with a Matched or Posted status. The load log file contains information about any transactions that were not loaded. The Merge mode does not delete any records in the database.
**Table 16  Example of Load In Merge Mode**

<table>
<thead>
<tr>
<th>Entity A - Existing Records</th>
<th>Load File for Entity A</th>
<th>Entity A After Load in Merge Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td></td>
<td>Record 1</td>
</tr>
<tr>
<td>Record 2 - Matched</td>
<td>New Record 2</td>
<td>Record 2 - Matched (not affected by load process)</td>
</tr>
<tr>
<td>Record 3</td>
<td></td>
<td>Record 3</td>
</tr>
<tr>
<td>Record 4 - Posted</td>
<td>New Record 4</td>
<td>Record 4 - Posted (not affected by load process)</td>
</tr>
<tr>
<td>Record 5</td>
<td>New Record 5</td>
<td>New Record 5</td>
</tr>
<tr>
<td></td>
<td>New Record 6</td>
<td>New Record 6</td>
</tr>
</tbody>
</table>

**Replace**

The Replace mode replaces all the transactions in the database for the given scenario, year, period, entity with the transactions specified in the load file. In the Replace mode, the system first clears all records for the entity for the scenario, year, period. If the system encounters any intercompany transactions for the entity that have a status of Posted or Matched, it does not clear those transactions; it skips them and continues with the load process. After clearing all applicable transactions for the entity, the system replaces all transactions for the entity with the records from the load file.

**Table 17  Example of Load In Replace Mode**

<table>
<thead>
<tr>
<th>Entity A - Existing Records</th>
<th>Load File for Entity A</th>
<th>Entity A After Load in Merge Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td></td>
<td>Record 1</td>
</tr>
<tr>
<td>Record 2 - Matched</td>
<td>New Record 2</td>
<td>Record 2 - Matched (not affected by clear or load process)</td>
</tr>
<tr>
<td>Record 3</td>
<td></td>
<td>Record 3</td>
</tr>
<tr>
<td>Record 4 - Posted</td>
<td>New Record 4</td>
<td>Record 4 - Posted (not affected by clear or load process)</td>
</tr>
<tr>
<td>Record 5</td>
<td>New Record 5</td>
<td>New Record 5</td>
</tr>
<tr>
<td></td>
<td>New Record 6</td>
<td>New Record 6</td>
</tr>
</tbody>
</table>

**Loading Intercompany Transactions**

To load intercompany transactions, you must be assigned the Intercompany Transaction User or Administrator role. In addition, the Intercompany Transaction Admin must have opened the period for the transactions. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.

Hyperion recommends that you add Financial Management to the exceptions for your Web pop-up blocker. When you perform some Financial Management tasks on the Web such as
loading data, a status window pops up showing the task status. If you have a pop-up blocker enabled on your computer, the status window is not displayed.

When you load intercompany transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

➤ To load intercompany transactions:

1. In the Browser View, expand Tasks and select Load Tasks.
2. Select Load IC Transactions.
3. For File, enter the transaction file to load, or click Browse to navigate to and open the file.
4. From Delimiter Character, select the character to use as the delimiter during the load process.
5. For Load Method, select an option:
   - Merge to merge the transactions
   - Replace to replace the transactions
6. To scan the file before loading, click Scan.
7. Click Load.

The scan and load status for each file is displayed in a new window.

Extracting Intercompany Transaction Files

You can extract intercompany transaction files if you have the Intercompany Transaction User or Administrator security role. You can also specify whether to extract matched, unmatched, mismatched, posted, or unposted transactions, reason codes, and transactions with a specific transaction currency, match code, or reason code.

You also have the option to extract the list of reason codes defined in the application.

➤ To extract intercompany transactions:

1. In the Browser View, expand Tasks and select Extract Tasks.
2. Select Extract IC Transactions.
3. From the Point of View bar, select the scenario, year, and period.
4. Enter the names of the Entity and Partner dimension members, or click Browse to find the Entity and Partner members.
5. Select one or more options in the extract process: UnMatched, Matched, MisMatched, Posted, UnPosted, and Reason Codes.
6. To extract transactions with a specific transaction currency, from Transaction Currency Filter, select a currency.
7. For Match Code, enter a match code value, or use the percent symbol (%) as a wildcard.
8. For Reason Code, select a reason code.
Tip:
To extract a list of reason codes defined in your application, select the check box for extracting reason codes.

9 Click Extract.

10 Take one of these actions:
- In Internet Explorer, click the Click Here to Download link and select Save.
- In Netscape, click the download link and click OK.

11 Enter a name for the extracted file and make sure that the location for the file is in the Web directory that you set up.

Note:
By default, transaction files use the .trn extension.

12 Click Save.

About the Process Transactions Window

The Process IC Transactions window is the main window from which you perform most intercompany transaction processes. You use the Process IC Transactions window for these tasks:

- “Creating Intercompany Transactions” on page 151
- “Viewing Intercompany Transactions” on page 154
- “Editing Intercompany Transactions” on page 159
- “Matching Intercompany Transactions” on page 160
- “Unmatching Intercompany Transactions” on page 169
- “Posting Intercompany Transactions” on page 170
- “Unposting Intercompany Transactions” on page 172
- “Deleting Intercompany Transactions” on page 173
- “Reporting on Intercompany Transactions” on page 174

Creating Intercompany Transactions

You can enter intercompany transactions for accounts that have been set up by the administrator as intercompany accounts. Entities that conduct intercompany transactions with each other are known as intercompany partners. The administrator identifies the entities that can be intercompany partners.

After the period is opened for intercompany transactions, you can manually enter transactions in the application. To create transactions, you must be assigned the Intercompany Transaction User security role.
The transaction should contain information for only one transaction as related to the entity in the point of view. The transaction ID and sub ID are used as the key to the transaction detail record.

<table>
<thead>
<tr>
<th>Table 18</th>
<th>Transaction Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scenario</strong></td>
<td>Must be a valid scenario defined for the application.</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td>Must be a valid year defined for the application.</td>
</tr>
<tr>
<td><strong>Period</strong></td>
<td>Must be a valid base period defined for the scenario.</td>
</tr>
<tr>
<td><strong>Transaction ID</strong></td>
<td>This ID is required. You must enter an ID for the transaction, with a maximum of 40 characters. When combined with the Sub ID, this ID becomes a unique identifier for the entity/partner/account/C1/C2/C3/C4 within the scenario/year/period combination.</td>
</tr>
<tr>
<td><strong>Transaction Sub ID</strong></td>
<td>(Optional). You can enter a sub-ID for the transaction, with a maximum of 40 characters. This is useful if you need to handle one-to-many or many-to-many transactions between two entities. For example, if one transaction in the originating entity’s book corresponds to multiple transactions in the partner’s book, you can use the Transaction ID text box for the common reference and use the Sub ID text box for the multiple transactions. Another use for the sub ID is when there is an adjustment needed to adjust the transaction in the &lt;Entity Currency&gt; instead of posting a journal adjustment in the &lt;Entity Curr Adj&gt;. In this case, you can create a dummy transaction and use the same Transaction ID from the original invoice, but use the Sub ID to identify as an adjustment by entering ADJ1 in the sub ID to show that it is an adjustment instead of a real invoice.</td>
</tr>
<tr>
<td><strong>Reference ID</strong></td>
<td>(Optional). You can enter a reference ID to store any reference information for the transaction. For example, the entity might have its own set of invoice numbering that is different from the entity that issued the invoice. You can enter additional information in this Reference ID text box for information purposes only. You can also use the reference ID for the partner’s transaction ID. You can enter the entity’s reference ID in the Transaction ID text box and enter the corresponding invoice number from the partner entity in this text box.</td>
</tr>
<tr>
<td><strong>Transaction Date</strong></td>
<td>(Optional). This must be a valid date.</td>
</tr>
<tr>
<td><strong>Entity</strong></td>
<td>The entity must be a valid ICP base entity, not a parent entity.</td>
</tr>
<tr>
<td><strong>Partner Entity</strong></td>
<td>The partner entity must be a valid ICP entity for the account.</td>
</tr>
<tr>
<td><strong>Account</strong></td>
<td>The account must be a valid ICP account and the cell must support transactions as specified in the Rules file. See the Rules section of the Hyperion Financial Management — System 9 Administrator's Guide.</td>
</tr>
<tr>
<td><strong>Custom 1-4</strong></td>
<td>The custom member must be a valid custom member for the account.</td>
</tr>
<tr>
<td><strong>Transaction Amount</strong></td>
<td>This is the invoice amount in the currency of the transaction. This is required only if the entity currency is not entered.</td>
</tr>
<tr>
<td><strong>Transaction Currency</strong></td>
<td>This is the currency used for the Invoice transaction. It must be a valid currency defined in the application.</td>
</tr>
<tr>
<td><strong>Conversion Rate</strong></td>
<td>This is the rate used to convert the transaction currency amount to the local reporting currency amount for the transaction.</td>
</tr>
</tbody>
</table>
**Transaction Detail**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>During the calculation of the local currency amount, if the operator is Divide, the system uses this formula: Local currency = transaction currency/rate. If the operator is Multiply, the system uses this formula: Local currency = transaction currency * rate. See the Hyperion Financial Management — System 9 Administrator’s Guide.</td>
</tr>
</tbody>
</table>

**Operator**

The Multiply or Divide operator depends on the local currency of the transaction. You must first define the Multiply or Divide operation for a specific currency in the currency table of the application. The default value for the operator is Divide. See the Hyperion Financial Management — System 9 Administrator’s Guide.

**Entity Currency Amount**

This is the invoice amount in the local entity currency. The currency must be a valid currency defined in the application. This is required if the transaction amount is not entered. Otherwise, the system can recalculate this information if you enter the transaction amount and the conversion rate.

**Comment 1**

(Optional). You can enter comments for the transaction. You can enter a maximum of 256 characters.

**Comment 2**

(Optional). You can enter additional comments for the transaction. You can enter a maximum of 256 characters.

You can use Comment 2 to enter comments related to the partner’s transaction. For example, Entity A might enter comments in Comment 1 related to the transaction. Later, Entity A might run a matching report or view the partner’s transaction and realize that there are discrepancies with the partner’s amount. Entity A can then enter the additional comments in Comment 2 to state anything related to the information in the partner’s record. This information is then part of the transaction and can be included in the matching report for informational or audit trail purposes.

Note that while Comment can be used for partner information, only the entity can enter the information. The partner entity cannot enter information in the entity’s record.

**Reason Code**

(Optional). The reason code must be a valid one defined by the administrator. The main purpose of the reason code is to indicate why a transaction has a MisMatched status; for example, because of a missing invoice from the partner entity, or an incorrect amount entered by the partner. If the transaction has a Matched status, you do not need to assign a reason code for the transaction. You cannot assign a reason code to a transaction with an UnMatched status.

➤ To create intercompany transactions:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. Click New.
4. From the POV bar, select a scenario, year, and base period.
5. For Transaction ID, enter the transaction or invoice number.
   You can enter a maximum of 40 characters.
6. Optional: For Transaction Sub ID, enter a sub identification for the transaction or invoice.
   You can enter a maximum of 40 characters.
7. Optional: For Reference ID, enter reference information for the transaction.
You can enter a maximum of 40 characters.

8 Optional: For Transaction Date, enter a valid date, or click the pop-up calendar to select a date.

9 For Entity, enter an entity or click Pick Members to select a member.

10 For Partner Entity, enter a partner entity or click Pick Members to select a member.

11 For Account, enter an account or click Pick Members to select a member.

12 For Custom 1-4, enter a custom member or click Pick Members to select a member.

13 For Transaction Amount, enter the invoice amount and from Currency, select the currency used for the transaction.

14 For Conversion Rate, enter the rate used to convert the transaction currency amount to the local reporting currency amount.

Note:
If you leave this text box empty and enter the entity currency amount, the system recalculates the rate for you.

15 For Entity Currency Amount, enter the invoice amount in the local entity currency, and enter the currency of the reporting entity.

16 Optional: For Comment 1 and Comment 2, enter comments for the transaction.

Note:
You can enter a maximum of 256 characters.

17 Optional: From Reason Code, select a reason code.

Note:
You can assign a reason code only to a transaction with the MisMatched status.

18 Click Save to save the transaction.

19 Click Close.

Viewing Intercompany Transactions

After you load transaction details or create them manually, you can view the transactions list in the Process IC Transactions window. You can change entity and partner selections and select other criteria to filter the translation list.

You select a point of view for which to view transactions. The scenario and year must be valid dimension members as defined in the application, and the period must be a base period of the Scenario frequency. The entity must be a valid base entity. After you select the point of view, the system displays the transaction detail related to the selected point of view. See “Creating Intercompany Transactions” on page 151.
In addition to the transaction detail that you entered, the transactions list displays system-generated information about the transaction that cannot be changed manually. For example, it displays the matching status, posting status, match code, user ID of the last user to modify the transaction, and the date and time the transaction was last modified. Matched transactions are indicated by double green boxes, and posted transactions are indicated by a green flag in the Status column. Mismatched transactions are indicated by a red triangle symbol.

You can set the Page setting by selecting the number of entries per page so that you can access a specific range of entries easily. If you change the row or column filter options to display a different range of transactions, you must reset the page setting.

To view intercompany transactions:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. In the POV bar, select a scenario, year, and period.
4. Optional: To filter the list of transactions, select columns and rows. See “Displaying Transaction Columns” on page 156 and “Displaying Transaction Rows” on page 157.

Selecting an Entity and Partner

An application can have many transactions for a scenario/year/period combination. You can filter the list of transactions to display by selecting only the entity and partner transactions to view.

You can use the Entity and Partner text boxes to manually enter the member names to view, or you can select members from the Member Selection dialog box. You can select multiple members if you separate them with a semicolon (;). You can also select member lists.
If you do not select any members for the entity and partner, the system displays transactions for all entities and partners.

## Displaying Transaction Columns

You can display these columns for transactions: Transaction ID, Transaction Sub ID, Entity, Partner Entity, Account, Custom 1-4, Transaction Amount, Entity Currency Amount, Translated Transaction Currency Amount, Translated Entity Currency Amount, Conversion Rate, Transaction Date, Reference ID, Match Code, Reason Code, Comment 1 and Comment 2, User ID, Date, and Time. The order in which you select the items controls the order in which they are displayed in the columns.

The first column is always the Status column, which consists of both the Matching and Posting status. You cannot change the status in this column, however you can sort the column. For example, if you want to see all of your posted transactions at the top of the list, you can sort the posting status in descending order.

You can sort the columns by ascending or descending order, or you can specifying no sorting as the option for the column. For a dimension member, you can display the dimension member label, the corresponding description, or both. The column settings are saved when you exit the session.

If you do not specify any column filters, the system displays all of the transaction columns.

To select the transaction columns to display:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Filter, select Columns and select Column Filter.
4. From Available Columns, select items to display and click to move them to Selected Columns.

   The Selected Columns list shows a list of the columns as they are displayed from left to right in the Process Transactions window.

   **Tip:**

   To return items to the Available Columns list, select items from Selected Columns, and click .

5. **Optional:** To move items up or down in Selected Columns, select an item, and click the up or down arrow.

6. If you selected to display Transaction Currency Amount and Entity Currency Amount, from the Common Currency drop-down, you must select a currency for translation.

7. To set column attributes:
   a. From Selected Columns, select the columns.
   b. Click Sort Options and select No Sort, Ascending or Descending.
   c. Click Display Options and select Label, Description, or Both.
The system displays a summary of the selected columns and their attributes to the right of the Selected Columns list. You can also right-click in the table and select column attributes.

**Tip:**
To restore the columns to their default settings, click Restore Defaults.

8 **Click Close.**

---

**Displaying Transaction Rows**

You can select the rows to display on the transaction list and filter the list of transactions. You can view transactions from partners if you have the appropriate security rights. See “Viewing Partner Entity Transactions” on page 158. You can view Entity transactions, Partner transactions, or both.

You can specify more than one account cell for the filter. Use a semi-colon (;) as the separator for each account cell. For example, you can specify these accounts:

A#RecItIC.C1#Increases;A#SalesIC.C1#Closing

You can also specify a parent account and the system automatically enumerates all of the base members for that account.

You can use the percent (%) symbol as a wildcard in these fields marked with an asterisk (*): Transaction ID, Transaction Sub ID, Reference ID, Match Code, or leave a text box blank to avoid filtering. The row settings are saved when you exit the session.

If you do not specify row filters, the system displays all transaction rows.

**Note:**
Depending on the setup of your database, text boxes might be case-sensitive. For example, filtering with “testgroup” might return different results than filtering with “TestGroup.”

➤ To select transaction rows to display:

1 **In the Browser View, expand Tasks and select IC Transaction Tasks.**
2 **Select Process IC Transactions.**
3 From Filter, select Rows and select Row Filter.
4 **Select filter options for rows:**
   a. For **Entity**, either use the default entity from the Process IC Transactions window, enter an entity, or click **Browse** and select a member.
   b. For **Partner**, either use the default partner entity from the Process IC Transactions window, enter a partner entity, or click **Browse** and select a member.
   c. If you select to display Entity Transactions, for **Entity Account**, enter an account, or click **Browse** and select an account.
d. If you select to display Partner Transactions, for Partner Account, enter a partner account, or click Browse and select an account.

e. For Transaction ID, enter an ID.

f. For Transaction Sub ID, enter a sub ID.

g. For Reference ID, enter an ID.

h. From Transaction Currency, select a currency.

i. For Match Code, enter a match code

j. For Transaction Amount, enter a range of amounts.

k. From Reason Code, select a code, or All, or None.

l. For Transaction Date, select a range of dates.

5 From Include, select one or more options: Matched, Unmatched, Mismatched, Posted, or Unposted.

6 Optional: From Options, select a value for the Scale Factor and Decimal Override for the amounts displayed for the transactions.

7 From Display, select Entity Transactions, Partner Transactions, or both.

Tip:
To restore rows to their default settings, click Restore Defaults.

8 Click Close.

Viewing Partner Entity Transactions

You can display only intercompany transactions for a specific entity and partner, or you can also display the corresponding transactions from the partner with the entity. For example, if you select only the transactions for Entity A with Partner B in the Entity and Partner selections, the system displays only the transactions that Entity A has with Partner B. However, to see the corresponding transactions for Entity B with Partner A, you can select to include both the Entity transactions and the Partner transactions.

To view partner entity transactions:

1 In the Browser View, expand Tasks and select IC Transaction Tasks.

2 Select Process IC Transactions.

3 From Filter, select Rows and select Row Filter.

4 Select the transactions to display and from Display, select Entity Transactions, Partner Transactions, or both.
**Editing Intercompany Transactions**

You can edit a transaction to change information or add comments to a transaction. You can make changes as long as the transaction has not been matched or posted. To make changes to a transaction that has been posted, you must first unpost the transaction. If you want to make changes to a transaction that has a Matched status, you must first unmatch the transaction, which also unmatches all of the related transactions in the same matching process with the same match code. If the transaction has a MisMatched status, any changes will change the status from MisMatched to UnMatched, with the exception of assigning a reason code to a mismatched transaction, or entering comments for a mismatched transaction.

After the transaction is saved, you can edit the Transaction ID, Sub ID, Entity, Partner, Account, or Custom 1-4 dimensions for the original transaction. When you save the edited transaction, the system replaces the original transaction with the new information.

➤ To edit intercompany transactions:

1. From the list of transactions, select the transaction to edit, and click Edit.
2. From the POV bar, select a scenario, year, and base period.
3. Edit the transaction.
4. Click Save to save the changes.
5. Click Close.

**Assigning Reason Codes to Intercompany Transactions**

You can assign a reason code to an intercompany transaction to indicate why it has a MisMatched status. For example, it could be mismatched because of a missing invoice from the partner entity, or an incorrect amount was entered for the transaction. Reason codes are defined by the administrator for the application, and you can select one from the list to apply to a transaction.

You can assign reason codes to individual intercompany transactions, or assign the same reason code to multiple transactions.

In addition to the intercompany transactions to which you have access, you can assign a reason code to the partner’s transaction even if you do not have All access to the entity assigned as the partner in the transaction. You can also enter comments in the Comment 2 text box to add an explanation of the reason code assignment.

➤ To assign reason codes:

1. From the list of intercompany transactions, select the transaction or transactions to which to assign a reason code and click Edit.

   **Note:**
   You can assign a reason code only to transactions with the MisMatched status.

2. Take one of these actions:
To assign a reason code to one transaction, from **Reason Code**, select a reason code.

To assign a reason code to multiple transactions, select **Edit > Set Reason Code**, and from **Reason Code**, select a reason code and click **Set**.

The reason code that you select is assigned to all the selected intercompany transactions.

3 Click **Save** to save the changes.

4 Click **Close**.

### Matching Intercompany Transactions

Before you post intercompany transactions to an account, you can perform a matching process to ensure that an entity’s partner has also completed the entry of the same transaction on its side. If your administrator has set up the period to require matching before posting, you must first match the transactions before you can post them. For transactions that have a **MisMatched** status, you can assign a valid reason code to the transactions and post them.

You can match transactions using several methods. You can allow the system to automatically match transactions based on criteria that you specify. You can also manually match specific transactions if they are not matched by the auto-match process.

See these procedures:

- “Auto-Matching Intercompany Transactions” on page 164
- “Manually Matching Transactions with Tolerance Amount ” on page 165
- “Manually Matching Transactions without Tolerance Amounts” on page 167

### Auto-Match Process

The auto-match process performs the matching only on transactions with a status of **UnMatched** or **MisMatched**. These transactions must also be unposted transactions. When you select the auto-match process, you can select whether to match transactions by account, or by ID.

You can filter the list to match only transactions with a specific transaction currency. Transactions that have been previously matched are excluded from the matching process because a match code has been assigned to those transactions.

After you include transactions in the matching process, the match status of the transactions becomes **Matched** or **MisMatched**. Any mismatched transactions can be included again in the auto-match process.

When you auto-match intercompany transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.
Auto-Match by ID

Performing the auto-match process using the Transaction ID is the most common and accurate method of matching intercompany transactions. The system performs the matching process for the entity and partner that you specify. You can select the Transaction ID or the Reference ID for matching. The system matches the transactions based on the ID that you specify.

You can specify an ID or use wildcards. If the ID is left blank, the system matches all transactions for the entity and partner.

When matching transactions using the transaction ID or reference ID, the system always uses the transaction currency. There is no need to specify a tolerance amount because the transactions are considered Matched only if the amounts match without error. The system assigns a separate match code to each group of transactions.

If you have transactions with different currencies but the same transaction ID or reference ID, during the auto-match process, the transactions are matched by currency group. If all the transactions in all the currency groups are matched, the system assigns one match code to all the transactions.

Table 19  Sample Transactions with Same ID and Different Currencies

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Entity</th>
<th>Partner</th>
<th>Currency</th>
</tr>
</thead>
<tbody>
<tr>
<td>T123</td>
<td>A</td>
<td>B</td>
<td>EUR</td>
</tr>
<tr>
<td>T123</td>
<td>B</td>
<td>A</td>
<td>EUR</td>
</tr>
<tr>
<td>T123</td>
<td>A</td>
<td>B</td>
<td>USD</td>
</tr>
<tr>
<td>T123</td>
<td>B</td>
<td>A</td>
<td>USD</td>
</tr>
</tbody>
</table>

In this example, if the transactions in EUR are matched and the transactions in USD are matched, the system assigns one match code for all four transactions. If the transactions in EUR match but the transactions in USD are not matched, the system considers all of the transactions MisMatched.

The following table shows the rules for matching transactions using IDs:

Table 20  Matching Process Using Transaction or Reference ID

<table>
<thead>
<tr>
<th>Matching Process</th>
<th>Entity’s Transactions</th>
<th>Partner’s Transactions</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match using Transaction ID</td>
<td>Transaction ID</td>
<td>Transaction ID</td>
<td>The system matches the entity’s transaction ID with the partner’s transaction ID.</td>
</tr>
<tr>
<td>Match using Reference ID</td>
<td>Transaction ID</td>
<td>Reference ID</td>
<td>The system first matches the entity’s transaction ID with the partner’s reference ID.</td>
</tr>
<tr>
<td></td>
<td>Reference ID</td>
<td>Transaction ID</td>
<td>If these do not match, the system performs the second test by comparing the entity’s reference ID with the partner’s transaction ID.</td>
</tr>
</tbody>
</table>
### Account Type Groups in the Auto-Match Process

During the auto-match by ID process, the system subdivides all the intercompany transactions with the same transaction or reference ID into separate groups based on their account type. It assigns a separate match code and match status to each group of transactions with the same ID. The transactions are grouped by their Balance Sheet or Profit/Loss account type as follows:

**Balance Sheet group**
- Asset
- Liability
- Balance
- Balance Recurring

**Profit/Loss group**
- Revenue
- Expense
- Flow

For each group of transactions, the system assigns a match status and separate match code. For example, the Balance Sheet group of transactions could have a Matched status and be assigned a match code, but the Profit/Loss group of transactions could have a MisMatched status.

### Example

In the following example, the intercompany transactions all have the same transaction ID 123:

<table>
<thead>
<tr>
<th>Entity</th>
<th>Partner</th>
<th>Account</th>
<th>Amount</th>
<th>Account Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Recltic</td>
<td>100</td>
<td>Asset</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>Sales</td>
<td>110</td>
<td>Revenue</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
<td>Payltic</td>
<td>100</td>
<td>Liability</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
<td>Cog</td>
<td>100</td>
<td>Expense</td>
</tr>
</tbody>
</table>

The system subdivides the transactions into the BS and PL groups as follows:
**Auto-Match by Account**

In addition to performing the matching process using the transaction ID, you can match the transactions based on specific accounts and matching accounts. The system performs the matching process for the entity and partner that you specify. The transactions to be matched are grouped by transaction currency during the matching process and are assigned a separate match code for each currency group.

For each transaction included in the matching process, the system first translates the transaction currency amount to the application currency, based on the default translation rules set up for the application. The translated amount is added to the total difference amount. The system performs the translation for each transaction in the auto-match process and the difference amount is calculated.

**Note:**

The conversion rate used in translation is the rate that is stored in the Rate account for the specific currency to the application currency.

After the total difference amount is calculated, this amount is compared to the matching tolerance amount set for the period. The matching tolerance amount is represented in the application currency and the amount should be entered in the scale of the application currency.

If the difference amount is within the tolerance level, the transactions are considered matched and the system assigns a match code to the group of transactions.

If the difference amount is not within the tolerance level, the system performs the next step in the translation process by translating the entity currency amount to the application currency. For any transactions without a transaction currency, the system uses the entity currency amount. If the difference amount is within the tolerance level, the transactions are considered matched and the system assigns a match code to the group of transactions.
Auto-Matching Intercompany Transactions

You can automatically match intercompany transactions by account or by ID. To match a transaction automatically, you must be assigned the Intercompany Transaction Auto Match by Account or Intercompany Transaction Auto Match by ID security role.

You can also create a template for auto-matching transactions. See “Creating Auto-Match Templates” on page 164.

➤ To auto-match intercompany transactions:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. Select the transactions to match.
4. From Match, select Auto-Match.
5. Optional: If you use an auto-matching template, select the template from the Template list.
6. From the POV bar, select a scenario, year, and base period.
7. Enter the names of the Entity and Partner dimension members, or click Browse to find the Entity and Partner members.
8. To auto-match by specific currency, select Include During Processing, and from the Only if Transaction Currency = drop-down list, select a currency.
9. Select an option:
   ● Match by ID, select Transaction ID or Reference ID, and enter an ID or use a wildcard.
   ● Match by Account, click Add to select the account dimension members or custom members, and in the Matching Accounts section, click Add to select the matching account dimension members or custom members.

   **Tip:**
   You can click Remove to remove accounts and matching accounts.

10. When you finish selecting matching options, click Match.

Creating Auto-Match Templates

You can save the settings that you frequently use for auto-matching in a template. The template is saved in the Manage Documents list for use the next time that you perform the auto-match process. From the Manage Documents list, you can also select the template and extract it to an ASCII script file for loading in the future.

To create an Auto-Match template, you must be assigned the Intercompany Transaction Match Template security role.

➤ To create Auto-Match templates:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2 Select Process IC Transactions.
3 From Match, select AutoMatch.
4 From the POV bar, select a scenario, year, and base period.
5 Select the settings for auto-matching. See “Auto-Matching Intercompany Transactions” on page 164.
6 To save it as a template, click Save as Template.

Manually Matching Transactions with Tolerance Amount

At times, you might need to manually match the transactions with the partner’s transactions because of discrepancies in the recording of the transaction ID or small discrepancies in the amounts. When you perform the manual matching process, the system updates the transaction status to Match and generates a match code for the transactions.

To match a transaction manually, you must be assigned the Intercompany Transaction Manual Match with Tolerance security role.

To perform the manual match process, you can use the filter options available in the Process Transactions window to display only the unmatched transactions for a specific entity and partner pair. You can select the group of transactions and perform the manual match process.

The system must first check if any transactions have a MisMatched status before you perform the manual match process. During the manual match process, the system checks to see if the transactions are a valid pair of transactions. For example, if you select transactions between A and B, and transactions between B and A, the transactions are considered a valid pair. If you select transactions between A and B, then select transactions between B and C, the transactions are not considered a valid transaction pair.

You cannot use single-sided transactions without the valid partner transactions for the Manual Match process. For example, you cannot select two transactions of A with B, A with B.

If you have the Manual Match with Tolerance security role when you perform the matching process, the system also checks if the amounts are matched for the transactions. The system performs the translation process to the application currency. For each transaction included in the matching process, the system first tries to match the transaction using the translation currency amounts by translating the transaction amount to the application currency, based on the default translation rules set up for the application, and applies the amount to the difference. If the difference amount is not within the matching tolerance, the system then translates the entity currency amount into the application currency and compares the difference amount to the Matching Tolerance that you specified for the period.

If the amount is within the tolerance level, the transactions are considered Matched and the system assigns a match code to the group of transactions. See “Matching Status” on page 168 and “Match Code” on page 169.

If you have the Manual Match security role, the system does not check the tolerance amount. See “Manually Matching Transactions without Tolerance Amounts” on page 167.
During the manual match process, transactions are not grouped by transaction currency. Therefore, you can select transactions in different transaction currencies and the system translates each transaction separately.

**Account Type Groups in the Manual Match Process**

During the manual match process, the system subdivides all the intercompany transactions with the same transaction or reference ID into separate groups based on their account type. The entire group of transactions within the manual match process must be matched before the transactions can be assigned a Matched status and a match code.

If both subgroups are matched, the system assigns all of the transactions the Matched status and assigns them one match code. If only one subgroup is matched, but the other is not, all of the transactions are considered mismatched.

The transactions are grouped by their Balance Sheet or Profit/Loss account type as follows:

**Balance Sheet group**
- Asset
- Liability
- Balance
- Balance Recurring

**Profit/Loss group**
- Revenue
- Expense
- Flow

**Example**

In the following example, the intercompany transactions all have the same transaction ID 123:

<table>
<thead>
<tr>
<th>Entity</th>
<th>Partner</th>
<th>Account</th>
<th>Amount</th>
<th>Account Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Rectic</td>
<td>100</td>
<td>Asset</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>Sales</td>
<td>110</td>
<td>Revenue</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
<td>Payltic</td>
<td>100</td>
<td>Liability</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
<td>Cog</td>
<td>100</td>
<td>Expense</td>
</tr>
</tbody>
</table>

The system subdivides the transactions into the BS and PL groups as follows:

<table>
<thead>
<tr>
<th>BS Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>A B Rectic 100 Asset</td>
</tr>
</tbody>
</table>
Subgroup status: Matched.

<table>
<thead>
<tr>
<th>BS Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>B  A  Payltic  100  Liability</td>
</tr>
</tbody>
</table>

Subgroup status: MisMatched.

The result is that because only one subgroup is matched and the other is not, the system considers all transactions mismatched, and assigns all transactions in this manual match process a MisMatched status and no match code.

To match intercompany transactions manually:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Match, select Manual Match.
4. From the POV bar, select a scenario, year, and base period.
5. Enter the names of the Entity and Partner dimension members, or click Browse to find the entity and partner.

**Manually Matching Transactions without Tolerance Amounts**

You can match intercompany transactions manually without comparing the difference with the matching tolerance amount. When you use this process, the system does not perform any translations or comparison to the matching tolerance amount. However, the transactions must be a valid pair with a status of MisMatched and UnPosted.

After you match transactions manually, the system updates the Match status and assigns a match code to the transactions.

To use this method of matching transactions manually, you must be assigned the Intercompany Manual Match security role. The procedure is the same as matching with tolerance amounts, but the tolerance amount is not checked. See “Manually Matching Transactions with Tolerance Amount” on page 165.

During the manual match process, the system subdivides the transactions into separate groups based on their account type. See “Account Type Groups in the Manual Match Process” on page 166.

**Generating Adjustments for Transaction Differences**

After you perform the matching process, some transactions may have a status of MisMatched. This could be due to several reasons, for example, a mistake in recording, a difference in the
currency rate for translations, or the timing of the recording of the transaction. In this case, you might need to generate an adjustment entry to adjust for the difference. You can make the adjustment at the transaction level or at the account balance level.

**Adjusting Data at the Transaction Level**

To adjust an intercompany transaction at the transaction level before it is posted to the database, you can enter a new transaction with the same transaction ID but with a different transaction sub ID to identify it (for example, SubID=Adjustment 1). During the posting process, the system accumulates all of the transactions with the same transaction ID and uses the total amount to post to the account. Using this method, the adjustment is included in the posting to the account balance in the entity currency.

**Adjusting Data at the Account Balance Level**

To make adjustments at the account balance level, you can make the adjustment as a journal entry and post the adjustment amount to the <Entity Currency Adjs> Value dimension. The system processes the adjustment similar to other journal adjustments and is reflected in the account balance in <Entity Currency Total>.

**Matching Status**

Intercompany transactions can have one of these matching statuses: UnMatched, Matched, or MisMatched. The matching status is updated by the system and cannot be changed manually.

When you create or load a transaction, it has a default status of UnMatched. If the transaction is included in the auto-match process, the transaction is updated to Matched or MisMatched status. The MisMatched status means that the matching process has been done for the transaction but it was not matched, or was not within the matching tolerance level as defined for the application. You can resolve this by rerunning the auto-match process or by manually matching. See “Auto-Matching Intercompany Transactions” on page 164 and “Manually Matching Transactions with Tolerance Amount ” on page 165.

**Changes from UnMatched to Matched or MisMatched**

During the auto-match or manual process, unmatched transactions can be changed to Matched or MisMatched status.

**Changes from MisMatched to UnMatched**

If a transaction has gone through the auto-match process and has a status of MisMatched, any changes to the transaction (with the exception of the comments and reason code) change the status to UnMatched. This applies to both manual entry and loading transactions.

**Changes from Matched to UnMatched**

Since the system does not allow changes to matched transactions except for comments and reason code, you cannot change the matched status by manual entry or loading transactions.
However, you can perform the Unmatch process manually, and the Matched status can be changed to UnMatched status.

**Match Code**

When you create a transaction, it has a status of UnMatched and a default of <blank> for the Match Code. After you perform the matching process, the system changes the matching status to Matched and generates a match code. It is for display only and you cannot change it manually.

The same match code applies to all the matching transactions in a group. For example, if you match the following transactions, the same code applies to all the transactions in this group. If there are reversed transactions, the system considers them a separate group and assigns them a separate match code.

During the match by ID process, the system subdivides all the intercompany transactions with the same transaction or reference ID into separate groups based on their account type. It then assigns a separate match code and match status to each group of transactions with the same ID. See “Account Type Groups in the Auto-Match Process” on page 162.

When the system generates the match code during the matching process, it uses one of these prefixes to distinguish the different types of matching processes:

- A - Auto-matching performed using accounts
- I - Auto-matching performed using the transaction ID
- R - Auto-matching performed using the reference ID
- M - Manual matching performed

<table>
<thead>
<tr>
<th>Table 21</th>
<th>Match Code Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
<td>Partner</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>A</td>
</tr>
</tbody>
</table>

For the Match by Account process, you can select the option to group by transaction currency. If one group of transactions has a different transaction currency than another group, the system generates separate match codes for the different groups.

**Unmatching Intercompany Transactions**

After transactions are matched, you cannot make changes to the matched transactions. If you need to edit the transactions, you must first unmatch the transactions. The Unmatch option enables you to manually reverse the matching status of specific intercompany transactions to Unmatched.
To perform the unmatch process, you must be assigned the Intercompany Transaction Unmatch security role.

When you perform the unmatch process, it applies to all transactions with the same match code. This ensures that all transactions related to that one match process are reversed to the original status.

When you unmatch a transaction, the system displays a list of transactions that have been matched. These transactions should all have a status of Matched and the same match code. The system does not unmatch posted transactions or transactions for locked entities. To unmatch posted transactions, you must first unpost the transactions and then unmatch them.

When you select UnMatch All to unmatch all transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

When the unmatch process is complete, the matching status for the transactions changes to UnMatched and the match code becomes <blank>.

For example, suppose a group of transactions that include T123, T124, T125, T126 were matched and assigned the same Match Code of A122. If you want to make changes to transaction T125, you need to select T125 to unmatch. When you select T125, the system displays all the transactions within the Match group for your review. After you confirm the selection, the unmatch process unmatches all the transactions in this match group.

To unmatch intercompany transactions:

1. From the list of transactions, select the transactions to unmatch.
2. From Match, select Unmatch, and then select UnMatch Selected or UnMatch All.
3. Review the transactions to be unmatched and click Unmatch.

Tip:
To clear transactions that you do not want to unmatch, click Clear All.

4. Click Close.

When the unmatch process is completed, the match status for these transactions is Unmatched and the match code changes to <blank>.

Posting Intercompany Transactions

When you create or load an intercompany transaction, by default it has a status of Unposted and no amount is reflected in the account balance. For example, you might input an intercompany transaction for Entity A with Entity B for the amount of $100. However, the amount has not yet been recorded in the ICRec account. The ICRec account balance is still zero until the transaction is posted.

When the selected intercompany transactions are posted to the account, the system updates the status of the transactions to Posted, and the total transaction amount is reflected in the account balance.
To post a transaction, you must be assigned the Intercompany Transaction Post/Unpost security role.

If the period is set up with the Match/Validate requirement before posting, the system checks the transactions before posting to ensure that only transactions with the Matched status, or MisMatched status with a reason code, are posted to the account balance. If this requirement is not set for the period, no validation is needed. See the Hyperion Financial Management — System 9 Administrator’s Guide.

When you select Post All to post all transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

After an intercompany transaction has a status of Posted, no more changes can be made to it. If you need to make changes to the posted transaction, you must unpost it, make the changes, then match and post the transaction again. See “Unposting Intercompany Transactions” on page 172.

➤ To post intercompany transactions:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. Select the transaction to post.
4. Click Post and select Post Selected or Post All.

Posted transactions are indicated by a green flag in the Status column.

Posting Process

During the posting process, the system accumulates the transactions related to a particular account cell and accumulates the amount to the account balance. For example, if you have two transactions with a total of 100 for the ICRec account, the system applies the total amount of 100 to the ICRec account balance. If this is the first transaction, the ICRec account has a balance of 100. If you later post four transactions to this account for a total amount of 300, after posting, the ICRec account has a balance of 400, because the system adds the amount to the account balance.

The system posts transactions to the <Entity Currency> Value dimension. If the account is a Balance type, the system posts the amount as YTD view regardless of the default view of the scenario.

Posting to Flow Accounts

For Flow accounts, the system posts according to the rules specified for the scenario. When administrators define rules for the application, they define the cells that are available for entering intercompany transactions. Administrators can define the period frequency in each scenario to determine which periods support transactions, based on the valid frequencies defined in the PER file. Valid frequencies for a monthly scenario are MTD, QTD, HYTD, and YTD and can
also be used to specify the period frequency for supporting transactions. See the Hyperion Financial Management — System 9 Administrator’s Guide.

For example, if the scenario is set up to accept intercompany transactions on a Quarterly frequency, the system only allows intercompany transactions to be entered for March, June, September, and December. For the other nonquarterly months, the system only allows users to enter the cell amounts manually without entering any transactions. However, for the transactions being entered for the quarterly months, you should enter all transactions for the entire quarter, not just the quarterly months. For example, in March, you should enter transactions for January, February, and March, so that the drill-down to the transactions matches the YTD amount.

Viewing Posted Status

Posted transactions are indicated by a green flag in the Status column in the Process IC Transactions window. You can use the column sorting capability to sort transactions by the Matching Status or Posting status. Therefore, to see all of your posted transactions at the top of the list, you can sort the Posting status in descending order.

You can also confirm the amounts posted to the account balance in a data grid or data form on the Web.

To view transactions with a Posted status, take one of these actions:

- From Process IC Transactions, select the point of view, and review the Status column for posted transactions.
- From Process IC Transactions, select the point of view, and sort by Post status. See “Displaying Transaction Columns” on page 156.
- From a Web data grid, drill down to view the transactions. See “Drilling Through to Intercompany Transactions” on page 101.
- From a Data Form, drill down to view the transactions. See “Drilling Through to Intercompany Transactions” on page 126.

Unposting Intercompany Transactions

After an intercompany transaction has a status of Posted, no more changes can be made to it. You cannot edit or delete the transaction. If you need to make changes to the Posted transaction, you must unpost the transaction, make the necessary changes, then match and post the transaction again.

To unpost a transaction, you must be assigned the Intercompany Transaction Post /Unpost security role.

During the unpost process, the system reverses the amount out of the account balance and changes the status from Posted to Unposted. Unposting the transaction does not affect the matching status.
When you select Unpost All to unpost all transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

➤ To unpost intercompany transactions:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. Select the transaction to unpost.
4. Click Unpost and select Unpost Selected or Unpost All.

**Viewing Intercompany Transaction Progress**

You can view the progress of intercompany transactions processes for these options: Load Transactions, Auto-Match, Post All, Unpost All, UnMatch All, Delete All, Matching Report by ID, Matching Report by Account, and Transaction Report. When you select these options, a progress bar page is displayed in a separate browser window with the current progress percentage, the status, and last update time.

In addition, you can view the task status from the Running Tasks module. In the Running Tasks module, you can stop the task if you are an administrator or have the appropriate security rights for the task. You can also select to view the log from the Running Tasks module to view the status information after the process is completed. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.

➤ To view the progress of intercompany transactions:

1. From the list of transactions, select the transaction, and select a task.
2. Take one of these actions:
   - From the Process Intercompany Transactions page, view the progress bar for the task that is running.
   - From the Running Tasks page, select the task from the Task Filter, and click View to view the progress.

**Deleting Intercompany Transactions**

You can delete intercompany transactions that you no longer need. However, you can delete only transactions with the posting status of Unposted and the matching status of UnMatched or MisMatched. You cannot delete posted or matched transactions. Any posted transactions must be unposted first, and any matched transactions must be unmatched before you can delete them.

You must be assigned the Intercompany Transaction User security role to delete transactions.
When you select Delete All to delete all transactions, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

➤ To delete intercompany transactions:
1. Select the transaction to delete.
2. Click Delete, and click Delete Selected or Delete All.

Note:
When you select Delete All, some transactions might not be deleted, based on their status. For example, posted or matched transactions are not deleted.
3. At the confirmation message, click OK.

**Reporting on Intercompany Transactions**

You can run these reports on intercompany transactions:

- Transaction Detail Report, a system report (list) of transactions. See “Running Transaction Detail Reports” on page 174.

When you run a Transaction Report, Matching Report by Account, or Matching Report by ID, a progress bar is displayed with the progress percentage, status, and last update time. You can also view the progress from the Running Tasks module. See “Viewing Intercompany Transaction Progress” on page 173.

You can export intercompany transaction reports to Microsoft Excel. See “Exporting Transaction Reports to Excel” on page 182.

**Running Transaction Detail Reports**

You can run a Transaction Detail Report to view a list of the transactions in the system. You can select columns and rows to display on the report, and you can change the column sort order. A default style sheet is provided for the report; however, you can apply and customize other style sheets.

You can create a Transaction Detail Report by these methods:

- Writing a script in a text file. See the Hyperion Financial Management — System 9 Administrator’s Guide.
Note:

The output of this report is a list of selected transactions with various sorting and grouping capability. This is not the matching report for reconciliation purposes. See “Running Matching Reports” on page 178.

To run Transaction Detail Reports:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Reports, select Transaction.
   - To select the columns and rows to display on the report, from Filter, click Columns, or Rows, and select items to display.
4. Select one or more options:
   - To print or preview the report, click Print/Preview.
   - To save the report locally, click Save Local.
   - To save the report remotely on a server, click Save Remote.

Displaying Transaction Report Columns

You can select the items to display in the report columns, and the order in which you would like to see them. For a dimension member, you can select whether to display the dimension member label, corresponding description, or both. You can sort the columns by ascending or descending order, or select no sorting. If you select the Totals option, a subtotal is displayed for the amounts in the column.

You can select whether to repeat the information in every row. For example, if you select the Repeat option for the entity label, the system displays the entity label for all of the selected transactions for that entity. If you do not select the Repeat option, the system displays the entity label for the first transaction but not the labels for subsequent transactions with the same label.

Table 22  Entity Column with Repeat Option Selected

<table>
<thead>
<tr>
<th>Entity</th>
<th>Partner</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>ICRec1</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>ICRec2</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>ICPay1</td>
</tr>
<tr>
<td>B</td>
<td>C</td>
<td>ICRec1</td>
</tr>
<tr>
<td>B</td>
<td>D</td>
<td>ICRec2</td>
</tr>
</tbody>
</table>
Table 23  Entity Column without Repeat Option Selected

<table>
<thead>
<tr>
<th>Entity</th>
<th>Partner</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>ICRec1</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>ICRec2</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>ICPay1</td>
</tr>
<tr>
<td>B</td>
<td>C</td>
<td>ICRec1</td>
</tr>
<tr>
<td>D</td>
<td></td>
<td>ICRec2</td>
</tr>
</tbody>
</table>

To display transaction report columns:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Reports, select Transaction.
4. Select Column Filter.
5. From Available Columns, select items to display and click ➤ to move them to Selected Columns.

The Selected Columns list shows a list of the columns as they are displayed from left to right on the report.

**Tip:**

To return items to the Available Columns list, select items from Selected Columns, and click ➡.

6. **Optional:** To move items up or down in Selected Columns, select an item and click the up or down arrow.

7. If you selected to display Transaction Currency Amount and Entity Currency Amount, from the Common Currency drop-down, you must select a currency for translation.

8. To set column attributes:
   a. From Selected Columns, select the columns.
   b. Click Sort Options, and select No Sort, Ascending or Descending.
   c. Click Display Options and select Label, Description, or Both.
   d. To repeat the information in every row, click Repeat.
   e. To display the subtotal for the amounts, click Totals.

The system displays a summary of the selected columns and their attributes to the right of the Selected Columns list. You can also right-click in the table and select column attributes.

**Tip:**

To restore the columns to their default settings, click Restore Defaults.
Displaying Transaction Report Rows

You can select specific rows to restrict the report to certain types of transactions. After you specify criteria for the report, only the transactions that meet the filter criteria are processed for the report. For example, you can display only the transactions that are matched and posted, or select transactions from a specific range of dates.

To display transaction report rows:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Reports, select Transaction.
4. Select Row Filter.
5. Select filter options for rows:
   a. For Entity, enter an entity, or click Browse and select a member.
   b. For Partner, enter a partner entity, or click Browse and select a member.
   c. If you select to display Entity Transactions, for Entity Account, enter an account, or click Browse and select an account.
   d. If you select to display Partner Transactions, for Partner Account, enter a partner account, or click Browse and select an account.
   e. For Transaction ID, enter an ID.
   f. For Transaction Sub ID, enter a sub ID.
   g. For Reference ID, enter an ID.
   h. From Transaction Currency, select a currency.
   i. For Match Code, enter a match code
   j. For Transaction Amount, enter a range of amounts.
   k. From Reason Code, select a code, or All, or None.
   l. For Transaction Date, select a range of dates.
   m. To display only the subtotal row instead of all transaction details, select Suppress Details.

Tip:
To restore the rows to their default settings, click Restore Defaults.

6. Click Close.
Running Matching Reports

After you load transactions into the application and view the transactions from the Process Transactions window or from the Transaction Detail report, you can run a Matching Report to see the potential matching transactions and mismatched transactions. You can run a Matching Report by account, by transaction ID, or by reference ID.

You can select columns and rows to display on the report, and change the column sort order.

You can create a Matching Report by these methods:

● Writing a script in a text file. See the Hyperion Financial Management — System 9 Administrator’s Guide.

Selecting Matching Report Options

When you run a Matching Report, you can display or suppress various types of transaction detail. For example, you can suppress details and matched transactions.

You define report options using these tabs:

● General Options
● Account Options
● Display Options

General Options

You use the General Options tab to define the entity and partner information for the Matching Report. You can select single or multiple members and a list for the entity and partner selection. If you do not select any members for the entity and partner, the system displays transactions for all entities and partners.

In addition to the entity and partner selection, you must specify the matching currency to use for the Matching Report.

Suppressing Details

If you want the Matching Report to display only the subtotal amount, you can select an option to suppress the intercompany details. When you select this option, the report displays only the total difference for each entity/partner section. If there is a discrepancy and you need to view each intercompany transaction, you can regenerate the report and show intercompany details.

Suppressing Matched Transactions

You can select these options for suppressing matched transactions:

● Matched using Transaction Currency Amount
Matched using Matching Currency Amount

Note:
If both options are selected, the system suppresses the transaction only if both conditions are met.

Since the matching tolerance amount is always entered in the matching report currency and is in the scale of the matching report, the system must first translate the transaction currency amount or the entity currency amount, and the total difference is then compared to the matching tolerance amount.

If you select to suppress matched transactions using the transaction or matching currency, the system suppresses the transactions if the entity and partner amounts are within the matching tolerance amount that you specify. For example, if an entity has an amount of 299 and the partner has 200, the difference is 99. If the matching tolerance amount is 100 and the difference between the entity and partner is less than 100 as in this example, the system suppresses the transactions because it is within the matching tolerance.

Account Options
You use the Account Options tab to define the accounts and matching accounts for the Matching Report. You can insert additional accounts and select accounts from the Member Selection dialog box.

Display Options
You can define the information to display in the report columns. For example, you can display transaction IDs, matching status, reason codes, and comments.
In addition, you can select whether to display dimension member labels, descriptions, or both, and you can display the scale factor and decimal override.

Running a Matching Report by Account
You can run a Matching Report by account to match intercompany transactions at the transaction level. If no match is found, the problem could be incorrect entry of the transaction, or no recording of the transaction entry on the partner’s side.

The Matching Report currency could be a specific currency or the common parent’s currency. The system translates both the transaction currency amount and the entity currency amount to the Matching Report currency that you select. If you leave the Matching currency blank, the system does not perform any translation, and the report does not display these columns: Entity Amount in Matching Currency, Partner Amount in Matching Currency, Matching Currency difference, Transaction Error, and Conversion Error.

See “Selecting Matching Report Options” on page 178.
To run a Matching Report by account:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Reports, select By Account.
4. From General, enter a report name.
5. Optional: Enter a report description.
7. From Security Class, select a security class for the report, or use the [Default] security class.
8. From the Point of View bar, select a scenario, year, and base period.
9. For Entity, enter an entity or click Browse to select an entity.
10. For Partner, enter a partner entity or click Browse to select a partner entity.
11. From Matching Currency, select a currency, or leave it blank.
12. Optional: From Suppress, select Details or Matched, and enter a tolerance amount if required.
13. From Include During Processing, select one or more match statuses: Matched, Unmatched, or MisMatched, and one or both post statuses: Posted or Unposted.
14. Optional: To filter by transaction currency, select Only if Transaction Currency = , and enter the currency.
15. From Accounts, click Add to select the Accounts and Matching Accounts to display on the report, or Remove to remove accounts from the report.
16. Select Display Options, and from Display, select the items to display on the report.
17. From Options, select one or both options:
   - To display the dimension member label, select Member Label.
   - To display the dimension member description, select Member Description.
18. Optional: From Options, select a value for the Scale Factor and Decimal Override for the amounts displayed for the transactions.
19. Select an option:
   - To print or preview the report, click Print/Preview.
   - To save the report locally, click Save Local.
   - To save the report remotely on a server, click Save Remote.
   - To close the report dialog box, click Close.

Running a Matching Report by Transaction ID

You can run a Matching Report by transaction ID to match intercompany transactions at the transaction level. The Matching Report currency could be a specific currency or the common parent’s currency. The system translates both the transaction currency amount and the entity currency amount to the Matching Report currency that you select. If you leave the Matching currency blank, the system does not perform any translation, and the report does not display
To run a Matching Report by transaction ID:

1. In the Browser View, expand Tasks and select IC Transaction Tasks.
2. Select Process IC Transactions.
3. From Reports, select By Transaction ID.
4. From General, enter a report name.
5. Optional: Enter a report description.
7. From Security Class, select a security class for the report, or use the [Default] security class.
8. From the Point of View bar, select a scenario, year, and base period.
9. For Entity, enter an entity or click Browse to select an entity.
10. For Partner, enter a partner entity or click Browse to select a partner entity.
11. From Matching Currency, select a currency, or leave it blank.
12. From ID, select an option and enter the IDs:
   - Transaction ID to Transaction ID
   - Transaction ID to Reference ID
   - Reference ID to Transaction ID
   - Reference ID to Reference ID
13. Optional: From Suppress, select Details or Matched and enter a matching tolerance amount if required.
14. From Include During Processing, select items to include on the report.
15. Optional: To filter by transaction currency, select Only if Transaction Currency = and enter the currency.
16. Select Display Options, and from Display, select the items to display on the report.
17. From Options, select one or both options:
   - To display the dimension member label, select Member Label.
   - To display the dimension member description, select Member Description.
18. Optional: From Options, select a value for the Scale Factor and Decimal Override for the amounts displayed for the transactions.
19. Select an option:
   - To print or preview the report, click Print/Preview.
   - To save the report locally, click Save Local.
   - To save the report remotely on a server, click Save Remote.
   - To close the report dialog box, click Close.
Exporting Transaction Reports to Excel

You can export an IC Transaction report, an IC Matching by Account report, or an IC Matching by Transaction ID report to Microsoft Excel.

➤ To export transaction reports to Excel:

1. Open a report, and from Report Type, select a report: IC Transactions, IC Matching by Account, or IC Matching by Trans ID.
2. Click the name of the report to export.
3. In the upper left corner of the report, click Export to Excel (.Excel).
4. Save or open the report:
   - To save the report as an Excel (.xls) spreadsheet, click Save, select a location for the file, enter a file name, and click Save.
   - To open the report as an Excel (.xls) spreadsheet, click Open. The report opens in Microsoft Excel.

Drilling Through to Transaction Details

In addition to viewing transaction details in the Process Transaction window and in Matching Reports, you can also view the corresponding transaction details from other modules after the transactions have been posted to the account cells. There are three areas where you can drill through to the transaction details:

- Drill through from an Intercompany Matching Report (account balance level). See “Drilling Through to Intercompany Transactions” on page 140.
- Drill through from Web data grids. See “Drilling Through to Intercompany Transactions” on page 101.
- Drill through from Data Forms. See “Drilling Through to Intercompany Transactions” on page 126.

E-mail Alerts for Intercompany Transactions

You can generate e-mail alerts for intercompany transactions. For example, you might notice that transaction M865 between Entity A and Partner C has a mismatched status. You can send an e-mail to Entity A to alert the user of the status, and ask for additional information.

You can generate e-mail alerts from the Intercompany Transactions Process window, the Intercompany Transactions Monitor window, Intercompany Transaction reports, and Intercompany Matching Partner reports. When you send an alert, it goes to the users who have security rights to receive intercompany transaction alerts.

To use e-mail alerts, see Chapter 13, “Using E-mail Alerts”.

182 Processing Intercompany Transactions
About Journals

After you load or enter data into the database, you might need to make adjustments to it. Journals enable you to make adjustments to accounts after the data is loaded or entered. They provide an audit trail of changes made in the application and indicate the accounts, entities, and periods that were affected.
You can create balanced journals, unbalanced journals, recurring journals for future periods, or auto-reversing journals to create reversing journal entries. In addition, you can use journal templates to post journals that have common adjustment information.

**Journal Security Roles**

Security roles are used to define access rights for Financial Management tasks. The tasks that you can perform in Set Up Journals, Journal Templates, and Process Journals depend on your role when you log on. If a journal option is not available to you, the option is disabled, or it is displayed with a message alerting you that you do not have the required rights to use it.

You must have Read access to the security class for a journal, and Read access to one or more of the cells referenced in the line items, to open the journal. If you do not have Read access to the cells, journal reports display NOACCESS status for these cells. You must have All access to the security class for a journal to edit the journal. To post a journal, you must have All access to the security classes of every dimension in the detail lines that uses security classes. Financial Management also contains a default security class. If a journal does not have a security class assigned, the system assumes the default class. Access to the journal depends on whether you have rights to the default security class, entities, accounts, scenario, or custom dimensions in the journal.

These default security roles pertain to journals:

- Journals Administrator (unrestricted journals access)
- Manage Templates
- Create Journals
- Create Unbalanced Journals
- Generate Recurring
- Read Journals
- Approve Journals
- Post Journals

To assign security roles, see the *Hyperion Financial Management — System 9 Administrator’s Guide*.

**Setting Up Journals**

Before you process journals, you can create templates and perform these tasks:

- Create, edit, and delete journal templates.
- View and sort lists of journal templates.
- Open and close periods.

You can also use the Set Up Journals module to create journals using recurring templates. See “Creating Journals Using Recurring Templates” on page 203.
Starting Set Up Journals on the Desktop

From the Financial Management Desktop, you use the Set Up Journals module to work with templates and manage periods for journals.

➤ To start Set Up Journals from the Financial Management Desktop, click Set Up Journals.

Note:

To exit the Set Up Journals module, select another task from the navigation frame on the Desktop.

Using the Templates Process Pad on the Desktop

The Journal Templates process pad is a bar at the top part of the Financial Management Desktop that guides you through a series of tasks related to the journal template process. The following table describes the buttons that are available on the Journal Templates process pad:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal Templates</td>
<td>Create, edit, and delete standard and recurring journal templates, create journals using recurring templates, and view lists of journal templates.</td>
</tr>
<tr>
<td>Manage Periods</td>
<td>View the status of periods, and open and close periods.</td>
</tr>
</tbody>
</table>

Using Journal Templates

You can create journal templates to save time when you enter journals. You can create these types of journal templates:

- Standard templates, which contain accounts and entities for adjustments that you enter frequently. See “Creating Standard Journal Templates” on page 186.
- Recurring templates, which contain complete information for identical journal entries that recur for more than one period. See “Creating Recurring Templates” on page 188.

Templates apply to all scenarios in an application. They are not dependent on scenario and year. Recurring templates are dependent on the Value dimension member.

To access templates, you must be assigned the Manage Templates security role.

See these procedures:

- “Viewing Template Lists” on page 190
Creating Standard Journal Templates

You can create a journal template when you need to post journals that have common adjustment information. For example, you can create a template that contains information such as common entities or accounts, and use the template as the basis for journals that contain similar adjustment information.

When you create a template, you select whether the journal is balanced, balanced by entity, or unbalanced. In a balanced journal, the total debits and credits must balance per journal entry before you can post the journal. In a balanced by entity journal, the debits and credits must balance for each entity included in the journal entry. In an unbalanced journal, the debits and credits do not need to balance before you can post the journal.

Windows Procedure

To create standard journal templates:

1. Open an application for which to create a journal template.
2. Click Set Up Journals.
5. From Journal Templates, click New.
6. Enter a template label and description.

   **Note:**
   The label can be a maximum of 20 characters. Do not include spaces in the label and do not use these characters: . + - * / # { } ; , @ " The description is optional and can be a maximum of 255 characters.

7. Select a balance type: Balanced, Unbalanced, or Balanced by Entity.
8. **Optional:** Enter a Journal Group for the journal

   **Note:**
   The journal group that you assign must exist in the application.

9. Select the point of view. See “Selecting Dimension Members for Journal Detail” on page 211. If you select the Use Single Entity option, you must select an entity.
Tip:
You can also double-click a blank cell or an area of a cell not occupied by text to bring up the Point of View dialog box. If the cell contains text, you must double-click within the cell to the right of any text to activate the Point of View dialog box.

10 Optional: Enter debit or credit amounts and a description.
11 Click OK.

12 Optional: To create additional templates from the Edit Template dialog box, click at the bottom of the dialog box and repeat steps 5 through 11.

Web Procedure

➤ To create standard journal templates:

1 In the Browser View, expand Tasks, and select Journal Tasks.
2 Select Manage Journal Templates.
3 Select Standard and click New.

4 Enter a template label.

Note: The label can contain a maximum of 20 characters. Do not include spaces in the label and do not use these characters . + - */ # {} ; , @ ”

5 Optional: From Group, select a group to assign to the journal.

Note: The journal group that you assign must exist in the application.
6 From Balance Type, select a balance type: Balanced, Unbalanced, or Balanced by Entity.

7 Optional: From Security, select a security class.

8 Optional: Enter a template description.

9 For each dimension, enter a member or click Pick Members to select members.

Tip:
You can also double-click the dimension to display the Pick Members dialog box, or you can right-click and select Pick Members. When you select an account, only the valid ICP or Custom members for that account are displayed.

10 Enter an adjustment in the Debit or Credit column.

11 Take one of these actions:
   ● To add rows to the template, click Add Rows. Rows are added to the bottom of the grid.
   ● To save the template, click Save.
   ● To restore the last saved version of the template, click Reset.
   ● To preview and print the template, click Print.

Creating Recurring Templates

You can create recurring templates when you need to make identical adjustments frequently. For example, you can create a recurring template that contains all the journal information, and use the template to generate Approved journals automatically for a specific scenario, year, and period.

To modify a template, you must have All access to the security class assigned to the template.

➤ To create recurring templates:

1 Open an application and click Set Up Journals.


3 Select Recurring Templates, and from Journal Templates, click New.

4 Enter a template label and description.

   Note:
   The label can contain a maximum of 20 characters. Do not include spaces in the label and do not use these characters: . + - */ # { } ; , @ " The description is optional, and can be a maximum of 255 characters.

5 From Value, select a journal value.

6 Select a Balance type: Balanced, Unbalanced, or Balanced by Entity.

7 Optional: Enter a journal group for the journal.
The journal group that you assign must exist in the application.

8 Select the point of view. See “Selecting Dimension Members for Journal Detail” on page 211.

Note:
If you select the Use Single Entity option, you must select an entity.

9 Enter the accounts, debit or credit amounts, and a description for the detail, and click OK.

Note:
The description is optional.

10 Optional: To create additional templates from the Edit Template dialog box, click at the bottom of the dialog box and repeat the steps to create a template.

➤ To create recurring templates from the Web:

1 In the Browser View, expand Tasks, and select Journal Tasks.

2 Select Manage Journal Templates.

3 Select Recurring click New, and enter a label.

Note:
The label can contain a maximum of 20 characters. Do not include spaces in the label and do not use these characters: . + - */ # {} ; , @ ”

4 Optional: From Group, select a group for the journal.

Note:
The journal group that you assign must exist in the application.

5 From Balance Type, select a balance type: Balanced, Unbalanced, or Balanced by Entity.

6 Optional: From Security Class, select a security class.

7 Select a Value dimension for the journal.

8 Optional: Enter a template description.

9 For each dimension, enter a member or click Pick Members to select members.

Tip:
You can also double-click the dimension to display the Pick Members dialog box, or you can right-click and select Pick Members. When you select an account, only the valid ICP or Custom members for that account are displayed.

10 Enter an adjustment in the Debit or Credit column, and take one of these actions:

• To add rows to the template, click Add Rows. Rows are added to the bottom of the template.
To save the template, click Save.
To restore the last saved version of the template, click Reset.
To preview and print the template, click Print.

**Viewing Template Lists**

You can view a list of all of the journal templates that you have in the system. In the Set Up Journals module on the Desktop, you can select how to view the list by selecting which columns to display, and sorting the list by column. You can also refresh the list at any time.

When you view a list of templates from the Web Templates page, the list displays the label, type, group, and description of all of the journal templates that you have in the system.

**Windows Procedure**

➤ To view template lists:
1. Open the application for which to view the template list.
2. Click Set Up Journals.
3. Select Standard Templates or Recurring Templates.
4. To refresh the list, click Refresh.

**Web Procedure**

➤ To view template lists, in the File Browser, expand Tasks, select Journal Tasks, and select Manage Journal Templates.

**Displaying Journal Template Columns on the Desktop**

You can select the columns to display on the Set Up Journals workspace. You can display these columns: Label, Short Description, Balance Type, Group, Description, Type, Entity, Parent, and Value. The order in which the columns are displayed on the workspace frame reflects the order in which you list them in the Displayed list box. You can also drag the columns on the workspace to change their order. The column order displayed remains the same until you change it.

➤ To select journal template columns to display:
1. Click Set Up Journals.
2. Click Filter,.
3. From Display Columns, select the columns to display.
4. Drag the selected column to Displayed, or click.
Tip:
To select all columns, click ✽.  

5 To change the column order, take one of these actions:
- In Displayed, drag the columns to rearrange their order.
- In Set Up Journals, drag the columns to rearrange their order.

6 Click OK.

Selecting Column Sort Order on the Desktop

You can select the columns by which to sort and their sort order in the Set Up Journals module. For example, you can sort journals by label in ascending or descending order. The order in which the columns are sorted in the workspace frame reflects the order in which you list them in the Sorted list box. The sort order displayed remains the same until you change it.

➤ To select the journal template column sort order:

1 Click Set Up Journals.

2 Click Filter, ✽.

3 From Displayed, select the columns by which to sort.

4 Drag the selected column to Sorted or click ✽.

Tip:
To select all columns, click ✽.

5 To change the sort order, select the column to change, click Sort Order ✽, and select Ascending or Descending.

6 Click OK.

Displaying Journal Template Columns on the Web

You can select the columns to display in the templates list. You can display these columns: Label, Balance Type, Group, Description, Short Description, Type, Entity, Parent, and Value. The order in which the columns are displayed in the list reflects the order in which you list them in the Displayed Columns drop-down lists. Column order remains the same until you change it.

For each column that you select to display, you can also select ascending or descending sort order.

➤ To select columns to display on the template list:

1 From the Journal Templates page, select Standard or Recurring.
2 Click Filter.
3 From Displayed Columns on the Columns tab, select the columns to display.
4 To change the sort order for each column, from Sort, select Ascending or Descending.
5 Click OK.

Filtering Journal Template Lists on the Web

You can filter the list of journal templates to display in the templates list. This enables you to find specific templates easily based on selected criteria. You can filter the list by entity, label, group, and description. You can enter text filters, including the % symbol as a wildcard, or you can leave a text box blank to avoid filtering on the text.

Note:
Depending on the setup of your database, text boxes for journal filters might be case-sensitive. For example, filtering with “testgroup” might return different results than filtering with “TestGroup.”

To filter template lists:
1 From the Journal Templates page, select Standard or Recurring.
2 Click Filter and select the Filter tab.
3 To filter by entity, enter an entity name or click Browse and select an entity.
4 To filter by label, group, or description, enter text or use the % symbol as a wildcard.
5 Click OK.
6 Optional: To restore the list to its default status, click Restore Defaults.

Editing Journal Templates

You can edit a journal template that you previously created. For example, you can change the description or balance type, or add rows to add adjustments.

Windows Procedure

To edit journal templates:
1 Click Set Up Journals.
3 Select Standard Templates or Recurring Templates.
4 Double-click a journal template, or select a template and click Open.
5 Edit the template information.
Web Procedure

➤ To edit journal templates:
1. From the list of templates, click the template to edit.
2. Edit the template information.
3. To add rows for more entries, click Add Rows.
4. Click Save to save the changes.

Printing Journal Templates on the Web

After you create a journal template, you can print the template at any time. The template report contains the journal header information, detail information in rows and columns, debit and credit information, variance, and line descriptions as they appear on the screen. The comments at the bottom of the report correspond to the line detail in the journal template.

➤ To print journal templates:
1. From the list of templates, open the template to print.
2. Click Print.
   The template opens in a new browser window.
3. Click File > Print.

Deleting Journal Templates

You can delete journal templates that you no longer need. For example, if you have a journal template for adjustments to an account, and you remove that account from your chart of accounts, you can delete the template for those adjustments.

Windows Procedure

➤ To delete journal templates:
1. Click Set Up Journals.
3. Select Standard Templates or Recurring Templates.
4. Select the template to delete.
5. Press Delete.
6. Click Yes.
Web Procedure

➤ To delete journal templates:

1 From the list of templates, select the template to delete and click Delete.
2 Click OK.

Tip:
You can also delete a template from within the template.

Managing Journal Periods

Before you can work with journals, you must open the periods for the journals. By default, all periods have a status of Unopened. You can view the status of journal periods and open or close them as needed.

See “Viewing Periods” on page 194 and “Opening and Closing Periods” on page 195.

Viewing Periods

You can filter the list of journal periods by selecting a scenario and year and by selecting the period status; for example, Opened, Closed, or Unopened.

Windows Procedure

➤ To view periods:

1 Click Set Up Journals.
2 On the Set Up Journals process pad, click Manage Periods.
3 From Scenario and Year, select a scenario and year for which to view periods.
4 Select the periods to view: Opened, Closed, or Unopened.

Web Procedure

➤ To view periods:

1 In the Browser View, expand Tasks and select Journal Tasks.
2 Select Manage Periods.
3 From Scenario and Year, select a scenario and year for which to view periods.
Opening and Closing Periods

Before you can post journals, you must open the periods for each scenario to which you want to post. You cannot post journals to an unopened or closed period.

By default, all periods have an initial status of Unopened. You can open and close periods as needed. However, after you open a period, it can never revert to the Unopened status.

You cannot close a period if there are unposted auto-reversals in the period. If you close a period that contains approved journals, a warning message is displayed.

Windows Procedure

➤ To open or close periods:

1. Click Set Up Journals.
3. From Scenario and Year, select a scenario and year for which to open or close periods.
4. Highlight the periods to open or close.

Tip:
Press Ctrl to select multiple periods.

5. Take one of these actions:
   ● Click Open to open the selected periods.
   ● Click Close to close the selected periods.

Web Procedure

➤ To open or close periods:

1. In the Browser View, expand Tasks and select Journal Tasks.
2. Select Manage Periods.
3 From Scenario and Year, select Scenario and Year members.

4 Select the periods to open or close.

5 Take one of these actions:
   - To open the selected periods, click Open.
   - To close the selected periods, click Close.

### Processing Journals

After you set up journals, you can enter journal information and process journals. See these procedures:

- “Creating Journals” on page 198
- “Scanning Journals” on page 204
- “Viewing Journal Lists” on page 206
- “Editing Journals” on page 209
- “Submitting Journals” on page 214
- “Unsubmitting Journals” on page 215
- “Approving Journals” on page 216
- “Rejecting Journals” on page 217
- “Posting Journals” on page 219
- “Unposting Journals” on page 220
- “Reviewing Journals” on page 221
Starting Process Journals

To start Process Journals:

- From the Financial Management Desktop, click Process Journals.
- From the Web, in File Browser, expand Tasks and select Journal Tasks, and select Manage Journal Templates.

Note:

To exit the Process Journals module, select another task from the navigation frame on the Desktop or on the Web.

Using the Journals Process Pad on the Desktop

The Journals process pad is a button bar in the top part of the Desktop that guides you through a series of tasks related to the journal process. The following table describes the buttons that are available on the Journals process pad:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>View and open journals with Working and Rejected status, and create, edit, and submit journals for approval.</td>
</tr>
<tr>
<td>Submitted</td>
<td>View and open journals with Submitted status, and edit, unsubmit, and approve journals for posting, or reject journals. A journal must be approved before you can post it to the database.</td>
</tr>
<tr>
<td>Approved</td>
<td>View and open journals with Approved status, post a journal to the database, or reject journals. A journal must be submitted and approved before you can post it to the database.</td>
</tr>
<tr>
<td>Posted</td>
<td>View and open journals with Posted status, and unpost a journal from the database.</td>
</tr>
<tr>
<td>Advanced</td>
<td>View and open journals with all statuses, submit, unsubmit, approve, reject, post, and unpost journals. Depending on your security rights, you can also process journals directly from Working to Posted status.</td>
</tr>
</tbody>
</table>
Creating Journals

You use journals to enter adjustments to account balances and maintain an audit trail of changes to your data. You create journals by entering a journal label and description, balance type, point of view, and adjustment amounts. You can create single entity or multiple-entity journals. You can also enter a security class for the journals, and a journal group that you can use to filter and sort journals. After you create a journal, its status is Working.

Before you create a journal, check the point of view to be sure that the scenario, year, period, and value are the ones to which you want to enter adjustments. See “Opening and Closing Periods” on page 195.

When you enter adjustments, you can scan the detail lines and ensure that the lines are valid. In this way, you can make any necessary changes before you post the journal. See “Scanning Journals” on page 204.

In addition to standard journals, you can create auto-reversing journals. You can also create journals using a recurring or standard template. See “Creating Auto-reversing Journals” on page 201 and “Using Journal Templates” on page 185.

Windows Procedure

➤ To create regular journals:

1 Click Process Journals.
2 From the Point of View bar on Process Journals, select a scenario, year, period, and value.
3 Click Working or Advanced on the process pad, and click New on Process Journals.
4 Take one of these actions:
   ● If you are not creating a journal from a template, select Start with Blank Journal.
   ● If you are creating a journal from a template, deselect Start with Blank Journal and select a journal template from the template list.
5 Optional: To create a journal for one entity, select Create Single Entity Journal.
6 Click OK.
7 Enter a journal label and description.

Note:
The label can be a maximum of 20 characters. Do not use these characters: . + - / # { } ; , @ ”
The description is optional and can be a maximum of 255 characters.

8 Select a security class for the journal.
9 Select a balance type: Balanced, Unbalanced, or Balanced by Entity.
10 Optional: Enter a journal group for the journal.

Note:
The journal group that you assign must exist in the application.
11 Select the point of view. See “Selecting Dimension Members for Journal Detail” on page 211.

Note:
If you selected Create Single Entity Journal from the New Journal dialog box, the line items do not include parent and entity. You must select an entity in the header point of view at the top of the journal.

12 Enter an adjustment amount in the Debit or Credit column, and enter an adjustment description in the Description column.

Note:
The description is optional.

13 Click OK.

14 Optional: To create additional journals from the Edit Journal dialog box, click at the bottom of the dialog box and repeat steps 7 through 13. When you use this method, the New Journal dialog box is not displayed.

Web Procedure

To create regular journals:

1 In the Browser View, expand Tasks and select Journal Tasks.

2 Select Process Journals, set the journal point of view, and click New.

3 For the type of journal, click Regular.

4 Select an option:
   ● To create a journal from a template, click Create from a template, select the template from the list, and click OK.
   ● If you are not creating a journal from a template, select Start with Blank Journal, and click OK.
   ● To create a journal for one entity, select Create as Single Entity Journal, and click OK.

Note:
When you create a single-entity journal, the system displays the corresponding currency in the top right of the detail window for the entity being adjusted. The system displays the currency of the entity or the parent, depending on the type of adjustment.
5 Enter a journal label.

Note:
The label can contain a maximum of 20 characters. Do not use these characters: . + - */ # {} ; , @ "

6 Optional: From the Group, select a group for the journal.

Note:
The journal group that you assign must exist in the application. See “Viewing Journal Lists” on page 206.

7 From Balance Type, select a balance type: Balanced, Unbalanced, or Balanced by Entity.

8 Optional: From Security class, select a security class.

9 Optional: Enter a journal description.

10 For each dimension, enter a member or click Pick Members to select members.

Tip:
You can also double-click the dimension to display the Pick Members dialog box, or you can right-click and select Pick Members. When you select an account, only the valid ICP or Custom members for that account are displayed.

11 Enter an adjustment in the Debit or Credit column.

Note:
If you made any changes, save your changes before you take the following step.

12 Optional: To scan the detail lines and ensure that the lines are valid, click Scan. See “Scanning Journals” on page 204.

13 Take one of these actions:
To add rows to the journal, click Add Rows. Rows are added to the bottom of the grid.

To save the journal, click Save.

To restore the last saved version of the journal, click Reset.

Creating Auto-reversing Journals

You create auto-reversing journals to enter adjustments that you want to reverse in the next period, for example, sales or expenses that are collected and paid in the next period. Auto-reversing journals affect two periods of data. You post an auto-reversing journal to adjust values in one period. When you post the auto-reversing journal, the system automatically creates a journal that would reverse those adjustments for the next period. The journal created in the following period has the Approved status. You can post this Approved journal for the reversal to take effect.

For example, you can create and post an auto-reversing journal in January that adjusts the Sales accounts for France. The system creates a journal that reverses those adjustments for February.

The status of the auto-reversal journal is Approved. You post this Approved journal for the reversal to take effect. When you unpost an auto-reversal journal, the status of that journal changes back to Approved.

You can edit, reject, post, or unpost an auto-reversing journal. When you unpost an auto-reversing journal, the system-generated auto-reversal journal in the next period is deleted. You cannot unpost an auto-reversing journal after its auto-reversal has been posted. If necessary, you can reject, edit, unpost, and delete the auto-reversal journal.

Windows Procedure

To create auto-reversing journals:

1. Click Process Journals.

2. From the Point of View bar in Process Journals, select a scenario, year, period, and value.

3. Click Working or Advanced on the process pad, and click New in Process Journals.

4. Select Create as Autoreversing Journal.

5. Take one of these actions:
   - If you are not creating a journal from a template, select Start with Blank Journal.
   - Clear Start with Blank Journal and select a journal template from the template list.

6. Optional: To create a journal for one entity, select Create Single Entity Journal.

7. Click OK.

8. Enter a journal label and description.

Note:

The label can contain a maximum of 20 characters. Do not use these characters: . + - */ # { } ; , @ ” The description is optional and can be a maximum of 255 characters.
9 Select a balance type: Balanced, Unbalanced, or Balanced by Entity.

10 Optional: Enter a journal group for the journal.

Note:
The journal group that you assign must exist in the application.

11 Select the point of view. See “Selecting Dimension Members for Journal Detail” on page 211.

Note:
If you selected Create Single Entity Journal from the New Journal dialog box, the line items do not include Parent and Entity. You must select an entity in the header point of view at the top of the journal.

12 Enter an adjustment amount in the Debit or Credit column, enter an adjustment description in the Description column, and click OK.

Note:
The description is optional.

13 Optional: To create additional journals from the Edit Journal dialog box, click at the bottom of the dialog box and repeat the steps to create a journal.

When you use this method, the New Journal dialog box is not displayed.

Web Procedure

➢ To create auto-reversing journals:

1 In the Browser View, expand Tasks, and select Journal Tasks.

2 Select Process Journals.

3 Set the journal point of view and click New.

4 Click Auto-reversing, and select an option:
   ● To create a journal from a template, click Create from a template, select the template from the list, and click OK.
   ● If you are not creating a journal from a template, select Start with Blank Journal, and click OK.
   ● To create a journal for one entity, select Create as Single Entity Journal, and click OK.

5 Enter a journal label.

Note:
The label can contain a maximum of 20 characters. Do not use these characters: . + - */ # { } ; , @ "

6 Optional: From Group, select a group for the journal.
Note:
The journal group that you assign must exist in the application.

7 From Balance Type, select a balance type: Balanced, Unbalanced, or Balanced by Entity.

8 Optional: From Security class, select a security class.

9 Optional: Enter a journal description.

10 For each dimension, enter a member or click Pick Members to select members.

Tip:
You can also double-click the dimension to display the Pick Members dialog box, or you can right-click and select Pick Members. When you select an account, only the valid ICP or Custom members for that account are displayed.

11 Enter an adjustment in the Debit or Credit column.

Note:
If you made any changes, save your changes before you take the following step.

12 Optional: To scan the detail lines and ensure that the lines are valid, click Scan.

13 Take one of these actions:
  ● To add rows to the journal, click Add Rows. Rows are added to the bottom of the grid.
  ● To save the journal, click Save.
  ● To restore the last saved version of the journal, click Reset.

Creating Journals Using Recurring Templates

You can use a recurring template to create journals automatically. When you generate a journal from a recurring template, you receive a confirmation message that the journal has been generated. The status of the journal is Approved.

To create a journal using a recurring template, you must be assigned the Generate Recurring security role. You must also have All access to the security class assigned to the template.

The system uses the security class assigned to the template as the security class for the journal. If you need to modify the security class assignment for the journal, you must reject the journal and then resubmit it. To edit a journal, you must have All access to the security class assigned to the journal. To modify the template, you must have All access to the security class assigned to the template.

Windows Procedure

➤ To create journals using recurring templates:
  1 Click Set Up Journals.
3 Select Recurring Templates.
4 Select a template from which to create a journal.
5 Click Generate.
6 Select a scenario, year, and period for which to generate the journal, and click OK.

Web Procedure

➤ To create journals using recurring templates:
1 From the Journal Templates page, select the Recurring Templates tab.
2 Select a template from which to create a journal, and click Open.
3 Click Generate.
4 Select a scenario, year, and period for which to generate the journal, and click OK.

Scanning Journals

When you enter adjustments, you can scan the detail lines and ensure that the lines are valid. In this way, you can make any necessary changes before you post the journal.

When you run a scan, if the journal contains errors, a separate window is displayed with the scan results by row number. If all of the entries are valid when you run a scan, no message is displayed.

➤ To scan journals:
1 Create a journal or open a journal.
2 Click Scan.
3 Review the results, and click Back to Journal.

Journal Status

The journal status indicates the current state of the journal. The status of a journal changes when you create, submit, approve, reject, or post the journal. The following table describes the journal statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>Journal is created. It has been saved, but it can be incomplete. For example, it might need to have a label or single entity assigned.</td>
</tr>
<tr>
<td>Submitted</td>
<td>Journal is submitted for approval.</td>
</tr>
<tr>
<td>Approved</td>
<td>Journal is approved for posting.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Journal is rejected or unposted.</td>
</tr>
</tbody>
</table>
The journal actions that are available from the Process drop-down list depend on the journal status. For example, if the journal has a status of Approved, the only actions available are Reject or Post.

Managing Journal Groups

You can create journal groups that you can use to filter and sort journals. To create a journal group, you must be the application owner or be assigned the Administrator or Journals Administrator security role. The Manage Groups option is available only on the Web.

The list of groups is displayed in alphabetical order. You can delete a journal group if it is not being used by other users.

You can also load journals group during a journals load. When you create a journal and specify a journal group, the system validates the group against the list of groups and displays an error message if the group that you specify is invalid.

See these procedures:

- “Creating Journal Groups” on page 205
- “Removing Journal Groups” on page 206

Creating Journal Groups

You can create a journal group if you are the application owner or are assigned the Administrator or Journals Administrator security role.

➤ To create journal groups:

1. In the Browser View, expand Tasks and select Journal Tasks.
2. Select Manage Groups.
3. For New Group Label, enter group name.

   Note:
   Group labels can contain up to 30 alphanumeric characters and spaces and cannot use these special characters: # * @ + - / . , ; " { }

4. Optional: For Description, enter a group description.

   Note:
   Group descriptions can contain up to 255 alphanumeric characters and spaces.
5. Click Add.
6 Repeat steps 3-5 to add journal groups.

<table>
<thead>
<tr>
<th>Remove</th>
<th>Remove All</th>
</tr>
</thead>
</table>

## Removing Journal Groups

You can remove a journal group if you are the application owner or are assigned the Administrator or Journals Administrator security role, and if the group is not being used by other users.

➤ To remove journal groups:

1. In the Browser View, expand Tasks and select Journal Tasks.
2. Select Manage Groups.
3. Take one of these actions:
   - Select one or more journal groups to remove and click Remove.
   - Click Remove All to delete all journal groups.

## Viewing Journal Lists

You can view a list of all of the journals in the system. You can select which columns to display, and you can sort the list by column. You can also refresh the list at any time.

When you view a list of journals from the Web Process Journals page, the list displays the label, status, entity, short description, and group of all of the journals in the system. You can sort the list of journals in alphabetical ascending or descending order. If you select to sort by entity, the journals display multiple times for multiple-entity journals.

### Windows Procedure

➤ To view journal lists:

1. Click Process Journals.
2. To refresh the list, click Refresh.
Web Procedure

➤ To view the journal list, in the Browser View, expand Tasks and select Journal Tasks, and select Process Journals.

Displaying Journal Columns on the Desktop

You can select the columns to display in Process Journals. You can select these columns: Status, Label, Type, Balance Type, Group, Description, Short Description, Created by, Date Created, Approved by, Date Approved, Posted by, Date Posted, Entity, Parent, and Security Class. The order in which the columns are displayed reflects the order in which you list them in the Displayed Columns list. The column order displayed remains the same until you change it.

➤ To select columns to display:

1 From the Financial Management Desktop, click Process Journals.

2 Click Filter.

3 From Display Columns, select the columns to display.

4 Drag the selected column to Displayed or click .

Tip:

To select all columns, click .

5 To change the column order, take one of these actions:

● In Displayed, drag the columns to rearrange their order.

● On the Process Journals, workspace, drag the columns to rearrange their order.

6 Click OK.

Selecting Column Sort Order on the Desktop

You can select the columns by which to sort and select the column sort order in Process Journals. For example, you can sort journals by label in ascending or descending order. The order in which the columns are sorted reflects the order in which you list them in the Sorted Columns list box. The sort order displayed remains the same until you change it.

➤ To select the column sort order:

1 From the Financial Management Desktop, click Process Journals.

2 Click Filter.

3 Select Columns.
From Displayed, select the columns to sort.

Drag the selected column to Sorted, or click ▶️.

Tip:
To select all columns, click ▶️.

6 To change the sort order, select the column to change, click Sort Order, ▼️, and select Ascending or Descending.

7 Click OK.

Filtering Journal Lists on the Desktop

You can filter the list of journals to display in Process Journals. This enables you to easily find specific journals based on selected criteria. You can filter journal lists by entity, journal group, label, description, status, type, and balance type. You can enter text filters, including the percent (%) symbol as a wildcard, or you can leave a text filter blank to avoid filtering on the field.

Note:
Depending on the setup of your database, text boxes for journal filters might be case-sensitive. For example, filtering with “testgroup” might return different results than filtering with “TestGroup.”

To filter journal lists:
1 From the Financial Management Desktop, click Process Journals.
2 Click Filter, ▶️.
3 Select Journal Filters.
4 Optional: Click ▼️ next to Entity and select an entity from the Point of View.
5 Optional: Enter a journal label by which to filter journals.
6 Optional: Enter a journal group by which to filter journals.
7 Optional: Enter a journal description by which to filter journals.
8 Optional: Select a status, type, or balance type by which to filter journals.
9 Click OK.

Displaying Journal Columns on the Web

You can select the columns to display on the Process Journals list. You can display these columns: Label, Status, Type, Balance Type, Group, Description, Short Description, Created By, Date
Created, Approved By, Date Approved, Posted By, Date Posted, Security Class, Parent, and Entity. The order in which the columns appear on the list reflects the order in which you list them in the Displayed Columns drop-down list. The column order remains the same until you change it.

For each column that you select to display, you can also select whether to sort the column in ascending or descending order.

➤ To select journal columns to display on the list:

1. From the Process Journals page, click Filter.
2. From Displayed Columns on the Columns tab, select the columns to display.
3. Optional: To change the column sort order, from Sort, select Ascending or Descending.
4. Click OK.

Filtering Journal Lists on the Web

You can filter the list of journals to display in the Process Journals list. This enables you to easily find specific journals based on selected criteria. You can filter the list by entity, label, group, description, status, type, or balance type. You can enter text filters, including the percent (%) symbol as a wildcard, or you can leave a text box blank to avoid filtering on the entry.

Note:

Depending on the setup of your database, text boxes for journal filters might be case-sensitive. For example, filtering with “testgroup” might return different results than filtering with “TestGroup”.

➤ To filter journal lists:

1. From the Process Journals page, click Filter.
2. To filter by entity, enter an entity name or click Browse and select an entity.
3. To filter by label, group, or description, enter text or use the percent (%) symbol as a wildcard.
4. To filter by status, type, or balance type, select the check box next to the filter.
5. Click OK.
6. Optional: To restore the list to its default status, click Restore Defaults.

Editing Journals

You can edit a journal that you previously created. For example, you can change the description of a journal, insert rows in a journal to add adjustments, or change the balance type.
You can edit only Working, Submitted, and Rejected journals. You cannot edit Approved or Posted journals. You must have All security access to the security class for a journal to edit the journal. See the *Hyperion Financial Management — System 9 Administrator’s Guide*.

Windows Procedure

➤ To edit journals:

1. **Click Process Journals.**
2. Select **Working**, **Submitted**, or **Rejected** on the process pad to view journals with those statuses.

   **Tip:**
   To view journals with all statuses, select **Advanced** on the process pad.
3. From **Process Journals**, select a scenario, year, period, and value.
4. Double-click the selected journal, or select the journal and click **Open**.
5. Edit the journal information.

   **Tip:**
   For a single entity journal, you can change the entity by clicking the member name in the Point of View bar.

6. Click **OK**.

Web Procedure

➤ To edit journals:

1. On the **Process Journals** page, set the journal point of view.
2. From the list of journals, select a journal with a status of **Working**, **Submitted**, or **Rejected** by clicking the journal label.

   **Tip:**
   You can also select the check box next to the journal, and click Open.
3. Change the dimension members or edit the line items.
4. Optional: To scan the detail lines and ensure that the lines are valid, click **Scan**.
5. Click **Save** to save your changes, or click **Reset** to restore the last saved version of the journal.
6. Click **Close**.
Selecting Dimension Members for Journal Detail

The journal detail contains a set of dimension members that you define to specify the data accessed for a specific journal. Each journal saves the journal detail with dimension information you select, which is displayed automatically the next time that you open the journal.

The point of view displays the members for the Scenario, Year, Period, and Value dimensions. To set the point of view for the journal detail, you can right-click a journal row. The system displays the point of view from which you can select the member for each dimension. To create journals for parent adjustments, you select the Parent Adjs member for the Value dimension. For each line of journal detail, you must specify a Parent member if the Value dimension is <Parent Currency Adj>, [Parent Adj], or [Contribution Adj]. In addition, you must specify an entity, account, intercompany partner, and Custom dimension.

The system displays entities based on the Value dimension that you select for the journal. If the selected Value dimension is <Entity Currency Adjs> or <Parent Currency Adjs>, the system displays a list of entities that have the Allow Adjustments application attribute enabled. If the selected Value dimension is [Contribution Adjs] or [Parent Adjs], the system displays a list of entities that have the Allow Adjustments from Children application attribute enabled.

You can select the journal detail when the journal status is Working, Submitted, or Rejected. You cannot make changes to the journal detail when the journal status is Approved or Posted.

Windows Procedure

To select dimensions for journal detail:

1. From the Financial Management Desktop, click Process Journals.
2. To view journals with a Working or Submitted status, select Working or Submitted on the process pad.

   Tip:
   To view journals with all statuses, select Advanced on the process pad.
3. From Process Journals, select a scenario, year, period, and value.

   Note:
   The Adjustments member list contains only the values that are valid for selection in the Journals module. The values are Contribution Adjustments, Parent Adjustments, Entity Currency Adjustments, and Parent Currency Adjustments.
4. Double-click the selected journal, or select the journal and click Open.
5. Click in a cell grid.
6. Right-click and select Set Point of View.
Tip:
You can also double-click a blank cell or an area of a cell not occupied by text to bring up the Point of View dialog box. If the cell contains text, you must double-click within the cell to the right of any text to active the point of view.

7 To edit the information on the journal, take one or more of these actions:

- If you did not select Create Single Entity Journal, you must select an entity from the point of view. To select an entity, select Entity, and select a member.
- To select an account, select Account, and select a member from the list of accounts.
- To select an intercompany partner, select ICP, and select a member from the list of intercompany partners.
- To select a custom dimension, select a custom dimension tab, and select a member from the list of custom members.

8 Click OK.

Web Procedure

➤ To select dimensions for journal detail:
1 From the Point of View bar, click Point of View.
2 Select a member for the scenario, year, period, and value.
3 Click OK.

Collapsing the Grid Columns on the Desktop

You can reduce the width of, or completely collapse, the columns in the journals grid on the Edit Journals dialog box. You can do this if you do not need to view a particular column and you need more space for other columns.

➤ To collapse grid columns:
1 From Process Journals, double-click the selected journal, or select the journal and click Open.
2 Click on the column grid line to collapse.

Note:
The cursor arrow becomes a line with arrows on both sides.

3 Left-click and drag the column grid line to the new position.

Expanding the Grid Columns on the Desktop

You can expand the width of the columns in the journals grid on the Edit Journals dialog box. You can do this if you need more space to view a particular column. You can expand the columns manually or use the grid menu to expand specific columns or all columns.
To expand columns manually:
1 From Process Journals, double-click the selected journal, or select the journal and click Open.
2 Click on the column grid line to expand.

Note:
The cursor arrow becomes a line with arrows on both sides.
3 Left-click and drag the column grid line to the new position.

To expand a column using the grid menu:
1 From Process Journals, double-click the selected journal, or select the journal and click Open.
2 Click in a cell in the grid.
3 Right-click and take one of these actions:
   ● Select Expand All Columns to expand all of the columns in the grid to their default width.
   ● Select Expand ICP Column to expand only the ICP column to the default width.
   ● Select Expand Custom 1 Column to expand only the Custom 1 column to the default width.
   ● Select Expand Custom 2 Column to expand only the Custom 2 column to the default width.
   ● Select Expand Custom 3 Column to expand only the Custom 3 column to the default width.
   ● Select Expand Custom 4 Column to expand only the Custom 4 column to the default width.

Copying and Pasting Cells
You can copy and paste the information in the journals grid from one cell to another to make journal entries. You can paste entries within a journal, across journals, and across journals and templates.

To copy or paste journal cells:
1 From Process Journals, double-click the selected journal, or select the journal and click Open.
2 Select a cell in the journals grid.
3 To copy the information in a cell and store it on the clipboard, right-click and select Copy.
4 To paste the information from the clipboard to the selected cell, right-click and select Paste.

To copy or paste journal rows:
1 From Process Journals, click the selected journal, or select the journal and click Open.
2 Select a row in the journals grid.
3 To copy the information in a row and store it on the clipboard, click Copy Rows.
4 To paste the information from the clipboard to the selected row, click Paste Rows.
Tip:
You can also select a cell, right-click, and select Copy Row, Paste Row, or Clear Row.

Submitting Journals

After you create a journal, you can submit it for approval before posting. You can submit a journal from the Edit Journal dialog box when you create it, or you can submit it later by selecting it from the journals list on the Process Journals workspace.

You can submit journals one at a time or in batches. After you submit a journal, the status changes to Submitted.

Windows Procedures

➤ To submit journals using the process pad:

1. Click Process Journals.
2. On the process pad, click Working or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Select the journals to submit.
5. Click Submit at the bottom of the workspace.

➤ To submit journals using the Edit Journal dialog box:

1. Click Process Journals.
2. On the process pad, click Working or Advanced.
3. From Process Journals workspace, select a scenario, year, period, and value.
4. Double-click the selected journal, or select the journal and click Open.
5. Click Submit.

Tip:
To submit multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6. Click OK.

Web Procedure

➤ To submit journals:

1. On the Process Journals page, set the journal point of view.
2. From the list of journals, select the Working or Rejected journal to submit.
3. From Process, select Submit.
Tip:
You can also select Submit from the Process drop-down list from within a journal.

Unsubmitting Journals

You can unsubmit a journal that you previously submitted. When you unsubmit a journal, the status reverts from Submitted to Working.

Windows Procedures

➤ To unsubmit journals using the process pad:
1 Click Process Journals.
2 On the process pad, click Submitted or Advanced.
3 From Process Journals, select a scenario, year, period, and value.
4 Select the journals to unsubmit.
5 Click Unsubmit at the bottom of the workspace.

➤ To unsubmit journals using the Edit Journal dialog box:
1 Click Process Journals.
2 On the process pad, click Submitted or Advanced.
3 From Process Journals, select a scenario, year, period, and value.
4 Double-click the selected journal, or select the journal and click Open.
5 Click Unsubmit.

Tip:
To unsubmit multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6 Click OK.

Web Procedure

➤ To unsubmit journals:
1 On the Process Journals page, set the journal point of view.
2 Select the submitted journal to unsubmit.
3 From Process, select Unsubmit.

Tip:
You can also select Unsubmit from the Process drop-down list from within a journal.
Approving Journals

After you submit a journal, you can approve it for posting. You can approve a journal from the Edit Journal dialog box after you create and submit it, or you can approve it later by selecting it from the journals list in Process Journals.

You can approve journals one at a time or in batches. After you approve a journal, the status changes to Approved and the journal cannot be edited.

Windows Procedures

➢ To approve journals using the process pad:

1. **Click Process Journals.**
2. On the process pad, click Submitted or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Select the journals to approve.
5. **Click Approve** at the bottom of the workspace.

➢ To approve journals using the Edit Journal dialog box:

1. **Click Process Journals.**
2. On the process pad, click Submitted or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Double-click the selected journal, or select the journal and click Open.
5. **Click Approve.**

**Tip:**
To approve multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6. **Click OK.**

Web Procedure

➢ To approve journals:

1. **On the Process Journals page,** set the journal point of view.
2. **Select the submitted journal to approve.**
3. **From Process,** select Approve.

**Tip:**
You can also select Approve from the Process drop-down list from within a journal.
Rejecting Journals

After a journal is submitted for approval, or approved, you can reject it. You can reject journals one at a time or in batches. After you reject a journal, the status changes to Rejected.

Rejecting Submitted Journals

You can reject a journal that has been submitted for approval.

Windows Procedures

➤ To reject submitted journals using the process pad:

1 Click Process Journals.
2 On the process pad, click Submitted or Advanced.
3 From Process Journals, select a scenario, year, period, and value.
4 Select the journals to reject.
5 Click Reject at the bottom of the workspace.

➤ To reject submitted journals using the Edit Journal dialog box:

1 Click Process Journals.
2 On the process pad, click Submitted or Advanced.
3 From Process Journals, select a scenario, year, period, and value.
4 Double-click the selected journal, or select the journal and click Open.
5 Click Reject.

Tip:
To reject multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6 Click OK.

Web Procedure

➤ To reject journals:

1 On the Process Journals page, set the journal point of view.
2 Select the submitted journal to reject.
3 From Process, select Reject.

Tip:
You can also select Reject from the Process drop-down list from within a journal.
Rejecting Approved Journals
You can reject a journal that has been approved.

Windows Procedures

➤ To reject approved journals using the process pad:
1. **Click Process Journals.**
2. On the process pad, click Approved or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Select the journals to reject.
5. **Click Reject at the bottom of the workspace.**

➤ To reject approved journals using the Edit Journal dialog box:
1. **Click Process Journals.**
2. On the process pad, click Approved or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Double-click the selected journal, or select the journal and click **Open.**
5. **Click Reject.**

**Tip:**
To reject multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).
6. **Click OK.**

Web Procedure

➤ To reject approved journals:
1. **On the Process Journals page, set the journal point of view.**
2. Select the approved journal to reject.
3. **From Process, select Reject.**

**Tip:**
You can also select Reject from the Process drop-down list from within a journal.
Posting Journals

You can post a journal after it is approved. You can post a journal from the Edit Journal dialog box after you submit and approve it, or you can post it later by selecting it from the journals list on the Process Journals workspace.

From Process Journals, you can also select the Advanced process pad button to post a journal directly from Working or Submitted status without submitting or approving it first.

The scenario view to which a journal is posted depends on the setting for the Scenario attribute “ZeroViewForAdj.” If this attribute is set to Periodic, the journal is posted to the Periodic value. If this attribute is set to YTD, the journal is posted to the YTD value.

You can post journals one at a time or in batches. You must have the journal period open before you can post. You must have All access to the security classes of every entity for the detail lines to post the journal.

Your ability to post a journal also depends on the process level of the data in the journal. For example, if you have a process management security role of Reviewer 2 and the data that the journal affects is at Process Level 6, you cannot post the journal. See “Process Levels” on page 231.

These four Value dimension members are valid for posting journals: Entity Currency Adjustments, Parent Currency Adjustments, Parent Adjustments, and Contribution Adjustments.

You can post a journal to a specific parent and child combination (node) by using one of these Value dimensions:

- Parent Adjs - Applied to the node before consolidation.
- Contribution Adjs - Applied to the contribution when determining the contribution total.

**Note:**

Node adjustments are posted in the currency of the parent.

When you post a journal, the system recalculates the account balances so that the database reflects the adjustments. The journal status changes to Posted, and you can view the adjustment in a data grid.

**Windows Procedures**

To post journals using the process pad:

1. Click Process Journals.
2. On the process pad, click Working, Submitted, Approved or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Select the journals to post.
5. Click Post at the bottom of the workspace.
To post journals using the Edit Journal dialog box:

1. From the Financial Management Desktop, click Process Journals.
2. On the process pad, click Approved or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Double-click the selected journal, or select the journal and click Open.
5. Click Post.

Tip:
To post multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6. Click OK.

Web Procedure

To post journals:

1. On the Process Journals page, set the journal point of view.
2. Select the journals to post.
   You cannot post previously posted journals.
3. From Process, select Post.

Tip:
You can also select Post from the Process drop-down list from within a journal.

Unposting Journals

You can unpost a journal after it is posted. For example, suppose you post several journals with adjustments to an entity, and you receive new data for that entity. You can unpost the journals, load the new data, and post the journals again.

When you unpost a journal, the journal status changes to Rejected. When you unpost an auto-reversal journal, the journal status changes back to Approved.

Windows Procedures

To unpost journals using the process pad:

1. Click Process Journals.
2. On the process pad, click Posted or Advanced.
3. From Process Journals, select a scenario, year, period, and value.
4. Select the journals to unpost.
5 Click **Unpost** at the bottom of the workspace.

To unpost journals using the Edit Journal dialog box:

1 Click **Process Journals**.
2 On the process pad, click **Posted** or **Advanced**.
3 From **Process Journals**, select a scenario, year, period, and value.
4 Double-click the selected journal, or select the journal and click **Open**.
5 Click **Unpost**.

**Tip:**

To unpost multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

6 Click **OK**.

**Web Procedure**

To unpost journals:

1 On the **Process Journals** page, set the journal point of view.
2 Select the posted journal to unpost.
3 From **Process**, select **Unpost**.

**Tip:**

You can also select Unpost from Process in a journal.

### Reviewing Journals

You can review journals that have been created, edited, submitted, unsubmitted, approved, rejected, or posted. You can review journals before they are posted, or after they are posted and before you run a journal report.

**Windows Procedure**

To review journals:

1 From the Financial Management Desktop, click **Process Journals**.
2 On the process pad, click **Advanced**.
3 From **Process Journals**, select a scenario, year, period, and value
4 Double-click the selected journal or select the journal and click **Open**.
Tip:
To review multiple journals from the Edit Journal dialog box, use the arrows at the bottom of the dialog box to scroll to the next journal in the list (for example, Journal 2 of 10).

5 When you finish reviewing journals, click OK.

Web Procedure

➤ To review journals:
1 From the Process Journals Web page, view the list of journals.
2 Click a journal to open and review it.

Journal Validation

When you submit, approve, or post a journal, the system validates the journal. The system checks for these conditions:

● The period must be a base period for the scenario’s base frequency.
● When you post or unpost a journal, the period must be opened
● The Value dimension must be an adjustment dimension.
● The journal must have the appropriate status for the action to be performed.
● Line items must exist for the journal.
● The entity and the parent must be valid dimensions. For regular journals, the entity must allow adjustments. If you are posting a journal to <Parent Currency Adjs>, you must enter a valid parent. Also, the entity must be a child of the specified parent for the journal entity.
● If you are posting a journal to a node, the parent must allow adjustments for child entities. The entity must be a child of the specified parent.
● Node journals must have valid parent-entity combinations. The system also checks for the Organization by Period application setting when you attempt to post node journals. The entity must be active for the parent for the period in which you are posting.
● The account must be valid. It must be an Asset, Liability, Revenue, Expense, Balance, Flow, or Balance Recurring account. The account must be a base account and cannot be calculated (that is, designated as calculated in metadata). It cannot be calculated through a roll-up; that is, the account cannot have children.
● All other dimensions must be valid. The ICP dimension cannot be ICP Top, ICP Entities, or left blank, but you can select [ICP None]. If an ICP is specified, the account must be set up as an ICP account.
● The custom dimensions cannot be designated as calculated in metadata and cannot be calculated through a roll-up; that is, the custom dimensions cannot have children.
● For a balanced journal, the total debits must equal the total credits. For a balanced by entity regular journal, the total debits must equal the total credits for each entity. For a balanced-by-entity node journal, the total debits must equal the total credits for each node. For a
balanced-by-entity node journal, the parent and children entities must have the same currency. If the Value dimension is <Entity Currency>, the parent entities in the journal can have different currencies, but they must have the same currency as their children entities.

- All intersections must be valid.
- The subcube containing the line item cell cannot be locked.
- The cell cannot be designated as a NoInput cell using rules.

Running Journal Reports

You can run journal reports to check the status of journals and to review adjustments for groups of journals. You can select columns to display on the report, and change the column sort order.

A default style sheet is provided for the report; however, you can apply and customize other style sheets. See “Applying Report Style Sheets” on page 137.

For specific reports, see these topics:

- “Running Journal Reports on the Desktop” on page 223.
- “Running Journal Reports on the Web” on page 224.

Running Journal Reports on the Desktop

When you create a report in the Journals module, the report definition is created automatically and displayed in the System Reports module on the Desktop. You can save the report locally or remotely, and you can set a report description. See “Saving Reports” on page 139 and “Setting Report Descriptions” on page 139.

Selecting Columns for Journal Reports

You can display these columns on a report: Label, Status, Type, Balance Type, Group, Description, Short Description, Security Class, Created by, Date Created, Approved by, Date Approved, Posted by, Date Posted, Entity, Parent, Account, ICP, Custom1, Custom2, Custom3, Custom4, and Line Description. The order in which the columns are displayed on the report reflects the order in which you list them in the Displayed list box.

To select columns to display on the report:

1. Click Process Journals.
2. Click Reports,  
3. Select Columns.
4. From Display Columns, select the columns to display on the report.
5. Drag the selected column to Displayed, or click  

➤
Tip:
To select all of the columns, click $\gg$.

6 To change the column order, drag the columns to rearrange their order.
7 Click OK.

Sorting Columns for Journal Reports

You can select the columns by which to sort and select the column sort order on the report. For example, you can sort journals by label in ascending or descending order. The order in which the columns are sorted on the report reflects the order in which you list them in the Sorted list box.

To select the column sort order:
1 Click Process Journals.
2 Click Reports.
3 From Displayed, select the columns to sort.
4 Drag the selected column to Sorted, or click $\gg$.

Tip:
To select all columns, click $\gg$.

5 To change column attributes, select the column in Sorted, and take one or more of these actions:

- To change the sort order, click Sort Order, and select Ascending or Descending.
- To have the column repeated for each journal, click Display, and select Repeat or No Repeat.
- To display totals for the column, click Totals, and select Yes to display totals or No to hide totals.

6 Click OK.

Running Journal Reports on the Web

You can run journal reports to check the status of journals and review journal adjustments that have been made to the database. You can select columns to display on the report, and you can change the column sort order.

A default style sheet is provided for the report; however, you can apply and customize other style sheets. See “Applying Report Style Sheets” on page 137.
You can save the report locally or remotely, and you can print reports for groups of journals or for individual journals. See “Saving Journal Reports” on page 226, “Printing Journal Reports” on page 227, and “Printing Reports for Individual Journals” on page 227.

To run journal reports:

1. From the Process Journals page, select the journals to display on the report.
2. Click Reports.
3. From Properties, enter a report Label and Description.
4. From the Point of View bar, select a scenario, year, period, and value for the report.
5. Select columns and display options for the report.


Displaying Columns for the Report

You can display these columns on a report: Label, Status, Type, Balance Type, Group, Description, Short Description, Created By, Date Created, Approved By, Date Approved, Posted By, Date Posted, Security Class, Entity, Parent, Account, ICP, Custom 1, 2, 3, or 4, and Line Description. The order in which the columns are displayed on the report reflects the order in which you list them in the Displayed Columns list box.

You can sort the columns by Ascending or Descending order. You can also specify whether to repeat the column label and display the total for the column. If the field is a dimension member, you can select whether to display the dimension member label, corresponding description, or both.

If you select the Totals option, a subtotal is displayed for the amounts in the column.

You can select whether to repeat the field information in every row. For example, if you select the Repeat option for the entity label, the system displays the entity label for all of the selected journals for that entity. If you do not select the Repeat option, the system displays the entity label for the first journal but not the labels for subsequent journals with the same label.

To select columns to display on the report:

1. From the Process Journals page, select the journals to display on the report.
2. Click Reports, and select Columns.
3. From Displayed Columns on the Columns tab, select the columns to display on the report.
4. From Displayed Columns, select the items to display in the columns.
5. Optional: To sort the columns, from Sort, select Ascending or Descending.
6. From Options, select an option:
   - To display the dimension member label, select Label.
   - To display the dimension member description, select Description.
To display both the dimension member label and description, select **Both**.

7 **Optional:** To repeat the information in every row, select **Repeat**.

8 **Optional:** To display the subtotal for the amounts, select **Totals**.

**Tip:**
To restore the columns to their default settings, click Restore Defaults.

8 **Click Close.**

### Filtering Journals for Reports

You can filter the list of journals to display on the report. You can filter the list by entity, label, group, description, status, type, or balance type. You can enter text filters, including the percent (%) symbol as a wildcard, or you can leave a text box blank to avoid filtering.

**Note:**
Depending on the setup of your database, text boxes for journal filters might be case-sensitive. For example, filtering with “testgroup” might return different results than filtering with “TestGroup.”

**To filter journal lists:**

1 From the **Process Journals** page, select the journals to display on the report.

2 **Click Reports** and select the **Filter**.

3 To filter by entity, enter an entity name or **click Browse** and select an entity.

4 To filter by label, group, or description, enter text or use the percent (%) symbol as a wildcard.

5 To filter by status, select an option: **Working**, **Submitted**, **Approved**, **Rejected**, or **Posted**.

6 To filter by type, select one or more options: **Auto-reversing**, **Regular**, **Auto-reversal**.

7 To filter by balance type, select an option: **Balanced**, **Unbalanced**, or **Balanced by Entity**.

8 **Click OK**.

9 **Optional:** To restore the list to its default status, click **Restore Defaults**.

### Saving Journal Reports

You can save the report locally or remotely on a server.

**To save reports locally:**

1 From the **Reports** page, open the report to save.

2 **Click Save Local**.

3 **Click OK** to download the report.
To save reports on the server:
1. From the Reports page, open the report to save.
2. Click Save Remote.
3. Enter a report file name.

**Note:**
The report name can contain a maximum of 20 characters. Do not use double quotes or an equal sign in the report name.

4. Save as a report definition, XML, or HTML file.
5. From Security Class, select a report security class.
6. To overwrite a file, select Overwrite an existing file.
7. Click OK, and click Close.

### Printing Journal Reports
You can preview and print reports that you created and saved on the local client computer or the server.

To print journal reports:

1. From the list of journals, select the journal for which to print a report.
2. Click Reports.
3. Select the columns to display on the report.
4. Click Print/Preview.
   
   The report is displayed in a separate browser window.
5. To print the journal report, select File > Print.

### Printing Reports for Individual Journals
In addition to printing reports on multiple journals, you can print a report on an individual journal. This can be useful for auditing purposes. The report contains the journal header information, detail information in rows and columns, debit and credit information, variance,
and line descriptions as they are displayed on the screen. The comments at the bottom of the report correspond to the line detail in the journal.

**Note:**

When you print a report on a selected journal from within the journal, you cannot select the columns or format. For instructions on selecting options for reports, see "Printing Journal Reports" on page 227.

➤ To print reports for individual journals:

1. **Select Tasks > Journal Tasks > Process Journals.**
2. **Open the journal for which to print a report.**
3. **Click Print.**
   The Journal report opens in a new browser window.
4. **Click File > Print.**

### Deleting Journals

You can delete unposted journals that you no longer need. You cannot delete Approved or Posted journals.

#### Windows Procedure

➤ To delete journals:

1. **Click Process Journals.**
2. **Select Working or Submitted** on the process pad to view journals with those statuses.
3. **From Process Journals,** select a scenario, year, period, and value.
4. **Select the journals to delete.**
5. **Press Delete.**
6. **Click Yes.**

#### Web Procedure

➤ To delete journals:

1. **From the journals list, select the journal to delete, and click Delete.**
2. **Click OK.**

**Tip:**

You can also delete a journal if you have the journal open.
About Process Management

Process management is the management of the review and approval process of financial data. You can use process management to submit budget plans and get them approved efficiently, and to transfer ownership of data. In a centralized environment, you can also use process management to provide review control and to ensure data privacy.

You use process management to review, submit, promote, approve, reject, or publish process units. A process unit is the combination of data for a specific scenario, year, period, entity, and value.

Enabling Process Management

Before you can use Process Management, you must set the Enable Process Management attribute for the Scenario dimension in the metadata file. When you enable this attribute, Process Management is available for the scenarios that you enabled.

When you select a cell, Process Management is available only for the input frequency of the scenario. For example, if the input frequency is months, Process Management is available when
you select January, but is not available when you select a quarter, such as Q1. In addition, if you select multiple cells and your selection includes a data cell in which Process Management is not supported, the Process Management option is not available.

If Process Management is enabled for a scenario, the system performs validation checks for each process unit as the data moves from one level to the next. See “Process Management Validation” on page 255.

## Accessing Process Units

You can access data in a process unit based on a combination of these items:

- Your assigned security role.
- The current process level of the process unit.
  See “Process Levels” on page 231.
- Your access rights to the process unit.
  Access rights can be None, Read, Promote, or All.
    - If your access rights are None, you have no access to the process unit.
    - If you have Read access rights, you can only view data for the process unit.
    - If you have Promote access rights, you can view data and also promote an entity even if you do not have All access.
    - If you have All access rights, you have complete access to the process unit, including the ability to view and to modify the data. See the Hyperion Financial Management — System 9 Administrator’s Guide.

## Process Management Security Roles

If Process Management is enabled for any scenario in the application, the application administrator must assign specific security roles to each individual user. An administrator can assign one or more security roles to users. See the Hyperion Financial Management — System 9 Administrator’s Guide.

To start Process Management, you must be assigned the Review Supervisor security role. After the Review Supervisor starts a process unit and promotes it to First Pass status, other users can review it, enter or change data, and promote it to the next level. If you have the Submitter security role, you can also skip levels of review and promote the data to the Submitted status.

You can have up to 12 security roles in an application.

<table>
<thead>
<tr>
<th>Security Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review Supervisor</td>
<td>The Review Supervisor has the access rights to start a process unit that allows input to the entity’s data, and has the access rights to approve and publish the data. To promote or reject</td>
</tr>
</tbody>
</table>
Security Role | Description
---|---
| a process unit, the Review Supervisor may also need the Reviewer 1-10 role, depending on the process level. See “Process Levels” on page 231.

Submitter | The Submitter has the access rights to move the process unit to the final stage of the review process so that it is ready for approval. Although the default action is to promote the process unit to the next level, a Submitter can skip many levels of review and go directly to the last process level (Submitted) before final approval.

Reviewer 10 | This user cannot promote a process unit to any level, because there is no next level available. To move the process unit to the Submitted level for final approval, the user must also have the security role of Submitter. This user is able to reject a process unit.

Reviewer 1 through 9 | This user can promote a process unit to the next level, or reject a process unit. See “Process Levels” on page 231.

**Process Levels**

The possible process levels are shown in Table 28 with a description of each level and the access rights that are required.

**Table 28 Process Levels**

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Started</td>
<td>Process unit has not been started by the Review Supervisor and no data can be entered by any users except the Supervisor. Only the Supervisor who has All access rights to the entity can change the process unit level to First Pass.</td>
</tr>
<tr>
<td>First Pass</td>
<td>Process unit has been started and is in the initial stage for data to be entered by any user with the proper access rights. Any user with Read or Promote access to the entity can view the entity’s data. Any user with All access to the entity can modify the entity’s data. No security role is checked when the process unit is in the First Pass level.</td>
</tr>
<tr>
<td>Review Levels 1 through 10</td>
<td>Process unit is at the beginning of the review process after initial data entry. To view data, a user needs access rights of Read, Promote, or All, and a security role of less than or equal to the process level of the data. To modify data or change the status, a user needs access rights of All and a security role equal to the process level of the data.</td>
</tr>
<tr>
<td>Submitted</td>
<td>Process unit has been submitted and is ready for final approval. To view data, a user needs access rights of Read, Promote, or All, and a security role. To modify data or change the status, a user needs access rights of All and the Review Supervisor security role. Submitted level is the common final process level before a process unit can be approved. If you have the Submitter security role, you have the option to skip levels of review and promote the process unit directly to the Submitted level.</td>
</tr>
<tr>
<td>Approved</td>
<td>Process unit has been approved. To view data, a user needs access rights of Read, Promote, or All, and any security role. To modify data or change the status, a user needs access rights of All and the Review Supervisor security role.</td>
</tr>
<tr>
<td>Published</td>
<td>Process unit has been published for public access. To view data, a user needs access rights of Read, Promote, or All, and any security role. To modify data or change the status, a user needs access rights of All and the Review Supervisor security role.</td>
</tr>
<tr>
<td>Level</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Not Supported</td>
<td>Process Management is not enabled for the scenario.</td>
</tr>
</tbody>
</table>

**Note:**
The ability to modify data also includes the ability to post journals.

**Process Levels for Summary Time Periods**
The process level that is displayed for summary time periods corresponds to the process level for the last period in that interval. For example, if your fiscal year begins in July, the system displays the process level for September as the process level for Quarter 1. If you select multiple cells for Quarter 1, for example, July, August, and September, and update the process level, the system displays an error message when it attempts to process Q1, because Q1 is not an input period. If you update the process level for the last period in the interval, September, the level is reflected for Q1.

**Review Levels and Submission Phases**
If you are using Submission Phases in process management, the review level for each process unit is stored by submission phase. You must promote each submission phase independently. The rules for promotion to each review level still apply, and in addition, there is the following dependency based on the submission phase number:

The review level of a submission phase must be less than or equal to the review level of all the lower numbered phases in that subcube.

For example, if an account is in Submission Phase 1 and the Review Level for Submission Phase 1 is Review Level 4, you cannot promote accounts in Submission Phase 2 to a review level greater than 4. If Balance Sheet and Profit/Loss accounts are Submission Phase 1 accounts, and Submission Phase 1 has Review Level 4 status, you cannot promote Supplemental accounts, which are Submission Phase 2 accounts, to a review level greater than 4. In the same way, you cannot reject a process unit if it violates the submission phase rule.

For information on setting up submission phases, see the *Hyperion Financial Management — System 9 Administrator’s Guide*.

**Starting Process Management**
The Review Supervisor must start a process unit before other users can enter data or perform any process management actions. The Review Supervisor or an administrative user are the only users who can access a process unit when the status is Not Started. See “Process Management Security Roles” on page 230.

After a Review Supervisor starts a process unit, its process level changes to First Pass.
You can start Process Management from a data grid or from the Process Control module. When you start a process unit from the Process Control module, you can select a data view and filter and sorting options. See “Using Process Control” on page 233.

To start Process Management from Process Control:

1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Select a scenario, year, and period.
4. From Data View, select Local, Translation, or Contribution.
   See “Selecting the Data View” on page 235 and “Using Process Control” on page 233.
5. Optional: To change the top member for the entity list, use one of these methods:
   - Enter a top member in the Top Member text box, and click Update to refresh the list.
   - Click Browse, and select a top member.
   - Click the Entity link at the top of the entity column, and select a top member.
6. Optional: Select the options for displaying, filtering, and sorting members.
   See “Setting Process Control Options” on page 236.
7. Select the process unit to start.
8. Click Manage Process and select Start, or select Manage Process > Start from Actions.
9. Optional: Enter a comment in Comments, or attach a document for more detail.
   See “Attaching Documents to a Process Unit” on page 246.
10. Optional: If you are using the Tree view, select Selected Entity Only or Selected Entity and Descendants.
11. Click Start.

To start Process Management from a data grid:

1. From a data grid, select the cell for which to start Process Management.
2. Right-click and select Manage Process.
3. From Action, select Start.
4. Optional: Enter a comment in Comments, or attach a document for more detail.
5. Click OK.

Using Process Control

You can use Process Control to perform Process Management tasks as an alternative to using data grids. The Process Control module provides a centralized place for review and consolidation processes, and enables you to easily view process validation. It also provides calculation and journal status, and the ability to drill down into details for journals, consolidation status, and
currency rate information. In addition, you can generate and receive e-mail alerts about process management status.

➤ To access the Process Control module, in the File Browser expand Tasks, select Data Tasks, and select Process Control.

<table>
<thead>
<tr>
<th>Process Control Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of the Process Control tasks are available from the Manage Process menu for the process units for which you have access rights. See these procedures:</td>
</tr>
<tr>
<td>● “Selecting the Data View” on page 235</td>
</tr>
<tr>
<td>● “Selecting Entities for Process Control” on page 236</td>
</tr>
<tr>
<td>● “Setting Process Control Options” on page 236</td>
</tr>
<tr>
<td>● “Starting Process Management” on page 232</td>
</tr>
<tr>
<td>● “Promoting Process Units” on page 247</td>
</tr>
<tr>
<td>● “Submitting Process Units” on page 249</td>
</tr>
<tr>
<td>● “Approving Process Units” on page 250</td>
</tr>
<tr>
<td>● “Viewing Process History” on page 254</td>
</tr>
<tr>
<td>● “Signing Off on a Process Unit” on page 252</td>
</tr>
<tr>
<td>● “Publishing Process Units” on page 252</td>
</tr>
<tr>
<td>● “Calculating Data from Process Control” on page 247</td>
</tr>
<tr>
<td>● “Translating Data from Process Control” on page 247</td>
</tr>
<tr>
<td>● “Consolidating Data from Process Control” on page 247</td>
</tr>
<tr>
<td>● “Viewing the Process Control Summary” on page 242</td>
</tr>
</tbody>
</table>
Selecting the Data View

The Process Control window displays a point of view with these dimensions: Scenario, Year, and Period. You can change any of these dimensions.

You can select these data views for Process Control: Local, Translation, or Consolidation. The system uses the corresponding Value dimension in the point of view and displays the calculation status and journal status based on the data view that you select. In addition, the system uses the corresponding Value dimension for the process unit validation. See “Viewing Calculation Status” on page 244, “Viewing Journal Status” on page 245, and “Viewing Validation Detail” on page 243.

Local View

When the Local Data View is selected, the Calculation Status (Calc Status) column is based on the Entity Currency Total member (<Entity Curr Total>) of the Value dimension. The Journal Status column (ECA Status) is based on the Entity Currency Adjustment member (<Entity Curr Adjs>) of the Value dimension.

Translation View

When the Translation Data View is selected, the Calculation Status (Calc Status) column is based on the Parent Currency Total member (<Parent Curr Total>) of the Value dimension. The Journal Status column (PCA Status) is based on the Parent Currency Adjustment member (<Parent Curr Adjs>) of the Value dimension.

Consolidation View

When the Consolidation Data View is selected, the Calculation Status (Calc Status) column is based on the Contribution Total member ([Contribution Total]) of the Value dimension. The Journal Status columns (PA and CA Status) are based on the Parent Adjustment ([Parent Adjs]) and Contribution Adjustment ([Contribution Adjs]) members of the Value dimension.
Selecting Entities for Process Control

The Process Control rows display the list of entities based on the selected top member of the entity. The entity list can be a user-defined list, or a system list such as Hierarchy, Descendant, Ancestors, Children, or Base. The top member text box is populated based on the entity that you are using in your point of view for the data grid. You can change the top member to filter the list of entities.

If you select a Hierarchy entity list, you can display the entities in a Tree view or a list view. If the entities are displayed in a Tree view, you can expand and collapse the hierarchy using the plus (+) and minus (-) signs next to the entity. When you use a Tree view, sorting and filtering are not available for rows. When you use a list view, sorting and filtering are available. See “Setting Process Control Options” on page 236.

➤ To select entities for Process Control:

1. Select a scenario, year, and period for which to perform process management actions.
2. From Data View, select Local, Translation, or Consolidation.
3. Optional: To change the top member, enter a top member in Top Member, and click Update to refresh the list.
4. Select the options to display the list of entities. See “Setting Process Control Options” on page 236.

Selecting Multiple Rows for Process Control

You can select multiple rows on which to perform process management actions. You can select contiguous or noncontiguous rows, or all rows. When you perform a process management action, the action applies to all selected items.

➤ To select multiple rows, from the Process Control module, use these options:

- To select contiguous rows, highlight a row and drag to select additional rows.
- To select noncontiguous rows, highlight a row, press and hold Ctrl, and select additional rows.
- To select all rows, click the top left cell corner of the grid.

Setting Process Control Options

You can select options to display the list of entities and review levels.

For applications that are not set up for phased submissions, Process Control displays one page of options for process control units. See “Setting Options for Applications without Phased Submissions” on page 238.

For applications with phased submissions enabled, Process Control options are displayed on two tabs (Row and Column) and include phased submission options. See “Setting Options for Phased Submissions Applications” on page 239.
You can display this information:

- Review Level; for example, Started, First Pass, Review Level 1, Approved. See “Process Levels” on page 231.
- Pass/Fail status, which displays whether the process unit is ready for promotion to the next level. See “Viewing the Pass or Fail Status” on page 242.
- Validation status, which displays the validation status for the entity based on the amount stored in the Validation account for the entity. See “Viewing Validation Detail” on page 243.
- Calculation status, for example, OK, NODATA, CH. See “Viewing Calculation Status” on page 244.
- Journal status, which displays a red or green flag for the status of journals for the entity, such as Entity Currency Adjustments, Parent Currency Adjustments, Parent Adjustments, or Contribution Adjustments. See “Viewing Journal Status” on page 245.

**Style**

You can display the entity list as a flat list or Tree hierarchy format. You can only use a Tree view if you select the [Hierarchy] system list. All other lists are displayed in the flat list view.

When the entities are displayed in a Tree view, you can expand and collapse the hierarchy using the plus (+) and minus (-) signs next to the entity. When changing the process level in a Tree view, you can choose to apply the action to the current selected entity only or to the selected entity and its descendants. Using the entity and descendants option allows you to perform an action without having to manually expand the entire organization.

When the list is displayed in a Tree view, no sorting or filtering is available for rows.

**Filters**

When you use a list view, sorting and filtering are available. For example, you can filter rows based on the review level and display all rows above or below a specific review level, such as all levels above First Pass. You can sort rows by review levels in descending or ascending order.

You can filter rows by validation status, such as Pass Only or Fail Only. You can also filter rows by calculation status, such as OK, CN, or TR. See “Viewing Calculation Status” on page 89.

After you set sorting and filtering options, the settings are displayed in tool tips for the columns in the Process Control window.

**Period View**

You can view one period or all periods. When you select All, you must also select Process Review Level or Calculation Status to display in the columns. The selected information is displayed across the columns for all the periods in the scenario.
**Entity View**
You can view entity information using the entity label, description, or both. The default setting is to display the label.

**Show Active Only**
If you are using an application set up for Organization by Period, you can display only the active descendants for a parent entity.

**Page Size**
Depending on the entity list selection, it is possible to display many entities in the Process Control window. To minimize the performance issue with a large number of entities, you can select the number of entities to display on the page.

You can also use the Up and Down arrows in the toolbar to navigate to the next or previous pages.

**Setting Options for Applications without Phased Submissions**

➤ To set Process Control options for applications without phased submissions:

1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Click Options ( ).
4. Select a style:
   - To display the entities in a list view, select List.
   - To display the entities in Tree hierarchy format, select Tree.

   **Note:**
   When you select the Tree view option, it sets your system list to [Hierarchy] and displays the Tree view.

5. Optional: If you use a list view, you can select filter and sorting options as follows:
   - To filter the list by review levels, from Review Levels, select a review level, and select an option:
     - and Above
     - and Below
     - Only
     If you do not change the default value of All, all review levels are displayed.
   - To sort review levels, from Sort Review Levels, select an option:
None
Descending
Ascending

To filter the list by Pass or Fail status, from the Show drop-down list, select an option:

- Pass Only
- Fail Only
- Pass and Fail

To filter the list by calculation status, select a Status option.

6 From Period View, select Single or All.

- If you select All, from Display select an option to display in the columns:
  - Process Level
  - Calc Status

The selected information is displayed across the columns for all the periods within the scenario.

7 From Entity View, select an option:

- To view the entity information using the label, select Label.
- To view the entity information using the description, select Description.
- To view the entity information using both the label and description, select Both.

8 Optional: To show only active entities for the parent entity, select Show Active Only.

Note:
This option is available only if the application is set up for Organization by Period.

9 Select one or more Review Options: Review Level, Pass/Fail, Validation.

10 Optional: Select one or both of these statuses: Calc Status, Journal Status.

11 Optional: To set the rows per page, enter a Rows Per Page value or use the default value.

12 When you finish selecting options, click OK to save the settings.

Setting Options for Phased Submissions Applications

➢ To set Process Control options for phased submissions applications:

1 In the Browser View, expand Tasks and select Data Tasks.

2 Select Process Control.

3 Click Options ( ).
Setting Row Options

To set row options:

1. Select the Row tab.
2. Select a style:
   - To display the entities in a list view, select List.
   - To display the entities in Tree hierarchy format, select Tree.
   
   **Note:**
   When you select the Tree view option, it sets your system list to [Hierarchy] and display the Tree view.
3. From Entity View, select an option:
   - To view the entity information using the label, select Label.
   - To view the entity information using the description, select Description.
   - To view the entity information using both the label and description, select Both.
4. Optional: To show only active entities for the parent entity, select Show Active Only.
   
   **Note:**
   This option is available only if the application is set up for Organization by Period.
5. Optional: If you use a list view, you can select filter and sorting options as follows:
   - To filter by phases, select a phase.
   - To filter by review levels, from Review Levels, select a review level, and select an option:
     - and Above
     - and Below
     - Only
     If you do not change the default value of All, all review levels are displayed.
   - To filter the list by Pass or Fail status, from the Show drop-down list, select an option:
     - Pass Only
     - Fail Only
     - Pass and Fail
   - To filter the list by status, select an option: All, Calc Status, or Journal Status.
6. Optional: To set the rows per page, enter a Rows Per Page value or use the default value.
Setting Column Options

To set column options:

1. Click the Column tab.
2. For Period View, click Single or All.
3. If you selected Single view, select one or more phases, review options, and status to display.
4. If you selected All view, from the Phase dropdown, select a phase, and from the Options dropdown, select an option.
5. When you finish selecting options, click OK to save the settings.

Displaying Multiple Phases in Process Control

You can display multiple submission phases, view review level status, and perform process management actions for multiple phases in Process Control.

If you select Single period view, you can select one or more submission phases to include in the columns. For each column, you can display one or more of these options: Calculation Status, Journals, Review Level, Pass/Fail, and Validation. If selected, Review Level, Pass/Fail, and Validation are included for each phase. Since Calculation Status and Journals apply to the entire processing unit, they are displayed only once regardless of how many phases are selected.

If you select All period view, you can select Calculation Status or Review Level information for the columns. If you select Review Level information, you should select one submission phase for display. When you select All periods, or Tree for the display, the filter option is unavailable.

Using the Process Control Toolbar

You can select process control options from the toolbar at the top of the grid.

<table>
<thead>
<tr>
<th>Table 29 Process Control Toolbar Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
</tr>
<tr>
<td>Options</td>
</tr>
<tr>
<td>Refresh grid</td>
</tr>
<tr>
<td>Manage process</td>
</tr>
<tr>
<td>Consolidate</td>
</tr>
<tr>
<td>Calculate</td>
</tr>
<tr>
<td>Translate</td>
</tr>
</tbody>
</table>
Viewing the Process Control Summary

You can view a status summary of the entities displayed in the Process Control window. The summary displays the status of all entities without filter selections. The Review Level summary lists the total number of entities by their review level. The Calculation Status summary displays a summary by calculation status for all entities included in the Process Control window, not just the ones displayed on the current page.

➤ To view the summary page:

1 From the Process Control window, select the Scenario, Year, Period, and Top Member Entity process unit for which to view a summary.

2 Click Summary and select Review Level Summary or Calculation Status Summary.

Tip:

You can also access the Summary option from the Actions menu or by right-clicking on a row.

The summary opens in a separate window.

3 When you finish viewing the summary, click Close Window.

Viewing the Pass or Fail Status

The icons in the Pass/Fail column show whether the process unit is ready for promotion to the next level. To determine whether the process unit passes or fails, the system checks the calculation status and the Validation account amount. Depending on the data view selected for Process Control, the system checks the calculation status and Validation account of the corresponding Value dimension of the entity as shown in Table 30. The value used for the validation is the validation account cell with the Custom dimension as the top member.

If the application uses submission phases, you can display a phase and view its Pass/Fail status.
If the calculation status is OK or NODATA and if the Validation account amount is zero or NODATA, the Pass/Fail column displays a check mark indicating that the unit is ready for promotion. If the process unit fails, the Pass/Fail column displays an X.

When the system checks for Pass/Fail status, it checks for derived data in the current period. A period can contain derived data if the validation account is a Flow account and if the ZeroViewForNonAdj metadata attribute is set to Periodic for the scenario. A unit with a calculation status of NODATA passes only if there is no data in prior periods. If a unit has a calculation status of NODATA but data exists in the prior period, the process unit displays a Fail status. For example, if you have no data in January, the calculation status for January is NODATA with a status of Pass. If you have data in January but no data in February, the status is Fail because February has derived data from January. In this case, you must perform calculation in the current period to ensure that the data is valid for promotion. After calculation, the calculation status is updated to OK, and the status of the column changes to Pass.

See “Viewing Validation Detail” on page 243.

> To view the Pass/Fail status, from Process Control, select the entities for which to show status. The Pass/Fail status is displayed in the Pass/Fail column.

### Viewing Validation Detail

The Validation Detail page enables you to view the supporting detail for the process unit, such as calculation status and Validation account information. It displays all children associated with the Validation account and any balances contained in those accounts.

If the application uses submission phases, you can display a phase and view its validation detail.

When you drill down to the detail screen, this information is displayed:

- Calculation status
- Validation account amount

Depending on the Data View option that you selected for the process unit, the system displays different data values. For example, if the Data View is Local Data, the system displays `<Entity Curr Total>`, `<Entity Curr Adjs>` and `<Entity Currency>`. If the Data View is Translate Data, the system displays `<Parent Curr Total>`, `<Parent Curr Adjs>` and `<Parent Currency>`. If the Data View is Consolidation Data, the system displays the `[Parent Adjs]`, `[Proportion]`, `[Elimination]`, `[Contribution Adjs]` and `[Contribution Total]`. 

---

**Table 30  Data View and Value Dimension for Process Control**

<table>
<thead>
<tr>
<th>Data View</th>
<th>Value Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Data</td>
<td><code>&lt;Entity Curr Total&gt;</code></td>
</tr>
<tr>
<td>Translate Data</td>
<td><code>&lt;Parent Curr Total&gt;</code></td>
</tr>
<tr>
<td>Consolidation Data</td>
<td><code>[Contribution Total]</code></td>
</tr>
</tbody>
</table>
The Raw Data option displays the data in units. The Formatted Data option displays data in the scaled value based on the scale of the currency assigned to the entity.

For example, suppose the Entity dimension member, WestSales, displays an X in the Validation column. To view more information, you can click the X in the column. The following figure shows the Validation account detail for the WestSales account.

Figure 8 Sample Validation Detail

In the example, there are two validation accounts: Surplus and ICMatch. The Surplus account contains a balance, causing West Sales to fail validation. WestSales is not ready for promotion because the Validation account does not equal zero. It cannot be promoted until the Surplus account has been balanced.

➤ To view the validation detail:

1 From the Process Control window, select the entities for which to show validation detail.
2 For the selected entity, double-click its icon in the Validation column.

Tip:

You can also click the icon for the entity in the Pass/Fail column.

The validation detail is displayed in a separate window.

3 Select one of these options:
   ● To display the data in units, select Raw Data.
   ● To display the data in the scaled value based on the scale of the currency assigned to the entity, select Formatted Data.

4 When you finish viewing validation detail, click Close Window.

Viewing Calculation Status

The Calc Status column displays the calculation status for the entity. Depending on the data view selected for Process Control, the system checks the calculation status and Validation account of the corresponding Value dimension of the entity.
To view calculation status, from the Process Control window, select the entity top member for which to show calculation status.

The calculation status is displayed in the Calc Status column.

Viewing Journal Status

The journal status (ECA, PCA, PA, or CA) column displays the status of journals for the entities in the selected entity list.

If you use the Local data view, the column displays the status of the Entity Currency Adjustments (ECA).

If you use the Translation data view, the column displays the status of the Parent Currency Adjustments (PCA).

If you use the Consolidation data view, the system displays a column for the status of the Parent Adjustments (PA) and a column for the Contribution Adjustments (CA).

A green flag in the journal status column indicates that there are no unposted journals. A red flag is a warning that there are unposted journals that need to be posted for the entity. When you hover the mouse over the flag, the system displays the number of unposted journals to which the entity has security access. When you click the flag, the system opens the Journals module so that you can view the unposted journals for the process unit that you selected. You can then post the journals.

Note:

Only the list of unposted journals to which you have security access is displayed.

To view the journal status:

1. From the Process Control window, select the entity top member for which to show journal status.

The journal status is displayed in the ECA, PCA, PA, or CA Status column.

2. Optional: If the column displays a red flag indicating unposted journals for a process unit, click the flag to open the Journals module and view the unposted journals.

Tip:

To return to Process Control, select it from the view pane.

Viewing Rate Data

From Process Control, you can link to a data grid on the Web to view rate data. You can then make any changes to the rate directly from the data grid.

To use this link, you must have previously created a data grid named “Rates” that contains rate information. See Chapter 5, “Using Data Grids on the Web”.

Using Process Control 245
To view rate data:

1. From the Process Control window, select the process control unit for which to view rates.

2. From the toolbar, click Rates.

   The system opens the Rates data grid that you previously defined. If you do not have a Rates data grid, an error message is displayed.

**Viewing Manage Ownership Information**

From Process Control, you can link to an ownership management grid to view ownership information. See Chapter 8, “Managing Ownership”.

To view ownership management information:

1. From the Process Control window, select the process control unit for which to view ownership management information.

2. From the toolbar, click Manage Ownership.

**Attaching Documents to a Process Unit**

From Process Control, you can attach one or more documents to cells for additional detail. For example, you can attach a Microsoft Word document, Excel spreadsheet, XSL, or RPT file. To attach or extract any custom documents to or from the server, you must be assigned the Manage Custom Documents security role.

You can set a size limit for document attachments and a maximum number of document attachments by user when you create an application. You set the limits in the AppSettings attribute for the application metadata.

You can attach multiple documents; however, Hyperion recommends that you not attach more than three documents to a cell. Each document should be smaller than 100K to limit the performance effect on the database.

After you attach a document to a process unit, you can download the document, but you cannot detach it from the process unit.

To attach a document to a cell:

1. Select the process unit for which to attach a document.

2. Select a process unit action.

3. Click Attach.

4. From your list of custom documents, select one or more documents to associate with the process unit, and click Attach.
Note:
You cannot attach private documents.

The document is associated with the scenario, year, period, and entity combination and the process level.

**Calculating Data from Process Control**
You can calculate and force data calculation for process units if you have the appropriate security access rights. See “Calculating Data” on page 108.

- To calculate or force data calculation:
  1. From Process Control, select the process unit for which to calculate data.
  2. Click Calculate, or right-click and select Calculate or Force Calculate.

**Translating Data from Process Control**
You can translate data and force data translation for process units if you have the appropriate security access rights. See “Translating Data” on page 109.

- To translate or force data translation:
  1. From Process Control, select the process unit for which to translate data.
  2. Click the Translate, or right-click and select Translate or Force Translate.

**Consolidating Data from Process Control**
You can consolidate data, calculate contribution, and force a contribution calculation for process units if you have the appropriate security access rights. See “Consolidating Data” on page 111.

- To consolidate data, calculate contribution and force a contribution calculation:
  1. From Process Control, select the process unit for which to consolidate or calculate contribution.
  2. Click Consolidate, or right-click and select Consolidate, Consolidate All, Consolidate All with Data, Calculate Contribution, or Force Calculate Contribution.

**Promoting Process Units**
The Process Management dialog box displays the current level of the selected process unit, available actions, and the promotion levels available depending on the current status and your security role.
To promote a process unit to the next process level, you must be assigned the appropriate security role and access rights for the process unit. For example, if the process unit is at Review Level 2, you must have the access right of All or Promote for the entity’s data, and you must be assigned the role of Reviewer 2 to promote it. See “Process Management Security Roles” on page 230.

**Note:**

When a process unit has a First Pass status, the system does not perform a check for security roles. Any user who has All access to the entity can modify the data.

The process unit must have a calculation status of OK, OK SC, or NODATA, and a zero balance in the validation account before you can promote it.

When you attempt to promote the parent entity data to the next process level, validation checks are performed to verify that the children entities are at the level to which you are trying to promote the parent. A parent can only be promoted to a level that is less than or equal to the lowest level of its immediate children.

If your application uses phase submissions, when you select a cell, the system determines the submission phase that applies to the cell. There can only be one review status for each submission phase, so when you promote the cell, you promote all the cells for that submission phase. When you promote multiple cells in the data grid, the system determines all submission phases that apply to those cells and promotes the phases at the same time, depending on the review level dependency rules.

After you promote a process unit, its process level changes to the next process level. You can promote a process unit up through Review Level 10, which is the last process level. When a process unit has a status of Review Level 10, you can submit it for approval. See “Submitting Process Units” on page 249.

**Note:**

If you receive javascript errors during the promotion process, you might need to increase the timeout setting for the Oracle's Hyperion® Reporting and Analysis – System 9 proxy server. See the *Hyperion Reporting and Analysis — System 9 Installation Guide*.

To promote process units from Process Control:

1. **In the Browser View, expand Tasks and select Data Tasks.**
2. **Select Process Control.**
3. **Set the rows and columns.**
   - See “Selecting Entities for Process Control” on page 236.
4. **Select the process unit to promote.**
5. **Click Manage Process and select Promote.**
6. **From Review Level, select a review level to which to promote the process unit.**
7. **Optional: Enter a comment in Comments, or attach a document for more detail.**
Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants. Click Promote.

To promote process units from a data grid:
1. From a data grid, select the cell for the process unit to promote.
2. Right-click and select Manage Process.
3. For Action, select Promote.
4. For Promotion Level, select the review level for the process unit.
5. Optional: Enter a comment in Comments, or attach a document for more detail.
6. Click OK.

Submitting Process Units

You submit a process unit to indicate that it is ready for approval. To submit a process unit for approval, you must be assigned the Submitter security role and All or Promote access rights. If you are assigned the Submitter security role, you can submit the process unit from any level except Not Started.

When you submit a process unit to the final stage of the review process, it indicates that the file is ready for approval. The default review action is to promote a process unit to the next level. However, the submitter can skip levels of review and go directly to the process level before final approval.

The submitter must also have the reviewer role for the current level to promote a process unit. For example, a submitter who has Review Level 5 and Submitter security roles can promote a process unit to Review Level 6 or submit the process unit.

The process unit must have a status of OK, OK SC, or NO DATA before you can submit it. After you submit a process unit, its process level changes to Submitted. When a process unit has a Submitted status, you must be assigned the Review Supervisor security role to change the data, promote it to Approved status or reject it.

To submit process units from Process Control:
1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Set the rows and columns.
   See “Selecting Entities for Process Control” on page 236.
4. Select the process unit to submit.
5. Click Manage Process and select Submit.
6. Optional: Enter a comment in Comments, or attach a document for more detail.
   See “Attaching Documents to a Process Unit” on page 246.
7 Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants.
8 Click Submit.

➤ To submit process units from a data grid:
1 Select the cell for the process unit to submit.
2 Right-click and select Manage Process.
3 For Action, select Submit.
4 Optional: Enter a comment in Comments, or attach a document for more detail.
5 Click OK.

Approving Process Units

A process unit in the Submitted status indicates that it is ready for approval. To approve a process unit, you must be assigned the Review Supervisor security role and All or Promote access rights. See “Process Management Security Roles” on page 230.

The process unit must have a status of OK, OK SC, or NO DATA before you can approve it. After you approve a process unit, its status changes to Approved. When a process unit has an Approved status, you must be assigned the Review Supervisor security role and All access rights to modify the data, reject it, or promote it to the next level by publishing the data.

➤ To approve process units from Process Control:
1 In the Browser View, expand Tasks and select Data Tasks.
2 Select Process Control.
3 Set the rows and columns.
   See “Selecting Entities for Process Control” on page 236.
4 Select the process unit to approve.
5 Click Manage Process and select Approve.
6 Optional: Enter a comment in Comments, or attach a document for more detail.
   See “Attaching Documents to a Process Unit” on page 246.
7 Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants.
8 Click OK.

➤ To approve process units from a data grid:
1 Select the cell for the process unit to approve.
2 Right-click and select Manage Process.
3 For Action, select Approve.
4 Optional: Enter a comment in Comments, or attach a document for more detail.
Rejecting Process Units

To reject a process unit to its previous state, you must be assigned the appropriate security roles and access rights for the process unit; for example, Read or Promote access rights. If the process unit has a status of Published, you must have All access rights to reject it. See “Process Management Security Roles” on page 230.

When you reject a process unit, the system automatically returns the process unit to its previous state. For example, when you reject a process unit that is at Review Level 2, it returns to Review Level 1. If a process unit that was at Review Level 5 has been Submitted by skipping several process levels, when you reject it, it returns to Review Level 5, which is the previous state, not Review Level 10, which is the process level before Submitted.

When a process unit has a First Pass status, only the Review Supervisor can reject it and return it to Not Started status. If a user rejects a process unit with an Approved status, its status returns to Submitted.

To reject process units from Process Control:
1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Set the rows and columns.
   See “Selecting Entities for Process Control” on page 236.
4. Select the process unit to reject.
5. Click Manage Process and select Reject.
6. Optional: Enter a comment in Comments, or attach a document for more detail.
7. Click Reject.

To reject process units from a data grid:
1. Select the cell for the process unit to reject.
2. Right-click and select Manage Process.
3. For Action, select Reject.
4. Optional: Enter a comment in Comments, or attach a document for more detail.
5. Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants.
6. Click OK.
Signing Off on a Process Unit

You can sign off on a process unit from Review Level 1 or higher. When you sign off on a process unit, its status does not change. The system records the action in the log file as an audit trail for informational purposes only.

➢ To sign off on process units from Process Control:

1 In the Browser View, expand Tasks and select Data Tasks.
2 Select Process Control.
3 Set the rows and columns.
   See “Selecting Entities for Process Control” on page 236.
4 Select the process unit on which to sign off.
5 Click Manage Process and select Sign Off.
6 Optional: Enter a comment in Comments, or attach a document for more detail.
   See “Attaching Documents to a Process Unit” on page 246.
7 Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants.
8 Click OK.

➢ To sign off on process units from a data grid:

1 Select the cell for the process unit sign off.
2 Right-click and select Manage Process.
3 For Action, select Sign Off.
4 Optional: Enter a comment in Comments, or attach a document for more detail.
5 Click Sign Off.

Publishing Process Units

After a process unit is approved, you can publish it to make its data available for viewing by all users. To publish a process unit, you must be assigned the Review Supervisor security role and All access rights.

The process unit must have a status of OK, OK SC, or NO DATA before you can publish it. After you publish a process unit, its status changes to Published. When a process unit has a Published status, you must be assigned the Review Supervisor security role to modify the data.

Note:

When a process unit has a Published status, the system does not perform a check for security roles. Any user who has Read or All access to the entity can view the entity’s data, but it is available only for viewing.
To publish process units from Process Control:

1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Set the rows and columns. See “Selecting Entities for Process Control” on page 236.
4. Select the process unit to publish.
5. Click Manage Process and select Publish.
6. Optional: Enter a comment in Comments, or attach a document for more detail. See “Attaching Documents to a Process Unit” on page 246.
7. Optional: If you use the Tree view, select Selected Entity Only or Selected Entity and Descendants.
8. Click Publish.

To publish process units from a data grid:

1. Select the cell for the process unit to publish.
2. Right-click and select Manage Process.
3. For Action, select Publish.
4. Optional: Enter a comment in Comments, or attach a document for more detail.
5. Click OK.

### Locking and Unlocking Process Units

After you receive approval for the submitted data, you might need to lock the data to prevent any modifications. Locking prevents any change to the data for the entity for a selected category, year, and period. You can lock and unlock data only in a data grid.

If you have the Lock or Unlock security role, you can lock and unlock process units. The process unit must be published before it can be locked. To publish a process unit, you must be assigned the Review Supervisor security role and All access rights.

When you lock a parent entity, the system automatically locks all of its descendants. If you do not have All access to some of the child entities for the process unit, the system skips the lock status for these children and continues the process for the rest. However, the system does not lock the parent entity, because not all of its children are locked.

When you unlock a parent entity, the system automatically unlocks all of its descendants. If a child entity belongs to multiple parent entities, you must manually unlock all of the parent entities first, then unlock the child entity.

For applications that support phased submissions, the system checks to ensure that all cells of the processing unit have reached the Published status or are “Not Supported” before it can be locked. It also checks that all validation accounts for the appropriate phases have a zero value before applying the lock status. The lock status is a calculation status and applies to the entire process unit.
To lock data:
1. From a data grid, select the cells for which to lock data.
2. Right-click and select Lock.

To unlock data:
1. From a data grid, select the cells for which to unlock data.
2. Right-click and select Unlock.

**Viewing Process History**

The Manage Process dialog box displays process history by date and time, username, action taken, process level, and comments. For example, if USER1 promotes a process unit to Review Level 2, the process history displays this line:

05/09/05 2:18:36PM USER1 Promote Review Level 2

To view process history from Process Control:
1. In the Browser View, expand Tasks and select Data Tasks.
2. Select Process Control.
3. Set the rows and columns.
   See “Selecting Entities for Process Control” on page 236.
4. Select the process unit for which to view history.
5. Right-click and select Process Flow History.
   The process history is displayed in a separate window.
6. When you finish viewing the process history, click Close Window.

To view process history from data grids:
1. From a data grid, select the process unit for which to view information.
2. Right-click and select Manage Process.
   The process history is displayed in a separate window.
3. When you finish viewing the process history, click OK.

**E-mail Alerts for Process Control**

You can set up the Process Control module to trigger e-mail alerts based on a change of status in process control. For example, you can send an e-mail alert that a process unit is ready for the next level of promotion. You can generate alerts for these actions: First Pass, Review levels 1 through 10, Submitted, Approved, or Published. You cannot generate alerts when the process unit is at the Not Started level or for the Sign Off action.
When a process review action is performed in the Process Control module or a Web data grid, the system automatically generates e-mail alerts to the appropriate users for the action, according to the scenario setting and security rights set up by the administrator. When the e-mail alert is generated, the user who performed the action also receives a confirmation e-mail that contains the action performed, the process units affected by the action, the names of users receiving the e-mail alerts for each process unit, and any comments entered about the action. The e-mail alerts display in a separate pop-up window in the Process Control module.

To use e-mail alerts for Process Control, the administrator must enable a Process Management metadata setting. For information on alerts, see Chapter 13, “Using E-mail Alerts.”

**Process Management Validation**

When you create an application, you can select a validation account. During the Review process, when you try to promote, submit, approve, sign off, or publish the process unit, the system checks whether the account value in the Validation account equals zero or NODATA. If it does not, the system displays a message that it cannot perform the action.

If the application is set up to use phased submissions, you can set validation accounts for each submission phase.

When you promote, submit, approve, sign off, publish, or reject a process unit, the system also checks the data to ensure that it has an OK, OK SC, or NO DATA status. If the process unit does not have one of these statuses, you must recalculate, translate, or consolidate the data before you can perform any process management action.

The system also checks the process unit to see if the data is locked. You cannot perform any process management actions until the data is unlocked. You can only lock data when it is published. See “Locking Data” on page 96.

The process level of the parent entity must always be lower than or equal to all of its immediate children. The process level of the child entity must always be greater than or equal to all of its immediate parents.

**Validation for Promotion**

When you promote a process unit, the system also performs these additional validation checks:

- It checks the process level of direct descendants to ensure that you are not promoting an entity to a level that is higher than the lowest level of all of the entity’s dependents.
- If you are using a different currency for the entity, the system checks the process level for the entity’s input currency to ensure that a current translation is being used.
- If you are using a node component, the system checks the currency process unit that applies to the parent’s input currency to ensure that the node values are correct.

The system also performs validation checks for child entities with 0% consolidation (unowned entities). Before you can promote the parent entity, you must promote the unowned entities to a specific level; for example, the lowest level of all of the child entities.
Validation for Rejection

When you reject a process unit, the system performs these additional validation checks:

- It checks the process level of the immediate parents to ensure that you are not rejecting an entity to a level that is lower than all of the entity’s parents.
- If the Value dimension equals the input currency for an entity, the system checks the input currency for all of the parents. If the parent’s input currency is the same as the entity’s input currency, the system checks the node process unit. If the parent’s input currency is different, the system checks the process level of the parent’s currency at the entity level.
- If the Value dimension uses a currency other than the input currency for an entity, the system checks the level of the node process unit.
- If the Value dimension indicates that you are using a node process unit, the system checks the process level for the parent’s input currency process unit.

Process Management and Consolidation

You can consolidate data at any time regardless of the process level of the dependents. The first time that you consolidate data for a process unit, the parent data status is NODATA and the initial process level is Not Started. After consolidation, the parent data status changes to OK, but the process level is still Not Started. The Review Supervisor can then start the process unit.

If any of the children contain NODATA, the consolidation process can still occur. When you attempt to promote the parent data to the next process level, the system performs validation checks. The initial process level is Not Started. After you consolidate, the parent process level is still Not Started. You can manually change the process level of the NODATA process unit. After the NODATA process unit has been changed, the parent can then be promoted to a level that is less than or equal to the lowest of all of its immediate children.
About E-mail Alerts

You can use e-mail alerts for intercompany transactions and in the process control review process. E-mail alerts help highlight a key event or data change in the system. For example, you can send an e-mail alert that an intercompany transaction is mismatched and needs to be matched, or that a process unit is ready for the next level of promotion.

E-mail alerts are sent using standard Simple Mail Transfer Protocol (SMTP), so you can use alerts with any e-mail system that works with Internet e-mail. To use alerts, you must specify the SMTP server name when you run the Financial Management configuration utility. See the Hyperion Financial Management — System 9 Installation Guide.

The alert process uses the e-mail addresses that are stored in your authentication files, such as LDAP, MSAD, or Native Directory.

Before you can send or receive e-mail alerts, you must have set up user and data security rights in the application. The security class assigned to the scenario and entity for the alert must support e-mail alerts, and users must be assigned a security role to receive e-mail alerts. See the Hyperion Financial Management — System 9 Administrator’s Guide.

See these procedures:

- “Generating Alerts for Intercompany Transactions” on page 257
- “Generating Alerts for Process Control” on page 262

Generating Alerts for Intercompany Transactions

You can generate e-mail alerts for intercompany transactions. For example, you might notice that transaction M865 between Entity A and Partner C has a mismatched status. You can send an e-mail to Entity A to alert the user of the status and ask for additional information.

When you send an alert, it is sent to the users who have been assigned security rights to receive intercompany transactions e-mail alerts.
There are several areas in intercompany transactions from which you can generate e-mail alerts:

- Intercompany Transactions Process window
- Intercompany Transactions Monitor window
- Intercompany Transaction Report by ID
- Intercompany Transaction Report by Account
- Intercompany Matching Partner Reports

**Sending E-mail Alerts from the Intercompany Transactions Process Window**

The Process IC Transactions window displays a list of intercompany transactions and is the main window from which you perform intercompany transaction processes. You can send e-mail alerts for any of the transactions in this window.

You can generate e-mail alerts for an entity, intercompany partner, or both.

- If you generate e-mail for a unique entity, the system sends alerts to the users who have access to the entity for the selected transactions. If multiple transactions are selected for the same entity, the system generates only one alert for each entity. Only the users who meet certain security criteria receive the alert. See “Receiving Intercompany Transaction E-mail Alerts” on page 262.

- If you generate e-mail for a unique partner, the system sends alerts to the users who have appropriate access to the partner entity.

- If you generate e-mail for both the entity and partner, the system sends alerts to the users who have appropriate access to the entity or partner entity.

You can include comments in the e-mail content in addition to the transaction information included by the system.

When you generate an e-mail alert, you receive a confirmation log that includes the information for the alerts sent to various users.

➤ To send e-mail alerts from the Intercompany Transactions Process window:

1. From the list of intercompany transactions, select the transaction for which to send an alert.

2. From the toolbar, click Alert ( ).
3 Select one of these options:

- Generate email for unique entity
- Generate email for unique partner
- Generate email for both entity and partner

4 Optional: In Comment for all alerts, enter a comment.
   The comment is used for all the alerts that are generated.

5 Click Send.

### Sending E-mail Alerts from the Intercompany Transactions Monitor Window

The Intercompany Transactions Monitor window displays a list of intercompany entities with their Process status and Lock status so that you can monitor the transaction status. You can select any entities from the list of transactions for which to generate e-mail alerts. For example, during the monitor process, you may notice that certain entities have not yet begun their intercompany transaction process. You may want to send e-mail alerts to the users responsible for the entities.

From the Monitor IC Transaction window, the system generates e-mail only to the users who are responsible for the entities, so only the option to generate e-mail for a unique entity is available. If multiple entities are selected to which the same user has security access, the system sends one alert to the user that contains information from all of the selected entities. See “Receiving Intercompany Transaction E-mail Alerts” on page 262.

You can include comments in the e-mail content in addition to the transaction information included by the system.

When you generate an e-mail alert, you receive a confirmation log that includes the information for the e-mails sent to various users.

➤ To send e-mail alerts from the Intercompany Transactions Monitor window:

1 From the list of entities, select the entities for which to send an alert.
2 From the toolbar, click Alert.

3 Optional: In Comment for all alerts, enter a comment.
   The comment is used for all the alerts that are generated.

4 Click Send.

Sending E-mail Alerts from Intercompany Transactions Reports

You can send an e-mail alert from an Intercompany Transactions Report by Transaction ID or a Report by Account. Within each group of matching transactions in the report, there is an Alert button next to the subtotal row and you can send an e-mail alert for the users responsible for a selected group. The e-mail alert displays the application, module, comment, point of view, and the entity and partner for the group of transactions.

Because the e-mail is generated for the matching report, the system automatically sends alerts to the users responsible for the entity or partner entity; therefore only the option to generate e-mail for both the entity and partner is available. The system generates an alert to the user responsible for the entity, and to the user responsible for the partner entity.

You can include comments in the e-mail content in addition to the transaction information included by the system.

When you generate an e-mail alert, you receive a confirmation log that includes the information for the e-mails sent to various users.

➤ To send e-mail alerts from an Intercompany Transaction Report:

1 Run the Intercompany Transactions Report by Transaction ID or by Account.
   See “Running a Matching Report by Transaction ID” on page 180 and “Running a Matching Report by Account” on page 179.

2 From the report, select Alert next to the transaction for which to send an alert.

3 Optional: In Comment for all alerts, enter a comment.
   The comment is used for all the alerts that are generated.

4 Click Send.

Sending E-mail Alerts from Intercompany Partner Matching Reports

You can send an e-mail alert from an Intercompany Partner Matching Report. For example, when you view a matching report, you may notice a difference in the amounts between the entity and its partner. If you are unable to reconcile the differences in the matching report, you may want to send an e-mail alert to the partner entity for the mismatching information.
Because the e-mail is generated for the report, the system automatically sends alerts to the users responsible for the entity or partner entity, therefore only the option to generate e-mail for both the entity and partner is available. The system generates an alert to the user responsible for the entity, and to the user responsible for the partner entity.

You can include comments in the e-mail content in addition to the transaction information included by the system.

When you generate an e-mail alert, you receive a confirmation log that includes the information for the alerts sent to various users.

➤ To send e-mail alerts from an Intercompany Partner Matching Report:

1. **Run the Intercompany Partner Matching Report.**
   See “Viewing Reports” on page 137.
2. From the report, select **Alert** next to the group for which to send an alert.
3. **Optional**: In **Comment for all alerts**, enter a comment.
   The comment is used for all the alerts that are generated.
4. **Click Send.**

### Intercompany Transactions E-mail Content

The Subject line of the alert displays the application name and the module name from which the e-mail was generated. The content contains this information regarding the action performed and the transaction detail:

- Comment: <additional comments entered by the user>
- Scenario, Year, Period
- Entity, Partner, TID, SID, Account, C1, C2, C3, C4
- Entity, Partner, TID, SID, Account, C1, C2, C3, C4

The following figure shows a sample intercompany transaction e-mail alert:
Receiving Intercompany Transaction E-mail Alerts

To receive e-mail alerts for intercompany transactions, you must be assigned all of the following security access:

- Intercompany Transaction Admin or Intercompany Transaction User security role for intercompany transactions. You do not need these roles to receive email for Intercompany Matching Reports.
- Receive E-mail Alerts for IC Transactions security role
- Security access rights of All, Read, or Promote to the data cell for the transaction
- Security class attribute of SupportAlert=Y for both the scenario and entity

When you receive an e-mail alert for intercompany transactions, it displays the module from which the alert was generated; for example, Intercompany Transactions. It also displays the point of view used in the transaction for which the alert was generated.

The comment that was used when generating the alert is displayed for all users. However, the specific information in the alert varies depending on your security role and the security class assigned to the transaction.

For security reasons, no data is displayed in e-mail alerts. The e-mail serves to alert you of a change in status, or that you must perform an action about the item in the alert.

Generating Alerts for Process Control

You can set up the Process Control module to trigger e-mail alerts based on a change of status in process control. You can set up alerts for these actions: First Pass, Review levels 1 through 10, Submitted, Approved, or Published. Alerts are not generated when the process unit is at the Not Started level or for the Sign Off action.

Before an e-mail alert can be generated, you must enable the Supports Process Management=A attribute for the Scenario dimension in the metadata file. When you enable this attribute, the scenario generates e-mail alerts during the review process for the users that have the security rights to receive them.

When a process review action is performed in a Web data grid or the Process Control module, the system automatically generates e-mail alerts to the appropriate users for the action, according to the scenario setting and security rights set up by the administrator. For example, when a process unit is promoted to the next level, only the users with appropriate access rights to the process unit at that review level can receive the alerts.

The system sends e-mail alerts to the users at the prior level before the process control action, and to the users at the current level after the action. For example, User 1 and User 2 both have Reviewer 4 role access, and User 3 and 4 have Reviewer 5 role access. When the process unit is at Level 4 and is promoted to Level 5, User 1 and 2 receive e-mail alerts because they are at Level 4 before the promote action. Users 3 and 4 receive e-mail alerts because they are at Level 5, which is the current level after the promote action.
When the e-mail alert is generated, the user who performed the action receives a confirmation e-mail. The confirmation e-mail contains the action performed, the process units affected by the action, and the names of the users receiving the e-mail alerts for each process unit.

➤ To generate e-mail alerts from Process Control:

1 **Enable security access for e-mail alerts for the process unit and for the appropriate users for the action.**
   See the Hyperion Financial Management — System 9 Administrator’s Guide.

2 **Optional:** To add a comment, from Process Control, select a process unit and enter a comment in Comments.
   As a result of the review action, an alert is generated to the appropriate users. The comment is used for all the alerts that are generated.

### Process Control E-mail Content

The Subject line of the e-mail alert displays the process review action, the review level after the action, and the entity, period, year, and scenario information.

For example, the e-mail subject line for the following review action notifies users that the process unit for the France entity for the Actual scenario in January has been rejected and returned to Review Level 3:

**Subject: Reject RL3 - France, January, 2007, Actual**

The e-mail content contains the following information regarding the action performed and the process unit:

- **Action:** <review action performed>
- **Comment:** <additional comments to be included in the e-mail>
- **Process unit information:** <list of entities in the review action>

Entity label - Entity description, Period, Year, Scenario, Review Level prior to action, Review Level after the action

The following figure shows a sample process control e-mail alert:

```
From: "Reviewer1 (reviewer1@Netive Directory)" <Reviewer1@htmail.com>
To: "HFAAdmin (HFAAdmin@LDAP)" <HFAAdmin@yahoo.com>
Date: 18 Aug 2006 15:21:26 -0400
Subject: Process Control - Start - First Pass - EastProduction, Buv1

Action: Start

Comment: Moved to first pass, 8/19/06 by Reviewer1

Processing Unit Information:

EastProduction - East Production, August, 2006, Buv1, Not Started-> First Pass
```
The process for sending process control alerts is different from that of intercompany transactions, where you can enter comments when you send the alert. Since the system generates process control alerts, it enables you to include additional comments in the content, and then includes the comments when generating the alerts. The additional comments are included in all the alerts generated from one review action. Therefore, all users in a specific distribution list receive the same comment information.

**Receiving Process Control E-mail Alerts**

A process unit consists of a scenario, year, period, and entity. To receive e-mail alerts for review actions, you must be assigned all of the following security access:

- Receive E-mail Alerts for Process Management security role
- Security access rights of All or Promote to the security classes for the scenario and entity in the process unit.
- Alertable rights to the security classes for the scenario and entity in the process unit. The security class attribute for SupportAlerts=Y for both the scenario and entity.
- A security role that requires an alert based on the original process unit status or the new process unit status

When you receive an e-mail alert for process management, it displays the module from which the alert was generated; for example, Process Control. It also displays the point of view used in the process unit for which the alert was generated.

The comment that was used when generating the alert is displayed for all users.

For security reasons, no data is displayed in e-mail alerts. The e-mail serves to alert you of a change in status, or that you must perform an action about the item in the alert.
Overview

Task Automation is a Web-based module that provides a method for chaining a series of tasks into a taskflow. You can use Task Automation to automate tasks that you commonly perform using Financial Management.

When you work with Financial Management, you routinely perform tasks such as loading data, running calculations and translations, consolidating parent entities, and extracting data through data extract or extended analytics. You can create and maintain taskflows to perform Financial Management operations and schedule critical tasks to be run as required.

To create taskflows, you must be assigned the Task Automation security role.

From the Administration menu, you can manage taskflows and view taskflow status. See these procedures:

● “Managing Taskflows” on page 266
● “Viewing Taskflow Status” on page 280
Available Financial Management Tasks

You can use Task Automation to automate these Financial Management tasks:

- Allocate
- Calculate
- Calculate Contribution
- Translate
- Consolidate
- Load Journals
- Extract Journals
- Load Data
- Extract Data
- Execute Journal Action
- Extended Analytics
- Process Management

Prerequisites for Task Automation

These items are prerequisites for Task Automation:

- You must install Oracle's Hyperion® Shared Services. See the Hyperion Shared Services Installation Guide.
- You must configure Financial Management to use external authentication. See the Hyperion Shared Services Installation Guide.
- You must register your application with Shared Services. Registering the application facilitates communication and enables Shared Services links to be displayed on the Home page. See the Hyperion Financial Management — System 9 Administrator’s Guide.
- You must be assigned the Task Automation security role in Financial Management.

Managing Taskflows

From the Manage Taskflows option, you can create, edit, save, copy, and delete a taskflow, view a list of available taskflows, assign access to a taskflow, and run a taskflow manually.

See these procedures:

- “Creating Taskflows” on page 267
- “Editing Taskflows” on page 276
- “Viewing Taskflows” on page 276
- “Copying Taskflows” on page 277
Creating Taskflows

You create a taskflow to link a series of tasks and specify the time to run them. When you create a taskflow, you assign it a name and description. Then you specify the taskflow details, such as task stages and links between tasks.

➤ To create taskflows:

1 Select Administration > Manage Taskflows.
2 Click New.
3 For Name, enter a taskflow name.
   The name can contain up to 40 characters.
   The Application text box displays the name of the current application.
4 For Description, enter a taskflow description.
5 Click Submit.
   The taskflow editor is displayed, where you can add stages and links.

Adding Stages

A stage describes a step in a taskflow usually performed by one individual. Each stage has an action. These actions can have parameters in which values are supplied at runtime.

You define a stage using these three tabs:

● General: Defines the stage name, description and user ID of the user responsible for running the stage. The user can be an initiator, which is the owner of the first stage in the taskflow, or another user for the other stages.

● Processing: Defines the action to be performed when the taskflow is run and any required parameters.

● Starting Event: Defines the taskflow start time, and the scheduled times for the event to occur, based on the application server time, not the local user’s computer. This tab is displayed only for the first stage in the taskflow. It displays the scheduled event (taskflow start time), or is disabled (for the manual start of a taskflow executed by the Run Now option).

➤ To add stages:

1 From the taskflow editor, click Add Stage.
A new stage is displayed in the left panel, and stage details are displayed in the right panel. If stages exist in the taskflow, the new stage is created at the end of the taskflow.

Figure 10  Task Automation General Tab

2 Select General and enter this information:
   a. For Name, enter a stage name; for example, LoadData.

   **Note:**
   Stage names cannot contain spaces. The name can contain up to 30 characters.

   b. **Optional:** For Description, enter a taskflow description; for example, Load a monthly data file.

   c. From Run As, select UserName, and enter a username and password for the user who launches the taskflow.

   **Note:**
   Stage 1 requires that you enter a username and password. When you create future stages, you can select to run as the Initiator, which tells the system to use the user ID and password that was defined in Stage 1.

3 Select Processing and enter this information:
   a. From Application, select an application from which to run the task.

   b. From Action, select an action to perform; for example, LoadData.

   **Note:**
   See “Financial Management Stage Actions and Parameters” on page 270.
c. From **Type** for each parameter, select **Picklist**, **Text Box**, or **URL** for the Point of View, depending on the action, and enter values for the parameter.

For example, for the LoadData action, the Mode option contains a picklist from which you can select Merge, Accumulate, or Replace.

For the data file and log file names and paths, you must manually enter the information in a text box. The taskflow is executed from the server, so you must make sure that the file names and paths are valid and can be accessed from the server running the task. Therefore, you should not enter a path such as `c:\file.dat` that references your own hard drive. You must identify the computer name and share directory for the file using Universal Naming Convention (UNC); for example, `\\HPMServer\share\path\file.dat`.

![Sample Parameters for LoadData](image)

**Figure 11** Sample Parameters for LoadData

4. **Select Starting Event** and enter this information:
   
a. From **Starting Event**, select an event.

   The Server Date information is displayed for informational purposes.
b. For **Start Date**, enter the date for the task to be run, or click the pop-up calendar and select a date.

c. From **Start Time**, select a time for the task to be run.

**Note:**

This time is based on the application server, which is identified on the Server Date line.

d. For a recurring task, select **Recurrence**, and from **Recurrence Pattern**, select the task frequency.

e. Select an option for the task end date and time:
   - No End Date
   - **End After** occurrences, and enter the number of occurrences
   - **End Date**, enter an end date and select an **End Time**.

5 Optional: To add a stage, click **Add Stage** and complete the stage information for **General** and **Processing**

**Note:**

The Starting Event tab is available only for the first stage.

---

**Financial Management Stage Actions and Parameters**

The following table lists the available Oracle’s Hyperion® Financial Management – System 9 actions and parameters.
<table>
<thead>
<tr>
<th>Action</th>
<th>Parameter Name</th>
<th>Type</th>
<th>Possible Values</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate</td>
<td>POV</td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for which the allocation is run. See “Running Allocations” on page 95.</td>
</tr>
<tr>
<td>Calculate</td>
<td>POV</td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for the data to be calculated. See “Calculating Data” on page 108.</td>
</tr>
<tr>
<td>Force</td>
<td></td>
<td>Picklist</td>
<td>● True ● False</td>
<td>Indicates whether to force calculation to run for selected cells, regardless of status.</td>
</tr>
<tr>
<td>Calculate Contribution</td>
<td>POV</td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for the contribution data to be calculated. See “Calculating Data” on page 108.</td>
</tr>
<tr>
<td>Force</td>
<td></td>
<td>Picklist</td>
<td>● True ● False</td>
<td>Indicates whether to force contribution to be calculated for all input periods.</td>
</tr>
<tr>
<td>Translate</td>
<td>POV</td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for the data to be translated. See “Translating Data” on page 109.</td>
</tr>
<tr>
<td>Force</td>
<td></td>
<td>Picklist</td>
<td>● True ● False</td>
<td>Indicates whether to force translation to run for selected cells, regardless of status.</td>
</tr>
<tr>
<td>Consolidate</td>
<td>POV</td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for the data to be consolidated. See “Consolidating Data” on page 111.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td>Picklist</td>
<td>● Impacted ● All With Data ● All</td>
<td>Indicates the type of consolidation to be performed.</td>
</tr>
<tr>
<td>Load Journals</td>
<td>Journals File</td>
<td>Textbox</td>
<td>Name and path of file</td>
<td>Indicates the journal file to load. See the Hyperion Financial Management — System 9 Administrator's Guide.</td>
</tr>
<tr>
<td>Action</td>
<td>Parameter Name</td>
<td>Type</td>
<td>Possible Values</td>
<td>Purpose</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>--------</td>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Log File</td>
<td>Textbox</td>
<td>Path for log file</td>
<td>Displays the journal load status.</td>
</tr>
<tr>
<td></td>
<td>Delimiter</td>
<td>Textbox</td>
<td>Delimiter in the journal file. Default is a semicolon (;).</td>
<td>Separates the data in the file.</td>
</tr>
<tr>
<td>Extract Journals</td>
<td>Journals File</td>
<td>Textbox</td>
<td>Name and path of file</td>
<td>Indicates the journal file to extract. See the Hyperion Financial Management — System 9 Administrator’s Guide.</td>
</tr>
<tr>
<td></td>
<td>Log File</td>
<td>Textbox</td>
<td>Path for log file</td>
<td>Displays the journal extract status.</td>
</tr>
<tr>
<td></td>
<td>Delimiter</td>
<td>Textbox</td>
<td>Delimiter in the journal file. Default is a semicolon (;).</td>
<td>Separates the data in the file.</td>
</tr>
<tr>
<td>Extract Templates</td>
<td>Picklist</td>
<td></td>
<td>● True                      ● False</td>
<td>Indicates whether to extract journal templates.</td>
</tr>
<tr>
<td>Extract Recurring Templates</td>
<td>Picklist</td>
<td></td>
<td>● True                      ● False</td>
<td>Indicates whether to extract recurring templates.</td>
</tr>
<tr>
<td>Extract Journals</td>
<td>Picklist</td>
<td></td>
<td>● True                      ● False</td>
<td>Indicates whether to extract journals.</td>
</tr>
<tr>
<td>POV</td>
<td>URL</td>
<td></td>
<td>Point of View</td>
<td>Indicates the point of view for which journals are extracted.</td>
</tr>
<tr>
<td>Load Data</td>
<td>Data File</td>
<td>Textbox</td>
<td>Name and path of file</td>
<td>Indicates the data file to load. See “Loading Data” on page 54.</td>
</tr>
<tr>
<td></td>
<td>Log File</td>
<td>Textbox</td>
<td>Path for log file</td>
<td>Displays the data load status.</td>
</tr>
<tr>
<td></td>
<td>Delimiter</td>
<td>Textbox</td>
<td>Delimiter in the data file. Default is a semicolon (;).</td>
<td>Separates the data in the file.</td>
</tr>
<tr>
<td>Mode</td>
<td>Picklist</td>
<td></td>
<td>● Merge                      ● Replace By Security ● Replace ● Accumulate</td>
<td>Indicates the mode to use for loading data.</td>
</tr>
<tr>
<td></td>
<td>Accumulate Within File</td>
<td>Picklist</td>
<td>● True                      ● False</td>
<td>Indicates whether to accumulate data in the data file.</td>
</tr>
<tr>
<td>Action</td>
<td>Parameter Name</td>
<td>Type</td>
<td>Possible Values</td>
<td>Purpose</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------</td>
<td>----------</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contains Ownership Data</td>
<td></td>
<td>Picklist</td>
<td>● True</td>
<td>Indicates whether the file contains ownership data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● False</td>
<td></td>
</tr>
<tr>
<td>Extract Data</td>
<td>Data File</td>
<td>Textbox</td>
<td>Name and path of file</td>
<td>Indicates the data file to extract. See “Extracting Data” on page 59.</td>
</tr>
<tr>
<td>Log File</td>
<td></td>
<td>Textbox</td>
<td>Path for log file</td>
<td>Displays the data extract status.</td>
</tr>
<tr>
<td>Delimiter</td>
<td></td>
<td>Textbox</td>
<td>Delimiter in the data file. Default is a semicolon (;). Separates the data in the file.</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
<td>Picklist</td>
<td>● Year to date</td>
<td>Indicates the view to use for extracting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Periodic</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Scenario Default</td>
<td></td>
</tr>
<tr>
<td>POV</td>
<td></td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for which data is extracted.</td>
</tr>
<tr>
<td>Calculated</td>
<td></td>
<td>Picklist</td>
<td>● True</td>
<td>Indicates whether the data is calculated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● False</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Approve</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Post</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Unpost</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Unsubmit</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Reject</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Delete</td>
<td></td>
</tr>
<tr>
<td>POV</td>
<td></td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view for which journal actions are performed.</td>
</tr>
<tr>
<td>Journal Label</td>
<td></td>
<td>Textbox</td>
<td>Name and path of file</td>
<td>Identifies the journal on which to perform the action.</td>
</tr>
<tr>
<td>Extended Analytics</td>
<td>DSN</td>
<td>Textbox</td>
<td>Data source name where the data is extracted</td>
<td>Indicates the data source name. See the Hyperion Financial Management — System 9 Administrator’s Guide.</td>
</tr>
<tr>
<td>Table Prefix</td>
<td></td>
<td>Textbox</td>
<td>Keys to dimension tables</td>
<td>Contains keys to the dimension tables.</td>
</tr>
<tr>
<td>Push Type</td>
<td></td>
<td>Picklist</td>
<td>● Create</td>
<td>Indicates whether to create or update a star schema.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>● Update</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Parameter Name</td>
<td>Type</td>
<td>Possible Values</td>
<td>Purpose</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>------------</td>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Extract Type</td>
<td></td>
<td>Picklist</td>
<td>• Standard • Metadata All • Selected Metadata only • SQL Aggregation • Essbase • Data Warehouse</td>
<td>Indicates the mode to use for extracting data.</td>
</tr>
<tr>
<td>Exclude Dynamic</td>
<td></td>
<td>Picklist</td>
<td>• True • False</td>
<td>Indicates whether to exclude dynamic accounts from the extract.</td>
</tr>
<tr>
<td>Accounts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>POV</td>
<td></td>
<td>URL</td>
<td>Point of View</td>
<td>Indicates the point of view to use for Extended Analytics.</td>
</tr>
<tr>
<td>Process Management</td>
<td></td>
<td>URL</td>
<td>Scenario, Year, Period, Entity, Value</td>
<td>Indicates the point of view to use for process management. See &quot;About Process Management&quot; on page 229.</td>
</tr>
<tr>
<td>Comment</td>
<td></td>
<td>Textbox</td>
<td>Comment text</td>
<td>Text of comment for process unit</td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td>Picklist</td>
<td>• Start • Promote • Reject • Sign Off • Submit • Approve • Publish</td>
<td>Indicates the type of action to perform on the process unit.</td>
</tr>
<tr>
<td>Promote to State</td>
<td></td>
<td>Picklist</td>
<td>• None • Review level 1 to 10</td>
<td>Indicates the level to which to promote the process unit.</td>
</tr>
</tbody>
</table>

### Shared Services Stage Actions and Parameters

The following table lists available actions and parameters.

#### Table 32 Stage Actions and Parameters for Shared Services

<table>
<thead>
<tr>
<th>Action</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>Action that enables e-mail messages to be sent automatically to an e-mail address. Complete these parameters for the e-mail action:</td>
</tr>
<tr>
<td></td>
<td>• To: Type an e-mail address for the recipient</td>
</tr>
<tr>
<td></td>
<td>• Subject: Type a subject for the e-mail</td>
</tr>
</tbody>
</table>
## Adding Links

A link is the point during the taskflow execution where the activity in one stage is completed and the control passes to another stage, which starts. A link can be unconditional, where the completion of one stage leads to the start of another, or conditional, where the sequence of operation depends on one or more link conditions.

A link specifies the action for the system to take next. Every stage needs a link. In general, most stages have two links: success and failure. For the success link, you can specify that if the first stage succeeds, the system should proceed to the second stage, called the Receiving stage. For the failure link, you specify the action to be performed if problems occur in the first stage.

For example, you can set a success link so that if the first stage of LoadData succeeds, the system proceeds to the Receiving stage of Consolidation. You can set a failure link so that if failure occurs or any problems are encountered in the LoadData stage, the system proceeds to the Receiving stage of End, which ends the process and terminates the taskflow.

The last stage in the taskflow must have a final link with “End” as the target to complete the taskflow.

You can specify variables for an event. For example, you can add a variable for a load data task such as LoadData_Result==Success.

To add links:

1. **Click Add Link.**
2. **Select General** and for **Name**, enter a link name.
   The name can contain up to 30 characters.
3. **For Description**, enter a link description.
   The Sending Stage is displayed for informational purposes.
4. **From Receiving Stage** select a stage.
5. **Select Condition** tab if applicable, and from **Variable**, select a variable, for example, LoadData_Result.
Tip:
To delete a condition, click Delete.

6 From Value, select Success or Failure.
7 Click Add.

Note:
Ensure that the last stage in the taskflow has a link with an End target.

Viewing Taskflows
You store and manage taskflows in Shared Services. The Taskflow Listing Summary shows the available taskflows by application, the user who created the taskflow, and a description.

➤ To view taskflow lists, select Administration > Manage Taskflows.

Editing Taskflows
After you create a taskflow, you can edit the taskflow description, and create, edit, or delete taskflow variables. You can also add or delete a stage or a link.

➤ To edit taskflows:

1 Select Administration > Manage Taskflows.
2 Select the taskflow to edit and click Edit.
3 In the taskflow editor, select an option:
   ● To add a stage, click Add Stage. See “Adding Stages” on page 267.
   ● To add a link, click Add Link. See “Adding Links” on page 275.
   ● To delete a stage or link, click Delete.

Note:
If you delete a stage, all links associated with it are also deleted.
   ● To edit the taskflow description, click Properties.

4 Edit the taskflow and take one of these actions:
   ● To save the edits, click Save.
   ● To cancel the edits, click Cancel. The system returns you to the Taskflow Listing Summary without saving your changes.
Copying Taskflows

After you define a taskflow for an application, you can copy it to a different application.

➤ To copy taskflows:
1 Select Administration > Manage Taskflows.
2 Select the taskflow to copy and click Save As.
3 Enter a new name and description for the taskflow.
4 Click Submit.

Shared Services adds a copy of the taskflow with a new name to the Taskflow Listing Summary.

Deleting Taskflows

You can delete a taskflow that you no longer need.

➤ To delete taskflows:
1 Select Administration > Manage Taskflows.
2 From the list of taskflows, select the taskflow to delete, and click Delete.

Running Taskflows Manually

You can run a taskflow manually instead of waiting for it to start automatically. You might want to test a taskflow before the time that it is scheduled to run. This enables you to make adjustments to the taskflow before it actually runs.

➤ To run taskflows manually:
1 Select Administration > Manage Taskflows.
2 From the list of taskflows, select the taskflow to run and click Run Now.

Managing Access Permissions to Taskflows

Shared Services enables you to manage access permissions to taskflows in applications independent from any product application. You assign permissions on a model-by-model basis to individual users or to groups of users. You can also assign permissions at the application level.

To access specific taskflows, users must be assigned access rights individually or inherit access rights by being part of a group that is assigned access rights. If an individual group is assigned to a group and the access rights of the individual user conflict with those of the group, the rights of the individual user take precedence.
To give users access to taskflows other than their own, an administrator must add the users and assign their permissions.

Taskflow management provides these types of permissions:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>View a taskflow.</td>
</tr>
<tr>
<td>Write</td>
<td>Edit a taskflow.</td>
</tr>
<tr>
<td>Write</td>
<td>Write permission does not automatically include Read permission. You must assign Read permission explicitly, in addition to Write permission, if you want a user to have both.</td>
</tr>
<tr>
<td>Manage</td>
<td>Create new users and change permissions for users.</td>
</tr>
<tr>
<td>Manage</td>
<td>Manage permission does not automatically include Read and Write permissions. You must assign Read and Write permissions explicitly, in addition to Manage permission, if you want a user to have all these permissions.</td>
</tr>
</tbody>
</table>

You can apply permissions to groups and to individual users. Users are automatically granted the permissions of the groups to which they belong. You can, however, explicitly add or deny permissions to a user to override group permissions.

For each type of access permission (Read, Write, and Manage), you must apply one of these actions:

- Grant: Explicitly grant the permission to the user or group.
  
  Granting permissions to a member of a group overrides permissions inherited from the group. For example, if a group is denied a permission, you can explicitly grant the permission to a member of the group.

- Deny: Explicitly deny the permission to the user or group.
  
  Denying permissions to a member of a group overrides permissions inherited from the group. For example, if a group is granted a permission, you can explicitly deny the permission to a member of the group.

- None: Do not apply the permission to the user or group.

### Assigning Access Permissions to Taskflows

You can assign permissions to individual users or to groups of users for individual taskflows. You must have Manage permission for a taskflow to assign permissions to it.

Users inherit the permissions of the groups to which they belong. Permissions that you assign to an individual user, however, override any group permissions that the user inherits.

Assigning (or denying) a permission does not implicitly assign (or deny) any other permissions; that is, assigning Write permission does not implicitly assign Read permission, and assigning Manage permission does not implicitly assign Read and Write permissions. Likewise, denying Read permission does not implicitly deny Write and Manage permissions, and denying Write permission does not implicitly deny Manage permission. You must explicitly assign all
To assign permissions to taskflows:

1 **Select a taskflow and click Access Control.**

   You can view the permissions that are assigned to users and groups for the selected taskflow in the Access Listing window.

2 **To add users or groups, click Add.**

   The Add Principal window is displayed. Available Users/Groups lists users who are authenticated as Oracle's Hyperion® Shared Services users. If a user that you want is not on the list, contact the administrator to add authenticated users.

3 **Optional: To search for users or groups:**
   a. From the drop-down list, select Users or Groups.
   b. Enter the user or group name.
   c. From Provider, select the provider that contains the user or group.
   d. Click Search.

4 **For Available Users/Groups, select users or groups to assign to this taskflow (press Ctrl to select multiple users).**

5 **Click Add to move the selected users and groups to Selected Users/Groups or click Add All to move all users and groups to Selected Users/Groups.**

**Note:**

Group names are preceded by an asterisk (*).

6 **For the Read, Write, and Manage permissions, select an access type: Grant, Deny, or None.**

7 **Click Add to assign the permissions.**

### Editing Permissions to Taskflows

You can edit the permissions of individual users and groups on individual taskflows. You must have Manage permission for a taskflow to change permissions for it.

To edit permissions to taskflows:

1 **Select Administration > Manage Taskflows.**

2 **Select a taskflow and click Access Control.**

3 **Select one or more users or groups and click Edit.**

   The window shows the permissions assigned to the selected users or groups.

4 **Select one of the Grant, Deny, or None options for the Read, Write, and Manage permissions.**

5 **Click one of these options:**
Deleting Permissions to Taskflows

You can delete all permissions for users and groups to individual taskflows. You must have Manage permission for a taskflow to delete access to it.

To delete access to taskflows:

1. Select Administration > Manage Taskflows.
2. Select a taskflow and click Access Control.
   
   You can view the permissions that are assigned to users and groups for the selected taskflow.
3. Select one or more users or groups and click Delete.

Viewing Taskflow Status

The Taskflow Status Summary enables you to check the status of taskflows, including those that are active, completed, or stopped. You can view all taskflows, or you can filter the list of taskflows by status, application, or the date or range of dates on which the taskflow was initiated.

You can drill down on individual taskflows to view details of the taskflow in the Taskflow Participant Summary. The Taskflow Participant Summary displays the status for each stage of the taskflow and the time it was completed. You can see the stages that were completed successfully and those that failed. This information can be used to troubleshoot the automation routine.

Figure 13 Sample Taskflow Status Summary Window

Table 34 describes the elements of the Taskflow Status Summary window.
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Filter on these taskflow types:</td>
</tr>
<tr>
<td></td>
<td>● Active</td>
</tr>
<tr>
<td></td>
<td>● Done</td>
</tr>
<tr>
<td></td>
<td>● Stopped</td>
</tr>
<tr>
<td></td>
<td>● All</td>
</tr>
<tr>
<td>Application</td>
<td>Application participating in the taskflow</td>
</tr>
<tr>
<td>Taskflow</td>
<td>Taskflow name</td>
</tr>
<tr>
<td>Initiated between (optional)</td>
<td>Enter or select by clicking the date or range of dates in which the taskflow was initiated</td>
</tr>
<tr>
<td>Search</td>
<td>Click to display in the Taskflow Listing area a list of taskflows that meet the search criteria that you specify</td>
</tr>
<tr>
<td>Taskflow Listing</td>
<td>Displays taskflows that meet the search criteria that you specify, such as:</td>
</tr>
<tr>
<td></td>
<td>● ID</td>
</tr>
<tr>
<td></td>
<td>● Application*</td>
</tr>
<tr>
<td></td>
<td>● Taskflow*</td>
</tr>
<tr>
<td></td>
<td>● Initiator*</td>
</tr>
<tr>
<td></td>
<td>● Started* (lists the latest taskflow first)</td>
</tr>
<tr>
<td></td>
<td>● Status*</td>
</tr>
<tr>
<td></td>
<td>● Description</td>
</tr>
<tr>
<td></td>
<td>*Indicates data that is sortable. You may sort taskflows by Application, Taskflow, Initiator, Started, or by Status by clicking on the column header.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop an active taskflow instance.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected taskflow instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The taskflow must be stopped before you can delete it.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Delete all of the selected taskflow instances.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Display in the Taskflow Listing area the first page of taskflow instances that meet the specified search criteria.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Display in the Taskflow Listing area the previous page of taskflow instances that meet the specified search criteria.</td>
</tr>
<tr>
<td>Page</td>
<td>Select a page to display in the Taskflow Listing area.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Display in the Taskflow Listing area the page you selected in the Page drop-down list box.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Display in the Taskflow Listing area the next page of taskflow instances that meet the specified search criteria.</td>
</tr>
<tr>
<td>≥</td>
<td>Display in the Taskflow Listing area the last page of taskflow instances that meet the specified search criteria.</td>
</tr>
</tbody>
</table>
From the Taskflow Status Summary, you can also stop an active taskflow. See “Stopping Active Taskflows” on page 282.

➤ To view taskflow status:

1 Select Administration > View Taskflow Status.
2 Double-click a task ID to display its status.
3 To search for a taskflow, select the filter criteria, and click Search.

Stopping Active Taskflows

Active taskflows are taskflows that are in progress. You can stop taskflows that are not in progress. For example, you can stop a taskflow that has errors and make adjustments to it.

➤ To stop active taskflows:

1 Select Administration > View Taskflow Status.
2 From Status, select Active.
3 Optional: To filter the list, select search criteria for the taskflow, and click Search.
4 Select the taskflow to stop and click Stop.

Viewing the Taskflow Participant Summary

The Taskflow Participant Summary lists the participants in a taskflow and provides status information for each participant instance.

➤ To view taskflow participant status:

1 Select Administration > View Taskflow Status.
2 Select the search criteria for the taskflows, and click Search.
   To view all of the taskflows in the Shared Services taskflow management system, select (Status) All and click Search.
3 In the Taskflow Listing area, find the taskflow for which to view the participant summary and click the taskflow ID.
   The Taskflow Participant Summary window is displayed.
4 Click Cancel to return to the Taskflow Status Summary window.
Table 35  Taskflow Participant Summary Window Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taskflow Summary</td>
<td>Summary information for the selected taskflow (items appear in the order of completion):</td>
</tr>
<tr>
<td></td>
<td>● ID</td>
</tr>
<tr>
<td></td>
<td>● Application</td>
</tr>
<tr>
<td></td>
<td>● Taskflow</td>
</tr>
<tr>
<td></td>
<td>● Initiator</td>
</tr>
<tr>
<td></td>
<td>● Started</td>
</tr>
<tr>
<td></td>
<td>● Status</td>
</tr>
<tr>
<td></td>
<td>● Description</td>
</tr>
<tr>
<td>Participant</td>
<td>Stage participant name. Participants are selectable. Click a participant to view details about a taskflow participant.</td>
</tr>
<tr>
<td>Stage Name</td>
<td>Stage name</td>
</tr>
<tr>
<td>Status</td>
<td>Stage status:</td>
</tr>
<tr>
<td></td>
<td>● Active</td>
</tr>
<tr>
<td></td>
<td>● Done</td>
</tr>
<tr>
<td></td>
<td>● Stopped</td>
</tr>
<tr>
<td></td>
<td>● All</td>
</tr>
<tr>
<td>Success Variable</td>
<td>Outcome of the completed stage</td>
</tr>
<tr>
<td>Completed</td>
<td>Date and time of stage completion</td>
</tr>
</tbody>
</table>

Viewing the Taskflow Participant Details

The Taskflow Participant Details window displays the details for a taskflow participant.

➤ To view taskflow participant details:

1 Select Administration > View Taskflow Status.

2 Select the search criteria for the taskflows, and click Search.
   - To view all the taskflows in the Shared Services taskflow management system, select (Status) All and click Search.

3 In Taskflow Listing, find the taskflow for which to view the participant summary and click the taskflow ID.

4 Click a participant to view taskflow participant details.
   - Shared Services displays the Taskflow Participant Details window and sorts the participant events chronologically.

5 Click Cancel to return to Taskflow Participant Summary.
Glossary

account A dimension that represents an accounting container that identifies the location and primary nature of the data.

account type The definition of how an account’s value flows over time, and its sign behavior. Account type options can include expense, income, asset, liability, currency rate, flow, balance, balance recurring, dynamic view, and equity. Expense examples: payroll expenses, salaries, office supplies, legal expenses, and rent. Revenue examples: sales and interest income. Asset examples: cash, accounts receivable, fixed assets, and accumulated depreciation. Liability examples: accounts payable, accrued expenses, and long-term debt.

activity-level authorization Defines user access to application components and the types of activities they can perform on the application component. Activity-level authorization controls whether a given user may perform a certain action in an application and is independent of the data that will be operated on by the action. Data access is controlled by data-level authorization.

alias An alternative name.

ancestor A branch member that has members below it. For example, in a dimension that includes years, quarters, and months, the members Qtr2 and 2007 are ancestors of the member April.

application A related set of dimensions and dimension members that are used to meet a specific set of analytical and/or reporting requirements.

application currency The default reporting currency for the application.

asset account An account type that stores values that represent the assets of a company.

attribute Characteristics of a dimension member. For example, a product dimension can have several attributes, such as size and flavor.

authentication Verification of identity as a security measure. Authentication is typically based on a user ID and password. Passwords and digital signatures are forms of authentication.

auto-reversing journal A journal for entering adjustments that you want to reverse in the next period.

balance account An account type that stores unsigned values that relate to a particular point in time.

balance recurring account An account type that stores unsigned values that remain constant from period to period.

balanced journal A journal in which the total debits equal the total credits.

base currency The currency in which daily business transactions are performed.

base entity An entity at the bottom of the organization structure that does not own other entities.

business rules Logical expressions or formulas that are created within an application to produce a desired set of resulting values.

CALC status A consolidation status that indicates that some values or formula calculations have changed. You must reconsolidate to get the correct values for the affected entity.

calendar User-defined time periods and their relationship to each other. Q1, Q2, Q3, and Q4 comprise a calendar or fiscal year.

cell A unit of data representing the intersection of dimensions in a multidimensional database; the intersection of a row and a column in a worksheet.
CHANGED status: A consolidation status that indicates data has changed for an entity.

child: A member with a parent above it in the database outline.

column: A vertical display of information in a grid or table. A column can contain data from one field, derived data from a calculation, or textual information.

consolidation: The process of gathering data from dependent entities and aggregating the data to parent entities.

consolidation rule: Identifies the rule that is executed during the consolidation of the node of the hierarchy. This rule can contain customer specific formulas appropriate for the correct consolidation of parent balances. Elimination processing can be controlled within these rules.

contribution: The value added to a parent from a child entity. Each child has a contribution to its parent.

conversion rate: See exchange rate.

currency conversion: A process that converts currency values in a database from one currency into another currency. For example, to convert one U. S. dollar into the euro, the exchange rate (for example, 0.923702) is multiplied with the dollar ($1* 0.923702). After conversion, the euro amount is .92.

custom dimension: A dimension created and defined by users. For example, channel, product, department, project, or region could be custom dimensions.

data form: A grid display that allows users to enter data into the database from a Web browser, and to view and analyze data or related text. Certain dimension member values are fixed, giving users a specific view into the data.

data lock: A user-controlled mechanism that prevents changes to data according to specified criteria, such as period or scenario.

dependent entity: An entity that is owned by another entity in the organization.

destination currency: The currency to which the balances are converted. You enter exchange rates and convert from the source currency to the destination currency. For example, when you convert from euros to USD, the destination currency is USD.

drill-down: Navigation through the query result set using the organization of the dimensional hierarchy. Drilling down moves the user perspective from general aggregated data to more detailed data.

dynamic member list: A named member set that is a system-created list based on pre-defined criteria. The dynamic member list is automatically refreshed whenever the list is referenced in the application. As dimension members are added and deleted, the dynamic member list automatically reflects the changes by reapplying the user-defined criteria.

dynamic view account: An account type indicating that the account value is calculated dynamically from the data that you are viewing.

elimination: The process that occurs when certain transactions are zeroed out or “eliminated” because they were generated between entities within the same organization.

entity: A dimension representing organizational units. Examples include divisions, subsidiaries, plants, regions, products, or other financial reporting unit.

exchange rate: A numeric value used to convert one currency to another. For example, to convert $1 into Euros, the exchange rate of 0.8936 is multiplied with the dollar. The Euro equivalent of $1 is 0.8936.

exchange rate type: An identifier associated with an exchange rate. Different rate types are used because there may be multiple rates for a period and year. Users traditionally define a rate at period end for the average rate of the period and also a rate for the end of the period. Additional rate types are historical rates, budget rates, forecast rates, and so on. All these exchange rate types apply to the same point in time.

expense account: An account type that stores periodic and year-to-date values that decrease net worth if the value is positive.

Extensible Markup Language (XML): A language comprised of a set of tags used to assign attributes to data that can be interpreted between applications based on the schema used.

external authentication: Logging on to Oracle’s Hyperion applications by means of user information stored outside the application, typically in a corporate user directory such as MSAD or NTLM.
file delimiter  One or more characters, such as commas or tabs that separate fields in a data source.

flow account  An unsigned account type that stores periodic and year-to-date values.

function  A predefined routine that returns a value, a range of values, a Boolean value, or one or more database members.

generation  A layer in a hierarchical tree structure that defines member relationships in a database. Generations are ordered incrementally from the top member of the dimension (generation 1) down to the child members.

holding company  An entity that is part of a legal group of entities, and has either a direct or indirect investment in all the other entities within the legal group.

IMPACTED status  A consolidation status indicating that the data that rolls up to this parent entity has changed.

INACTIVE status  A consolidation status indicating this entity is not active for the current period.

intercompany elimination  See elimination.

intercompany matching  The process of comparing balances for pairs of intercompany accounts within an application. Intercompany receivables are typically matched or compared to intercompany payables. The system uses these matching accounts to eliminate any intercompany transactions from your organization's consolidated totals.

intercompany matching report  A report that compares the balances of a group of intercompany accounts and indicates if the accounts are in balance or out of balance for any branch of an organization.

journal entry (JE)  A set of debit/credit adjustments to natural account balances for one scenario and period.

liability account  An account type that stores “point in time” balances that represent a company's liabilities. Examples of liability accounts include accrued expenses, accounts payable, and long term debt.

locked  A user-invoked process that prevents the data from being modified by any process, user, or other means.

LOCKED status  A consolidation status indicating that an entity contains data that is locked for the specified period.

member list  A named group, system- or user-defined, that references members, functions, or other member lists within a dimension.

merge  A data load option that clears existing values from the accounts specified in the data load file and replaces them with the values in the data load file. Unlike the Replace option, the Merge option clears only the values from the accounts specified in the load file.

metadata  A set of data that defines and describes the properties and attributes of the data stored in a database or used by an application. Examples of metadata are dimension names, member names, properties, time periods, and security.

NO DATA status  A consolidation status indicating that this entity contains no data for the specified period and account.

ODBC  Open Database Connectivity. A database access method used from any application without regard to how the database management system (DBMS) processes the information.

ODBC data source  Location of the data that you are accessing and the information necessary to access the data using ODBC. For example, an ODBC data source that connects to an SQL Server might require a server name, a database name, a user name, and a password. See also Open Database Connectivity.

OK status  A consolidation status indicating that an entity has already been consolidated, and that data has not changed below it in the organization structure.

Open Database Connectivity (ODBC)  Standardized application programming interface (API) technology that allows applications to access multiple third-party databases.

organization  A hierarchy of entities that defines each entity and their relationship to others in the hierarchy.

P&L accounts (P&L)  Profit and loss accounts. Refers to a typical grouping of expense and income accounts that comprise a company's income statement.

parent adjustments  The journal entries that are posted to a child in relation to its parent.
parents  The entities that contain one or more dependent entities that report directly to them. Because parents are both entities and associated with at least one node, they have entity, node, and parent information associated with them.

percent consolidation  The portion of a child’s values that is consolidated to its parent.

percent control  Identifies the extent to which an entity is controlled within the context of its group.

percent ownership  Identifies the extent to which an entity is owned by its parent.

periodic value method (PVA)  A process of currency conversion that applies the periodic exchange rate values over time to derive converted results.

plug account  An account in which the system stores any out of balance differences between intercompany account pairs during the elimination process.

promote  The action to move a data unit to the next review level. This would allow a user who has the appropriate access to review the data. For example, an analyst may promote the data unit to the next level for his supervisor’s review.

PVA  See periodic value method (PVA).

recurring template  A journal template used to make identical adjustments in every period.

regular journal  A journal used to enter one-time adjustments for one period only.

relational database  A type of database that stores data in the form of related tables. One database can be spread across several tables, and can be viewed in different ways.

replace  A data load option that clears the existing values from all accounts for the periods specified in the data load file, and loads the values from the data load file. If an account is not specified in the load file, its values for the specified periods are cleared during the load.

review level  A Process Management review status indicator that represents the process unit level. Review levels include the following: Not Started, First Pass, Review Level 1, Review Level 2 ... Review Level 10, Submitted, Approved, and Published.

rules  User-defined formulas.

scenario  A dimension that specifies a data classification. Examples include Actuals, Budget, Forecast1, and Forecast2.

source currency  The currency from which the balances originate and are converted. You enter exchange rates and convert from the source currency to the destination currency. For example, when you convert from the euro to USD, the source currency is the euro.

standard journal template  A journal template used to post adjustments that have common adjustment information for each period.

system extract  A feature that allows you to transfer data from an application’s metadata into an ASCII file.

translation  See currency conversion.

triangulation  A means of converting balances from one currency to another via a third common currency. In Europe, this is the euro for member countries. For example, to convert from guilder to lira, the common currency is defined as euro. Therefore, in order to convert balances from guilder to lira, balances are converted from guilder to euro and from euro to lira.

triangulation currency  A currency through which exchange rates can be derived. For example, if you set up the Euro/Dollar exchange rate and the Euro/Yen rate, the Dollar/Yen rate can be derived by using Euro as the triangulation currency.

unbalanced journal  A journal in which total debits do not equal total credits.

user-defined member list  A named, static set of members within a dimension defined by the user. As dimension members are added to an application, member lists will remain constant and will not reflect any changes made to the application outline.

value dimension  A dimension that is used to define the input value, translated value, and consolidation detail.

view  The representation of either a year-to-date or periodic display of data.

XML  See Extensible Markup Language (XML).
# Index

## A
- Account dimension, 18
- Accumulate data load option, 53
- Accumulate Within File data load option, 53
- active entities, 32, 36
- Active status, 130
- adjustments
  - entering, 196
  - viewing in Data Explorer, 74
  - viewing on the Web, 91
- alerting, 257
- allocations
  - running from Data Explorer, 77
  - running on the Web, 95
- Approved journal status, 204
- approving process units, 250
- autoreversing journals, 201

## B
- balanced journals, 186

## C
- Calculate Ownership option, 131
- calculating data, 108
- calculation status
  - displaying in Data Explorer, 68
  - displaying on the Web, 82
- cell adjustments
  - viewing in Data Explorer, 74
  - viewing on the Web, 91
- cell colors
  - in Data Explorer, 71
  - in Web data grids, 88
- cell descriptions
  - in Data Explorer, 75
  - on the Web, 92
- cell history, 95
- cell information, 74, 91
- cell text
  - in Data Explorer, 75
  - on the Web, 92
- Chart Logic (CH) status, 73
- clearing data, 65
- colors
  - in Data Explorer cells, 70
  - in Web data grids, 88
- column widths in Data Explorer, 68
- Consolidate All option, 111
- Consolidate All with Data option, 110
- Consolidate option, 110
- consolidation
  - canceling, 113
  - effects on process management, 256
  - entering percentages, 108
  - options, 110
  - procedure, 111
  - process overview, 103
  - viewing progress, 112
  - viewing statuses on the Web, 89
- Consolidation (CN) status, 73
- consolidation method
  - calculations, 131
  - selecting, 129
- consolidation statuses, 73
- contribution values, 109
- copying data, 61
- copying line item detail, 64
- currency rates, 107
- Custom dimension, 18
- custom documents, 40

## D
- data
  - calculating, 108
clearing, 65
clearing from grids, 88
copying, 61
displaying on the Web, 82
editing, 70
editing on the Web, 86
entering, 70
entering on the Web, 86
extracting, 59
filling blocks, 87
loading, 54
translating, 109
Data Explorer
editing data, 70
entering data, 70
locking data, 77
opening a settings file, 69
reports, 78
running allocations, 77
setting default column widths, 68
starting, 67
unlocking data, 77
Data Explorer settings
accessing, 69
saving, 69
selecting, 68
data file
column order, 50
creating, 49
grouping by dimension, 51
line item detail, 50
script example, 51
view, 50
Data Forms
adding members, 124
calculating data, 123
changing point of view, 123
editing cell text in, 119
entering cell text in, 118
entering data in, 117
exporting to Excel, 125
importing to Excel, 125
linked forms, 122
opening, 116
suppressing data, 123
toolbar, 116
viewing instructions, 117
viewing intercompany transactions, 126
viewing lists of, 115
data grids
attaching documents, 92
saving settings on the Web, 83
setting rows and columns on the Web, 82
viewing intercompany transactions, 101
data grids: viewing FDM detail, 102
data history, 74
data load methods, 52
data view for process control, 235
delimiter characters, 19
descriptions
adding cell text, 75
requirements for, 19
Desktop
overview, 29
setting the point of view, 29
showing and hiding components, 29
dimensions
overview, 16
searching for on the Desktop, 32
searching for on the Web, 36
Direct Percent Ownership (DOWN) account, 132
documents
accessing related content, 41
adding to favorites, 45
copying links, 40
creating folders for, 38
custom documents, 40
setting up links to, 39
showing private documents, 39
Documents menu options, 37
E
elimination detail, 106
Entity dimension, 17
Entity Transaction Detail Report, 97
error log, 46
extracting data, 59
F
favorites
adding, 45
managing, 45
removing, 45
FDM: accessing from data grids, 102
File Contains Ownership Data load option, 53
Fill option for data grids, 87
Fill option in Manage Ownership, 129
Financial Management
  architecture, 16
  Desktop, 29
  dimensions, 16
  help, 28
  starting from Windows Desktop, 23
  starting on the Web, 24

G
  grids
    in journals, 212
    setting default column widths, 68

H
  help in Financial Management, 28

I
  Intercompany dimension, 18
  Intercompany Reports print override options, 141
  intercompany transactions
    auto-match template, 164
    auto-matching, 164
    copying, 65
    creating, 151
    deleting, 173
    editing, 159
    extracting, 150
    load files, 147
    loading, 149
    manually matching, 165
    match code, 169
    matching status, 168
    posting, 170
    receiving alerts, 262
    sample workflow, 145
    security roles for, 144
    sending alerts, 257
    unmatching, 169
    unposting, 172
    viewing, 154

J
  journal grid
    collapsing columns, 212
    copying and pasting cells, 213
    expanding columns, 212
  journal groups
    creating, 205
    removing, 206
  journal reports
    running, 223
    selecting columns for, 223
    sorting columns, 224
  journal templates
    creating recurring, 188
    creating standard, 186
    deleting, 193
    editing, 192
    process pad, 185
  journals
    approving, 216
    closing periods, 195
    creating, 198
    creating autoreversing, 201
    creating journal groups, 205
    deleting, 228
    editing, 209
    managing journal groups, 205
    opening periods, 195
    posting, 219
    process pad, 197
    rejecting approved journals, 218
    rejecting submitted journals, 217
    removing journal groups, 206
    reviewing, 221
    security roles, 184
    sorting in Process Journals, 207
    sorting in Set Up Journals, 191
    sorting report columns, 224
    status, 204
    submitting, 214
    unposting, 220
    unsubmitting, 215
    using recurring templates, 203
    validating, 222
    viewing lists of, 206
L
label requirements, 19
limitations for characters, 19
line item detail
  adding, 76
  adding on the Web, 94
  viewing in Windows, 76
  viewing on the Web, 95
linked Data Forms, 122
loading data
  procedure, 54
  viewing load progress, 57
Locked status, 73
locking
  data in Data Explorer, 77
  data on the Web, 96
  process units, 253
logging on
  Financial Management Desktop, 23
  from the Web, 24

M
Manage Ownership
  Calculate Ownership option, 132
  changing point of view, 128
  entering information, 129
  overview, 127
  selecting multiple entities, 129
  setting display options, 128
member selection
  on the Desktop, 31
  on the Web, 33
Merge data option, 52
metadata
  displaying in Data Explorer, 68
  displaying on the Web, 82
Method account, 130

N
navigation frame on Desktop, 29
NoData status, 73

O
OK status, 73
operator keys for entering data, 71
Org by Period option, 32
override options for Intercompany reports, 141
ownership management
  Calculate Ownership option, 132
  calculating values for, 131
  changing point of view, 128
  entering values for, 129
  Fill option, 129
  setting display options, 128
  system accounts, 129
percent consolidation
  calculation, 132
  entering percentages, 108
Percent Consolidation (PCON) account, 130
Percent Control (PCTRL) account, 130
percent control calculation, 131
Percent Ownership (POWN) account, 130
percent ownership calculation, 132
Period dimension, 17
periods
  closing, 195
  managing for journals, 194
  opening, 195
point of view
  changing in Data Forms, 123
  in Web Ownership Management, 128
  Org by Period option, 32
  searching for dimensions, 32
  selecting members on the Desktop, 30
  selecting members on the Web, 33
  setting on the Desktop, 29
  setting on the Web, 33
  using check boxes in, 30
  viewing active entities only, 32, 36
Posted journal status, 204
posting journals, 219
preferences, setting user, 25
printing reports, 141
process control
  attaching documents, 246
  calculating data from, 247
  calculation status summary, 242
  consolidating data from, 247
  data view, 235
  options, 236
  Pass/Fail status, 242
receiving alerts, 264
review level summary, 242
sending alerts, 262
toolbar, 241
translating data from, 247
validation detail, 243
viewing calculation status, 244
viewing journal status, 245
viewing rate data, 245
Process Control module, 233
process history, viewing, 254
Process Journals
displaying columns, 207
starting, 197
process levels
description, 231
displaying on the Web, 82
viewing on the Web, 90
process management
approving, 250
enabling, 229
levels, 231
locking and unlocking data, 253
overview, 229
promoting, 247
publishing, 252
rejecting, 251
security roles for, 230
signing off on, 252
starting, 232
submitting, 249
validation, 255
viewing history, 254
process unit sign-off, 252
promoting process units, 247
proportion detail, 106
publishing process units, 252

R
rate data from process control, 245
recurring journal templates, 203
Rejected journal status, 204
rejecting
 approved journals, 218
 process units, 251
 submitted journals, 217
 Replace by Security load option, 53
Replace data load option, 52
report style sheets, 137
reports
 adding descriptions for, 139
 applying style sheets, 137
 Data Explorer reports, 78
 deleting, 142
 Journal reports, 223
 opening, 135
 printing, 141
 saving, 139
 viewing, 137
 viewing intercompany transactions, 140

S
scale value, 82
Scenario dimension, 17
security roles
 for journals, 184
 for process management, 230
 for running allocations, 77
Setup Journals
displaying columns, 190
starting from the Desktop, 184
Shared Services taskflows
deleting permissions, 280
editing permissions, 279
viewing participant details, 283
viewing participant status, 282
showing and hiding Desktop components, 29
signing off on process units, 252
SiteMinder security, 24
standard journal templates, 186
status
 Active, 32
calculation, 73
Chart Logic (CH), 73
Consolidation (CN), 73
Locked, 73
NoData, 73
OK status, 73
viewing in Data Explorer, 73
viewing on the Web, 89
style sheets
 for reports, 137
retrieving, 138
Submitted journal status, 204
submitting
  journals, 214
  process units, 249
summary-level time periods
  in Data Explorer, 70
  on the Web, 87
suppressing data in Data Forms, 123
system messages, 46

T
task automation
  overview, 265
  prerequisites, 266
task lists on Web
  creating, 42
  deleting, 45
  editing, 44
taskflows
  adding links, 275
  copying, 277
  creating, 267
  creating stages, 267
  deleting, 277
  editing, 276
  managing, 266
parameters for Hyperion Financial Management, 270
  running manually, 277
  stopping, 282
  viewing, 276
  viewing status, 280
templates
  creating recurring journal templates, 188
  creating standard journal, 186
  deleting journal templates, 193
  editing journal templates, 192
  using recurring journal templates, 203
  viewing lists of, 190
toolbar on Desktop, 29
transactions
  viewing consolidation, 97
  viewing intercompany, 101
translation
  entering currency rates, 107
  process, 105
  running logic, 109
Translation (TR) status, 73

U
unbalanced journals, 186
unlocking
  data in Data Explorer, 77
  data on the Web, 96
  process units, 253
unsubmitting journals, 215
user preferences, 25
user-defined element requirements, 19

V
validation
  for journals, 222
  for process management, 255
Value dimension, 18
View dimension, 18

W
Working journal status, 204

Y
Year dimension, 17

Z
zero values
  in Data Forms, 123
  in data grids, 82